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Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come lintensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)
Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze tra i livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 \W/kg in media per dieci grammi
di tessuto.

Il valore SAR piti elevato registrato per questo modello per ['uso vicino allorecchio e pari a
0,244 W/kg (10 g) e paria 1,466 W/kg (10 g) a contatto con il corpo.

Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed e
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.
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Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso lazione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo e conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio & conforme alla parte 15 delle norme FCC. Il funzionamento & soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare (autorita
dellutente allutilizzo dellattrezzatura.

Funzionamento del dispositivo indosso all'utente

Il presente dispositivo & stato testato per le tipiche funzioni in cui lo si indossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Indicazioni per un uso sicuro ed efficiente 7



Parte 15.105

Questa apparecchiatura e stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, puo causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

Orientare o posizionare di nuovo lantenna di ricezione.
Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.

Manutenzione e cura del prodotto

Indicazioni per un uso sicuro ed efficiente

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare lapparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.
Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere apparecchio.

Non sottoporre lapparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo allinterno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).



+ Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre lapparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. | danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.

Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e [assenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, & necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente all'interno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed un'insufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dell'utente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Puo
generare calore o fuoco.

Evitare di esporre il dispositivo a basse pressioni dellaria ad alta quota.

Non esporre il dispositivo a pressioni dellaria estremamente basse. Altrimenti cio puo
causare [esplosione della batteria o perdite di liquido o gas infiammabile.

Indicazioni per un uso sicuro ed efficiente 9



Funzionamento efficiente del dispositivo

Dispositivi elettronici
Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

| produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.

Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 35 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse pud causare danni,
malfunzionamenti o perfino esplosioni.

Sicurezza in automobile
Verificare le leggi e le normative che riguardano l'utilizzo dei dispositivi quando si guida.
+ Non utilizzare il dispositivo in modalita manuale durante la guida.
Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

Lenergia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo é dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Indicazioni per un uso sicuro ed efficiente 10



Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.

+Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume ¢ tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato puo causare la perdita
dell'udito.

Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili all'interno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
Luso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

« Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Indicazioni per un uso sicuro ed efficiente 11



Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.

Manutenzione e informazioni sulle batterie

Non & necessario scaricare completamente la batteria prima di ricaricarla. A differenza
dialtri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
Tenere puliti i contatti metallici della batteria.

Sostituire la batteria quando le prestazioni non sono pit accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo e completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Consumo energetico (modalita standby di rete): 0,4 W

Indicazioni per un uso sicuro ed efficiente 12



Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

Assicurarsi di esequire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire 'uso improprio delle informazioni sensibili.

Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

Non utilizzare applicazioni provenienti da fonti sconosciute.

A Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

« Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificati, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

« Larimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http7//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni di registrazione video

Fotocamera grandangolare

E possibile scattare foto o registrare video con un angolo di campo piti ampio
del campo visivo effettivo utilizzando lobiettivo grandangolare della fotocamera
posteriore e di quella anteriore.

Toccare (&), quindi toccare (¢) / @) per passare tra obiettivo standard e
grandangolo.

Obiettivo standard Grandangolo

E « Peridettagli, vedere, consultare la sezione Awio della fotocamera.

+ Puoi passare dalle lenti standard a quelle a campo ampio solo sulla fotocamera
posteriore.

Funzioni personalizzate
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Google Lens

Potrai ottenere maggiori informazioni o effettuare azioni su oggetti intorno a te
usando Google Lens, come pietre miliari, poster, menu di ristoranti, animalj, fiori, o
codici a barre, direttamente nel tuo dispositivo.

Per esempio, quando usi Google Lens su una:

carta di credito: potrai salvare il numero o un indirizzo su un contatto.

Libro: Puoi ricevere recensioni e altri dettagli su di esso.

Pietre miliari o edifici: Potrai ricevere altri dettagli su di esso.

Dipinto in un museo: Potrai ricevere dettagli su di esso.

Una pianta o un animale: Potrai sapere altri dettagli su di esso.

Un volantino o un tabellone di un evento: Puoi aggiungere quell'evento al tuo
calendario.

E + Google Lens é disponibile solo quando il proprio dispositivo & connesso a una rete.
Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

Usare Google Lens

1 Toccare (B)> (e,

7 Punta la tua fotocamera su un oggetto.

3 Perottenere dettagli o eseguire un'azione:
+ Tocca l'elemento sul tuo schermo.

« Per selezionare il testo: Tocca una parola quindi toccala nuovamente e
trascina i punti blu.

Chiedi una domanda o pronuncia un comando, come:
. Cos'e questo?
« Chiama questa persona

Aggiungilo a Google Keep
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Ritratto

Puoi scattare un ritratto applicando un effetto di sfocatura delle lenti per la
fotocamera.

1 Toccare (&), quindi toccare Ritratto.
2 Sfiorare O per scattare una foto.

« Perregolare il livello dello sfocaturg, trascina la barra di scorrimento a sinistra

o0 adestra.

E + Mantieni la distanza dal tuo soggetto entro 1,3 - 5,0 piedi quando usi la
fotocamera posteriore.
Questa funzionalita non & disponibile se 'ambiente & buio
Dopo avere applicato questa funzionalita, tocca la posizione desiderata sulla
schermata di anteprima per applicare automaticamente il valore di esposizione e
messa a fuoco quando usi la fotocamera posteriore, oppure soltanto un valore di
esposizione quando usi la fotocamera anteriore.

Funzioni personalizzate
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Al CAM

Puoi scattare foto o registrare video efficacemente perché |a telecamera riconosce
l'oggetto quando scatti una foto o registri un video.

1 Toccare (&), quindi toccare Al CAM.

2 Quando l'oggetto viene riconosciuto, viene applicato il miglior effetto per la
scena.
+ Per applicare altri effetti, toccare licona della scena.

- Ritratti, cuccioli, cibo, tramonto, alba, scenario, vista della citta, fiori, bambini,
cielo, spiaggia, ecc, vengono riconosciute automaticamente 19 categorie in
totale.

5 « Ilrisultato del riconoscimento della scena potrebbe essere differente a seconda
dell'illuminazione o della posizione del soggetto quando si scatta |a foto. Le parole
chiave non appaiono sulle foto o i video.

+ Questa funzionalita & disponibile solo quando le telecamere posteriore e anteriore
sono in modalita automatica.
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Cine Video
E possibile registrare un video cinematografico.
T Toccare (&) quindi toccare Altro > Cine Video @

2 Toccare o per registrare un video.

- L& :Registrare un video selezionando la funzione "Point zoom" per
ingrandire o rimpicciolire un'area specifica.

. :Consente di selezionare un effetto da applicare durante la registrazione.
Inoltre, & possibile regolare la vignettizzazione e l'intensita di ciascun
effetto Cine. Una volta iniziata |a registrazione, non e possibile modificare la
funzione.

« Lafunzione Point Zoom supporta una velocita di ingrandimento fino a 3x.

+ Questa funzione supporta solo registrazioni video con un obiettivo standard.
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Cine shot

E possibile registrare un momento e creare un video con solo una parte della scena

in movimento.

Durante |a registrazione di un video, tenere fermo il dispositivo. Dopo la
registrazione, sfiorare larea del video che si desidera in movimento. Larea
selezionata inizia a muoversi mentre il resto del video rimane fermo.

1 Toccare (&), quindi toccare Altro >,

2 Toccare @ per registrare un video di 3 secondi.
+ Tenere fermo il dispositivo durante la registrazione del video.

3 Toccare (#) e sfiorare area che si desidera in movimento con leffetto scatto
Cine.

Annulla — de—— Ripetutamente in avanti e

indietro.
Ripeti

Riproduce ripetutamente in
avanti

Seleziona l'area da spostare. —guunel e —— Cancella l'area selezionata.

+ Toccare (9) per cancellare l'area selezionata.
« Toccare (3) per riprodurre ripetutamente in avanti larea selezionata.

- Toccare (@) per riprodurre ripetutamente in avanti e indietro larea
selezionata.

/' Toccare SALVA.
« L'area selezionata sara in movimento.

Funzioni personalizzate
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Jump-cut flash

Le foto scattate a intervalli regolari sono salvate come file GIF
T Toccare (&), quindi toccare More > Jump-cut flash ;)=

7 Sfiorare © per scattare una foto.
« Le foto sono scattate ogni 3 secondi e sono salvate come file GIF

+ Tocca (@] sullo schermo per selezionare il numero di foto che vuoi scattare.

+ Quando scatti foto, tocca ‘® per creare file GIF cono foto scattate in
precedenza.

Il flash si accende automaticamente e agisce come un timer.

i

Gli scatti realizzati questa volta e il numero totale di scatti vengono visualizzati in
fondo allo schermo.

Tutte le foto scattate sono salvate come file GIF

« Non puoi maodificare la velocita dei GIF né ['ordine delle immagini

Funzioni personalizzate
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Graphy
E possibile applicare i valori consigliati per il bilanciamento del bianco, [1SO ¢ la
velocita dell'otturatore, come quelli di un esperto.

T Toccare (&), quindi toccare Fotocamera manuale.
2 Toccare £53 e quindi Foto con Graphy (O per attivare la funzione.
3 Toccare @ e selezionare la scena desiderata tra le immagini consigliate.

4 Sfiorare O per scattare una foto.

+ Questa funzione & disponibile solo nella modalita Fotocamera manuale.

« E possibile aggiungere nuove scene, toccando i e scaricando 'app Graphy dal
Play Store. A seconda del proprio piano tariffario, potrebbe essere addebitato il
costo dei dati utilizzati per il download.

« Toccare €,§3 quindi tocca @3) nel menu Graphy per disattivare questa funzione.

Registrazione di video Hi-Fi
E possibile registrare un video di qualita alta con audio Hi-Fi.
Toccare (), quindi toccare Altro > Video manuale ((¥) > 63> Hi-Fi.

« Peridettagli vedere, consultare la sezione Awio della fotocamera.

« | video Hi-Fi possono essere riprodotti solamente in app che supportano ['Hi-Fi.
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Composizione Al

Durante la ripresa di ritratti, il motore Al consente di modificare automaticamente
la posizione del soggetto e individuare la composizione ottimale dellimmagine.
\lengono salvate sia la foto originale che la composizione Al.

1 Durante lo scatto di foto con la fotocamera posteriore, toccare Al CAM.
2 Quando la fotocamera rileva il soggetto, nella parte superiore dello schermo
appaiono [£:3] consigliato e Verra applicata Composizione Al
+ Il soggetto deve essere composto da meno di tre persone.
+ Il soggetto vene riconosciuto quando viene posizionato nella parte superiore
dello schermo.
3 Quando appare l'icona di Composizione Al toccare (O per scattare la foto.
+ Toccare la miniatura con | £23| dalla Galleria per visualizzare la foto.
- Le foto con[_]sono le foto originali scattate dall'utente.
+ Le foto con [£23] sono foto di Composizione Al.
- Toccare ] e[ per confrontarle.

np

Foto originale Foto Composizione Al
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Ilrisultato del riconoscimento della scena potrebbe essere differente a seconda
dell'illuminazione o della posizione del soggetto quando si scatta la foto.

i

+ Quando si scatta una foto, sullo schermo appaiono le parole chiave associate al
soggetto. Le parole chiave non appaiono sulle foto stesse.

+ Questa funzionalita e disponibile solo con la fotocamera posteriore.

Funzioni della Galleria

Contenuti correlati
E possibile modificare e personalizare i contenuti correlati nella Galleria.

1 Mentre sivisualizza lanteprima di una foto, toccare & .

2 Unavolta visualizzata licona relativa alla data o al luogo in cui si & scattata la
foto, toccare lo schermo.

- E possibile visualizzare le foto correlate alla data o al luogo scelto.

Funzioni personalizzate
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- Toccare + peraccedere a ulteriori opzioni.

Realizzazione di una GIF
E possibile creare un file GIF dalla Galleria.

1 Mentre si sta visualizzando un album, toccare > Crea GIF.

7 Seleziona le foto e i video desiderati per creare un file GIF, quindi toccare Avanti.
- E possibile aggiungere piti immagini e regolare la velocit3, le proporzioni
schermo e l'ordine dei file della GIF

3 Tocca Salva.

E « Per creare un file GIF possono essere utilizzate un massimo di 100 immagini.
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Realizzazione di un collage
Puoi creare un collage dai contenuti associati.

1 Mentre si sta visualizzando un album, toccare > Realizza collage.

2 Selezionare le immagini desiderate da aggiungere al collage, quindi toccare
Avanti.
+ Selezionare il layout desiderato sul fondo dello schermo.

3 Toccare Crea.

E + Per creare un collage possono essere utilizzate un massimo di 9 immagini.

Realizzazione di un video da contenuti correlati

Puoi riunire i contenuti correlati per realizzare un video, toccando @ sul video che
mostra la data o/l luogo.

Selezionare il tema e la musica di sottofondo, regolare gli effetti della didascalia e
ordinare o aggiungere la data e la firma, quindi toccare Salva.

- &% Selezionare il tema del video.
- Per scaricare il tema, toccare i .
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+ dd :Aggiungere la musica di sottofondo o regolare il tempo di riproduzione.
- Per selezionare un file per la musica di sottofondo, toccare -
- Per scaricare un file per la musica di sottofondo, toccare .
- Perregolare il volume della musica di sottofondo e del video originale, toccare
- A :Selezionare un tipo di carattere.
- Per scaricare un carattere, toccare i .
- 3 :Aggiungere il nome dellautore nel video.
- P : Cambiare l'ordine dei file da riprodurre in video.
- Per aggiungere file, toccare .

5 « Scaricare 'app VASSET dal Play Store per aggiungere temi, musica di sottofondo o
tipi di carattere al video.
A seconda del proprio piano tariffario, se non si utilizza una connessione Wi-Fi,
potrebbe essere addebitato il costo dei dati utilizzati per il download.
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Creazione di un filmato
E possibile creare un nuovo filmato, mettendo insieme immagini e video.

1 Toccare la scheda @8 > Foto, quindi toccare > Crea filmato.
E possibile anche toccare la scheda @3> Play, quindi toccare : > Crea filmato.

2 Selezionare immagini e video per il tuo filmato e toccare Avanti.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.
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Eliminazione di file

E possibile selezionare le immagini e i video che vuoi rimuovere dal filmato,
toccando € nell'angolo in alto a destra di questa miniatura.

Aggiunta di file

E possibile selezionare le immagini e i video che vuoi aggiungere al filmato, toccando
- sul fondo dello schermo. E anche possibile selezionare le immagini e i video che
sono stati aggiunti in precedenza.

E + Toccare e tenere premuto un file, quindi toccare un altro file per una selezione
multipla.

Riorganizzazione dei file

Per riorganizzare le immagini e i video, toccare e tenere premuto il file che si vuole
spostare, quindi trascinarlo nella posizione desiderata.

Aggiunta di effetti ai file

Toccare 7 per aggiungere un tema o la musica di sottofondo, oppure modificare il
carattere.

Reset delle modifiche del filmato

E possibile resettare le modifiche applicate al filmato (ad es. tempo di riproduzione),
toccando &.

Anteprima di un file

Controllare il nuovo video prima del salvataggio, toccando . Al termine dalla
riproduzione, il file seguente viene riprodotto in automatico.

E « Per creare un video possono essere utilizzate un massimo di 50 immagini e video.
« lltempo di riproduzione di un'immagine per impostazione predefinita e di 3
secondi, e non pud essere modificato. | video possono essere tagliati fino a un
minimo di 1 secondo.

Questa funzione potrebbe non supportare alcuni formati di immagini o video.
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Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video o foto registrati.

Crea una GIF utilizzando video registrati.

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @),

7 Selezionare la durata della GIF che si desidera creare.
+ Viene generata una GIF della durata desiderata a partire dal punto indicato.

+ In caso divideo con durata inferiore ai 5 secondi, le immagini GIF vengono
generate automaticamente per il tempo restante.

Crea una GIF utilizzando foto
T Mentre si sta visualizzando un album, toccare ¢ > Crea GIF.

2 Seleziona le foto desiderati per creare un file GIF, quindi tocca AVANTI.
- E possibile aggiungere piti immagini e regolare la velocitd, le proporzioni
schermo e l'ordine dei file della GIF

A - E possibile utilizzare questa funzione solo per finalita creative. L'utilizzo di questa
funzione per finalita che comportino una violazione dei diritti di un altro individuo,
come la violazione del copyright, la diffamazione o dichiarazioni offensive, sara
soggetto a responsabilita civili, penali o amministrative e/o a sanzioni, in base a
quanto stabilito dalla legge applicabile. Non & consentita la copig, a riproduzione,
la distribuzione o qualsiasi altro uso illegale dei materiali protetti da copyright,
senza previo consenso del proprietario di diritto o del titolare del copyright. LG
Electronics non riconosce alcuna garanzia, espressa o implicita, né responsabilita a
essa collegata, nella massima misura consentita dalla legge applicabile.

+ Per creare un file GIF possono essere utilizzate un massimo di 100 immagini.
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Qualita audio e funzionalita effetti

DTS:X 3D Surround

Puoi riprodurre una canzone o un video con un suono vivido, immersivo e
tridimensionale. Per usare questa funzionalita, connetti auricolari, altoparlante, o
altrei dispositivi audio esterni al tuo dispositivo.

Nella schermata Home, toccare Impostazioni > Suono > Qualita del suono ed
effetti > DTS:X 3D Surround, quindi toccare Q) per attivare questa funzionalita.

Consente di regolare la direzione dell'audio
Puoi regolare la direzione dell'audio come la desideri.

1 Nella schermata Home, toccare Impostazioni > Suono > Qualita del suono ed
effetti > DTS:X 3D Surround, quindi toccare QD).

7 Seleziona la direzione dell'audio.
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Floating Bar

Panoramica Pulsante fluttuante

Puoi attivare le funzioni piti frequenti, tra cui scorciatoie, screenshot, lettore
musicale e contatti rapidi, toccando e facendo scorrere la Floating Bar sullo
schermo.

Per attivare la funzione "Floating Bar", toccare () > Impostazioni > Estensioni >
Floating Bar Q).

Apertura e chiusura della Floating Bar
+ Per aprire la barra fluttuante: Toccare € oppure ».
+ Per chiudere a barra fluttuante: Toccare » oppure <.

Funzioni personalizzate
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Modificare la posizione della Floating Bar
+ Floating Bar aperta: Toccare e tenere premuta la barra fluttuante, quindi
trascinarla nella posizione desiderata.
- Floating Bar chiusa: Toccare e tenere premuta la barra fluttuante, quindi
trascinarla nella posizione desiderata lungo il margine dello schermo.

Disattivazione della Floating Bar
E possibile disattivare la barra fluttuante utilizzando una delle sequenti opzioni:

+ Toccare e tenere premuto € oppure > sulla barra fluttuante, quindi trascinarla
nell'area di eliminazione nella parte superiore dello schermo.

+ Toccare < oppure » sulla Floating Bar; quindi toccare G=o > @  nella parte
superiore dello schermo.

- Toccare O > Impostazioni > Estensioni > Floating Bar @ .
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Impostazione della barra fluttuante
E possibile selezionare gli elementi da visualizzare nella Floating Bar e modificarne
lordine di visualizzazione. Toccare =9 sulla Floating Bar oppure O > Impostazioni
> Estensioni > Floating Bar.

- Mansione: E possibile impostare unarea in cui spostare la Floating Bar

- Collegamenti: Accedi rapidamente alle app e alle funzioni utilizzate piti spesso.

+ Acquisizione schermata: Scatta un'immagine dello schermo per ritagliare la

parte desiderata oppure creare un file GIF

Z E possibile usare Capture+ sulla schermata desiderata.
w0 E possibile acquisire uno screenshot scorrevole e usarlo per Q Memo+ o
L salvarlo nella galleria.
ey E possibile acquisire larea desiderata e usarla per Q Memo+ o salvarla nella
== galleria.
Salvare la schermata corrente come un file GIF. E possibile regolare la
dimensione dellimmagine che vuoi catturare.
C.: + Per spostarla nella posizione desiderata, trascinare =.

+ Per awiare la registrazione di una GIF, toccare (o),
+ Per interrompere la registrazione di una GIF, toccare (),

Lettore musicale: Controlla la musica che stai ascoltando.
Contatti rapidi: Chiama o invia un messaggio alle persone identificate come

contatti rapidi.

5

Possono essere aggiunte alle scorciatoie fino a 5 app o funzioni.
E possibile aggiungere ai contatti rapidi fino a 5 contatti.

GIF Capture e una funzione che consente all'utente di produrre immagini creative.
La violazione dei diritti di proprieta intellettuale o la diffamazione della reputazione
di altre persone mediante la funzione GIF Capture possono comportare
responsabilita civili o penali in conformita con le leggi vigenti. Fare attenzione a non
copiare o trasmettere opere di altre persone senza autorizzazione. LG Electronics
declina ogni responsabilita per tali azioni degli utenti.

E possibile creare GIF di una durata massima di 15 secondi.
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Assistente Google

Panoramica Assistente Google
Puoi awviare o usare app con la tua voce.

E « Per usare questa funzionalita, per prima cosa connettiti alla rete e accedi al tuo
account Google.

« Questa funzionalita potrebbe non funzionare correttamente oppure l'accuratezza
del riconoscimento vocale potrebbe ridursi in aree dove la potenza del segnale della
rete mobile o Wi-Fi & debole.

+ Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

Awvio di Assistente Google
T Tieni premuto Q) dalla schermata iniziale per lanciare Assistente Google .
7 Tocca INIZIA.
3 Seguile istruzioni su schermo e pronuncia "Ok Google".
- Il dispositivo salva i dati della tua voce per il riconoscimento.
4 Selezionare se abilitare 0 meno la funzionalita di riconoscimento vocale.

+ Quando questa funzionalita e abilitata, & possibile eseguire Assistente
Google pronunciando “OK Google” nella schermata Home.
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Avwvio di Assistente Google usando la tua voce
1 Pronuncia "Ok Google" quando lo schermo & spento o bloccato.

7 Pronuncia un comando o una domanda quando " Ciao, come posso aiutarti?"
appare sullo schermo.

Awvio di Assistente Google dalla schermata iniziale
1 Tieni premuto O dalla schermata iniziale.
7 Pronuncia un comando o una domanda quando "Ciao, come posso aiutarti?"

appare sullo schermo.

E + L'accuratezza del riconoscimento vocale potrebbe ridursi se parliin modo poco
chiaro o in un luogo rumoroso. Quando usi la funzionalita di riconoscimento vocale,
aumenta |'accuratezza parlando in modo chiaro e in un luogo silenzioso.

Funzioni di registrazione audio

Il Registratore Audio HD ti consentira di configurare manualmente le impostazioni
audio in modo tale da poter registrare audio in base all'ambiente in cui ti trovi.

Modalita di registrazione

E possibile registrare un file audio ad alta definizione selezionando e configurando
la modalita audio desiderata, adatta allambiente di registrazione.

Nella schermata Home, toccare Essenziali > Registratore Audio HD > =

Normale
E possibile registrare audio senza impostazioni aggiuntive.

Concerto
E possibile registrare audio durante un concerto o altri eventi musicali
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Personalizzato

E possibile configurare manualmente le impostazioni desiderate per registrare
laudio.

Modalita Studio

La modalita Studio consente di riprodurre un file audio o musicale e registrare
contemporaneamente |a propria voce, creare un accordo registrando piti volte
la propria voce, nonché registrare i propri commenti sul file audio originale del
presentatore o del parlante.

T Nella schermata Home, toccare Essenziali > Registratore Audio HD > =>

Personalizzato.
Sfiorare J -
Selezionare un file audio da utilizzare come musica di sottofondo.

Toccare . per registrare la voce.

u b wN

Toccare @) per salvare il file registrato.

5 « Lamusica di sottofondo puo essere riprodotta solo attraverso gli auricolari.
Assicurarsi di collegare gli auricolari prima di utilizzare questa funzione.

Altre funzioni utili per l'uso dell'app Registratore Audio HD

GAIN
E possibile regolare la sensibilita dellaudio registrato dal microfono.

Maggiore ¢ il valore su cui & impostato il GAIN, maggiore la sensibilita di
registrazione dellaudio.

LCF

E possibile filtrare qualsiasi rumore a bassa frequenza, come il ronzio del
condizionatore.

Maggiore ¢ il valore su cui & impostato LCF (Low Cut Filter; filtro taglia-bassi),
migliore risulta il filtraggio dei rumori ad alta frequenza.
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LMT

Consente diimpedire il fenomeno di clipping dellaudio registrato. Piu alto e il
valore su cui e impostato LMT (Limitatore), maggiore ¢ la quantita di suoni a bassa
frequenza che non subiranno clipping.

E « Per modificare altre impostazioni, toccare E > Impostazioni, quindi personalizzare
il tipo di file, la profondita in bit, la frequenza di campionamento e altre

impostazioni.

Quando vengono selezionate le modalita Concerto o Personalizzata, verra

visualizzato l[.]nﬂ Toccare LU@ quindi selezionare il microfono da utilizzare.

E possibile monitorare la qualita del suono mediante (altoparlante auricolare
collegato durante una registrazione audio. Durante una registrazione audio in
modalita Studio, il monitoraggio del suono non & supportato. E possibile sentire
solamente la musica di sottofondo.

Riconoscimento delle impronte digitali

Informazioni generali sul riconoscimento delle
impronte digitali
Prima di utilizzare la funzione di riconoscimento delle impronte digitali, & necessario
registrare la propria impronta sul dispositivo.
La funzione di riconoscimento delle impronte digitali puo essere impiegata nei casi
seguenti:

+ Per sbloccare lo schermo.

+ Per visualizzare i contenuti bloccati nella Galleria o in QuickMemo-+.

+ Per confermare un acquisto effettuando laccesso a unapp o identificandosi
tramite limpronta digitale.

E - Limpronta puo essere utilizzata dal dispositivo per il riconoscimento dellutente.
Impronte digitali molto simili appartenenti a utenti diversi potrebbero essere

riconosciute dal sensore di impronte come la stessa impronta.

Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il

valore specificato per la registrazione, recarsi presso il pit vicino Centro di servizio

clienti LG con il dispositivo e la scheda di identificazione.
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Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, eseguire le sequenti verifiche prima dell'utilizzo
del dispositivo.

Il dispositivo dispone di un sensore per impronte digitali. Assicurati che il sensore
per impronte digitali non venga danneggiato da un oggetto metallico, come ad
esempio una moneta o una chiave.

Nel caso in cui sul sensore per impronte digitali o sul dito siano presenti acqua,
polvere o altre sostanze estranee, la registrazione o il riconoscimento delle
impronte digitali potrebbero non avere esito positivo. Pulire e asciugare il dito
prima di procedere al riconoscimento dellimpronta.

Il riconoscimento dell'impronta potrebbe non andare a buon fine se la superficie
del dito ha una cicatrice oppure non ¢ liscia a causa dellimmersione in acqua.

Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Eseguire la scansione di un solo dito per ciascuna registrazione. La scansione
di piti di un dito potrebbe compromettere la registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante e secca. Se
laria circostante e secca, evitare la scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.

Funzioni personalizzate 39



Registrazione delle impronte digitali

E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

7 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

E « E necessario impostare una schermata di blocco per poter utilizzare questa
funzione.
+ Seil blocco schermo non é attivo, configurare la schermata di blocco seguendo le
istruzioni visualizzate sullo schermo. Per i dettagli, vedere, consultare la sezione
Impostazione di un blocco schermo.

2 Individua la posizione del sensore per impronte digitali sul retro del dispositivo e
appoggia il dito con delicatezza per registrare [impronta digitale.

E + Premere delicatamente il sensore per impronte digitali in modo che il sensore
possa riconoscere [impronta digitale dell'utente.
« Assicurarsi che la punta del dito copra lintera superficie del sensore delle impronte
digitali.
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3 Seguire le istruzioni visualizzate sullo schermo.
« Ripetere la scansione dellimpronta digitale muovendo leggermente il dito
fino alla registrazione dellimpronta digitale.
/. Una volta completata la registrazione dell'impronta, toccare OK.

+ Toccare Aggiungi altro per registrare unaltra impronta digitale. Se si registra
solo un'impronta digitale e il dito corrispondente non € in condizioni ottimali,
il riconoscimento dellimpronta potrebbe non funzionare correttamente. Per
prevenire linsorgere di questo tipo di situazione, & consigliabile registrare pit
impronte digitali.

Gestione delle impronte digitali
E possibile modificare o eliminare le impronte digitali registrate.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un'impronta digitale per rinominarla.
Per eliminarla, toccare EJT

Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo e visualizzare i contenuti bloccati utilizzando la

propria impronta digitale. Attivare la funzione desiderata:

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:
+ Blocco schermo: consente di sbloccare lo schermo con un'impronta digitale.

+ Blocco del contenuto: consente di sbloccare un contenuto con un'impronta
digitale. A questo scopo, assicurarsi che sia impostato il blocco contenuto.
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Riconoscimento del volto

Informazioni generali sul riconoscimento del volto
E possibile sbloccare il blocco schermo utilizzando i dati di riconoscimento del volto.

5

Questa funzione puo risultare piti vulnerabile in termini di sicurezza rispetto ad
altri metodi di blocco schermo come Knock Code, Sequenza, PIN o Password.

Se si utilizza un volto somigliante o una foto del tuo volto, & possibile che il blocco
schermo venga rimosso.

| dati del volto riconosciuti sono salvati in modo sicuro nel dispositivo.

Quando si seleziona il riconoscimento del volto per il blocco schermo, & necessario
immettere il codice Knock Code, la Sequenza, il PIN o la Password utilizzata per

la registrazione del volto senza utilizzare direttamente il riconoscimento del

volto dopo 'accensione. Prestare pertanto attenzione a non dimenticare il valore
specificato.

Se il dispositivo non riesce a individuare il volto o se si dimentica il valore specificato
per la registrazione, recarsi presso il piti vicino Centro di servizio clienti LG con il
dispositivo e la scheda di identificazione.

Per risparmiare la batteria, la funzione di Riconoscimento del volto non e
utilizzabile quando la percentuale della batteria e al di sotto del 5%.

Precauzioni per il riconoscimento del volto
L'accuratezza del riconoscimento del volto potrebbe diminuire nei casi riportati
di seguito. Per aumentarla, eseguire le sequenti verifiche prima dell utilizzo del
dispositivo.
+ Seil volto e coperto da un cappello, da occhiali o da una maschera o se il volto
appare molto diverso a causa di un trucco pesante o di una folta barba.

+ Se sono presenti impronte digitali 0 sostanze estranee sulla parte anteriore
dell'obiettivo della fotocamera o se il dispositivo non riesce a individuare il volto a
causa di una luce troppo intensa o troppo scarsa.
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Registrazione dei dati del volto
Prima di utilizzare la funzione di riconoscimento del volto, registrare i dati del volto
sul dispositivo.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento del volto.

E + Per utilizzare questa funzione, il blocco schermo deve essere impostato tramite
Knock Code, Sequenza, PIN o Password.

«+ Senon e stato impostato il blocco schermo, registrare i dati seguendo le
istruzioni visualizzate sullo schermo. Per i dettagli, vedere, consultare la sezione
Impostazione di un blocco schermo.

7 Toccare Avanti e sbloccare il dispositivo secondo il metodo specificato.
3 Toccare Inizia e sollevare il dispositivo davanti ai propri occhi.

A Registrare il volto sequendo le istruzioni visualizzate sullo schermo.
« Registrare il volto in un ambiente non troppo luminoso né troppo buio.

« Posizionare lintero volto all'interno delle linee guida sullo schermo e quindi
regolarlo eseguendo lenti spostamenti in alto, in basso, a sinistra o a destra.

+ Resta fermo quando registri il tuo volto. Puoi migliorare il tasso di
riconoscimento scattando foto da fermo piti volte.

5 Una volta completata la registrazione del volto toccare OK.

Sblocco dello schermo con il volto

£ possibile rimuovere il blocco schermo con il volto anziché tramite Knock Code,
Sequenza, PIN o Password.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo.

7 Sbloccare lo schermo in base al metodo specificato.

3 Toccare Consenti Riconoscimento del volto (O per sbloccare lo schermo
tramite il riconoscimento del volto.
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Miglioramento del riconoscimento del volto

Per migliorare il riconoscimento del volto, e possibile aggiungere i dati del volto in
varie condizioni.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento del volto.

Sbloccare lo schermo in base al metodo specificato.
Selezionare Migliora il riconoscimento del volto.

Registrare il volto seguendo le istruzioni visualizzate sullo schermo.

b wN

Una volta completata la registrazione del volto toccare OK.

Eliminazione dei dati del volto

Se il riconoscimento del volto non funziona correttamente, & possibile eliminare i
dati del volto registrati in precedenza e quindi registrarli di nuovo.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento del volto.

7 Sbloccare lo schermo in base al metodo specificato.

3 Selezionare Elimina volto per eliminare i dati del volto.

Sblocco dello schermo con il volto quando lo schermo & spento

Con lo schermo spento, sollevare il dispositivo e guardare la parte anteriore dello
schermo. Il dispositivo pud quindi rilevare il volto e lo schermo si sblocca.

Per disattivare questa funzione, sequire le istruzioni riportate di sequito.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento del volto.

2 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Consenti quando lo schermo & spento @) per disattivare la
funzione.

+ Lafunzione di riconoscimento del volto ¢ disponibile solo quando lo schermo
& bloccato.
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Sblocco dello schermo con il riconoscimento del volto seguito
da scorrimento

Con lo schermo spento, & possibile sbloccare lo schermo tramite il riconoscimento
del volto sequito dallo scorrimento.

1 Nella schermata Home, toccare > Impostazioni > Blocco schermo & sicurezza
> Riconoscimento del volto.

7 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Richiedi sblocco con scorrimento dopo il riconoscimento del
volto QD per attivare la funzione.

Impostazione avanzata del riconoscimento del volto
E possibile impedire che il dispositivo sia sbloccato da foto, immagini o video.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento del volto.

2 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Riconoscimento del volto avanzato Q) per attivare la funzione.

E «+ Quando si attiva questa funzione, la velocita del riconoscimento del volto potrebbe
diminuire.
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Riconoscimento vocale

Informazioni generali sul riconoscimento vocale
Consente di sbloccare lo schermo utilizzando le tua voce.

5

Questa funzione puo risultare piti vulnerabile in termini di sicurezza rispetto ad
altri metodi di blocco schermo come Knock Code, Sequenza, PIN o Password.

Se si utilizza un voce somigliante o una voce registrata, & possibile che il blocco
schermo venga rimosso.

Quando si seleziona il riconoscimento vocale per il blocco schermo, & necessario
immettere il codice Knock Code, la Sequenza, il PIN o la Password utilizzata per la
registrazione vocale senza utilizzare direttamente il riconoscimento vocale dopo
l'accensione. Prestare pertanto attenzione a non dimenticare il valore specificato.

Se il dispositivo non riesce a individuare la voce o se si dimentica il valore
specificato per la registrazione, recarsi presso il pit vicino Centro di servizio clienti
LG con il dispositivo e la scheda di identificazione.

| dati vocali riconosciuti sono salvati in modo sicuro nel dispositivo.

Precauzioni per il riconoscimento vocale

L'accuratezza del riconoscimento vocale potrebbe diminuire nei casi riportati
di seguito. Per aumentarla, eseguire le sequenti verifiche prima dell utilizzo del
dispositivo.

Quando non utilizzi uno dei comandi vocali registrati.
Quando parli in un luogo rumoroso.
Quando il buco del microfono é coperto dalla tua mano o da altre sostanze

estranee.

Quando il comando vocale registrato e troppo breve (si consiglianoda 3a 5

sillabe).
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Registrazione di un comando vocale
Prima di utilizzare la funzione di riconoscimento vocale, registrare i comandi vocali
sul dispositivo.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento vocale.

E + Per utilizzare questa funzione, il blocco schermo deve essere impostato tramite
Knock Code, Sequenza, PIN o Password.

«+ Senon e stato impostato il blocco schermo, registrare i dati seguendo le
istruzioni visualizzate sullo schermo. Per i dettagli, vedere, consultare la sezione
Impostazione di un blocco schermo.

7 Toccare Avanti e sbloccare il dispositivo secondo il metodo specificato.

w

Toccare Inizia.

4 Tocca &, quindi segui le istruzioni su schermo per registrare un comando vocale.
« Ripeti un comando vocale per 4 volte con una voce distinta e forte.

+ Registra il comando vocale in un luogo silenzioso.

+ Registrazione di un comando vocale di 2-3 parole. (Ad es. "LG mobile")

5 Quando il comando vocale & stato registrato, toccare OK. Quindi scegliere come
usare il riconoscimento vocale.

Modifica di un comando vocale

E possibile modificare un comando vocale registrato in precedenza.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento vocale.

2 Sbloccare lo schermo in base al metodo specificato.

w

Toccare Cambia Voce.

/' Tocca 8, quindi sequi le istruzioni su schermo per registrare nuovamente un
comando vocale.

5 Quando il comando vocale & stato modificato, toccare OK.
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Eliminazione di un comando vocale
E possibile eliminare un comando vocale registrato.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento vocale.

7 Sbloccare lo schermo in base al metodo specificato.

3 Toccare Elimina Voce.

+ In questo caso, non e possibile utilizzare la funzione di sblocco per il blocco
tramite riconoscimento vocale.

E « Perregistrare di nuovo un comando vocale dopo che lo hai cancellato, vedere
Registrazione di un comando vocale.

Selezione del metodo di riconoscimento vocale
E possibile selezionare come utilizzare il riconoscimento vocale.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento vocale.

7 Sbloccare lo schermo in base al metodo specificato.

3 Toccare Riconoscimento vocale usato per.
+ Sblocca: Sbloccare il dispositivo tramite un comando vocale.
+ Accendi lo schermo: Accensione dello schermo tramite un comando vocale.

Visualizzazione del blocco schermo di scorrimento in seguito
al riconoscimento vocale

Anche quando lo schermo & spento, e possibile utilizzare il riconoscimento vocale e
sbloccare lo schermo per scorrimento.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Riconoscimento vocale.

2 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Trascina per sbloccare dopo che la voce & stata riconosciuta Q)
per attivare la funzione.
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Funzione Multitasking

Schermata Utilizzi recenti

Scorrere verso lalto e trattenere il pulsante Home = per visualizzare la cronologia
di utilizzo recente.

Finestra pop-up
E possibile aprire piti app sullo schermo e passare facilmente da una allaltra in
qualsiasi momento.

1 Scorrere verso l'alto su = dal lato inferiore dello schermo.

2 Toccare licona dellapp nella parte superiore sinistra della schermata dellapp e
selezionare Finestra pop-up.

+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

3 Lapp appare sullo schermo nella forma di una finestra pop-up.

np

E « Questa funzione potrebbe non essere disponibile per alcune app o schermate.
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Utilizzo della finestre popup
+ — :Riduce a icona |a finestra pop-up. La finestra pop-up viene ridotta a icona
mobile dell'app e puo essere spostata dove desiderato sullo schermo.

U :Espande lapp a schermo intero.

X :Chiude l'app.

Per spostare la finestra pop-up: Trascinare |a parte superiore della finestra
pop-up.

Per regolare le dimensioni della finestra pop-up: Trascinare il bordo sinistro,
destro o inferiore della finestra pop-up.

« E possibile aprire finoa 5 app usando le finestre popup

« Per selezionare un'app tra quelle aperte, toccare |a relativa finestra pop-up. La
finestra pop-up selezionata viene portata in primo piano.

« Lefinestre popup non possono essere spostate nellarea della barra di stato o della
barra di navigazione.

Uso della cartella delle app per le finestre popup

Toccando — sulla finestra pop-up, la finestra popup viene ridotta a icona dellapp.
E possibile trascinare licona dell’app in qualsiasi punto trascinandola.

Se due o pit finestre popup sono ridotte a icona, viene creata la cartella delle app
per contenere le icone delle app.

E « Licona dellapp utilizzata piu di recente viene usata come icona della cartella delle
app. Toccando licong, tutte le icone delle finestre popup ridotte a icona appaiono
nella cartella delle app.

+ Sesitoccaalungo la cartella delle app delle finestre popup e si trascina la cartella
della app in Rimuovi, la cartella delle app viene rimossa.

+ Per rimuovere una delle app dalla cartella delle app, aprire la cartella delle app e
trascinare l'icona dell'app fuori dalla cartella delle app.
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Finestra multipla

Quando si usa la navigazione a gesti

1 Scorrere verso lalto su — dal lato inferiore dello schermo.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare Multi Window.
« Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

« Le applicazioni selezionate vengono visualizzate nella parte inferiore dello
schermo.

Quando si usa la navigazione sono con i pulsanti

1 Toccare E] nella barra di navigazione.
+ Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.

2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare =

+ Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

E + Perregolare le dimensioni dello schermo diviso, trascinare la barra al centro dello
schermo

« Per disattivare la funzione di finestra multipla, trascinare la barra al centro verso
lalto o verso il basso fino allestremita dello schermo.

« La funzione Multi Window non é supportata da alcune app LG o da alcune app
scaricate dal Play Store.
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AOD (always-on display)
E possibile visualizzare la data, lora o [a firma, anche se lo schermo principale & spento.

Scorri fino in cima alla schermata di Always-on display per attivare diverse funzioni, tra
cui Camera, Capture+, \Wi-Fi, impostazioni audio, Bluetooth® Flash, Musica e molto
altro.

T Nella schermata Home, toccare Impostazioni > Display > AOD (always-on display).

7 Seleziona limmagine che vuoi visualizzare e tocca Salva.

+ Tocca limmagine desiderata tra Orologio digitale, Orologio analogico, Doppio
orologio, Firma, Calendario o Immagine.

Trascina Strumenti rapidi e lettore musicale (") per scorrere sulle icone di
stato per Strumenti rapidi e il lettore musicale.

+ Perimpostare un periodo di tempo in cui non attivare la funzione AOD (always-on
display), toccare Timeout giornaliero.

+ Per aumentare la luminosita della funzione AOD (always-on display), toccare
Display piti luminoso.

E « La batteria potrebbe scaricarsi piti velocemente quando si utilizza AOD (always-on
display). Spegnere questa funzione per risparmiare la batteria.

« Per disattivare la funzione Always-on display, nella schermata Home toccare
Impostazioni > Display > AOD (always-on display), e quindi toccare @).

Quick Help

E possibile visualizzare le informazioni della quida relative alle principali funzioni del
dispositivo, le domande frequenti o la guida per [utente. Le informazioni della quida
possono essere cercate utilizzando parole chiave. E possibile risolvere rapidamente
eventuali problemi confrontandosi direttamente con un esperto.

1 Nella schermata Home, toccare Quick Help.

7 Cercare le informazioni della guida immettendo parole chiave nel campo di

+ Questa funzione viene aggiornata periodicamente utilizzando il feedback dellutente.
Le voci del menu disponibili possono variare a seconda dell'area o del provider del servizio.

E possibile visualizzare il manuale dellutente online dallapp Quick Help per consultare le
informazioni dettagliate relative alle funzioni del dispositivo.
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Note sulle proprieta di impermeabilita

Questo prodotto é resistente ad acqua e polvere in conformita con il grado di
protezione in ingresso IP68.

Il prodotto e stato sottoposto a test in un ambiente controllato ed e risultato
resistente all'acqua e alla polvere in determinate circostanze (soddisfa i requisiti
del grado di protezione IP68 specificati dallo standard internazionale IEC 60529
- Gradi di protezione per gli involucri [Codice IP]; condizioni di test: 15-35 °C, 86-
106kPa, 1,5 metri, per 30 minuti). Non esporre il dispositivo in condizioni diverse
dalle condizioni di test. | risultati possono variare in base all'uso effettivo.

A ATTENZIONE

Sebbene il dispositivo sia conforme allo standard IP68, potrebbe non essere
resistente alle condizioni non testate in un ambiente controllato da LG. Il colore
dell'indicatore LDI (Liguid Damage Indicator) cambia se si verificano danni provocati
da tali cause. Se il colore dell'indicatore LDI situato all'interno del prodotto cambig,
il dispositivo non verra considerato idoneo per i servizi di riparazione gratuiti forniti
con la garanzia limitata del prodotto.

Evitare di esporre il prodotto ad ambienti con eccessiva polvere o umidita. Non
utilizzare il prodotto nei sequenti ambienti.

Non immergere il prodotto in agenti chimici liquidi (come il sapone).
Non immergere il prodotto in acqua salata o acqua di mare.
Non immergere il prodotto in acqua calda.

Non nuotare portando il prodotto in acqua.
Non poggiare il prodotto direttamente su sabbia (ad esempio in spiaggia)
o fango.

Non immergere il prodotto in acqua profonda piti di 1,5 metri circa.
Non immergere il prodotto in acqua per pit di 30 minuti.

RO®O®®
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Se il prodotto si bagna, strofinare il microfono, l'altoparlante e il jack stereo con
un panno asciutto prima dell'uso.

Se il prodotto o le proprie mani si bagnano, asciugarsi le mani e asciugare il
prodotto prima di toccare il dispositivo.

Non usare il prodotto in luoghi in cui potrebbe essere raggiunto da schizzi

di acqua ad alta pressione (ad es. vicino a un rubinetto o una doccia), né
immergerlo in acqua per periodi di tempo prolungati, poiché il prodotto non e
progettato per sopportare acqua ad alta pressione.

Questo prodotto e sensibile alle scosse elettriche. Non lasciar cadere o
sottoporre a scosse il prodotto, poiché cio potrebbe danneggiare o deformare
l'unita centrale provocando una perdita d'acqua.

Le caratteristiche di resistenza all'acqua e alla polvere del prodotto possono
risultare compromesse in sequito a una caduta o un urto.

Se il prodotto si bagna, utilizzare un panno morbido e pulito per asciugarlo
accuratamente.

Lo schermo a sfioramento e altre funzioni potrebbero non funzionare
correttamente se il dispositivo viene usato quando e bagnato.

Il prodotto e resistente allacqua solo quando il vassoio della SIM/Scheda di
memoria & inserito correttamente.

Non aprire o chiudere il vassoio della SIM/Scheda di memoria quando il prodotto
& bagnato o immerso in acqua. L'esposizione del vassoio aperto ad acqua e
all'umidita puo danneggiare il prodotto.

Il vassoio della SIM/Scheda di memoria contiene una guarnizione in gomma
che consente di impedire che polvere, acqua o umidita penetrino nel prodotto.
Non danneggiare la guarnizione in gomma perché polvere, acqua o umidita
potrebbero penetrare nel prodotto e arrecare danni.

A « Lamancata osservanza delle istruzioni fornite potrebbe rendere nulla la garanzia
limitata del dispositivo.

« Seil dispositivo & bagnato, ['LDI collocati all'interno del dispositivo cambia colore. In
questo caso, il dispositivo non sara idoneo per i servizi di riparazione gratuiti forniti
nel contesto della garanzia limitata del dispositivo

« Nonostante una valutazione IP68, il tuo dispositivo non & completamente
resistente all'acqua in tutte le situazioni.

Funzioni personalizzate 54



Funzioni di base



Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

+ Dispositivo + Caricabatteria
+ Auricolare stereo + Guida introduttiva
+ Cavo USB + Spillo di espulsione

A

Gli elementi descritti sopra possono essere facoltativi.

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui e
stato acquistato il dispositivo.

Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti
LG

Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawiso.

L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso.
Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
servizio.

Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte.
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Panoramica delle parti

Spia LED

f:ﬁllm:ﬂﬁ —=

Microfono

Sensore di prossimita/luminosita
ambientale

Tasti volume (+/-) —I:

Tasto Assistente Google —*|

Altoparlante auricolare

Obiettivo fotocamera anteriore

Tasto accensione/blocco

Touchscreen

Jack stereo per auricolare

Porta per caricabatteria/cavo USB

1—\— Alloggiamento scheda
Flash —— SIM/scheda di memoria
& @-—l

Messa a fuoco automatica con 9 .H_, Obiettivo fotocamera

rilevamento laser @ posteriore
Sensore per impronte digitali — @
Area dell'antenna per la ricarica. ————— E-—— Area NFC
wireless H H

Altoparlante -1 | B Microfono
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A Non tentare di rimuovere il coperchio posteriore.
Questo dispositivo e dotato di una batteria non rimovibile. Non tentare di rimuovere
il coperchio posteriore. Fare cio potrebbe danneggiare gravemente la batteria e il
dispositivo, e cio potrebbe causare surriscaldamento, incendi o infortuni.

+ Sensore di prossimita/luminosita ambientale

- Sensore di prossimita: Nel corso di una chiamata, il sensore di prossimita
spegne lo schermo e disattiva la funzionalita touch quando il dispositivo
si trova molto vicino al corpo umano. Riaccende lo schermo e attiva la
funzionalita touch quando il dispositivo si trova al di fuori di un campo
specifico.

Sensore di luminosita ambientale: il sensore di luminosita ambientale analizza
lintensita della luce ambientale quando & attiva la modalita di controllo
automatico della luminosita.
+ Messa a fuoco automatica con rilevamento laser
- Rilevare la distanza tra la fotocamera e il soggetto per la messa a fuoco
automatica.
- E possibile mettere a fuoco rapidamente oggetti piti vicini o piti lontani,
quando si utilizza la fotocamera posteriore per scattare foto.
+ Tastivolume
- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.
- Durante utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.
- Quando lo schermo & spento o bloccato, premere il tasto volume giti (-) due
volte per awviare [app Fotocamera. Premere due volte il tasto volume su (+)
per awiare Capture+.

Funzioni di base 58



+ Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
+ Tasto Assistente Google

- Il'tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte
e fai cose mentre sei in giro. per iniziare, basta toccare il tasto Assistente
Google sul lato del telefono. Tenere premuto il tasto per parlare rapidamente
con il tuo assistente. Premere due volte per aprire Google Lens.

- Awio di Assistente Google. Per ulteriori dettagli, consultare Assistente
Google.
+ Sensore per impronte digitali
- Attivare la funzione di riconoscimento delle impronte digitali per semplificare
il processo di sblocco dello schermo. Per i dettagli, vedere, consultare la
sezione Informazioni generali sul riconoscimento delle impronte digitali.

L'accesso ad alcune funzioni potrebbe essere limitato a seconda delle specifiche
del dispositivo.

5

Sulretro del dispositivo & collocata unantenna NFC integrata. Prestare attenzione
mentre si maneggia il dispositivo, al fine di non danneggiare o coprire lantenna
NFC.

Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire coniil
sensore di prossimita.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o i
pulsanti a sfioramento potrebbero non funzionare correttamente.
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Tenete correttamente il dispositivo in mano, come mostrato di seguito. Se coprite
il microfono con una mano, dito o cover protettiva durante ['uso del dispositivo, in
caso di chiamata il suono potrebbe risultare poco chiaro.

Corretto Non corretto
EEERCTI=Ta — e
Q

™~

Microfono Non coprite il microfono
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.

E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione
iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti (-) fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
+ Spegni e riavvia: consente di riawviare il dispositivo.
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Installazione della carta SIM e della
scheda di memoria

Inserire nel dispositivo a carta SIM del proprio operatore telefonico e la scheda di
memoria acquistata separatamente.

E « Affinché le caratteristiche di resistenza allacqua e alla polvere siano efficaci, &
necessario che lalloggiamento della scheda sia inserito correttamente.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

2 Collocare la carta SIM o la scheda di memoria nel foro di alloggiamento della
scheda e inserirlo nel dispositivo, sequendo la direzione della freccia.

Scheda di memoria
(Opzionale, venduta separatamente)

Scheda SIM
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Questo dispositivo supporta solamente le schede Nano SIM.

i

Nano Micro

Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
telefono con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

Non perdere la scheda SIM. LG non é responsabile di eventuali danni e altri
problemi causati dalla perdita o dal trasferimento di una scheda SIM.

Fare attenzione a non danneggiare la scheda SIM durante le operazioni di
inserimento e rimozione.

Quando si inserisce la carta SIM o la scheda di memoria, & necessario collocarla
correttamente nel foro di alloggiamento della scheda.

Quando inserisci di nuovo il foro di alloggiamento della scheda nel dispositivo, &
necessario inserirlo orizzontalmente seguendo la direzione della freccia, come
mostrato in figura. Assicurati che la scheda collocata sul foro di alloggiamento
della scheda non si sposti dalla posizione corretta.

Inserire la scheda SIM sull'alloggiamento con i contatti color oro rivolti verso il
basso.

Assicurati di inserire la carta SIM nel dispositivo seguendo le istruzioni nel manuale
utenti.

Se inserisci o rimuovi ['alloggiamento dal dispositivo, assicurati che non vi entrino
acqua o altri liquidi. Se un alloggiamento o una scheda bagnati vengono inseriti nel
dispositivo, questo potrebbe danneggiarsi.

« Lascheda di memoria e un elemento opzionale.

Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.

Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.
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Rimozione della scheda di memoria

Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
7 Nella schermata Home, toccare Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo di ricarica
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A .

Non utilizzare il terminale esterno, il cavo di alimentazione o l'adattatore di genere
del dispositivo in presenza di umidita. Cio puo provocare incendi, scosse elettriche,
infortuni o il malfunzionamento del dispositivo. In caso di umidita, interrompere
immediatamente [utilizzo e rimuovere completamente ['umidita.

Assicurarsi di utilizzare il cavo USB fornito in dotazione con il dispositivo.

Assicurarsi di utilizzare caricabatteria e cavo di caricamento approvati da LG. Se
la batteria viene caricata con un caricabatteria di terze parti, la batteria potrebbe
esplodere o danneggiarsi.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

L'utilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.
Un adattatore di ricarica che supporta a ricarica rapida € incluso nel prodotto.

La funzione di ricarica rapida potrebbe non funzionare se si utilizza un adattatore
di ricarica rapida diverso da quello originale fornito in dotazione con il prodotto.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo

e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

Non caricare la batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.

Precauzioni per ['utilizzo del dispositivo
« Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
l'uso di accessori di terze parti.

+ Il mancato rispetto delle istruzioni contenute in questa quida e ['utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.
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Ricarica wireless

Questo dispositivo supporta una funzione di ricarica wireless. Carica il dispositivo
con un caricabatteria wireless certificato Qi (opzionale, venduto separatamente).

Caricare la batteria con un caricabatteria wireless

1 Colloca il tuo dispositivo al centro del caricabatteria wireless, allineandolo con
I'antenna per la ricarica wireless sul retro del dispositivo.

« Per controllare ['area dell'antenna per la ricarica wireless, vedere Panoramica

delle parti.

7 Quando la batteria & stata ricaricata, rimuovere il dispositivo dal caricabatteria.

A

Quando si ricarica la batteria con il caricabatteria wireless, evitare di porre materiali
magnetici, metallici o conduttori tra il dispositivo e il caricabatteria. Infatti, questi
materiali possono disturbare la ricarica e far surriscaldare il caricabatteria. In
questo caso, il dispositivo, il caricabatteria o la carta SIM/scheda di memoria
possono essere danneggiati.

Se la temperatura della batteria supera un certo livello quando il dispositivo & in
carica, sara necessario interrompere |a ricarica.

Se materiali magnetici, metallici o conduttori dovessero trovarsi vicino al retro del
dispositivo, oppure fosse inserita una custodia protettiva, il dispositivo potrebbe
non essere caricato adeguatamente.

Se siricarica la batteria con il caricabatteria wireless in aree in cui il segnale di
rete & debole, le prestazioni di rete del tuo dispositivo potrebbero essere ridotte
ulteriormente.

Carica il dispositivo con un caricabatteria wireless certificato Qi (opzionale, venduto
separatamente). Dato che la garanzia limitata LG non copre (uso di accessori di
terze parti, contattare il produttore delle stesse.

Questo prodotto supporta la ricarica wireless. Per ricaricare il prodotto utilizzare
un caricabatterie wireless certificato Qi (venduto separatamente). Alcuni
caricabatterie wireless con cavo a spirale potrebbero non supportare |a ricarica
wireless. | caricabatterie che supportano il profilo EPP (Extended Power Profile)
consento la ricarica wireless ad alta velocita.

Dato che la garanzia limitata LG non copre l'uso di accessori di terze parti,
contattare il produttore delle stesse.
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Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.
Per ridurre al minimo il consumo della batteria, seqguire questi Consigli:
« Disattivare la funzione Bluetooth o rete Wi-Fi quando non le si utilizza.
- Impostare lo spegnimento dello schermo su un lasso di tempo il pits breve
possibile.
+ Ridurre al minimo la luminosita dello schermo.
+ Impostare un blocco schermo quando il dispositivo non & in uso.

« Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.

Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.
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Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.

Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un'app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.
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Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina \Web, delle foto, delle
schermate e altro ancora.

Awvicinare e allontanare le dita

Awicinare due dita per esequire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

A + Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch potrebbe
danneggiarsi
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Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire la lettura.

Non premere lo schermo applicando una forza eccessiva.

Toccare delicatamente ['opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dell'unghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo e umido
0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di unimmagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessa immagine per un lungo
periodo quando il dispositivo non € in uso.

Sfondo

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Scorrere verso lalto dal bordo inferiore di qualsiasi schermata per
andare direttamente alla schermata Home.

Sulla schermata Home e possibile gestire tutte le app e i widget. Scorrere sulla

schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app
installate.
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Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla
schermata Home.

Barra di stato

gt metee _._

_’— Widget di ricerca di Google

Cartella —- 7 D0

Icona della pagina

*— Area di accesso rapido

Barra di navigazione

E + Laschermata Home puo variare a seconda della politica del produttore, delle
impostazioni dell'utente, della versione del software o del provider del servizio.

Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: digita o parla per aprire Google Search.

Cartella: £ possibile creare cartelle per classificare le app in base ai criteri
desiderati.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. L'icona corrispondente allarea corrente verra
evidenziata.
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- Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

- Barra di navigazione: consente di andare alla schermata precedente o alla
schermata Home durante ['uso dellapp, e controllare lelenco delle app usate di
recente.

Uso della barra di navigazione
Questa ¢ la guida alle gesture per il controllo della barra di navigazione.
- Per andare alla schermata Home, scorrere verso ‘alto dal bordo inferiore dello
schermo.
+ Per tornare alla schermata precedente, scorrere verso l'interno dal bordo sinistro
o destro dello schermo.
+ Perandare alla schermata Panoramica, scorrere verso ['alto e tenere premuto
dal bordo inferiore dello schermo.
« Per passare rapidamente tra le app, scorrere verso destra sul bordo inferiore
dello schermo per andare alle app utilizzate in precedenza.

E + Gesture é [impostazione predefinita per la barra di navigazione. Per cambiarla
a Solo pulsanti Q 10/ D nella schermata Home toccare Impostazioni >
Display > Barra di navigazione, quindi selezionare Solo pulsanti.
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

“ll Nessun segnale

Trasmissione di dati tramite la rete in corso
=N L

© Sveglia impostata

ng Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

GPS attivo

Hotspot attivo

Nessuna scheda SIM

La modalita di lettura/scrittura NFC con funzione P2P é attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.
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Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare l'icona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare 0 peraggiungere, eliminare o disporre le icone nella finestra
di awiso.

+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

I

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo é bloccato per accedere rapidamente alle
funzioni desiderate
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.
In alternativa, toccare Impostazioni > Display e attivare Rotazione automatica.

Modifica della schermata Home
Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi avviare
l'azione desiderata da sotto.
+ Per ridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un‘altra posizione.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un'area vuota della schermata Home, quindi selezionare Widget.
+ Per modificare sfondi, temi, icone e AOD, toccare e tenere premuta un'area
vuota della schermata Home, quindi selezionare Sfondo & Tema.
E inoltre possibile toccare Impostazioni > Display > Schermata Home
> Sfondo, e quindi selezionare sfondi, temi, icone e AOD da applicare al
dispositivo.
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Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un‘area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per i dettagli, vedere, consultare la sezione Impostazioni della
schermata Home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un'area vuota della schermata Home, quindi selezionare Cestino app. Per i
dettagli, vedere, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare 0, quindi
toccare nuovamente la schermata.

LS —— Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home e possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awvicinare le dita sulla schermata Home o trascinare verso lalto — dal bordo
inferiore dello schermo.

Spostamento di app sulla schermata Home
Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un'‘altra posizione.

+ Perinserire le app utilizzate pili spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un'app, quindi trascinarla nellarea di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.

Funzioni di base

77



Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.
+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.

- Per modificare il nome e il colore della cartella, toccare il nome della cartella.

« Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra

la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta ['app, quindi
trascinarla all'esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E anche possibile aggiungere o rimuovere le app dopo aver toccato (+) nella
cartella.

E « Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.

Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.

T Nella schermata Home, toccare Impostazioni > Display > Sfondo.

7 Personalizzare le seguenti impostazioni:

- Seleziona Launcher: consente di selezionare una modalita per la schermata

Home.
+ Sfondo: consente di cambiare lo sfondo della schermata Home.

- Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un'altra area della schermata Home.

« Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.

+ Ordina le app per:Impostare la modalita di ordinamento delle app sulla
schermata Home.
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Griglia: consente di modificare la modalita di disposizione delle app nella
schermata Home.

Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

Scorrimento continuo: attivare per consentire lo scorrimento continuo della
schermata Home (ritorno alla prima schermata dopo 'ultima schermata).
Smart Bulletin: consente di utilizzare la schermata Home per visualizzare
informazioni personalizzate in base alle proprie esigenze.

Ricerca: consente di effettuare una ricerca scorrendo verso il basso sulla
schermata Home.

Sfondo Lock: consente di impedire che le app o i widget siano spostati o
rimossi.

Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awviene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire 'accesso indesiderato al dispositivo,
impostare un blocco schermo.

5

+ I blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.
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Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie

opzioni.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo e quindi selezionare il metodo preferito.

7 Personalizzare le sequenti impostazioni:
+ Nessuno: consente di disattivare la funzione di blocco schermo.

Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.

Knock Code: Consente di sbloccare lo schermo toccandolo con una
determinata sequenza.

Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.

PIN: consente di immettere una password numerica per sbloccare lo
schermo.

Password: consente diimmettere una password alfanumerica per sbloccare
lo schermo.

Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.

Consenti Riconoscimento del volto: Consente di sbloccare o schermo
tramite il riconoscimento del volto.

Consenti riconoscimento vocale: Consente di sbloccare lo schermo tramite
comandi vocali specifici.

E « Sesitenta di sbloccare in maniera scorretta il dispositivo per 5 volte, lo schermo
viene bloccato per 30 secondi.

Impostazioni di avvio sicuro

Se si seleziona Sequenza, PIN o Password come metodo di blocco dello schermo, &
possibile configurare il blocco del dispositivo a ogni accensione per proteggere i dati.
+ Finché il dispositivo non viene sbloccato, non e possibile utilizzarne le funzioni,
ad eccezione delle chiamate di emergenza.

+ Se e stata dimenticata la password di decrittografia, non & possibile ripristinare i
dati decrittografati né le informazioni personali.

Funzioni di base 80



Precauzioni per la funzione "Awvio sicuro"

Se é stata dimenticata la password di decrittografia, non e possibile ripristinare i
dati decrittografati né le informazioni personali.

Assicurati di mantenere le tue password per il blocco schermo separate.

Se inserisci una password sbagliata per il blocco schermo piti del numero di
volte consentito, il dispositivo si resetta in automatico, cancellando tutti dati
crittografati e le informazioni personali contenute, che non possono pili essere
recuperate.

Fare attenzione a non inserire una password sbagliata per il blocco schermo pit
del numero di volte consentito.

Quando accendi il dispositivo subito dopo averlo resettato, viene riawiata
anche la crittografia. Se interrompi volontariamente la crittografia, alcuni dati
potrebbero danneggiarsi. Assicurati di attendere il completamento del reset.

Personalizza Blocco schermo

Puoi personalizzare il blocco schermo.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Personalizza Blocco schermo.

7 Seleziona una funzione che vuoi impostare.
+ Sfondo: Consente di impostare lo sfondo del blocco schermo.

+ Orologio: Consente di impostare il punto in cui posizionare ['orologio sul
blocco schermo.

« Collegamenti: Consente di scegliere le app da esequire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

- Effetto scorrimento schermo: Consente di impostare effetti di transizione
da applicare quando lo schermo e sbloccato.

+ Animazione meteo: Consente di visualizzare le animazioni meteo relative
alla posizione attuale sulla schermata di blocco.

« Informazioni di contatto per telefono perso: Consente di impostare il

testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.
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Impostazioni di Blocco con sicurezza
Puoi impostare blocchi schermo sicuri.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Impostazioni di Blocco con sicurezza.

2 Seleziona una funzione che vuoi impostare.

5

Rendi visibile la sequenza (visualizzato solo quando come blocco schermo
& impostata una sequenza): attivare questa opzione per rendere visibile la
sequenza.

Blocco timer: Consente di impostare l'intervallo di tempo prima che

lo schermo si blocchi automaticamente dopo lo spegnimento della
retroilluminazione (time out a causa di inattivita).

Blocco istantaneo con tasto accensione: Attivare questa opzione

per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.

Mostra blocco (visualizzato solo quando & impostato un blocco schermo):
Attivare questa opzione per visualizzare l'icona di blocco tenendo premuto il
pulsante di accensione/blocco. Toccare licona di blocco per disattivare il smart
lock, lo sblocco biometrico e le notifiche sulla schermata di blocco.

Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

+ Le opzioni di menu disponibili possono variare a seconda del metodo di blocco
schermo selezionato.

Toc Toc
E possibile accendere o spegnere lo schermo toccandolo due volte.

5

+ Questa opzione ¢ disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.
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Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Se sitocca la parte superiore o inferiore dello schermo, a velocita di
riconoscimento potrebbe essere pill bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

Knock Code

E possibile sbloccare lo schermo creando un codice Knock Code personale. Quando
lo schermo e bloccato, si potra accedere direttamente alla schermata Home
toccando lo schermo secondo la sequenza specificata.

E « E possibile utilizzare il codice Knock Code insieme alla funzione Toc Toc

+ Quando si tocca lo schermo, assicurarsi di utilizzare la punta di un dito

Creazione di un codice Knock Code

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo > Knock Code.

2 Toccare i quadranti in base a una sequenza di propria scelta per creare il codice
Knock Code, quindi toccare Avanti.

3 Ascopo di verifica, immettere di nuovo il codice Knock Code creato, quindi
toccare Conferma.

Sblocco dello schermo con un codice Knock Code
E possibile sbloccare lo schermo immettendo il codice Knock Code creato.

Si puo inoltre immettere il proprio codice Knock Code sul touchscreen quando lo
schermo e spento.

- E possibile immettere un codice Knock Code anche quando la schermata di
blocco e accesa.
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Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.
l'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro
dispositivo.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Crittografia e credenziali > Cripta la Scheda SD.

7 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Crittografia.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo la crittografia.

Crittografia completa: consente di crittografare tutti i dati attualmente
salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.

E + Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

Se il dispositivo si spegne mentre la crittografia e in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awiare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cui i file sono stati
crittografati.

« Lascheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda

« E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.
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Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido
Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume giu per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite la funzione Capture+

Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare (2,

E + Quando lo schermo & spento o bloccato, & possibile accedere alla funzione
Capture+ premendo due volte il tasto volume su. Per usare questa funzionalita,
nella schermata Home, toccare Impostazioni > Estensioni> Collegamenti e
attivare Apri Capture+.

« Peridettagli vedere, consultare la sezione Scrittura di note su uno screenshot.
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Immissione di testo

Utilizzo della barra degli strumenti Smart

E possibile usare vari metodi di immissione da tastiera da un'unica posizione. E
possibile selezionare il metodo di immissione desiderato dalla parte superiore della
tastiera.

1 Selezionare il metodo di immissione da tastiera desiderato dalla barra degli
strumenti Smart.

7 Toccare \V e selezionare il metodo di immissione da visualizzare nella barra
degli strumenti Smart, oppure riorganizzarli.

Barradegi —& @ % & & @ B ~
strumenti
Smart

o a

th - — B =t

E - E possibile aggiungere fino a 6 strumenti alla barra degli strumenti Smart.
+ | metodi di immissione supportati possono variare a seconda del dispositivo.

« E possibile attivare o disattivare la barra degli strumenti Smart dalle impostazioni
della tastiera.

« £ possiile anche utilizzare i metodi di immissione da tastiera toccando §83.

. @ :Aggiungere emoji.

+ 22 :Aprire Draw Chat.

+ §03 : Accedere alle impostazioni della tastiera.

«  :Toccare & per inserire il testo con la propria voce.

- Per ottimizzare il riconoscimento dei comandi vocali, pronunciarli in modo
chiaro.

- Perimmettere testo con la voce, assicurarsi che il dispositivo sia connesso
aunarete.

- Per selezionare la lingua per il riconoscimento vocale, toccare %% > Lingue
sulla schermata del riconoscimento vocale.
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- Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

. - Aprire Appunti.
. - Attivare a tastiera fluttuante quando si usa la funzione Multi Window. E
possibile anche spostare la testiera nella posizione desiderata.

Utilizzo della tastiera Smart
E possibile utilizzare la tastiera Smart per immettere e modificare testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita, senza dover
passare dalla schermata a una tastiera tradizionale e viceversa. In questo modo e
possibile trovare e correggere con facilita gli eventuali errori durante la digitazione.

Spostamento del cursore

Con la tastiera Smart e possibile spostare il cursore esattamente nella posizione
desiderata. Quando si digita un testo, toccare e tenere premuta la barra spaziatrice,
quindi trascinarla verso sinistra o destra.

< Smart keyboard >

E + Questa opzione ¢ disponibile solo sulla tastiera QWERTY.
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Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo dell'utente per
suggerire le parole utilizzate pili spesso durante la digitazione. Quanto piu si utilizza
il dispositivo, tanto pit precisi saranno i Consigli.

Immettere un testo, quindi toccare una parola suggerita o trascinare delicatamente
verso lalto il lato sinistro o destro della tastiera.

+ La parola selezionata viene inserita automaticamente. Non e necessario digitare
manualmente ogni lettera della parola.

Smartphone et o = P—— sra| Smartphones

LL L LD LALL
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Copia e incolla

E possibile tagliare o copiare del testo da unapp, quindi incollarlo nella stessa app. £
anche possibile eseguire altre app e incollare il testo al loro interno.

1 Toccare e tenere premuta l'area attorno al testo che si desidera copiare o
tagliare.

7 Trascinare @/ B per specificare l'area da copiare o tagliare.

3 Selezionare Taglia o Copia.
« Il testo tagliato o copiato viene aggiunto automaticamente agli Appunti.

/. Toccare e tenere premuta la finestra di inserimento del testo, quindi selezionare
Incolla.

E + Inassenza di un elemento copiato o tagliato, 'opzione Incolla non verra

visualizzata.

Immissione di testo tramite voce
Nella tastiera selezionare .

5

Per ottimizzare il riconoscimento dei comandi vocali, pronunciarli in modo chiaro.

« Perimmettere testo con la voce, assicurarsi che il dispositivo sia connesso a una
rete.

Per selezionare la lingua per il riconoscimento vocale, toccare ¥ > Lingue sulla
schermata del riconoscimento vocale.

+ Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.
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Appunti

Quando si copia o si taglia un'immagine o un testo, tali elementi vengono salvati
automaticamente negli Appunti e possono essere incollati ovunque in qualsiasi
momento.

1 Nella tastiera selezionare .
In alternativa, toccare e tenere premuta la finestra di inserimento del testo,
quindi selezionare Appunti.

2 Selezionare e incollare un elemento negli Appunti.
- E possibile salvare negli Appunti fino a un massimo di 20 elementi.

- Toccare £} per bloccare gli elementi salvati al fine di non eliminarli anche
quando la quantita massima viene superata. £ possibile bloccare fino a
un massimo di dieci elementi. Per eliminare gli elementi bloccati, € prima
necessario sbloccarli.

- Toccare [if] per eliminare gli elementi salvati negli Appunti.

E « Gli Appunti potrebbero non essere supportati da alcune app scaricate.

Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere la TV el dispositivo alla stessa rete \Wi-Fi.

7 Mentre si visualizzano gli elementi dell'app Galleria o Musica, toccare Cg o + >
Riproduci su un altro dispositivo.
Oppure, nella schermata Home toccare Impostazioni > Dispositivi connessi >
Condivisione schermo e quindi toccare () ) per attivare la funzione.

3 Selezionare la TV a cui si desidera connettersi.

E « Per lutilizzo con Chromecast, & consigliabile che i servizi di Google Play siano
aggiornati
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Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer; un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

E « Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel dispositivo mittente
che nel dispositivo connesso.

Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu ¢ > Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se li si stesse utilizzando
sul proprio dispositivo.

Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG oppure
un tablet.

Invio di file

Dalla Galleria o altre app, toccare + > Condividi o <, quindi selezionare un
dispositivo dallelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, nella
schermata Home toccare Impostazioni > Dispositivi connessi > Condivisione File
> SmartShare Beam () ).

E « E possibile condividere file con determinati dispositivi che supportano DLNA.
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Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di essere disturbati
per un determinato periodo di tempo.

Nella schermata Home, toccare Impostazioni > Suono > Non disturbare.
+ Toccare Modo e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con vibrazione per le
app selezionate. Anche se ¢ attiva la modalita Solo priorita, le sveglie suonano
comunque.

- Silenzio totale: consente di disabilitare sia laudio che la vibrazione.

- Seleziona le priorita: rricevi allarmi e le notifiche per le app selezionate.
- Chiamate da:imposta una serie di notifiche quando ricevi una chiamata.

E « Chiamate ripetute: [a seconda chiamata dalla stessa persona entro 15 minuti non
viene resa silenziosa.

- Messaggi da:imposta una serie di notifiche quando ricevi un messaggio.
Utilizza modalita Non disturbare: Attiva la funzionalita Non disturbare.

Sonno:imposta il programma in base al quale attivare la funzionalita Non
disturbare.

Guida: Visualizzare la quida per Non disturbare.
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App utili



Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga

Tenere premuta unarea vuota della schermata, e quindi premere € dellapp da
eliminare.

Disinstallazione tramite il menu delle impostazioni
Nella schermata Home, toccare Impostazioni > App & notifiche > Informazioni
applicazione, selezionare unapp e quindi toccare Disinstalla.

E « Alcune app non possono essere disinstallate dagli utenti
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Disinstallazione di app dallo store di app

Per disinstallare un'app, accedere allo store di app da cui e stata scaricata e
disinstallarla.

Installazione e disinstallazione di app durante il

setup

Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.

E possibile saltare alla fase successiva senza linstallazione.

Cestino app
E possibile visualizzare le app disinstallate sulla schermata Home. E inoltre possibile
reinstallare le app che sono state disinstallate nelle ultime 24 ore.
1 Nella schermata Home, toccare Gestione > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.
7 Attivare la funzione desiderata:
- Ripristina: consente di reinstallare lapp selezionata.
- T : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E « Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

« Questa funzione ¢ attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher; queste vengono
immediatamente e definitivamente rimosse dal dispositivo.
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Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. Utilizza le app in maniera pit semplice grazie alle scorciatoie per app.

- Toccad] per configurare le impostazioni per la widget che desideri per l'app.
« Tocca (D) per visualizzaare le informazioni per I'app desiderata.

E « Questa funzione é disponibile solo in alcune app.
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Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibili, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dall'elenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
1 Nella schermata Home, toccare (% > Componi.
2 Eseguire la chiamata utilizzando un metodo a scelta:

- Immettere un numero di telefono e toccare @@.

« Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando la lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare 9.

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

« Peridettagli vedere Aggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.

Esecuzione di chiamate dalla Rubrica
1 Nella schermata Home, toccare (@ > Rubrica.

2 Dopo aver selezionato il numero da chiamare dallelenco dei contatti nella
rubrica, toccare &...
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Risposta a una chiamata

Per rispondere a una chiamata, trascinare @@ sulla schermata della chiamata in
arrivo.
+ Se e collegato un auricolare stereo, e possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.

+ Per terminare una chiamata senza spegnere lo schermo, nella schermata Home
toccare Impostazioni > Rete & internet > Impostazioni chiamate > Rispondi
e termina chiamate e quindi attivare Termina le chiamate con il tasto di
accensione.

E + Nella schermata Home, toccare Impostazioni > Rete & internet > Impostazioni
chiamate > Rispondi e termina chiamate > Termina le chiamate con il tasto
di accensione, € possibile terminare le chiamate premendo il tasto di accensione/
blocco mentre ¢ attiva la schermata della chiamata in corso.

Rifiuto di una chiamata

Per rifiutare una chiamata in arrivo, trascinare @ attraverso la schermata della
chiamata in arrivo.
+ Per inviare un messaggio di rifiuto, trascinare ['opzione del messaggio di rifiuto
per la schermata.

« Per aggiungere o modificare un messaggio di rifiuto, nella schermata Home
toccare Impostazioni > Rete & internet > Impostazioni chiamate > Blocco
chiamate & Rifiuta con messaggio.

+ Quando e in arrivo una chiamata, premere il tasto volume su, volume giti o il

tasto di accensione/blocco per disattivare laudio della suoneria o la vibrazione,
oppure per mettere in attesa la chiamata.

Verifica di una chiamata in arrivo durante ['utilizzo
di un'app
Quando si riceve una chiamata mentre si sta utilizzando un‘app, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si pud
accettare la chiamatg, rifiutarla o inviare un messaggio dalla schermata pop-up.

E + Nella schermata Home, toccare Impostazioni > Rete & internet > Impostazioni
chiamate > Altre impostazioni > Mostra chiamate vocali mentre in un‘app
e quindi selezionare il modo in cui si desidera visualizzare la chiamata in arrivo
quando si usa un'app.
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Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato 4,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. E inoltre possibile toccare (& > Chiamate nella schermata Home.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

+ Rubrica: consente di visualizzare ['elenco di contatti durante una chiamata.
Attesa: mette in attesa la chiamata corrente.

Tastiera: consente di mostrare o nascondere la testiera del telefono.
Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ Connesso.

- @ : consente di terminare una chiamata.
+ [N consente di passare a una chiamata video da una chiamata vocale.
-+ :consente di accedere a opzioni di chiamata aggiuntive.

« Alcune funzioni non sono disponibili durante le chiamate video.

+ Levoci delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate
Per visualizgare i record delle chiamate recenti, nella schermata Home toccare (8 >
Chiamate. £ quindi possibile utilizzare le sequenti funzioni:
« Per visualizzare i record dettagliati delle chiamate, selezionare un contatto. Per
eseguire una chiamata a un contatto selezionato, toccare &...
+ Per eliminare i record delle chiamate, toccare = > Elimina.

E + Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

« Lacronologia delle telefonate non pud essere recuperata una volta cancellata.

Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.
7 Nella schermata Home, toccare (% > Componi o Chiamate.

2 Toccare : > Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio

E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E « Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

1 Nella schermata Home, toccare B

2 Sfiorare Gl

3 Specificare un destinatario e creare un messaggio.
+ Per usare le opzioni multimediali, tocca ().
+ Per accedere alle voci di menu opzionali, toccare & .

A Toccare B> per inviare il messaggio.

Lettura di un messaggio

E possibile visualizzare i messaggi scambiati organizzati per singolo contatto.

1 Nella schermata Home, toccare e

7 Selezionare un contatto dall'elenco dei messaggi.

E + Nell'elenco dei messaggi o nella finestra di chat, & possibile regolare le dimensioni

dei caratteri posizionando due dita sullo schermo e allontanando o awicinando
le dita.
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Configurazione delle impostazioni dei messaggi
E possibile modificare le impostazioni dei messaggi in base alle proprie preferenze.

1 Nella schermata Home, toccare B
2 Toccare : > Impostazioni dall'elenco dei messaggi.

E - E possibile specificare le impostazioni per la finestra di awiso, il blocco delle
chiamate, l'awiso di emergenza, i messaggi multimediali ecc.

Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tutti i momenti
memorabili.

Nella schermata Home, toccare (&).

E « Prima di scattare una foto o registrare un video, pulire ['obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre

sostanze.

Le immagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

+ Lefoto e i video possono essere visualizzati o modificati dalla Galleria. Per i
dettagli, vedere, consultare la sezione Funzioni della Galleria.

« Non utilizzare il prodotto per scopi che potrebbero violare la privacy o i diritti di
altre persone.
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Scatto di una foto
E possibile scattare foto con la fotocamera del prodotto.
T Toccare (&) e mettere a fuoco il soggetto.
- E possibile toccare il soggetto da mettere a fuoco.
- E possibile allontanare o awicinare due dita per ingrandire o ridurre.

7 Sfiorare per scattare una foto.
- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.

- E possibile scattare una foto durante la registrazione di un video premendo
® sullo schermo.

« Le informazioni visualizzate nella schermata di ripresa possono variare a
seconda della fotocamera selezionata (anteriore o posteriore) e alla modalita
fotocamera.

« Lafotocamera si disattiva automaticamente se non la si usa per un po’ di
tempo dopo aver aperto lapp Fotocamera.

Awvia Google Lens

Modalita corrente della
fotocamera

Imposta/annulla —

limpostazione del timer ;e — Passa alla fotocamera

anteriore/posteriore
. &g — Scatta foto

Selezionare lo zoom
bl — Anteprima

| — Ottimizzazione

automatica della scena

Imposta/annulla —¢
limpostazione del flash

Applica leffetto filtro —¢J

Imposta la fotocamera —

E possibile aprire [app della fotocamera premendo brevemente due volte il tasto
di accensione. Nella schermata Home, toccare Impostazioni > Estensioni >
Collegamenti e quindi toccare Apri Fotocamera per attivarla.

Wil

+ Quando lo schermo & spento o bloccato, awiare la fotocamera premendo due
volte il tasto volume gili.

+ Nella schermata Home, toccare Impostazioni > Estensioni > Collegamenti e
quindi toccare Apri Fotocamera =~ @ per attivarla.
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Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 sulla schermata.

E « Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

+ [J]: Scattare una foto in FullVision (rapporto 18,9:9).
+ [0]:Consente di selezionare i valori relativi a proporzioni e dimensioni per le foto

da scattare.

+ [X:Consente di selezionare i valori relativi a risoluzione e dimensioni per i video

da registrare.

- (9 :Consente di impostare il timer per scattare automaticamente le foto o
registrare un video dopo un periodo di tempo specificato.

Fotocamera super
luminosa

Scatta foto piti luminose e nitide in condizioni di scarsa
illuminazione. (Quando la modalita luminosa & selezionata, si
accende o spegne automaticamente a seconda delle condizioni
della luce circostante.)

Consente di ottenere foto dai colori vividi ed effetti compensati
anche quando le foto sono scattate contro luce. Queste funzioni

HDR sono disponibili grazie alla tecnologia High Dynamic Range
(HDR) integrata nella fotocamera.
Foto dal vivo Registra |'azione prima e dopo aver scattato una foto.

Scatto al Cheese

Consente di scattare foto tramite comandi vocali.

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione
GPS.

Griglia

Consente di visualizzare le griglie di guida in modo da poter
scattare foto o registrare video in base alle linee di riferimento
orizzontali e verticali.

Aggiungi firma

Consente di visualizzare una firma personalizzata sulle foto.

Consente di selezionare se si desidera archiviare le immagini

Archiviazione e i video nellArchivio interno o nella Scheda SD. (Disponibile
quando la scheda di memoria ¢ inserita.)
Guida Fornisce una quida per ciascun menu della fotocamera.
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Opzioni aggiuntive della fotocamera anteriore

Scatta un selfie selezionando le sue opzioni tra Scatto tramite

Scatto di selfie :
gesto della mano e Scatto automatico.

Consente di salvare le immagini come capovolte dopo aver

Salva come capovolta )
P scattato dei selfie.

E + Quando si utilizza la fotocamera anteriore, & possibile regolare il filtro, leffetto di
illuminazione e il tono della pelle.

Selezione della modalita

E possibile selezionare comodamente tra le modalita visualizzate sullo schermo, che
sono selezionate per adattarsi all'ambiente di ripresa.

Toccare (&) e scorrere le modalita della fotocamera verso sinistra o destra, oppure
scorrere lo schermo a sinistra o a destra per selezionare una modalita della
fotocamera.

Modalita della fotocamera
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Uso delle modalita della fotocamera

Registrazione di un video
1 Toccare @ e selezionare Video scorrendo le modalita della fotocamera.

7 Toccare @ per registrare un video.

Imposta la fotocamera ——¢ &— Imposta il timer

Applica leffetto filtro Imposta/annulla

l'impostazione del flash
Attiva/disattiva Steady Cam

1— Passa alla fotocamera
anteriore/posteriore

]— Registrazione di un video

« Per scattare una foto mentre si registra un video, toccare © .

Anteprima ——gslid

- Per mettere in pausa la registrazione del video, toccare (1) Per riprendere la
registrazione del video, toccare (® .

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare l'area desiderata per regolare la
luminosita.

3 Toccare (=) per terminare la registrazione del video.
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Scatto di una foto
Toccare () e selezionare Foto scorrendo le modalita della fotocamera.

Per ulteriori informazioni, consultare la sezione Scatto di una foto.

Scatto di ritratti

E possibile scattare foto o video in cui il soggetto risalta ed & piii distinto sfocando
lo sfondo.

1 Toccare @ e selezionare Ritratto scorrendo le modalita della fotocamera.

+ Selezionare un effetto desiderato scorrendo le opzioni di effetto disponibili
per Ritratto.

2 Sfiorare () per scattare una foto.

Imposta la fotocamera —3g

& Imposta il timer

Applica leffetto filtro Imposta/annulla

l'impostazione del flash
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3 Toccare (=) per terminare la registrazione del video.

E .

Quando appare il messaggio “Ritratto & disponibile’, iniziare a scattare una foto.

La funzione Ritratto potrebbe non essere disponibile se la fotocamera non & in
grado di riconoscere il soggetto-

Durante lo scatto di foto, mantenere una distanza di 1,3 ~ 5 piedi dal soggetto.
Questa funzionalita non e disponibile se ['ambiente & buio.

La registrazione di video e possibile solo con leffetto di sfocatura. Toccare e tenere
premuto () per attivare la funzione.

Uso di altre modalita della fotocamera
Toccare () e selezionare Altro scorrendo le modalita della fotocamera.
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Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da
fotografare e unire gli scatti continui di una vista ampia.

1 Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.
2 Sfiorare )}y
3 Toccare ), quindi spostare lentamente la fotocamera in una sola direzione.
A Toccare @ per interrompere lacquisizione della panoramica.
Imposta la fotocamera !‘ Imposta il timer
Applica leffetto filtro Imposta/annulla
limpostazione del flash

E + Quando si sposta la fotocamera in una direzione, assicurarsi che ['inquadratura
ripresa non sia fuori dalla linea guida.

App utili 109



Fotocamera manuale

E possibile creare foto dal tocco professionale grazie a varie funzioni avanzate.

1 Toccare @ e selezionare Fotocamera manuale scorrendo le modalita della
fotocamera.

7 Personalizzare le sequenti impostazioni della fotocamera.

« Se per le opzioni si imposta Auto, le opzioni vengono regolate
automaticamente in base al soggetto e allambiente di ripresa.
+ Se e impostata lopzione Focus peaking, larea di messa a fuoco viene

evidenziata con u n colore. Questa funzione e disponibile solo nella modalita
Messa a fuoco manuale (MF).

Imposta la fotocamera 3

Applica leffetto filtro 41

e—— Imposta il timer

Imposta/annulla
limpostazione del flash

es————— Visualizza le varie
opzioni di Graphy

Regolail
bilanciamento del Regolare il la
bianco 3 velocita
Regola la messa a

dellotturatore
fuoco

Regola la velocita

Regola la ISO

luminosita

3 Toccare per scattare la foto.
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Se si tocca @ e si seleziona un effetto Graphy, appare un elenco delle foto
consigliate con varie impostazioni.

La selezione degli effetti Graphy consente di scattare utilizzando il bilanciamento
del bianco, la velocita dell'otturatore e i valori di impostazione ISO applicati alla foto
consigliata.

Questa funzione ¢ disponibile solo nella modalita Fotocamera manuale.

E possibile vedere una varieta di foto consigliate scaricando l'app Graphy da
Google Play Store.

A seconda del proprio piano tariffario, potrebbe essere addebitato il costo dei dati
utilizzati per il download.

Toccare @ quinditoccare ( () nel menu Foto con Graphy per disattivare questa
funzione.

Personalizzazione delle opzioni della fotocamera

E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 in Fotocamera manuale.

Foto con Graphy

Regolare il bilanciamento del bianco, [1SO e la velocita dell'otturatore
per la foto consigliata.

Per i dettagli, vedere, consultare la sezione Fotocamera manuale.

Salvare come
RAW

Limmagine é salvata nel formato file RAW, in modo tale che sia
possibile modificarla.

Durante lo scatto vengono creati i file DNG e JPEG, poi vengono
salvati come immagini ad alta risoluzione non compresse.

Scatto al Cheese

Consente di scattare foto tramite comandi vocali.

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione GPS.

Guida

Consente di visualizzare le griglie di guida in modo da poter scattare
foto in base alle linee di riferimento orizzontali e verticali.

Aggiungi firma

Consente di visualizzare una firma personalizzata sulle foto.

Consente di selezionare se si desidera archiviare le immagini e i video

Archiviazione nellArchivio interno o nella Scheda SD. (Disponibile quando la scheda
di memoria & inserita.)
Guida Fornisce una guida per ciascun menu della fotocamera.

App utili



Slow Motion

Crea video divertenti modificando la velocita di movimento. Questa funzione e utile
quando si desidera riprodurre un video a una velocita inferiore rispetto alla velocita
effettiva della clip originale.

1 Toccare G e selezionare Altro scorrendo le modalita della fotocamera.
7 Sfiorare @.
3 Selezionare Parte =)o Tutte = ) a cui applicare leffetto slow
=) =) pp
motion.
« Parte: Consente di applicare [effetto slow motion a una sezione specifica
del video.

- Premere © nel momento in cui si desidera che venga applicato leffetto
slow motion. Con una breve pressione, leffetto slow motion viene
applicato per 0,5 secondi. Con una pressione prolungata, leffetto slow
motion viene applicato fino a quando non si rilascia il dito.

« Tutte: Consente di applicare leffetto slow motion allintero video.
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Imposta la fotocamera —— e—— Impostail timer

Applica leffetto filtro Imposta/annulla

limpostazione del flash

/. Toccare () per riprendere un video.

- Per mettere in pausa la registrazione del video, toccare (11). Per riprendere la
registrazione del video, toccare (® .

5 Per terminare la ripresa, premere (= .

YouTube Live
E possibile registrare un video e caricarlo direttamente su YouTube.

Per utilizzare questa funzione, & necessario soddisfare i requisiti di idoneita. Per i
requisiti, contattare YouTube.

T Nella schermata Home, toccare (&).
7 Selezionare Altro scorrendo le modalita della fotocamera, quindi toccare (o).
E « YouTube Live & disponibile solo quando il proprio dispositivo & connesso a Internet.

Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.
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Utili funzioni della fotocamera

Blocco Esposizione automatica/Messa a fuoco automatica

E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuta lo schermo nella modalita automatica. Per disattivare
la funzione, toccare unarea vuota sulla schermata.

Imposta la fotocamera —g — Impostail timer

Imposta/annulla

Applica leffetto filtro
limpostazione del flash

Blocco
Esposizione
automatica/Mess
a afuoco
automatica

E « Questa funzione é disponibile solo in alcune modalita specifiche.

App utili 114



Passaggio dalla fotocamera posteriore a quella anteriore e
viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e vice versa in
base allambiente circostante.

+ Per passare tra la fotocamera anteriore e posteriore, scorrere lo schermo verso

lalto o verso il basso nella schermata di ripresa dellapp Fotocamera.

E « Utilizzare la fotocamera anteriore per scattare i selfie. Per i dettagli, vedere,
consultare la sezione Scatto di selfie.

Zoom avanti o indietro

E possibile allontanare o awicinare due dita per ingrandire o ridurre quando si
scattano foto o si registrano video.

E « Lafunzione di zoom avanti/indietro non & disponibile in modalita selfie

(fotocamera anteriore).
+ Questa funzione non e supportata in diverse modalita.
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Utilizzo di Burst Shot
E possibile scattare foto consecutive e visualizzarle come immagini in movimento
nella Galleria.
1 Toccare @ e selezionare Foto.
2 Tenere premuto
+ Vlengono scattate pili foto consecutive mentre si tiene premuto

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.
Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.
E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

E « Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi

toccare @ > Scatto di selfie > Scatto tramite gesto della mano.

+ Assicurarsi che il palmo e il pugno siano allinterno della linea di riferimento in
modo che la fotocamera possa rilevarli.

+ Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.
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Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.

+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

E - Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.

Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.

+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §63 > Salva come
capovolta. Llimmagine viene capovolta in senso orizzontale.

E « Durante utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per i dettagli, vedere, consultare la
sezione Personalizzazione delle opzioni della fotocamera.

Scatto di selfie

E possibile utilizzare la fotocamera anteriore per visualizare il proprio volto sullo
schermo e scattare selfie.

1 Toccare @ e selezionare Foto scorrendo le modalita della fotocamera.
7 Toccare {0} per passare alla fotocamera anteriore.

3 Toccare ! per scattare le foto.
- Toccare §) per applicare vari effetti estetici.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

Visualizzazione delle foto
E possibile visualizzare le foto salvate nel prodotto.

1 Toccare c e selezionare la cartella desiderata.

7 Toccare la foto desiderata.
+ Lacartella Galleria contiene Album, Foto, Ricordi e Play.

17 Awviare Google Lens.

&— Consente di accedere a opzioni

aggiuntive.
Consente di awiare la fotocamera

Consente di aggiungere a o
rimuovere dai preferiti.

Consente di tornare alla ——sE
schermata precedente.

Consente di scrivere un —=s]

promemoria su una foto, ]
Consente divisualizzare i contenuti Consente di condividere le

correlati immagini
Consente di modificare le immagini

s — Consente di eliminare le immagini

E « Toccando leggermente lo schermo, appare il menu Dettagli. Toccando nuovamente
lo schermo, il menu scompare.
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Riproduzione di un video

E possibile riprodurre i video salvati nel prodotto.

Consente di tornare —)

alla schermata
precedente.

Consente di riprodurre
o sospendere la
riproduzione del video.

Consente di visualizzare i
contenuti correlati
Consente di modificare le
immagini.

o

LN
-

Consente di accedere a opzioni
aggiuntive.

Consente di awviare la
fotocamera.

Consente di aggiungere a o
rimuovere dai preferiti

Consente di eliminare
le immagini.
Consente di
condividere le
immagini.

5 Per regolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il
lato sinistro della schermata.

Trascinando lo schermo a sinistra nella schermata di riproduzione video & possibile

riawolgere (REW) e trascinando a destra ¢ possibile avanzare rapidamente (FF).
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Eliminazione di file
E possibile eliminare file utilizzando una delle sequenti opzioni:
+ Toccare e tenere premuto un file nell'elenco, quindi toccare Elimina.

- Ifile eliminati vengono spostati automaticamente nel + > Cestino e possono
essere ripristinati nella Galleria entro 7 giorni.

- Toccare [x] per eliminare completamente i file. In questo caso, i file non potranno
essere ripristinati.

Condivisione di file
E possibile condividere file utilizzando una delle sequenti opzioni:

- Mentre si visualizza una foto o un video, toccare o< per condividere il file
utilizzando il metodo desiderato.

5

Se si scattano foto o si registrano video dopo aver toccato @ > €§3 >Tag
posizione - @), dopo un po' di tempo nella scheda Memorie di Galleria viene
creato automaticamente un album di memorie specifiche della posizione.

E possibile cercare le foto o i video per luogo, tag, modalita della fotocamera ecc.
toccando Q nella Galleria.

Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

Alcuni file potrebbero non aprirsi a causa della codifica.
« [file di dimensioni superiori al limite massimo potrebbero generare un errore.

« Devi attivare la funzionalita GPS per creare album di Memoria.

Realizzazione di un collage
Puoi creare un collage dai contenuti associati.
T Toccare (Y e selezionare : > Realizza collage.

2 Selezionare le immagini desiderate da aggiungere al collage, quindi toccare
Avanti.

+ Selezionare il layout desiderato sul fondo dello schermo.

3 Toccare Crea.
E + Per creare un collage possono essere utilizzate un massimo di 9 immagini.
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Creazione di un filmato

E possibile creare un nuovo filmato, mettendo insieme immagini e video.
T Toccare @Y e selezionare : > Crea filmato.

2 Selezionare immagini o video per il filmato e toccare Avanti.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.

g Fileinteressati
Reimpostazione dei file

e — Anteprima di un file

Eliminazione di file

T Aggiunta di file

E « Per creare un filmato possono essere utilizzati un massimo di 50 video.
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Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video registrato.
Toccare [ e selezionare : > Realizza una GIF.

Creazione di un video

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @,

7 Selezionare la durata della GIF che si desidera creare.

+ Viene generata una GIF della durata desiderata a partire dal punto iniziale
specificato.

« Perivideo di durata inferiore ai 5 secondi, le immagini GIF vengono generate
automaticamente per il tempo restante.

Creazione di fotografie GIF
71 Nellelenco delle fotografie nella galleria, toccare > Crea GIF.

7 Selezionare unimmagine da trasformare in fotografia GIF e quindi toccare
Avanti.

- E possibile aggiungere/eliminare una fotografia, regolare la velocita o le
proporzioni dello schermo e impostare ['ordine delle fotografie.

E + La creazione di fotografie GIF e una funzione che consente all'utente di
produrre immagini creative. La violazione dei diritti di proprieta intellettuale o la
diffamazione della reputazione di altre persone mediante la funzione di creazione
di fotografie GIF possono comportare responsabilita civili o penali in conformita
con le leggi vigenti. Fare attenzione a non copiare o trasmettere opere di altre
persone senza autorizzazione. LG Electronics declina ogni responsabilita per tali
azioni degli utenti

Quando si crea una fotografia GIF, € possibile selezionare di produrre finoa 100
fotografie.
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Nella schermata Home, toccare Essenziali > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .
« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.
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Aggiunta di contatti all'elenco di composizione veloce
1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
2 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre si aggiunge un nuovo contatto, toccare (3] per aggiungere un numero di
chiamata rapida.

Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:
+ Toccare la barra di ricerca nella parte inferiore della schermata Rubrica e inserire
il contatto o il numero di telefono che si desidera cercare.
+ Scorrere ['elenco dei contatti verso lalto o verso il basso.

- Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

« Premendo la barra di ricerca nella parte inferiore della schermata Rubrica e
E inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrata dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.
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Elenco dei contatti

Modifica di contatti
1 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:

+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare {i].

- Toccare + > Elimina nella schermata dellelenco dei contatti.

E « | contatti cancellati non possono essere recuperati.

Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.

7 Nella schermata dei dettagli dei contatti, toccare .

Creazione di gruppi

7 Dall'elenco dei gruppi di contatti, toccare -

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Aggiungi.

A Toccare Salva per salvare il nuovo gruppo.
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QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Creazione di una nota
1 Nella schermata Home, toccare QuickMemo+.
7 Toccare @ per creare una nota.
- @ : consente di salvare una nota.
+ <5 :Annullare le modifiche precedenti.
+ 7 :Applicare di nuovo le modifiche annullate di recente.
. 'ff,‘, :consente di immettere una nota utilizzando la tastiera.
-/ :consente di scrivere delle note a mano.
- &> :consente di cancellare le note scritte a mano.

- {7 :consente di eseguire lo zoom avanti o indietro, ruotare o cancellare

parte di una nota scritta a mano.
- :Consente di accedere a opzioni aggiuntive.

3 Toccare @ per salvare la nota.
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Scrittura di note su uno screenshot
1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di
stato verso il basso, quindi toccare (..
+ Lo screenshot viene visualizzato come tema di sfondo del blocco note.
Nella parte superiore dello schermo vengono visualizzati gli strumenti di
promemoria.
2 Tagliare limmagine (se necessario) e aggiungere note a proprio piacimento.
« Scrivere delle note a mano sulla foto.

3 Toccare @ e salvare le note nella posizione desiderata.
« Le note salvate possono essere visualizzate in QuickMemo+ o in Galleria.

« Per salvare le note sempre nella stessa posizione, selezionare la casella di
controllo Usa come predefinita per questa azione. e selezionare unapp.

E + Puoi scattare una foto dell'intero schermo, utilizzando la funzione di scatto di
scorrimento.

+ Quando si utilizza un'app come Invia messaggio o Chrome, trascinare il pannello
notifiche verso il basso, quindi cliccare Capture+ > Esteso per scattare una foto
dell'intero schermo cosi come lo si vede e salvarla in un solo file.

+ Questa funzione e disponibile solo in alcune app che supportano la funzione scatto
di scorrimento.

Stringi due dita o allargale per regolare il layout del promemoria.
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Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
T Nella schermata Home, toccare Orologio > Sveglia.

2 Toccare —|— per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.

E « Sesi seleziona una sveglia impostata in precedenza, e possibile modificarla.

Fusi orari
E possibile visualizzare l'ora attuale delle citta di tutto il mondo.
1 Nella schermata Home, toccare Orologio > Fusi orari.

2 Toccare —|— e aggiungere una citta.

Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

7 Nella schermata Home, toccare Orologio > Timer.

2 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.
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Cronometro
E possibile utilizzare il cronometro per registrare un tempo.
1 Nella schermata Home, toccare Orologio > Cronometro.
7 Toccare Inizio per awiare il cronometro.
+ Perregistrare un tempo, toccare Giro.
3 Toccare Pausa per sospendere il cronometro.
+ Per riprendere il cronometro, toccare Riprendi.

+ Per cancellare tutte le registrazioni e awviare di nuovo il cronometro, toccare
Reset.

Calendario

Informazioni generali sul calendario
E possibile utilizzare il calendario per gestire eventi e attivita.

Aggiunta di eventi
1 Nella schermata Home, toccare Essenziali > Calendario.
7 Selezionare una data, quindi toccare e

3 Immettere i dettagli dellevento e toccare Salva.

Sincronizzazione di eventi

Toccare * > Calendari da sincronizzare e selezionare un calendario da
sincronizzare.

E + Quando si salvano i propri eventi dal dispositivo allaccount Google, vengono
automaticamente sincronizzati anche con il calendario di Google. E inoltre possibile
sincronizzare altri dispositivi con il calendario di Google, in modo tale che quei
dispositivi presentino gli stessi eventi del proprio dispositivo e sia possibile gestire i
propri eventi su quei dispositivi.

App utili 129



Attivita

E possibile registrare attivita sul dispositivo per gestirne con facilit la pianificazione.
1 Nella schermata Home, toccare Essenziali > Attivita.

2 Toccare @ per aggiungere un‘attivita,

3 Immettere i dettagli dell'attivita, quindi toccare Salva.

Musica

E possibile riprodurre e gestire canzoni o album musicali
T Nella schermata Home, toccare Essenziali > Musica.
7 Selezionare una categoria.

3 Selezionare un file musicale.

Consente di impostare effetti
sonori.

Consente di tornare alla —e

schermata precedente. Consente di accedere a opzioni

aggiuntive.

Passare alla playlist.

Consente di riprodurre o

Accendi/spegni Boombox show. ——
sospendere la riproduzione.

Accendi/spegni Flash Light.

Toccare per riprodurre il file

corrente dall'inizio / Toccare due ) .
volte per riprodurre il file = Toccare per riprodurre il file
precedente / Toccare e tenere l l successivo / Toccare e tenere
premuto per riawolgere. premuto per avanzare
x M P oo velocemente.
Consente di riprodurre in ordine ——T L— Consente di selezionare una
casuale. L modalita di ripetizione.
Consente di regolare il volume ———e= w +—— Modifica velocita e intonazione.
dellaudio. =

Consente di aggiungere a o 1

rimuovere dai preferiti.
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Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

i

I file di dimensioni superiori al limite massimo potrebbero generare un errore.

| file musicali potrebbero essere protetti dai titolari di copyright internazionali o da
leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne l'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.

Questo modello supporta la riproduzione audio Hi-Fi. | file audio Hi-Fi presentano
licona Hi-Fi.

Quando la funzionalita Boombox Show, lo schermo mostra effetti visivi sulla
musica.

Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice
scientifica.

71 Nella schermata Home, toccare Calcolatrice.

7 Utilizzare il tastierino numerico per eseguire un calcolo.
« Per calcolare dallinizio, toccare e tenere premuto {X].

Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
l'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

1 Nella schermata Home, toccare Essenziali > Launcher Del Gioco.

2 Selezionare lopzione desiderata.
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LG Health

Informazioni generali su LG Health

E possibile gestire il proprio stato di salute e mantenere buone abitudini di fitness
monitorando lesercizio fisico svolto.

Informazioni preliminari su LG Health
E possibile configurare LG Health al primo awio dellapp o dopo averla ripristinata.
1 Nella schermata Home, toccare Essenziali > LG Health.

2 Sequire le istruzioni visualizzate sullo schermo per completare la
configurazione.

Utilizzo di LG Health

E possibile visualizzare le informazioni principali su LG Health e gestire la quantita di
esercizio fisico e le informazioni relative alla salute.

1 Nella schermata Home, toccare Essenziali > LG Health.

2 Sono disponibili le sequenti opzioni.
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+ = :consente divisualizzare il registro del proprio esercizio fisico nel giorno

che si desidera monitorare.

- Q :consente diiniziare a monitorare una sessione di esercizio fisico. Il
percorso e la quantita di esercizio fisico svolto vengono registrati per
ciascuna tipologia di esercizio.

-+ :consente diimpostare gli obiettivi giornalieri di esercizio fisico, compresii
passi e le calorie, oppure di configurare diverse impostazioni di LG Health.

E + Le informazioni relative alla salute fornite da LG Health sono studiate per la
comodita dell'utente e non possono essere utilizzate a scopo di prevenzione,
trattamento e diagnosi di malattie né per altri scopi medici.

LG Health potrebbe variare o potrebbe non essere disponibile a seconda del paese
e del provider del servizio. Le funzioni di LG Health disponibili e le app che possono
essere abbinate a LG Health possono variare a seconda del paese. Le variazioni
sono dovute alle diverse leggi e normative vigenti.

App utili 133



Email

Informazioni generali sulle e-mail

E possibile registrare un account e-mail sul dispositivo e quindi controllare e inviare
e-mail dal dispositivo.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario. Rivolgersi al proprio provider del servizio per ulteriori
informazioni.

Registrazione di account e-mail

Al primo utilizzo dell'app di e-mail, registrare il proprio account e-mail.
1 Nella schermata Home, toccare Essenziali > Email.

7 Selezionare un provider di servizi e-mail.

3 Immettere il proprio indirizzo e-mail e la relativa password, quindi toccare
Avanti per registrare ['account
« Per registrare manualmente un account email, toccare Impostazione
manuale (se necessario).

Gestione degli account e-mail
Per visualizzare o modificare le impostazioni degli account e-mail, toccare + >
Impostazioni.

+ Per aggiungere un account, toccare Aggiungi account.

« Per eliminare un account, toccare > Rimuovi account.

Apertura di un altro account e-mail

Se sono registrati vari account e-mail e si desidera visualizzare un altro account,
toccare = e selezionarne un altro dall'elenco degli account.
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Controllo delle e-mail
1 Toccare — e selezionare una casella di posta.

7 Selezionare un'e-mail dal relativo elenco.
« Viene visualizzato il messaggio e-mail.

Invio di e-mail
1 Sfiorare €.
7 Immettere lindirizzo email del destinatario.

3 Immettere [oggetto e il messaggio.
+ Per allegare file, toccare (.
+ Per accedere alle voci di menu opzionali, toccare .

/L Toccare 9 per inviare ['e-mail.

E « Stringi due dita o allargale per regolare la dimensione del carattere secondo la
dimensione della tua lista di e-mail.

Radio FM

E possibile ascoltare la radio FM.
Nella schermata Home, toccare Essenziali > Radio FM.

E « Per utilizzare questa app, collegare prima degli auricolari al dispositivo. Gli auricolari

fungono da antenna radio.
+ Questa funzione potrebbe non essere supportata a seconda della zona.
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File Manager

E possibile visualizzare e gestire i file salvati sul dispositivo o sul cloud.
T Nella schermata Home, toccare Gestione > File Manager.

7 Toccare = e selezionare il percorso di archiviazione desiderato.

LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo
mediante LG Mobile Switch.

1 Nella schermata Home, toccare Gestione > LG Mobile Switch.
E possibile anche toccare Impostazioni > Sistema > Backup > LG Mobile
Switch.

2 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.

E + | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza 'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.

Download

E possibile visualizzare, eliminare o condividere file scaricati tramite Internet o app.
Nella schermata Home, toccare Gestione > Download.
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SmartWorld

E possibile scaricare vari giochi, contenuti audio, app e tipi di carattere forniti da LG
Electronics. Si puo inoltre personalizzare il dispositivo in base alle proprie preferenze

utilizzando temi per la schermata Home e tipi di carattere.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ Questa funzione potrebbe non essere supportata a seconda dell'area o del
provider del servizio.

71 Nella schermata Home, toccare Servizi > SmartWorld.
7 Toccare > Account LG, quindi effettuare l'accesso.

3 Selezionare e scaricare i contenuti desiderati.

Download dell'app SmartWorld

Se I'app SmartWorld non e installata, sequire questa procedura per scaricarla.

1 Nella schermata Home, toccare Impostazioni > Sistema > Centro
aggiornamenti > Aggiornamento applicazione.

7 Dallelenco, selezionare SmartWorld e toccare Scarica.
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RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, e prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

T Nella schermata Home, toccare Servizi > RemoteCall Service.

2 Collegare una chiamata al centro di assistenza clienti LG.

3 Al collegamento della chiamata, seguire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

+ Il dispositivo viene connesso in modalita remota e viene awviato il servizio di
assistenza remota.

Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Nella schermata Home, toccare Servizi > Messaggio CB.

App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un'app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del
Servizio.
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Chrome
Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs & uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive & un'app di condivisione e immagazzinaggio di file che facilita lindividuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.

Duo

Crea video chiamate semplici e di alta qualita verso i tuoi amici e famigliari su
telefoni Android e iPhones.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende pit smart la
tua casella di posta e ti aiuta a restare organizzato.

Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Maps

Stai andando da qualche parte? Vai con Maps, [app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.

Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose piti importanti.

Play Film
Consente di utilizzare il proprio account Google per noleggiare o acquistare film. E
possibile acquistare contenuti e riprodurli ovunque.
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Play Musica

Acquista file musicali dal Play Store. E possibile riprodurre i file musicali salvati sul
dispositivo.

Fogli

Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.

Presentazioni

Google Slides e uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.

YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.

Assistente Google

Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro. per inizare, basta toccare il tasto Assistente Google sul lato
del telefono o tenere premuto il pusante home del telefono.

E « Assistente Google non & disponibile in tutte le lingue o paesi.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Nella schermata Home, toccare Impostazioni.

E + Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, & possibile trovare comodamente gli elementi da impostare,

Rete & internet

Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete Wi-Fi.

Connessione a una rete Wi-Fi
7 Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.
2 Toccare () ) per attivarlo.
« Vengono visualizzate automaticamente le reti Wi-Fi disponibili.
3 Selezionare una rete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

« Questo processo viene ignorato in caso di reti a cui é gia stato effettuato
l'accesso in precedenza. Se non si desidera eseguire automaticamente la
connessione a una determinata rete \Wi-Fi, toccare la rete, quindi toccare
Elimina.
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Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.

- Passa a rete dati: se la funzione connessione dati mobile ¢ attiva e il dispositivo
non & in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

5 + Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.

Wi-Fi Direct

E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione
\Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre
di un punto di accesso. Utilizzando la funzione \Wi-Fi Direct, e possibile connettere
piti di due dispositivi.

T Nella schermata delle impostazioni, toccare Rete & Internet > Wi-Fi> : >
Avanzate Wi-Fi > Wi-Fi Direct.

+ Vlengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.

2 Selezionare un dispositivo.
+ La connessione awiene quando il dispositivo accetta la richiesta di
connessione.

E - La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.
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Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne lutilizzo.

Attivazione dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.

2 Toccare ()) per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.
7 Personalizzare le seguenti impostazioni:

« Attivo: consente di utilizzare le connessioni dati su reti mobil.

+ Limita l'utilizzo dei dati mobili: consente diimpostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

: :consente di personalizzare le impostazioni dei dati mobili.

+ Il volume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.

Impostazioni chiamate

E possibile personalizare le impostazioni di chiamata, ad esempio le opzioni per le
chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

1 Nella schermata delle impostazioni, toccare Rete & internet > Impostazioni

chiamate.

2 Personalizzare le impostazioni
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Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere
i dati mobili.

1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete & Internet > Tethering >
Tethering USB e quindi toccare () ) per attivarlo.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer;, scaricare il driver USB da
wwwlg.com e installarlo sul computer.

+ Non e possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, 0 Linux.

Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Hotspot Wi-Fi e toccare () ) per attivare la funzione.

2 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

/4 Immettere la password di rete.
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E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tetherswifi

Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se ['hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth

Un altro dispositivo connesso tramite Bluetooth puo connettersi a Internet

utilizzando i dati mobili del proprio dispositivo.

1 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering Bluetooth e quindi toccare (1)) per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

+ Ulteriori informazioni sono disponibili su questo sito Web:
http.//www.android.com/tether#Bluetooth_tethering

Guida

E possibile visualizzare la quida sullutilizzo del tethering e degli hotspot.

Nella schermata delle impostazioni, toccare Rete & internet > Tethering > Guida.

Impostazioni

146



Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e la riproduzione di brani musicali.

1 Nella schermata delle impostazioni, toccare Rete & internet > Modalita aereo.

7 Toccare Attiva nella schermata di conferma.

Reti mobili
E possibile personalizzare le impostazioni delle reti mobili
T Nella schermata delle impostazioni, toccare Rete & internet > Reti mobili.

7 Personalizzare le sequenti impostazioni:

+ Roaming dati: consente di navigare sul \Web, utilizzare e-mail, messaggi
multimediali e altri servizi di dati all'estero.

+ Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per |'utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

« Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.
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VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire la rete privata virtuale connessa.

Aggiunta di una rete VPN

1 Nella schermata delle impostazioni, toccare Rete & internet > VPN.

2 Sfiorare

3 Immettere i dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare una rete VPN nell'elenco VPNS.

7 Immettere i dettagli relativi allaccount utente della rete VPN e toccare
Connetti.

+ Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.

DNS privato
E possibile configurare le opzioni del DNS (Domain Name System) privato.
1 Nella schermata delle impostazioni, toccare Rete & internet > DNS privato.

7 Selezionare lopzione desiderata e toccare Salva.
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Dispositivi connessi

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara pit semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare () ) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

3 Selezionare un dispositivo di destinazione per il file.
« Il file viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.
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Condivisione schermo

E possibile riprodurre la schermata e laudio del dispositivo su un altro dispositivo,
come ad esempio una TV, in grado di supportare la funzione Miracast.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione schermo.
2 Toccare ()) per attivarlo.

3 Selezionare un dispositivo dall'elenco dei dispositivi vicini.

+ Seil dispositivo desiderato non é visualizzato, toccare Ricerca per aggiornare
l'elenco.

+ Una volta effettuata la connessione al dispositivo, sul relativo schermo viene
visualizzata la schermata del dispositivo.

E « La Condivisione schermo si spegne automaticamente se non vi & alcun dispositivo
compatibile per la condivisione nelle vicinanze.

NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.

7 Toccare ()) per attivarlo.

+ Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

E - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.
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Android Beam

E possibile condividere file mettendo a contatto il retro di due dispositivi. E inoltre
possibile condividere file tra cui file musicali, video o contatti e aprire una pagina
\Web o awviare unapp dall'altro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Android
Beam.

7 Mettere a contatto il retro del dispositivo con un altro dispositivo.

E - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.

Pannello di condivisione

E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone
specifiche nelle app che utilizzano Google Condivisione diretta.

T Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.

7 Toccare @ per disattivare ciascuna opzione.

& possibile condividere i contenuti delle app Galleria, Musica e File Manager.

« Condivisione diretta: da unapp che supporta Google Condivisione diretta,
& possibile visualizzare un'icona che consente di condividere contenuti con
persone specifiche.
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Condivisione File
E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.

7 Personalizzare le sequenti impostazioni:
+ G7 ThinQ: consente di modificare il nome del dispositivo.

+ Salva in: consente diimpostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.

- Condivisione File: consente la ricezione di file inviati da altri dispositivi.

- SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

+ Guida: consente di visualizzare la guida alla condivisione dei file.

Server multimediale
E possibile condividere contenuti multimediali presenti sul dispositivo con dispositivi
vicini che supportano la funzione DLNA.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Server
multimediale.
7 Personalizzare le sequenti impostazioni:

+ Condivisione di contenuti: consente di condividere contenuti presenti sul
dispositivo con dispositivi vicini.

G7 ThinQ: consente di impostare il nome del dispositivo.

E « A seconda del prodotto dell'utente, i nomi dei menu potrebbero apparire in modo
diverso

+ Contenuti da condividere: consente di selezionare il tipo di contenuti
multimediali da condividere con altri dispositivi.

- Dispositivi consentiti: consente di visualizzare un elenco dei dispositivi a cui
& consentito accedere ai contenuti presenti sul dispositivo.

Dispositivi non autorizzati: consente di visualizzare un elenco dei dispositivi
a cui non e consentito accedere ai contenuti presenti sul dispositivo.
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MirrorLink

E possibile connettere il dispositivo a un'auto tramite USB per utilizzare [app
MirrorLink installata sul dispositivo dallimpianto di infotainment o dalla head unit
dellauto.

5

Questapp e disponibile soltanto nelle automobili che supportano MirrorLink.

« Scaricare [app MirrorLink da uno store o un mercato di app. Per maggiori
informazioni, visitare https7/mirrorlink.com/apps.

Alcune funzioni potrebbero essere limitate per la sicurezza del conducente quando
si usa la funzionalita MirrorLink.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > MirrorLink.

2 Collegare il dispositivo a unautomobile usando il cavo USB e attivare Collega
tramite Cavo USB.

5

Se il dispositivo viene collegato a un veicolo che supporta la connessione
MirrorLink automatica, Collega tramite Cavo USB si attiva automaticamente sul
dispositivo.

. . N
Toccare + per configurare la connessione MirrorLink USB automatica.

Stampa

E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.

Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.

+ Toccare Servizio di stampa predefinito per cercare le stampantia cui &
possibile connettersi. Oppure, toccare + > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Nuovo servizio per scaricare lapp della stampante desiderata.

E + Questa funzione é disponibile sono quando e attiva la funzione di rete mobile o
Bluetooth.

« Per scaricare [app della stampante in @ Nuovo servizio, & necessario prima
accedere al proprio account Google.
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Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le seguenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. £
possibile aggiungere o eliminare suonerie.

Suono di notifica: consente di selezionare una suoneria per le notifiche. £
possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.

Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

Volume: consente di regolare il volume dellaudio di diversi elementi.

- Normalizza volume: Usare la funzione per normalizzare i volumi di sorgenti
audio differenti.

Equalizzatore: Usare [a funzione per regolare le impostazioni
dell'equalizzatore.

- DTS:X 3D Surround: Usare la funzione per riprodurre musica o video in un
audio tridimensionale, immersivo e vivido quando cuffie, altoparlanti, o altri
dispositivi audio esterni sono connessi. Per i dettagli, vedere, consultare la
sezione DTS:X 3D Surround.

- Hi-Fi Quad DAC: Connettere auricolari, casse o altri supporti audio esterni
alla presa delle cuffie stero utilizzandoli come Hi-Fi Quad DAC.
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- Profilo audio: Usare la funzione per selezionare la preimpostazione audio.

- Filtro digitale: Usare la funzione per regolare l'eco e riprodurre la musica
come desiderato.

- Equilibrio: Usare la funzione per regolare il volume sinistro e destro
dellauricolare.

Potenza vibrazione: consente di regolare lintensita della vibrazione.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.

Vibrazione al tocco: consente di impostare la vibrazione del dispositivo quando
si toccano determinati elementi sullo schermo.

Suono della tastiera di composizione: seleziona l'effetto sonoro del tastierino.
Suono della tastiera LG: seleziona 'effetto sonoro della tastiera LG.
Suono touch: Selezionare un effetto sonoro per quando si tocca un elemento.

Suoni di blocco schermo: selezionare un effetto sonoro per quando lo schermo
viene bloccato o sbloccato.

Display

E possibile personalizzare impostazioni dettagliate per ogni tipo di schermata.

Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti
impostazioni:

Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
i dettagli, vedere, consultare la sezione Impostazioni della schermata Home.
Sfondo & Tema: seleziona un wallpaper, tema, icona e AOD per lo schermo del
tuo dispositivo.

Carattere: modificare dimensione, grassetto, o facciata.

New Second Screen: selezionare 'aspetto della barra dello stato e dell'angolo
delleapp.

Barra di navigazione:impostare lo stile della barra d navigazione come Gesti
0 Solo pulsanti. Quando come stile della barra di navigazione si seleziona Solo
pulsanti, e possibile anche cambiare la combinazione di pulsanti. Per maggiori
informazioni, vedere Barra di navigazione.
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AOD (always-on display) consente di visualizzare sempre informazioni come
data, ora e notifiche, anche quando lo schermo & spento. Per maggiori dettagli,
vedere AOD (always-on display).

Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare ['affaticamento degli occhi.

Modalita notte: di notte e possibile applicare un tema dello schermo oscurato
per evitare ['abbagliamento.

Colore dello schermo: Regola colore e temperatura del colore per lo schermo
desiderato.

E « Toccare 5 per ripristinare le impostazioni

- Ridimensionamento della app: consente di regolare le dimensioni sullo
schermo delle app.

Proporzioni
+ Questo dispositivo utilizza le proporzioni 19,59.
- Alcune app scaricate potrebbero non supportare le proporzioni 19,5:9.

In tal caso, selezionare le proporzioni dello schermo pili adatte allapp o
consultare il provider dellapp per ulteriori informazioni.

- Puoi selezionare il rapporto per app singole premendo O> Impostazioni >
Display > Ridimensionamento della app. Selezionare le proporzioni desiderate
tra Compatibilita (16:9), Standard (16.7:9), e Schermo intero.

- Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per l'utente. Alcuni elementi potrebbero
cambiare posizione.

- Risoluzione dello schermo: Regola la risoluzione dello schermo.

5 « Quando si modifica la risoluzione dello schermo, le app attualmente attive
vengono chiuse.

+ Luminosita: consente di utilizzare la barra di scorrimento per modificare la
luminosita dello schermo. Per regolare automaticamente la luminosita dello
schermo in base all'intensita della luce ambientale, toccare l'interruttore
Automatico.

+ Automatico: consente di impostare |a regolazione automatica della luminosita
dello schermo in base allintensita luminosa dellambiente.
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Timeout di Aumento di luminosita: consente di impostare la disattivazione
automatica dellaumento luminosita dopo il tempo impostato.

Timeout schermo: consente di disattivare automaticamente lo schermo
quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo &
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Schermo a una mano: ridurre le dimensioni dello schermo in modo da poter
utilizzare il dispositivo con una sola mano. Trascinare il bordo sinistro/destro al
centro e tenerlo fermo.

Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

Trova il mio dispositivo: tracciare a distanza a posizione del dispositivo. Puoi
anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo dispositivo.

Aggiornamento sicurezza: controlla gli aggiornamenti software e configura le
impostazioni di installazione automatiche.

Seleziona il blocco dello schermo: seleziona il metodo di blocco schermo
desiderato. Per i dettagli, vedere, consultare |a sezione Impostazione di un blocco
schermo.

Personalizza Blocco schermo: modifica le informazioni visualizzate sullo
schermo bloccato.

Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco
sicuro.

Impronte digitali: consente di usare limpronta digitale per sbloccare lo schermo
o il contenuto. Per i dettagli, vedere, consultare la sezione Informazioni generali
sul riconoscimento delle impronte digitali.
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Riconoscimento del volto: consente di sbloccare lo schermo con il proprio
volto. Per i dettagli, vedere, consultare la sezione Informazioni generali sul
riconoscimento del volto.

Riconoscimento vocale: Sblocca la blocco schermo tramite il riconoscimento
dei comandi vocali.

Blocco del contenuto: consente di impostare un tipo di blocco (password o
disegno) per i propri file QuickMemo+ e Galleria.

Crittografia e credenziali: configura le impostazioni per la cifratura e le

credenziali della scheda SD.

- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire [utilizzo su un altro dispositivo. Per i dettagli, vedere, consultare la
sezione Crittografia della scheda di memoria.

Awvio sicuro: consente di proteggere il proprio dispositivo con un blocco
allaccensione. Per i dettagli, vedere, consultare la sezione Impostazioni della
schermata Home.

Protezione delle credenziali: consente di visualizzare il tipo di memoria su
cui sara salvato il certificato di sicurezza.

- Credenziali di fiducia: visualizza i certificati CA root e i certificati CA installati
dall'utente del tuo sistema.

Credenziali dell'utente: visualizza e modifica le informazioni dei certificati
sicuri conservati sul tuo dispositivo.

- Installa dalla memoria:installare un certificato sicuro da un archivio.

Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.

Impostazioni blocco SIM: consente di bloccare o sbloccare la scheda USIM o di
modificare la password (PIN).

Amministratori dispositivo: consente privilegi per limitare il controllo o ['utilizzo
del dispositivo a determinate app.

Trust agents: consente di visualizzare e utilizzare agenti attendibili installati sul
dispositivo.

Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto [app attiva al momento.

Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app sul
dispositivo.
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Privacy

Gestione autorizzazioni: Consente di controllare e cambiare le autorizzazioni
concesse alle app.

Mostra password: visualizza brevemente i caratteri durante la digitazione.

Blocco schermo: Consente di impostare le notifiche da visualizzare sul blocco
schermo.

Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere cosa
si staimmettendo.

Compilazione automatica Google: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, o numero
di carta di credito con un singolo tocco. E possibile anche disattivare questa
opzione, usare la funzione Google Autocomplete, oppure aggiungere un nuovo
account di servizio.

Cronologia delle posizioni Google: Consente di abilitare o disabilitare

la Cronologia delle posizioni. Quando e abilitata, Google periodicamente
memorizza e utilizza i dati sulla posizione piti recenti del telefono in connessione
con laccount Google. Nella schermata Cronologia delle posizioni, toccare + per
visualizzare e/o gestire i dati sulla posizione.

Gestione attivita: Seleziona attivita e informazioni che si desidera vengano
salvate da Google.

Annunci: Consente di controllare ['ID pubblicita e impostare le pubblicita
personalizzate.

Utilizzo e diagnostica: Abilitare questa opzione per migliorare l'esperienza
Android inviando automaticamente a Google dati diagnostici e sull'utilizzo del
dispositivo e delle app.

Posizione

E possibile controllare come vengono condivise le informazioni sulla propria
posizione e configurare |'autorizzazione per accedere alle informazioni sulla propria
posizione. Nella schermata delle impostazioni, toccare Posizione e impostare la
funzione desiderata..
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Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per eseguire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Context Awareness

E possibile modificare automaticamente le impostazioni del dispositivo in base alla
sequenza di utilizzo e alla posizione.

T Nella schermata delle impostazioni, toccare Estensioni > Context Awareness.

7 Attivare gli elementi per i quali si desidera modificare automaticamente le
impostazioni.

- AUTOMATIZZATO: E possibile impostare il dispositivo in modo che modifichi
automaticamente il profilo audio, le opzioni Bluetooth e Wi-Fi in diversi
ambienti, ad esempio A casa, Fuori casa, Al lavoro e Non al lavoro. E possibile
anche impostare che unapp si apra quando vengono collegati gli auricolari o
quando viene connesso un dispositivo Bluetooth.

E « Per poter usare questa funzione, le posizioni di casa e lavoro devono essere
presenti in I miei luoghi. Nella schermata delle impostazioni, toccare Posizione > |
miei luoghi per impostare le posizioni.
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Gaming
E possibile configurare le impostazioni di gioco per gli strumenti, la grafica e il
risparmio energetico.

T Nella schermata delle impostazioni, toccare Estensioni > Gaming.

7 Personalizzare le seguenti impostazioni:
Launcher Del Gioco: Toccare QD) per usare la funzione Launcher Del Gioco.

Strumenti di gioco: E possibile esequire la funzione durante il gioco
toccando l'icona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

Grafica di gioco: Regola |a grafica di gioco.

E « Se si modifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello
schermo potrebbero non funzionare correttamente.

« Questa funzione potrebbe non essere disponibile per alcune app di gioco.

Tempo di pausa: Riduce la luminosita dello schermo e le prestazioni, ogni
volta che si abbandona il gioco per piti di 5 minuti.

Registrazione schermata

E possibile configurare le impostazioni della registrazione dello schermo.

1 Nella schermata delle impostazioni, toccare Estensioni > Registrazione
schermata.

7 Personalizzare le sequenti impostazioni:

« Includi te stesso nel video da: Selezionare una delle seguenti opzioni e
toccare Salva.

- Immagine:Include limmagine del profilo nel video durante la
registrazione. Una volta effettuata questa selezione, toccare @) e
selezionare unimmagine del profilo. Regolare quindi le dimensioni
dellimmagine usando la barra di scorrimento.

- Fotocamera anteriore:Include sé stessi registrati con la fotocamera
anteriore durante la registrazione dello schermo.

- Mai: Non viene incluso niente.

« Sorgente Audio: Scegliere [sorgente audio tra Mic e Contenuto.

- Risoluzione video: Selezionare |a risoluzione per la registrazione dello
schermo.
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Per registrare lo schermo

1 Trascinare verso il basso la barra di stato per aprire lelenco delle icone di
accesso rapido.

7 (Se necessario, scorrere a sinistra sull'area delle icone di accesso rapido.)
Sfiorare .

3 Leggere la dichiarazione di non responsabilita e toccare Inizio. La registrazione
inizia in 3 secondi.

A Per arrestare la registrazione, toccare (®), nella parte inferiore destra dello
schermo. Il video registrato viene salvato nella Galleria.

E « Laviolazione dei diritti di altre persone, quali il diritto di ritratto o di proprieta
intellettuale, o la diffamazione della reputazione di altre persone utilizzando le
funzioni fornite per il servizio di registrazione dello schermo, possono comportare
responsabilita civili, penali o amministrative in conformita con le leggi vigenti. LG
Electronics declina ogni responsabilita legale per le azioni degli utenti.

Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due
account contemporaneamente.

1 Nella schermata delle impostazioni, toccare Estensioni > Dual App.
2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nellelenco delle app disponibili, toccare Installa per installare una copia dellapp
desiderata e seguire le istruzioni visualizzate sullo schermo.

+ Sullo schermo viene visualizzato lelenco delle app duplicate disponibili.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.

App suggerite

Consente di accedere rapidamente alle app di cui si ha bisogno al momento nella
schermata Panoramica
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Floating Bar

Puoi attivare le funzioni piti frequenti, tra cui scorciatoie, screenshot, musica,
contatti e molto altro, toccando e facendo scorrere la barra fluttuante sullo
schermo. Per i dettagli, vedere, consultare la sezione Panoramica Pulsante
fluttuante.

Collegamenti

E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

7 Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

7 Personalizzare le seguenti impostazioni.

+ Apri Fotocamera: premere il tasto di accensione due volte per awiare la
Fotocamera.

« Apri Capture+:quando lo schermo & bloccato o spento, premere due volte il
tasto volume su (+) per awiare Capture+.

+ Apri Fotocamera: quando lo schermo é bloccato o spento, premere due
volte il tasto volume gili (-) per avviare Fotocamera.

- Apri Assistente Google: premere il tasto Assistente Google sul lato del
telefono.

« Parla con Assistente Google: tenere premuto il tasto Assistente Google
per parlare rapidamente con [Assistente.

E « Assistente Google non supporta alcune lingue.

Toc Toc
Eseguire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per i dettagli, vedere, consultare la sezione Toc Toc.
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Benessere digitale e Controllo
genitori

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app.

E possibile inoltre gestire il tempo di utilizzo del telefono cellulare utilizzando le
modalita Bedtime e Focus.

Nella schermata delle impostazioni, selezionare Benessere digitale e Controllo
genitori e impostare |a funzione desiderata.

App & notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.

T Nella schermata delle impostazioni, toccare App & notifiche.

2 Personalizzare le impostazioni.
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Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

1
2

Nella schermata delle impostazioni, toccare Batteria.

Personalizzare le sequenti impostazioni:

Utilizzo della batteria: consente di visualizzare i dettagli sull'utilizzo della
batteria. Per visualizzare altri dettagli, selezionare un elemento specifico.

Percentuale della batteria sulla barra di stato: consente di visualizzare il
livello della batteria residua come percentuale sulla barra di stato.

Batteria adattiva: consente di limitare il consumo della batteria da parte
delle app non utilizzate limitandone lattivita in background.

Limitazione sfondo: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

Risparmio energetico: consente di ridurre il consumo della batteria
riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: seleziona le app che vengono
utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.
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Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.

1 Nella schermata delle impostazioni, toccare Archiviazione.

2 Personalizzare le seguenti impostazioni:

+ Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

« Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Utenti & account
E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
1 Nella schermata delle impostazioni, toccare Utenti & account.

7 Personalizzare le impostazioni.

Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.
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Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pit recente dell'app o del software fornito
alG

T Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le seguenti impostazioni:
- Aggiornamento applicazione: controlla se & disponibile un aggiornamento.
Se disponibile, puoi installare ['aggiornamento.
« Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.

1 Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.

7 Personalizzare le sequenti impostazioni:

« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: e possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Voice. E possibile inoltre impostare se visualizzare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un'altra tastiera.

- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.

« Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, 0 aggiungere un nuovo account di
servizio.

- Uscita text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.
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+ Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

« Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Data e ora.

7 Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

1 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.

Backup
E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

1 Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le sequenti impostazioni:

+ LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per i dettagli, vedere, consultare la sezione LG Mobile Switch.

+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A « llripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

- Google Backup: modifica le impostazioni di backup di Google. E possibile

anche controllare ['account di backup attualmente usato, 0 aggiungere un
nuovo account di backup.
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Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
7 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: riavvia e ottimizza automaticamente il telefono allora
impostata. Toccare () ) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawvio.

E - Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

Una volta che il dispositivo si riawvia, le notifiche e i badge sono cancellati. Salvare i

dati importanti prima dell'ora preimpostata.

+ Lafunzionalita di riavvio automatico non ¢ attivata nelle seguenti situazioni.

Quando lo schermo ¢ acceso, quando il dispositivo & in uso, quando il livello della

batteria & il 30% o meno, o quando la scheda USIM ¢ bloccata.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riawio
automatico potrebbe non essere disponibile.

Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fj,
Bluetooth e altre impostazioni di rete.

Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.

Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

E « |lripristino e il riavvio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire

nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

« Dopo linizializzazione dei dati, i dati non possono piti essere recuperati.
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Info sul telefono

5 possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.

Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.
Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.

Accesso facilitato
E possibile gestire i plugin di accessibilita installati sul dispositivo.
1 Nella schermata delle impostazioni, toccare Accesso facilitato.

7 Personalizzare le sequenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo la lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.

Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per [utente. Alcuni elementi
potrebbero cambiare posizione.

Visione > Zoom touch: consente di eseguire lo zoom avanti o indietro
toccando lo schermo tre volte.

Visione > Zoom della finestra: consente di esequire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.
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Visione > Regolazione del colore dello schermo: consente di regolare il
colore del display.

Visione > Monocromatico: consente di far passare lo schermo alla modalita
scala di grigi.

Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

Udito > Didascalia: consente di attivare il servizio dei sottotitoli durante la
riproduzione di video per non udenti.

Udito > LED lampeggiante:Impostare per accendere la luce LED per le
chiamate e le notifiche in arrivo.

Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

Udito > Disattiva tutti i suoni: consente di disattivare tutti i suoni e
abbassare il volume sul ricevitore.

Udito > Canale audio: consente di selezionare il tipo di audio.

Udito > Bilanciamento del suono: consente di regolare il bilanciamento
dell'uscita audio. Consente di utilizzare a barra di scorrimento per modificare
il bilanciamento.

Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare [utilizzo di pulsanti e gesti.

Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.

Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamatg, invece di trascinarlo.

Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.
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- Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dallinserimento touch.

+ Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente a una funzione utilizzata di frequente toccando O tre volte.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

+ Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua LG

E possibile selezionare una lingua da utilizare sul dispositivo.
+ Nella schermata Home, toccare Impostazioni > Sistema > Lingua e tastiera >
Lingua > Aggiungi lingua, quindi selezionare una lingua.
- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

E possibile esequire il backup dei contatti, delle foto e di altri elementi sul computer
o0 aggiornare il software del dispositivo.

« Peridettagli, vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Fun2|on| di LG Bridge

Consente di eseguire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

+ Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E « LGsiriserva il diritto di rendere disponibili aggiornamenti del firmware
esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione piti recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

« Peribrevetti DTS, vedere http//patents.dts.com. Prodotto sotto licenza da DTS
Licensing Limited. DTS, il relativo simbolo e DTS e il simbolo insieme, DTSX e il
logo DTSX sono marchi commerciali o marchi commerciali registrati di DTS, Inc.
negli Stati Uniti e/o in altri Paesi. © DTS, Inc. Tutti i diritti riservati.

LG Boombox Edition

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ G7ThinQ e un marchio di LG Electronics Inc.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google Docs,
Google Drive, Google Sheets e altri marchi e logo correlati sono marchi di Google
LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
- Wi-Fi®eil logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVCAdvance”

‘: Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dell'utente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT

CLASSE 1 PRODUIT LASER

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-G710EM é conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration
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Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

Labanda 5150 - 5350 MHz e limitata esclusivamente all'utilizzo domestico.
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Ulteriori informazioni

Parti in vetro temperato
Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.
+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.
In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.
+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.
Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Proporzioni
Questo dispositivo utilizza le proporzioni 19.59.
+ Alcune app scaricate potrebbero non supportare le proporzioni 19.5:9.

In tal caso, selezionare le proporzioni dello schermo piti adatte allapp o
consultare il provider dell'app per ulteriori informazioni.

CUSTOMER CARE

c 199600044

Per conoscere gli orari di apertura e i relativi costi ti invitiamo a visitare il sito di LG
[talia wwwilg.com/it
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo Ii':z:s:;“;? Dispositivo
LG . i0S
parti terze
Tipo Dettagli dell'elemento - N —
Dlspféltwo Dispositivo Dlsplt-)éltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 0 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie X X
Datll - Foto, wdeq, canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | i personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
A hamate o
' f 0 X X

e notifiche, accessibilita,
batteria)

E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del

produttore del dispositivo o del gestore del servizio.
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Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 34,0dBm

GSM 1800 31,0dBm

WCDMA B1 235dBm

\WCDMA B8 24,8 dBm

LTEB1 23,5dBm

LTE B3 24,2 dBm

LTE B7 24,5dBm

LTE B8 24,8 dBm

LTEB20 24,8 dBm

LTE B28 24,8 dBm

LTEB38 24,5 dBm

LTEB40 24,5 dBm

BT 2,4GHz 11,0dBm

WLAN 2,4GHz 15,5dBm

WLAN 5,150-~5,350GHz 15,0dBm

WLAN 5,470~5,725GHz 150dBm

WLAN 5,725~5,875GHz 10,5dBm
NFC -22 dBuA/m

Le informazioni sulladattatore da viaggio si possono trovare su
http7/wwwi.lg.com/global/support/cedoc/cedoc
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle

I autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)

Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni piti dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.

La batteria si scarica piu rapidamente rispetto a quando é
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria e usurabile e la sua durata si riduce nel corso del tempo.
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Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.

Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto & bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard & migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.

Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
0 quando & esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.
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Chiude la chiamata o si blocca

Riavviare il dispositivo.
« Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono pill in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

Azzerare il dispositivo
+ Se i metodiillustrati sopra non risolvono il problema, esequire un ripristino dati

di fabbrica.

+ Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino >

Ripristino dati di fabbrica.

- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di esequire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Se il dispositivo & associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.
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L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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EAAHNIKA
MAnpo@opieg OXETIKA UE AUTO TO

gyxepidio xpnong

Yag euxaploToUpE Tou eMAEEaTE AUTO To TTPOIOV LG. Nal Tnv ao@ali Kat owoTn
XPrion TG CUOKEUNG, TAPAKAAEIOTE va SIaBACETE MPOTEKTIKA AUTO TO EYXELPISI0
TIPWV XPNOIHOTOIOETE TN CUCKEUH yla TIPWTN QOPA.

- Na xpnotpomoleite mavtote yvriola agecoudp LG. Ta mapexopeva e§apTripata
TipoopiCoval AmOKAEIOTIKA YIal XPrioN HE AUTHY TNV GUOKEUN Kal EVOEXETaL va
unv eivat oupBatd pe AMNEG CUOKEUEC,

« Otmeplypagéc Bacifovtal oTig MpoemAeYUEVEG PUBIOELS TNG OUOKEUNG.

OL TIPOEYKATECTNHEVES EPAPLIOYEG 0T GUOKEUK UTIOKEIVTAL OE EVNUEPWOELG,
Kal 1 TTapoxT| UMOOTAPIENG VIO AUTEC TIC EQAPHOYES EVOEKETAL VA SLOKOTTE
Xwpi¢ mpoeidomoinon. Ev éxeTe EpWTHOELC OXETIKA LIE L0l EQAPLOYI TIOU
TIAPEXETAL LIE Tr) OUOKEUN), EMKOWVWVAOTE PE éva KEvTpo emokeuwv TG LG.
TXETIKA HE EQAPHOYE TIOU EXOUV EYKATAOTABEL A6 TOV XPHOTN, UMOPEITE Val
ETMIKOWWVIOETE PIE TOV APHOSIO TIAPOXO UTINPECIWV.

+ H tpomomoinon Tou A&lToupykoU GUGTAKATOC TNG CUOKEUNG 1 N EYKATAOTACN
MOyIopIKOU amo avemionpeg myég umopei va mpokahéoel BAABN oTn ouokeur
Kat va 0dnynoel o€ Kataotpo®n 1 anwAela Sedopévwvy. Tétolou gidoug
evépyelec anmoteholy mapaBiaon g adelag xpriong e LG Kat €xouv w¢
QmOTENEGHA TNV AKUPWON TG EYYUNONG 00G.

Kdmolo meplexOpeVo Kal EIKOVEC UMopE( va Sla@épouv oe axéon He TN
GUCKEUN 00C, avAAoya LE TNV TIEPLOKT, TOV TIAPOXO UTINPESIWY, TV €KSoon
TOU AOYIGUIKOU 1 TNV €KS00N TOU AEITOUPYIKOU CUOTAKATOC, KAl UMOpEi va
aMdG€ouv xwpic mpoeidomoinon.

+ To MoyIOUIKO, OL XOl, Ol TATETOAPIEC, Ol EIKOVES Kat BAAA Uéoa TTou TIapExovTal
padi pe Tn GUOKELN 0ag ouVOSEVOVTAL OO AGEL VIO TIEPIOPICUEVN XPriON.
Tuxdv e€aywyn Kat Xprion autwv Twv VMKWV Yia UTopIKoUG r AAOUG OKOTIOUG
evOEXETAL VO OLVIOTA TTAPABIcN TWV VOUWY TERT TIVEUMATIKWV SIKAUWUATWV.
Q¢ TENKOG XPAOTNG, EXETE TNV TP €UBUVN yia TUXOVV TAPAvVOuN XProN Twv
HEOWV QUTWV.

EvSéyetat va umdpyouv mpAoBeTeS XpeWTELS yia TN peaieg SeSopévwy, OTwG
Yia TIC U peoieg avTaAayng INVURATWY, T @opTwon i T Mjwn Sedopévwy,
TOV QUTOHATO CUYXPOVIOUO Kal TIG UTinpeaieg TomoBeaiag. MNa va unv
€MBOPUVEDTE Ue MPOOBETEC XPEWTELC, EMAECTE éva TpOypappa dedopévwv
TI0U VOl KAAUTITEL TIG AVAYKEG GG, ETTIKOIVWVIOTE L TOV IAPOXO UTTNPECIWV 0O
Y10 TTEPIOOOTEPEC NETTTOUEPELEG,



- To mapdv eyxelpidio xpriong éxet ouvtayBei oTig BaoikéC Y\wWooeC yia KdBe
Xwpa. Avaloya pE T YAWooa TTou XPnOLHOTIOLEITAL, TO TIEPLEXOUEVO EVEEKETAL
va Slagoporoleital.

ZUUBOVAEUTIKEG AVAKOIVWOELC

MPOEIAONMOIHZH: KataoTagoelg mou Umopei va MPOoKAaAéCOULV TPAUHATIOHO
TOU XPAOTN KAl TPITWV.

A MPOZOXH: Kataotdoelg mou pmopei va mpoKaAéaouv ENapPU TPAUHATIOHO
1 {nWa 0T GUOKEUH.

5 THMEIQZH: Avakovwoelg 1y TpdoBeTeq TANPOQOpIEC.

MAnpo@opieg OXETIKA PE AUTO TO EYXELPISIO XPrIONG



Mivakag mePLEXOUEVWV

6

08nyieg yla ao®alr] Kai amoTEAESUATIKA XPrion

)

Eid1kéG AerToupyieg

16 Nertoupyieg eyypagnc Bivieo

25 Nertoupyieg TG EQapUoyng
Ahumoup

32 MoldtnTa Kat EMITTWOELG TOU YO
XOPOKTNPIOTIKE

33 Floating Bar

36 Google Assistant

37 Nertoupyieg yypagng rixou

39 Avayvwpion Aaktul.
Anotunwpata

43 Avayvwpion Tpoowiou

47 Avayvwplon Qwvng

50 Aeroupyia mohudiepyaciag

54 AOD (Always-on Display)

55 Quick Help

55 TNUEWOELC Yia TIG 1810TNTES
QVTOXNG OTO VEPO

02

Baoikég Aetroupyieg

59  E€optriuata Kat a§ecoudp Tou
TIPOIGVTOG

60  Emokomnon otolxgiwv

64 Evepyomoinon rj amevepyomoinon

65  Ewoaywyn kdptag SIM kat kdptag
HvAlNG

67 Agaipeon TG KAPTAG HVAKNG

67  Mmatapia

70 086vn agric

73 Apxikri 0B6vn

82 Kheibwua 0B6vng

87 Kpumtoypd@non KapTag pvAipng

88  Aqyn otypotunwy

89  Ewoaywyr Kelpévou

93 Kown xprion mepiexopévou

95  Mnv evoyheite



03

Xprioipeg epappioyég

97  Eykotdotaon kai ameykatdotaon

£QAPUOYWV

99  ZuVTOHEUOEIG EQAPLOYWV

100 TnAépwvo
104 MAvupa

105 Kduepa

122 Ahumoup

127 Emagég

130 QuickMemo+
132 Pohdt

133 Huepohoylo
134 Epyaoieg

134 Movuoikn

135 ApiBuopnyavn

135 Mpdypappa Exkiv. Maxwid.

136 LG Health

138 E-mail

139 Padidgwvo FM
140 Awayeipton apyeiwv
140 LG Mobile Switch
140 Myeig

141 SmartWorld

142 RemoteCall Service
142 EKmoprr KUPENNG
142 Epapuoyéc Google

Mivakag meplexopévwv

04

Pubpioeig

146
146
153
158
159
161
163
164
164
168

168
169
170
170
170
171
174

PuBpioeig
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0d6nyisg yia ac@aln Kat amoteAEGUATIKA
Xpnon

AlaBaoTe TIg mapakdtw amég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amnofei emkivéuvn 1 mapdvopn.

Y& MePIMTWon oQAAUATOE, N GUCKELN 0ag SlaBETel éva epyaleio Aoyiopikol Tou Ba
SnuioupyroeL éva apyxeio kataypagrg o@aiuatog. To epyaleio cuMéyel Sedopéva
€151KA Y10 TO CUYKEKPIUEVO OPAAua OTIwG Ta £€AG: LoxUG onpatog, cell ID position

0€ TIEPIMTWON AmPACHEVNG AMOPPIYNG KARONG KAl EQAPHOYEG TTOU UTIAPXOULV 0T
GUOKeUN. To apXEio KATaYPAPrG XPNOIUOTIOLETAL AMTOKAEIOTIKA YI0l TOV TPOGSIOPIoHO
NG AITiag Tou OQAAUATOG. AUTA Ta OPXEQ KATAYPAPG Eival KpUTTToypag@nuéva Kat n
TIPOORacn o€ auTd gival EPIKTH POvVo amd e€0uCIoS0TNHEVA KEVTPA EMIOKEVAG TNG LG,
O€ TIEPITTTWON TIOU XPELOOTEL Va EMOTPEWETE TN OUOKEUR OAG VIO ETIIOKEVN.

'EkBeon o¢ evépyela padlocuyvotritwy

MAnPoPopieC OXETIKA HE TNV €KBETN O€ PASIOKUHATA Kall TO GUVTENEDTH EIOIKIG
amoppd@nong (XEA).

AuTH N GUOKEUN €XEl OXESIAOTEL WOTE VOl GUMUOPPWVETAL LE TIG LOXUOUOEG AMAITHOELS
aopaleiag yia tnv ékBeon og padiokupata. Ot amartioelg autég BaciCovtal og
EMOTNUOVIKEG 0dnyieg Tou ephapBavouv mepBwpLa aopaleiag yia Ty TPooTasia
OAWV TWV aTOPWY, ave€apTnTa amod TNV NAKia fj TNV KATtdoTaon TG Uyeiag Toug.

+ XTI 08nYieg OXETIKA pE TNV éKBEDN OE PASIOKUHATA XPNOIMOTIOLETA Miat HovASa
UETpNOoNG N omoia gival yvwoTh w¢ CUVTENEDTAG EISIKNG amoppoenang i XEA. Ot
é\eyyol yla 1o XEA Sie§dyovtal pe Tumomoinpéveg HeBdS0UC, e Tn GUOKEUN va
EKTTENTTEL OTO PEYIOTO TIIOTOMOINMEVO ETMESO 10XVOG O ONEG TIC {WVES CUXVOTATWY
TIOU XPNOIUOTIOLE.

« Av Kal umopei va umapyouv Sla@opég petady Twv emmédwv Tou LEA yia
S1apopa povTéNa BUOKEUWV TNG LG, OAa Ta HovTéAa €xouv oXedIOTEl WOTE Va
QVTATIOKPIVOVTaL OTIG OXETIKEG 0dNYiEG yia TV ékBeon o€ padlokupata.

« To 6pto Tou ZEA mou ouviotatat amd t Alebvr) Emtporm Mpootaciag améd  Mn
loviCouoa AktivoBoAia (ICNIRP), givat 2 W/kg pe Bdon Tov UMoAoYIoHS TG HENG
TG ya 10 ypappdpla owpatikol 10Tou.

+ HuynAotepn T tou ZEA yia autd To povTého, Omwe éxel eheyxDei yia xprion oto
auri, eivat 0,244 W/kg (10 g) kat yla xprion oto owpa givat 1,466 W/kg (10 g).



« AutA n cuokeur MAnPEOI TIG MPOUTTOBETELS Yia TN ékBEaN OE PadlooUXVOTNTEG
€iTe TAV XpNolHomolETal TNV Kavovikr Béon xpriong Sima ato auri gite dtav
Bpioketal og amdoTacn TouAdxioTov 5 mm amnd to owpa. Otav xpnotpomnoleital
BrKn petagopdg, KA {wvng fi Brkn yia xprion oto owua, Sev mpémel va
mepthapBavel pETAMIKA oTolxEla Kal TTPETEL VO GUYKPATEL TO TIPOIOV G€ amdoTaon
TOUAdXI0TOV 5 mm amd To owpa oac. Na tn petadoon apyeiwv Sedopévwy iy
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTikA¢ oUvEeonc oTo Siktuo. Xe
OPIOHEVEG TIEPITTTWOELG, N METAS00N apyeiwv SeSopEVWY 1} UNVUPATWY UMOpPEi
va kaBuoTteproel éwg 6Tou givat Slabéoiun pia Tétota ouvdeon. Beaiwbeite ott
TNPOUVTAL Ol IAPATTAVW 08NYIEG OXETIKA HIE TNV AMAOTACK AT TO CWHA UEXPL VA
olokAnpwbei n petadoon.

MAnpo@opieg oxeTIKA pe TNV €KOEDN GE PASIOCUXVOTNTES
ané tnv Opoomnovdiakn Emrpornn Emkowvwviwy twv HIMA

Tov AlyouoTo Tou 1996, n Opoomovdiakr Emtporr Emkowwviwv (FCC) Twv Hvwpévwv
MoNTewwv, pe tn Spdon tng Report and Order FCC 96-326, ui0B£tnoe éva evnuepwpévo
TPATUTIO AOPANELQG YIa TNV €KBEON TOU AVBPWTTOU OTNV NAEKTPOUAYVNTIKY EVEPYEL
padioouyvotitwy (RF) mou ekméumeTal amd MOUMOUE ot 0TToiot TEAOUV UTIO ToV
puBpIOTIKG éNeyxo TnG FCC. Ot odnyieg auTEC €ival CUVETEIG HIE TOUG KAVOVIOHOUG
acpaleiag mou eixav 1ebei 0To MapeN@OV amd Ta Siebvny Kal apepikavika mpotuma. H
oxediaon auTrg TG CUOKEURG CUMHOPPWVETAL UE TIG 0dnyieg Tng FCC kat pe autd ta
S1ebvry mpdruma.

AnAwon Part 15.19

AUTH 1 CUOKEUH} CUHHOPPWVETAL HE TO ApBpo 15 Twv Kavoviopwv T FCC. H xprion
UMOKEITal 0TI akoAouBe¢ 500 mpoUmoBEéaelc:

(1) AutA n cuokeun Sev pmopei va mpokaléoel emPBAaPeic mapepBoAEC kat

(2) auTr n ouokeun Mpémel va amodéxeTal omoladnmoTe MAPEUPOAN,
oupnepAapBavopévwy mapeUBOAWV TIOU HITOPET va IPOKAAEGOUY avemBUpnTn
Aertoupyia.

AnAwon Part 15.21

Tuxov ahayég iy TPomoTToloEI TToU GV EYKPIVOVTAL PNTA amd TOV KATAOKELAOTH
MIOPOUV VA AKUPWOOUV TO SIKaiwua xpriong Tou e§omAiopoU.
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Xpron oto cwpa

AUTH 1 OUOKEUT €XEL ENeYXDE( Y10 TUTIIKN XPriON OTO OWHA, HE TO TTOW MEPOC TNG

og anéotaon 0,39 vtowv (1 cm) amoé To oW Tou XPHOTN. [a CUPHOPPWON PE TIG
anaitrioelg g FCC yia tnv ékBeon o€ padioouyvdtnteg, mpémel va Statnpeitat eNdyiotn
anéotaon 0,39 vtowv (1 cm) avapesa To WA TOU XPROTN KAl TO THow PéEPOG TNG
OUOKEUNG.

Evééxetat va pnv pmopolv va xpnaotpomotnBouv KA otipténg oe {wvn, Brikeg kat
napepepn afeaoudp mou Slabétouv peTarika e§aptripata. Ta afecoudp yia xprion
0TO OWHa 1o Sev umopouv va Slatnpricouv amdotaocn 0,39 vtowv (1 cm) petady

TOU OWHATOG TOU XPHOTN KAl TOU TToW MEPOUG TNG CUOKEUNG Kall Ta ortoia Gev €xouv
GOKIHOOTEL yia TUTTIKEG XPROEIG 0TO OWHA, EVOEXETAL va Uy TANpolv Ta 6pia T FCC yia
Vv €kBeon o€ PadlooUXVOTNTEC Kall TIPETEL VOl AMTOPEVYOVTAL.

AfAwon Part 15.105

AUTOG 0 £EOMANIGHOG ExEL ENEYXBEL KOl CUUOPPWVETAL LIE TA OPLA VIO TIG PNPLAKES
OUOKEVEG Katnyopiag B, cuppwva pe To Part 15 twv kavoviouwv FCC. Autd ta 6pta
eival oxedlaopéva yia va Tapéxou EMAPKI TPOOTAsia évavTt eMPAABWY mMapepBoAwY
o€ OIKIaKr eykatdotaon. O €0mNOHOC QUTOG TTAPAYEL XPNOILOTOLE KAl MMTOPE( val
EKTTEUDEL EVEPYELD PASIOOUXVOTHTWY Kal, av Sev eyKaTaoTabe( Kat xpnotpomoindei
oUpPWvVa pe TIG 0dnyieg, umopei va mipokahéoel empPAapeic mapepBolég oTig
padioemkowwvieg. QaTo00, Sev uTApxEL £yyunon 6Tt Sev Ba undp&ouv mapepPoAEG
O€ M0 GUYKEKPIPEVN EYKATAOTAON. AV auTOG 0 EE0MAIOHOG TIPOKaNEDEL emPAapEic
TIAPEUPONEG OTNV TNAEOTTIKA AN, YEYOVOG TTOU UMOpPEi vat SlamoTwOei pe Thv
amevepyomoinon kai evepyomoinan Tou eE0mAIGHOU, 0 XpoTng evBappuvetal va
Sokipaoel va SlopBuwoel Tic mapepBolég Ue éva 1y eploodtepa amd Ta e§RG PETPa:

AMGETE TV TPOsaVATONOHO 1y TN Béon TG Kepaiag ARYnG.

Auénote v amdotacn petal eEomiopou Kat SkTn.

« ZuvdéaTe Tov e§0MAIOUO o€ TIPIla TTOU AVIAKEL 08 AANO KUKAWHA QO QUTO WE TO
ormoio eival ouvSeSepEvog 0 SEKTNC.

+ YUMPOUNEUTEITE TO METAMWANTH 1} évav EUTTEIPO TEXVIKO pado@uvwv/TnAedpaonc
yia Boribela.

Opovtiba kal GUVTHPNON TOU TIPOIOGVTOC
+ Naypnotporoleite povo ta e€aptripata mou mepthapBavovtal 0T CUOKEUAGia Kal ivat
eoualodotnpéva amd v LG. H LG Sev mapéxel eyyunoelg yia tuxov BAaBeg fy amotuyieg
Aettoupyiag mou ogeilovtal og e€apTripaTa GMWV KATAOKEUAOTWV.

+ Oplopéva TepLEOpEVA Kall EIKOVEC EVEEXETAL va SlagEéPouv amd Tn CUOKEUN 0aG XWPIG
npogidomnoinan.
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+ Mnv amocuvappoloyeite T povada. Otav anatouvTal pyacieg EMOKEUNC, TapadwoTe
NV o€ €EEIBIKEVPEVO TEXVIKO.

+ Katatn Siakprrikr euxépeta tng LG, ot EMOKeVE Tou KAAUTITOVTAL OO TNV €yyonon
evdéxetat va mepihapBdvouv Ty TomoBETon avTaMAKTIKWVY HEPWY 1 TIVAKWV (giTe
KQIVOUPIWV EITE EMOKEVAOEVWVY), E TNV TPOUTOBEON OTL N AEITOUPYIKOTNTA TOUG Eival
10080Vapn KE TN AETOUPYIKGTNTA TWV HEPWV TTOU AVTIKATACTABNKAV.

+ Kpatdte T 6UOKEUN HaKPIA amO NAEKTPIKEG CUOKEVES OMWG TNAEOPATELS, padidpwva Kal
UTIOAOYIOTEG,

+H ouokeur) mpémel va QUAGOOETAL LAKPLA artd TINYEC BepOTNTAG, OTIWG KAAOPIYEP 1
NAEKTPIKEC KOUCive.

+ TNpooé€te va pnv méoeL.

«H ouokeur| dev mpémel val UOKELTaL O€ PNXAVIKEG GOVATELS 1} KpadaaopoUg.

+ AmevepyOTOIEITE T OUOKEUN OTIG TIEPIOKEG OTTOU amayopeVETal N XPrion TNG COHPWVA e
€181koU¢ KavoviopoUg. Mo Mapadelya, pnv XPnOIHOTIOIETE TN GUGKEUT) OE VOOOKOWEID,
KaBWG N XPoN TG UMOpE( va EMNPEACEL EVAITONTO 1ATPIKG EOTINIOHO.

+ Mnv mavete T ouokeun pe Ppeypéva xépla, otav popTilel. Mmopei va mdbete
nAektpomAngia kat va mpokAnBei coBapr) BAABN oTn cuokeun.

+ Mnv @oprilete To TNAéwvo KovTd o8 E0PAEKTA UNKG, KaBG evaéxeTal va BeppavBei kat
va dnptoupynBei kivduvog mupkayldc.

« Xpnotpomotjote éva oTeyvd mavi yia va kaBapioete To mePIPANaA TG CUOKEUNG (Unv
xpnotporoleite SlahuTe 6muwg Bevdivn, SIOAUTIKO ) OIVOTIVEUNA).

+ Mn @oprilete T cuokeur dtav PpiokeTal MAvw o€ MOAAKE UAcHaTa.

+H ouokeun) mpémet va poprtiletal o€ KaAG agpI{OpEVO XWpo.

+ Mnv a@riVeTe Tn GUOKEUN G€ XWPOUG HE UMIEPBONIKO KOO 1y OKGvI.

+ Mnv tomoBeteite T cUoKeUR Sim\a 0€ MOTWTIKES KAPTEG 1} EIOITAPIA HECWV PETAPOPAG.
Mmopei va emnpeAcel TG TANPOPOPIES TTOU TTEPLEXOVTAL OTIC MOYVNTIKES TaIViE,

« Mnv xtumdre tnv 086vn pe atuned avtikeipeva, Kabwg evoéxetal va mpokaléoete BAABN
OTN GUOKEUN.

+ Mnv ekBétete T oUOKEUN O€ LYPA ) uypaaia.

« Xpnotpomoleite pe mpoooxr Ta aeaoudp, Omwg m.y. Ta akouoTika. Mnv ayyilete dokoma
TNV Kepaia.

+ Mnv xpnotpomoleite, pnv ayyilete Kat pnv mpoomabeite va apaipEoETE 1 va
emblopbwoETe OMAGUEVO, KOUWEVO 1 paylopévo yuali. H eyyunon dev kahumel BAAReC
TIOU 0QEINOVTaL OE KAKN XPron TG Yudhivng 08dvng.
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+H ouokeun eivat n\exTpovikr Kat mapdyet BepuOTNTA KATA Tr SIAPKELD TG KAVOVIKNAG
Aerroupyiag, H mapatetapévn, Apeon emagr ke 1o G€ppa 0ag UM OUVONKEG AVETAPKOUG
€€0EPIOUOL EVOEXETAI VAl EMPEPEL SUOPOPIQ 1} LIKPA EYKAUUATO. ZUVETIGIG, XEIPIOTEITE UE
TIPOOOKT T GUOKEUN 0aG KATA TN AEIToupyia ) apéowg PeTa.

+ Av Bpaixei n GUOKEN), AMOCUVOEDTE TNV AUECWG KAt OTEYVWOTE TNV KaAd. Mnv
EMIYEIPNOETE VOl EMOTIEVOETE TO OTEYVWUO UE Piat EEWTEPIKR TNy BeppotnTag, omwg eivat
01 POUPVOL, Ol YOUPVOL MIKPOKUUATWVY 1) Ol OTEYWVWTHPEG MOANWV.

+ Touypo otn Bpeypévn ouokeur aMACel TO XpWHa TG ETIKETAE TOU TIPOIOGVTOC 0TO
EOWTEPIKO TNG OUOKEUNG. H eyyinon Sev kaAimTel BAABEC TG GUOKEURG TOU opeihovTal
otnv ékBear) g o€ uypa.

+ Mia @opnr ouokeur amaite{ owoTr Kukhogopia aépa yia m Sidxuon g BeppotnTac.
H aueon emaegn pe o Géppa Kall ) avemapkrig KUKAOQOPIa Tou aépa aTn GUOKEUN UMopei
va odnynoet o€ umepBéppavon) . H ouokeur) Ba mpémet va Bpioketal o amdotaon
TouAdloTov 1,0 cm oo To OWHA TOU XPAROTN.

+ Epnodiote Ty gicodo akdvng 1 aMwv EEvwv ouctwv oTn BUpa Tou popTIoTr/Tou
kahwdiov USB. EvdéxeTat va mpokAnBei umepBéppavan 1y mupkayld.

« ATOQUYETE TNV €KBEDN TNG CUOKEUNG OE XAUNAY ATHOOQAIPIKY TTiEDN OE UPNAG
peyaro uPSpETPO.

+ Mnv ekBETETE TN GUOKELN OE TTONY XAUNAR ATHOGQAIPIKR THEDT. AlOQOPETIKE,
umopei va mpokAnBei ékpnén g pmatapiag f Slappor) EVEAEKTOU LYPOU 1 aEpiou.

AmoteAeopatiki XPrion TG CUOKEUNG

HAEKTPOVIKEG CUOKEVEC
'ONeG Ot GUOKEVEG MMTOpE( va GéxovTal TapeUBONEG Tou emnpealouv Ty anddoaor Toug.
+ Mnv XPNOIUOTIOLEITE TN GUOKEUT KOVTA OE LATPIKO EE0MAIOUO XWpiG va xeTe Adfel
OXETIKN adela. ZUUBOUNEUTEITE TO yIaTPO GG yia va SIOMOTWOETE av N Aeitoupyia
TNG OUOKEUNG UMopEi va TIPoKaéoel TApEUPBONEG 0TN AelToupyia TG laTPIKAG 0ag
OUOKEUNG.
+ Ol KATOOKEVOOTEG BNUaTOSOTWY OUVIOTOUV EAAXIOTN amdaTaon 15 cm petagy
AMWV CUOKEUWV KAl TOU BUatodotn, yia Ty amo@uyn moavwv mapepUBoAwy.
+ AUTHA ) GUOKEUN MITOPE( VAl TIAPAYEL EVTOVO GWG 1} GWE TOU AvaBooPrvel.
« Oplopéva BonBrpata akorg evagxeTal va eIoTavVTal TAPEUPONEG AMTO GUOKEVEG.
« MiKpéG MapepPBONEC EVOEXETAI VOl EMTNPEACOUV OUOKEVEG, OTIWG TNAEOPATELG,
padIOeWva, UTTOAOYIOTEG KT
+ Av eival Suvato, XpPNOIOTOIOTE TN CUCKEUN O€ Beppokpaocieg petagd 0 °C kat
359C. H ékBeon tng cLokeurig o€ MOAD XapnAEG 1 uPNAEC Beppokpaaieg evoéxetal
va IPOKAAEDEL (i, SuoAerToupyia iy akOpa Kat EKpnén.
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0481Kn ao@alela

ENéyE€Te TOUG VOMOUG KOl TOUG KAVOVIGHOUG YIaL Tr XPr0N OUCKEUWY OTAV OONYEITE.

+ Mnv XPNOIUOTIOLEITE TTIOTE GUOKEUN XEIPOG OTAV OSNVYE(TE.

Eotiaote OAn oag Ty mpoaooyr oty odriynon.

YTAPOTAOTE OTNV AKPEN TOU SPAOU Kal 0TABUEVOTE TO OXNKA 0ag TPV
TIPOYHOTOTOINOETE 1 AMAVTHOETE O€ M KAON, €GV TO amaitouv ol ouvBriKeg
odriynong.

+ H evépyela padloouyvoTATWY EVOEXETAL VO EMNPEAGEL OPIOUEVA NAEKTPOVIKA

GUOTAUATA 0TO OXNHA 00E, OTIWE TO PASIOPWVO TOU QUTOKIVITOU Kall TOV E§0TTANICHO
acgaleiag.

« Eav 10 0xnpa oag ivat §omAiopévo e évav 1y TIEPICOATEPOUG AEPOCAKOUCG,

unv eykabioTdte Kat Pnv tomobeteite actppato eomiiopd o onpeia omou Ba
eumodietal n Aerroupyia Tou agpooakou. Evaéxetal va mpokAnbei Suohettoupyia
TOU 0EPOOAKOU 1 00PBaPAC TPAUUATIONAE AOYw aKATAANANG anddoond.

« 'Otav akoUTe HOVOIKN eV BpiokeoTe £§w, PePaiwbeite OTi éxete pubuioel Tnv

£€vtaon og éva Aoyiko eminedo, yla va €XeTe emiyvwon Tou Tt cupBaivel yopw oag.
AUTO gival IBLAITEPA CNUAVTIKO OTAV KIVEIOTE KOVTA 08 SPOUOUC.

MpokAnon BAAPNC otnv akon cag
Ta va mpogulayteite amd mBavr) PAGPN TG akorig oag, amo@UyeTe TV
aKpdaon o€ UPNAG emimeda oL yia Peyala Xpovikd SlaoTtruarta.

Evééxetat va mpokAnBei BAGPN otnv akor) oag eav ekTiBeoTe og Suvatd fixo yia
TIAPATETAPEVO XPOVIKO SIA0TNUA. EMOPéVG, 0aG GUVIGTOUE Va NV EVEPYOTIOIEITE
1] AMEVEPYOTIOLEITE TO TNAEPWVO KOVTA 0Ta aUTId 0aG. Emiong, oag cuvioToUpe va
pUBpieTe TNV évTaon TNG HOUGIKG Kall TOU fi¥ou KAong o éva hoyikd emimedo.

« '0tav XPNOIHOTOLEITE OKOUOTIKE, VA MEIWVETE TNV €VTacon TOU XoU av Sev akoUTe

600U HINOUV YUpw 00 1} av To dTopo Tou KABeTal Sim\a o0 UMOPE va aKoUoEL
QUTO TTOU OKOUTE.

E + H umepPoNkn nNTIKr TEn amd Ta AKOUOTIKA UITOPE( va TTPOKOAEDEL

QMWAELD TNG AKONG.
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luvdhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdaMovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.

Eneiyouoec KA\oEIC

O1 emeiyouoeg KANOELG evEéxeTal va pnv ivat Slabéotpeg og OAa Ta Siktua KIvnTrg
Aepwviag, Ma to Adyo auto, Sev mpémel va Bacileate amokAEIOTIKA OE auTr TN
GUOKEUN YIa EMEIYOUTEG KANTELC. ETIKOIVWVIAOTE HIE TOV TOTTIKO TIAPOXO UTINPETIAV Yial
Va EVIUEPWOEITE OXETIKA UE AUTO TO Bépa.
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H}\npocpoplac Kal @PovTida pumataplwv
Aev ival amapaitnTo va anogopTioTel Mpw N ratapia yia va Ty
EMAVAPOPTIOETE. Z& avTiBeon pe GAa ouoTApaTa prataplwy, Sev epgavifetal 1o
QAIVOLEVO UVIALING TTOU UMTOPE VOl EMNPEACEL TNV amdS00n TNG Unatapia.

« Xpnoworoleite uovo pmatapieg kat opTioTég LG. Ot popTioTéq LG éxouv oxediaoTei
UE TPAOTO TETOI0, WOTE Va peyloTomololy Tn Sidpkela {whg TG Prmatapiod.

+ Mnv amoouvappoNoYEiTe Kat unv BPOUKUKAWVETE TV Pmatapia.

« Alotnpeite KaBapEG TIG METAANKES EMOPES TNG PmaTapiag.

« AvtikaBiotdre v pmatapia otav pelwdei onuavtika n anddoon e, H umatapia
UMOPEL VOl POPTIOTEL EKATOVTASES POPES LEXPL VA XPEIAOTE AVTIKATAOTAON.

« Edav n umatapia Sev éxel xpnotpomoindei yia moAl kaipd, popTioTe T yia va
UEYIOTOMOINOETE TN SIAPKEL XPAONG TNG.

+ Mnv a@rivete ekTeBeIpévo To PopTIoTH TG umatapiag ameubeiag otnv nAakn
QKTIVOBONIC Kall NV TOV XPNOIMOTIOLEITE OE XWPOUG HE TTOAR LYPAGia, OTTWE TO
umavio.

+ Mnv a@rivete v pratapia og Beppolc i KPUOUG XWPOUE, KaBWG evaéxeTal va
pewwbei n amdédoor e,

« Eav avtikataotiioete T pratapia pe AavBaopiévo TOmo pmatapiag, umdpyel
Kivouvog ékpnéng. H amdppudn Twv XpnotuomotnuéVWY Hmatapliv PEMEL va yiveTat
oUPPWVa PE TIG 08nyieC.

« o va amo@UyeTe TNV AOKOTIN KATAVAAWGN EVEPYELAG AMTO TO YOPTIOTH, VA TOV
QmoCUVSEETE TAVTOTE Mo TNV TPICa META TNV T PN YOPTION TNG CUCKEUNC.

H mpaypatikn Sapketa {wng Tng umatapiog e§aptdatat amoé t Slapdpewon Tou
SIKTUOU, TIG PUBHITELG TV TTPOTOVTWY, TIC CUVIBELEG XPrONG, TV MmaTapia Kat Tig
TEPIBANNOVTIKEG OUVORKEG,

« BePawwBeite mwg n prmatapia Sev EpeTal o€ EMAQN HE AIUNPA QVTIKEIPEVT, OTIWE
Sovtia {wwv 1 kap@ld. Ydpyxel Kivduvog avaphegne.

+ Katavalwon evépyelag (\ertoupyia avapovrig Siktuou): 0,4 W

Ac@ANEIQ TIPOCWTTIKWV GTOIXEIWV
+ Na TIpooTATEVETE IAVTA TA IPOCWTTIKA GO OTOIKEID, WOTE VA EUMOSIOETE TUXOV
S1appoég Sedopévwy 1 KATAXPNON EVAIcONTWY TANPOPOPILV.
+ Na énpioupyeite mavta avtiypaga ac@aleiag Twv onpavtikwv oag Sedopévwy dtav
XPnolpomoleite Tn ouokeun. H LG Sev ivat umevBuvn yia Tuxov anwAeleq SeSopévwv.

« Mpv meTd&eTe TN OUOKEUR, Va SNUIOVPYATETE avTiypaga ac@aleiog OAwv Twv
Sedopévwv Kal va KAVETE EMavapopd TG SUOKEUNG WOTE Va EPMOSIOETE TUXOV
Katdypnon euaiocbnTwv MANPOPOPIWV.
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« 'Otav katePalete pappoyég, va SlaPalete MPOOEKTIKA TNV 006V TwV SIKAIWHUATWV.

+ Na €ioTe MPOOEKTIKO{ OTAV XPNOILOTOIEITE EQAPHOYES TIOU €xOUV TTPOORacH oe
TIOMEG NETOUPYIEC 1) OTA TTPOCWTTIKA 0O OTOIXEICL.

+ Na eNéyxeTe TAKTIKG TOUG TTPOOWTTIKOUE GOG AOYOPLACHOUG. AV EVTOTIIOETE TUXOV
€eVOEICEIC KATAYPNONG TWV TTPOCWTTIKWY GAC OTOIXEIWY, {NTAOTE amod ToV TAPOXO TNG
umnpeoiag va dtaypayet ry va aMdgel Ta oTolyeia Tou Aoyaplaopol oag.

« Av n ouokeun oag xabei ) Kharei, aMate Tov Kwdiko MpdoPacng Tou Aoyaplacpou
00G WOTE Va SI00PANCETE Ta TIPOOWTTIKA 0AG OTOIXE(Q.

+ Mnv xpnolHOTIOLEITE EPOPHOYES TTOU TIPOEPKOVTAL ATTO AYVWOTES TINYEG.

A El&onotnon Y1a TV QVTIKATAGTAGT ThG pratapiag
H pmatapia ovtwv Aibiou eivat emkivéuvn KaBwg Umopei va mpoKaNEDEL
TPOUUATIOO.

+ H avtikatdotaon g umatapiag amo pUn KATapTIoHEVO EMAyYEAUATIa pmope
Vol TIPOKAAEGEL {NIA 0T GUCKELN GO,
Mnv avtikaBiotdte T umatapia pévot oag. Mmopei va mpokAnBei BAABNn ot
umatapia mou Ba 0dnyroel o€ uepOEpavan Kat TpavpaTiopd. H pmatapia
TIpEMEL va avTiKataoTaBel amd katapTiopévo enayyeAuatio. H pmatapia
TIPEMEL VA AVOKUKAWVETAL 1) VO AMTOPPITTTETAL EEXWPIOTA aTTd Tal OIKIAKA
amoppippata.
«+ XNV mepimTwon mou To oidv S1abétel evowpatwpévn pmatapia mou de
umopei va agaipebei amd to xpriotn, n LG oag mpoteivel va ameuBuvBeite
O€ EMAYYEAUATIA YIO TNV AQAipEDN TNG UraTapiag, av mpdKeTal va T
QVTIKATAOTAOETE I Va TN OTEINETE Yia aVaKUKAWON 0T0 TENOG TG (wiig TG,
MNa v mpoAnyn BAGPNG oTo mPOIdY, Kal yia TV ac@AAELd TOU XPHOTN,
UNV EMIXEIPHOETE VO APAIPECETE TN prmatapia. AmeuBuvBeite otn Mpauun
BonBeiag ¢ LG, fj og Mo emayyehpartio.
H agaipeon tng pmatapiag mpoumoBétel amoouvapuoAdynon
TOU TEPIBAALATOG TOU TTPOIOVTOG, AMOCUVEEDN TWV NAEKTPIKWV
KaAwdiwv/ EMaQWy, Kal MPOCEKTIKN AMOPAKPLVON TG MraTapiag
e e€e1dikeupéva epyaleia. EQv xpeldleoTe TIG EmayyEAUATIKES
odnyieg yla TV agaipeon g pnatapia, emokepOeite T SievBuvon
http://www.lge.com/global/sustainability/environment/take-back-recycling.
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Nertoupyieg eyypa@nc Bivteo

Evpuywvia kapepa

Mriopeite va TpaPriete pwtoypagieg iy va eyypdpete Bivieo o peyahiTepo P0G
ano To MPAYHATIKO TTESi0 OPAONC XPNOIUOTIOIWVTAG TNV EUPEIQ ywvia oTnv Tiow
KApepa.

Ayyi&te Ta ewovidia (5) kat, otn cuvéyela, Ta (&) /@) yia evalhayr peta&l g
TUTIKAG KAl TNG EVPEiag ywviag.

Eupuywviog gakdg

TuTTIKOG POKOG

E « Ta Nemrtopépeleg, avatpé€te otny evotnTta EKKiVoT) TNG KAUEPAC.
« Mmopeite va aMEEeTe PETASY TWV TUTTIKWVY Kl EVPUYWVIWY QAKWY KAMEPAG
0TNV TMOW KAPEPA HOVO.
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Google Lens
Mrmiopeic va AdBelg meplocoTepeC MAnpo@opieg 1 va avahdBelg Spdon o
avTikeipeva xpnotpomowvtag Google Lens, 6mwg opdonpa, agioeg, pevou
eoTiaTopiwy, {Wa, AouvholUdia, 1 YPAUUOKWAIKES, KATELBEIQV 0TN GUOKELH GOU.
Mo mopadetypa, 6Tav xpnotpomoleic Google Lens mavw oe:
« EmayyeAuatikn kdpta: Mmopeic va amoBnkeloelg Tov apiBud tnAepwvou o€
Wia emapn.

« BiBAio: Mrmopeic va S1aPAoELC KPITIKEG KL AANEG AETTTOUEPELEG YI' AUTO.
Opdonpo N ktipto: Mmopeic va S1aBAoElC TepIooOTEPEG AETTTOEPELEC YI' QUTO.
« Mivaka (wypagikrig og pouceio: Mmopeic va SlaBaceig Aemtopépeleg yi' auto.
‘Eva uTo ri {wo: Mmopeic va pdbelg meploootepa yi' auTo.

+ 'Eva @uANASI0 1 SlaenuioTiki mvakida ekdnAwoewv: Mmopeig va mpocBéoeig
TNV ekSAWON 0TO NUEPONGYIO GOU.

5 « To Google Lens €ivat Slabéoiuo dtav n ouokeun oou gival ouvSedepévn
oto Sladiktuo Edv xpnotpomoleite Sedopéva KivnTrg TNAEPVIag, Pmopel
va eMPapuVOE(Te e XPEWTELS yia TN Xprion Sedouévwy, avdhoya e To
TIPOYPAUHA XPEWCEWV TTOU EXETE EMAEEEL

+ Auti n Aertoupyia pmopei va pnv umoatnpiCetay, fj ol umooTnPI{OUEVES
YAWOOEG eVEEXETAL VA SIOPEPOLY aVANOYQ UE TNV TIEPLOXT).

Xpnotpomoinoe 1o Google Lens
1 Natrorte To koupri (&) > e,
7 TTPEYE TV KAUEPA 00U O £Va AVTIKEILEVO.
3 Tava pudbeig Aemopépeteg iy va avolaBelg Spaon:
+ Mdvta 1o avTiKeipevo otnv 086vn cou.
+ TNava emAéEeIC Keipevo: MaTa pia NéEn, petd mdta tnv ava kal UPE TIG
UmAE BoUAeG.
Kdve pia epwtnon A Teg Jia eVIONY, OMwG:
« Tieival auto;
+ Kaheoe autd
+ Mp606eoé 1o oto Google Keep
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Moptpaito
Mriopeite va TpaPri&ete éva eukpivég MopTpaito eQapuolovTag To PAVOUEVO
B0Awon¢ akouL NG KAPEPAG.
T Ayyi€te ta ewovidia (&) kat émerta emhé€te Moppaito.
2 Natote O yia va BydAete pia pwioypagia.
« Nava puBpioete T dOvaun tng BoAdtnTag, oupeTe T PARSO oAioBnong
TIPOG TA APLOTEPA 1) TIPOG Ta OEEIE.

E + Alatripnoe TV amdoTaon TOU AVTIKEIPEVOU oou o€ amootaon 1.3 ~ 5.0
TIOSIWV VW) XPNOIUOTIOLEITE TNV TTOW KAUEPQ.

+ Auti n Aertoupyia Sev eivat SlaB£otpn o€ oA oKoTeo TePIBAANOV.

« Metd v epappoyn autiig g Suvatdtntag, matioTe oTny EMOUUNTH
6éon otV 006V TIPOEMOKOTNONG YI0 VO EQAPUOCETE AUTOUATA TNV TN
€KBeoNG Kal TNV €0Tia0N OTAV XPNOIHOTOLETE TNV THOW KAUEPQ, 1 TNV TIUA
€KBEONG HOVO GTAV XPNOIUOTIOLEITE TNV MIMTPOCTIVH KAPEPQ.
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Al CAM
Mriopeite va Byalete 16avikéC pwToypagieg iy Biveo kabwg n kdpuepa avayvwpilel
TO QVTIKE(UEVA KATA T pwToypaeia iy To Bivteo.
1 Ayyifte o G Kal, 0Tn ouvéxela, matriote Al CAM.
7 ‘Otav avayvwpIOTEl TO QVTIKEIHEVO, XPNOIMOTOLETAL TO KAAUTEPO EPE YA TO
OKNVIKO.
+ Ta va xpnotpomoloete AANa @€, TATAOTE TO EIKOVISIO OKNVIKOU.
+ Moptpaito, katoikidia {wa, TPOPIUA, avatolr, nAtofacilepa, Toio,
0¢a otV mOAN, AouhoUdia, pwpd, oupaved, Tapalia, KA., GUVOAIKE 19
KOTNYOPIEG UTTOPOUV VA AVAYVWPIOTOUV QUTOHATA.

E « To amoTéNeopa TG avayvwpLong TNG OKNVAG iowg va Slagépet avdhoya Tov
QWTIOPS 1y TV Béon Tou avTIKEévou v Bydlels puToypapies. Ot AEEeIg
KAES1A Gev epgavifovtal oTIC amoBnKeVPEVEC GuTOYPAYIES iy BivTeo.
+ Autij n Suvatdtnta eivat Slabéoiun udvo dtav ot EmPAE Kal THow KAPEPES
Bpiokovtal og Autopatn Aettoupyia.
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Cine Video

Mriopeite va eyypdaypete éva BIVTEO KIVNUATOYPAPIKNE TOLOTNTAG.

T Ayyi€e ta ewovidia () kay, énerta, emhé€te Nepiooétepa> Cine Video )
2 I'Iurncne @ v va eyypayete éva Bivteo.

+ & : Katd Ty eyypagn Bivteo UmopeiTe va E0TIAOETE OF pia TIEPILOYY) TTOU
BéNete 1 va amopakpuvBeite amo autry, emAéyovtag T duvatdtnta Point
Zoom.

. : Mropeite va emAECETE VA EQAPUOOETE EVa EPE OTNV EYYPAPH.
Mmopeite emiong va mpooapuOoETe To BIVIETAPIOUA Kal TV évTaon yla Kabe
Kivnuatoypagikd epé (Cine Effect). Aev pmopeite va aMd&eTe autiv
SuvatdtNTa Ao EEKIVIOETE TNV EYYPAPH.

+ Hduvatétnta Point Zoom umootnpilel taxutnta (oup €wg 3x.
« Autij n Suvatdtnta umootEilet HOVO eyypagr BIVIED GE TUTTKI Ywvid.
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Cine shot

Mriopeite va KataypAYeTe pia oTiyur Kai va Sniloupynoete éva Bivieo pe éva
MEPOG HOVO TNG OKNVNAG OF Kivnon.

Katd v kataypagn evog Bivteo, kpatdte otabepr| T ouokeun. Metd v
Kataypa®n, TPITe pia meptoxn Tou Bivieo n omoia OéNeTe va Kiveitat. H
emAeypévn TEPLOXT EEKIVAEL va KIVELTaL Kal TO UTIONOTTO BIVTED péVEL OTATIKO.

1 MNatiote (&) kay, ot ouvéxela, matote Neploodtepa > I:T;«j,
7 Tatriote @ yia kataypagr evog Bivieo 3 SeutepolémTwy.
- Kpatrote otabepr T cuokeur Katd v eyypaen Tou Bivteo.
3 Natfote (#) kau tpiPte Ty meployn mou Belete va kveital pe egé Cine shot.

Avaipeon —¢ B —— EmaveiAnupévn

avarmapaywyn Tpog Ta

EmavaAnyn EPTTPAG KAl TTPOG TA TTHOW.

EmraveiAnupévn
avarmapaywyn Tpog Ta
EPTTPAG.

EmAESTE TNV TTEpIOX TTOU —sl

e —— A\I0YPAPN TNG ETTIAEYPEVNG
Oa JETAKIVIOETE. A

TIEPIOXNG.

+ Matote (©) yia va oPRoeTe TV eMAgypEVN TIEQLOKN.
« TMatAote () yia emavahapBavopevn avamapaywyr e UmpooTIve Kivnon
NG EMAeYpéVNG TTEPLOKNG.
+ Natrote @) yia emavahapBavopevn avamapaywyr He UTPOCTIV Kat TTow
Kivnon g emAeypévng mePLOXG.
A Em)\é€te AMOOHKEYZH.
+ HemMeypévn mepoyn Oa kiveitat.
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lpriyopo gAag
Ot pwtoypagieg mou AapBAavovTal g Kavoviko S1aoTna amobnkKevovTal W
apxeia GIF.

T Natiote (&) kau émerta emAéte Meproodtepa > Mpryopo GAag ~N.
2 Natiote O yia va BydAete pia wioypagia.
- Otpwroypagieg AapBavovtal kabe 3 SeutepOAemTa Kal amobnKevovTal wg
apxeio GIF.
« Ayyi€te (2] TV 086vn yia va emAEEETE ToV aPIBHO TWY PWTOYPAPIGV TIOU
BéNete va TpaPniete.
+ Katd tn Myn @wTtoypa@iay, mTatioTe (= yia va Snuioupynoete apyeia GIF
UE QuToypaieg Tou éxeTe TPaBrEeL 0To MapPeABOv.

E + To (g eVEPYOTTOLEITAL AUTOMATA YA VA AEITOUPYOEL WG XPOVOUETPO.
+ AuTA €ivail n A kat 0 oUVOAIKOG apBOS Twv AYEwV Tou epgaviovat
Kdtw amd Ty 086vn.
« 'O)eg o1 e1KOVEG TOU €x0uV An@Oei amoBnkevovTal povo we apyeia GIF.
« Aev pmopeite va alagete Ty Taxutnta GIF oUTE TV OElPd EIKOVWV.
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Graphy

Mriopeite va eQapUOOETE TIC TPOTEIVOMEVES TILEC VIO TNV L0OPEOTTia AEUKOU, TV

Tipn 1SO Kat Ty TayutnTa KAEITPOU, yia va a0QaNOETE £va EMAYYEALATIKO

QMOTENECAL.

1 MNatAote (5) kay, ot ouvéxela, matote Xelpokivntn Kapepa.

2 Tava evepyomoinoeTe Tn uvatdtnTa, ayyi&te 1o ekovidio $53 kat émerta
emAé€te Graphy gutoypagia

3 Ayyi€te 10 eovibio (@ kat emAéETe TV EMBUUNTH OKNVA oo TIG
TIPOTEIVOLEVEG EIKOVEG.

A Natiote O yia va Bydete pia pwtoypagia.

E « Auti n Suvatdtnta eivat Slabéoiun udvo oe Xelpokivntn Aettoupyia
KapEPQG.

« Mmopeite va mpoobEcETe EPIOOOTEPEG OKNVEG TATWVTAG i Kalt
mpaypatomolwvTtag Ajyn e epappoyng Graphy amé To Play Store. Edv
xpnotporoleite Sedopéva KivnTig TNAEQuviag, pmopei va empBapuvOeite pe
XPEWOELG Yia TN Xprion Sedopévwy, avaloya e TO TPOYPOHHA XPEWOEWY
TIOU €XETE EMAEEEL.

« Ayyi€re £53, 0Tn OuVéxelo MaTAOTEC ) amd To pevou Graphy yia va
QITEVEPYOTTOINCETE AUTH TN SuvatoTnTa.

Eyypapn Bivteo Hi-Fi

Mriopeite va mpaypoTomoloeTe eyypagr uynAig moldtntag Bivteo pe o Hi-Fi.
Natote (&) kay, 0T cuvéyela, Tatiote Neproodtepa > Xetpokivnto Bivteo (X
)>£03> Hi-Fi.

« Ta Nentopépeleg, avatpé€te otn evotnta EKKivinon Tne KApePag.

« Havamapaywyn Bivteo Hi-Fi givat Suvatr pévo o€ eQappoyE mou
umootnpiouv Hi-Fi.
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Al Composition

Katd tn AMqyn Moptpaito, n unxavn Al oag emtpénet va ene§epydleote autdpata
N Béon Tou BépaTtog Kat va BpiokeTe Tn PENTIOTN 0UVOEDN TNG EIKOVAC.
AmoBnkelovTal TOO N MPWTOTUTIN PWTOYPAPia GO0 Kat N pwToypapia Tou Al
Composition.
T Katdm Myn ewtoypagiag pe Ty miow kdpepa, matrote Al CAM.
7 'Otav n Kauepa eviomioel To Bépa, Oa EQapPUOOTEL N CUVICTOUEVN Kkatn Al
Composition 010 emdvw PEPOG TG 006vNC.
+ To Bépa Ba mpémel va mephapBavel Myotepa amd tpia dtopa.
+ To Bépa avayvwpiletal dtav TomoBetnOei 010 EMdvw PEPOG TNG 006VNG.
3 'Otav epgaviorei To ekovidio Al Composition, matriote oto O yla va
Tpapngete pa pwtoypagia.
« MatioTe T pikpoypagia pe To [ 3] otnv epappoyr AAUmoup yia mpoBoAr
™G PWToypaPiag.
- OLpuwroypaoieg pe v évdeién [ eivatl ot mpwtdTUTES PUTOYPAPIES TTOU
Tpapnéate.
+ Otowtoypaeieg pe Tnv évdelén [£3] eivar ot pwtoypagieg Tou Al
Composition.
- NMatfote[ | kai[Z3] yia va tig ouykpivete.

MpwTéTUTIN PWTOYPaPia Pwroypagia Al Composition
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E + To amoTéNeopa TG avVayvWPIoNG TNG OKNVAG iowg va Slagépet avdhoya Tov
QWTIOUO 1y TV Béan Tou avTIKEUéVOU VW ByAlelS puTOYPapiES.
+ Kata Myn ewtoypagiag, otnv 006vn eugavifovtat A€eig KAeSIA
mou oxeTiCovTal pe 1o B€pa. Ot Aéeig kheidia Sev epgaviovtal oTig
amoBNKEVUEVES PWTOYPAPIEC.
« Auti n Suvatdtnta givat SlaBotun Povo aTnv Mow KAEPQ.

Nerroupyieg TG epappoyng AAumoup

ZXETIKO TIEPIEXOUEVO

Mriopeite va eme§epyaoTeite Kal va SIOLOPQWOETE OXETIKO TTEPIEXOLEVO OTO

AApmOU.

T 'Oco BAémeTe Wit MPOEMOKATINON EIKGVAC, AyYIETE TO KOUWTTE 2.

7 MO eupavioTei To £1KoVibIo TTou OYETICETaL ME TNV NUEPOUNVia 1y TV
tonoBeaia dmou tpaBréate Tn pwtoypaia, ayyi&te Tnv 006vn.

« Mmopeite va Seite TIC pwToypagieg mou oxeTi{ovTal e TV NUepoUNnvian
Tnv TonoBeaia mou emAégate.

E181kég Aertoupyieg 25



- Ayyi&te To koupri  yia va amoktroete MpdoBaon o MpAoBeteg emMoyéc.

Anpovpyia GIF
Mropeite va dnpioupynoete éva apyeio GIF amd to AAumoup.
T Koty mpoBohr evog dhpmouy, en\é€te & > Anpioupyia GIF.

7 Em)é€te TIC pwtoypaieg kat Ta Pivieo mou BENETE yia va SNUIOUPYAOETE éva
apyxeio GIF kat émerta matrote Emépevo.

+ Mnopeite va mpooOEoETe IEPIOOOTEPEC EIKOVEC KAl VA TIPOCAPHOCETE TV
TaxutnTa Tou GIF, Tov Adyo 006vNn¢ Kal T O€lpd TwV apXEiwV.

3 Em\é€re AmoBrikeuon.

« Tatn dnpiovpyia apxeiou GIF, pmopeite va xpnotpomolroete éwg 100
EIKOVEG,
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Anpioupyia kohag

Mriopeite va Snpioupynoete éva KoAAL XPNOILOTOIWVTAG OXETIKO TIEPIEXOUEVO.

T Katémy mpoBohr evog dhpmouy, matriote : > Anpoupyia KoAGL.

7 Em\é€te TIC e1kdveg Tou BéNeTE va TIpooBEoETe 0TO KOAAL Kal EMErTa TaTHoTE
Emopevo.

+ EmAé€te T Sidtagn mou BéNeTe amd To KATw PEPOG TNG 006VNG.
3 Emé€re Anovpyia.

E « Tlatn Snpiovpyia KONAL, UMOPEITE VAl XPNOILOTIOIOETE WG 9 EIKOVEC.

Anpioupyia Bivieo and GXeTIKO mePIEXOUEVO
MMOPEITE VO OUYKEVTPWOETE OXETIKO TIEPIEXOUEVO KAl VA PTIAEETE éva BIvTEOKNIT

nat@vTag To miktpo (») to Bivieo Kat eméyoviag va epgavietal n nuepopnvia
1 n TonoBeoia.

EmAé€Te TO O£ Kal T LOUCIKN GOVTOU, IPOCAPUOOTE Ta £9€ AeAvTag Kal
N O€1Pd, 1) TPOCOEOTE TNV NUEPOUNVIA KAl TNV UTIOYPAQH| 0AG, KAl TIATHOTE
AnoBrikeuon.
« &% Em\é€re To B¢pa Tou Bivreo.
- T va ipaypatonojoete Myn tou Bépatog, matiote .
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+ Jd:MpocBEoTe POUTIKK PAVTOU I} TPOGAPHOCTE TOV XPOVO AVATIAPAYWYNG.
- T va emAé€eTe £va apye(o yia T HOUCIKA QOVTOU, TOTHOTE .
- o va mpaypatomoloeTe Aryn VoG apxeiou Yia T HOUCIKH pOvVTOU,
natiote ¥ .
Mo va TPOCAPUOCETE TNV £VTAON TNG MOUCIKAG GOVTOU Kal TV £VTach xou
0TO apKIKO Bivteo, matoTe =
A : Em\é€te TOmo ypappatooeipdg.
- Ta va mpaypatonoioete An Wag ypaupatooelpds, matiote 4 .
« 2 :NpooBEoTe To Gvopa Tou CUVTAKTN OTO Biveo.
+ : ANGEre ™ oeipd Twv apxeiwv yia avamapaywyr wg Bivteo.
- Ta va poobéoete apyeia, mathote -

E « Tpaypatomoirote Ajyn g epappoyrg VASSET amé to Play Store yia va
npocbéoete Oépata BivTeo, OUOIKY GAVTOU 1 TUTIOUG YPAUUATOCEIPWV.
Av xpnotporoleite SeSopéva Kivntig TNAepuviag xwpig ouvdeon Wi-Fi,
umopei val MPAPUVOELTE [IE XPEWTELG Yia T XPron SeSopéVwV.

E181kég Aertoupyieg 28



Anuovpyia Tawvieg

Mriopeite va SnpioupynoeTe pia véa Tatvia cuvdualovTag eikOve kat Bivteo.

1 Natiote @3> Kaptéha Dutoypagieg Kal, 0Tn OUVEXELD, TATAOTE 0TN + >
Anpovpyia Tawvieg.
Mropeite emiong va natioete €8> kaptéha Avamap. Kal, 0Tr CUVEXELD, Val
natroete + > Anpoupyia Tawieg.

7 Em\é€te TiC eikdveg 1y Ta Bivieo mou BéAete va oupmepIAIBeTe 0TV Tawvia oag
Kot matiote Emopevo.

3 Eme€epyaoTEiTe TIC EIKOVEC Kl Ta BIVTED TIOU £XETE EMAECEL KAl TTATHOTE
Amobrkeuon.
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Awaypagn apyeiwv

Mrmopeite va emAé€eTe elKOVEC 1 Bivieo mou BéNeTe va Slaypdyete amo To Bivied
oag mat@vTag 1o koupr ) ot kétw Seéid ywvia T pikpoypagiag mou
aVTIOTOIXEl 0TO KaBéva.

Mpoabrikn apyeiwv

Mmopeite va mpooBéoete elkoveg 1y Bivieo mou BéNeTe matwvTag To kKouuni -+ oto
KATW PE€POG TG 080vNG. Mmopeite emiong va emAEEETE €IKOVEC 1) BivTeo TTOU €xeTe
1on mpooBEaeL

5 « MNatjote mapateTapéva mavw o€ éva apxeio Kal EMeita mavw o€ éva GAAo yial
ToMamAf emAoyr apxeiwv.

Avadidraén apyeiwv

Ma va aMagete T dlatagn Twv ekdVwY Kat Twv Bivteo, MATHOTE Kal KPATAOTE
TIOTNHEVO TIAVW OTO OPXEIO TTOU BENETE VOl LETAKIVIOETE Kall GUPETE TO OTNV
TomoBeaia mou BéAeTe.

MpocBrikn epé apyeiwv
Avyyi&te To elkovibIl0 5 yia va TIpooB£oeTe va BEpa 1 LOUGIKA GOVTOU Kal yia Va
aMd&ete T ypappatooelpd.

Emavagopd Twv pubpicewv Tauviag

Mrmiopeite va avakaAéOETE TIC PUBIOELS TIOU EXETE OpioEl 0TNV Tavid (.. XpOVOS
Quanapaywyrg) MaTwvTag 1o Koupmi &).

Mpoemaokomnon apyeiov

Atite T0 BivTeo TTOU SNUIOUPYROATE TIPIV TO AMOBNKEVCETE, MATWVTAC TO
koupri . Otav ohokAnpwOei n avamapaywyn, TPAYHATOTOIETaL AUTOHATA
avanapaywyr Tou eNdpEVOU apxeiou.

E « ot dnpiovpyia Bivteo, pmopeite va xpnoILOTOINOETE WG 50 EIKOVES Kat
Bivteo.

O mpoemAeyHEVOG XPOVOG avamapaywyng Yia pia €lKova givat 3
Seutepolernta kat Sev pmopei va aAd€el. H Sidpketa Twv Bivieo pmopei va
pelwBEl o €wg 1 SeutepONemTO.

+ AUt n SuvatoTNTA UMOPEL VA PNV OO TNPI(El OPIOUEVES LOPPEC EIKOVWY
1 Bivteo.
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Anovpyia GIF
Mmopeite ebkoha va SnuoupynoeTe éva apyeio GIF xpnotpomolwvag
€yyeypappéva Bivieo i pwtoypapied.

Kavovtag éva GIF xpnoipomolwvtag Ta eyyeypappéva Bivteo
1 Tnouypr mou Ba emAé€ete otnv apyr TG MPoPoi¢ evog Bivieo, matrote G).
7 Em)\é€te 1o urikog Tou GIF iou B4AeTe va SnuioupynoeTe.
+ To GIF dnuioupyeitat yia 1o Xpovikd S1dotnpia mou éxel emAeYei amé Ty
TPEKOUOA WPA.
« Ta Bivreo pe Sidpkela Aiydtepo amo 5 SeutepoAemta, ot eikoveg GIF
SnioupyoLVTaAL AUTOMATA Yia TV UTIOAOITN WPA.

Anpiovpyia evog GIF xpnoipomolwvTag gwtoypapieg

T Koty mpoBohr evog dhpmouy, em\é€te & > Anpioupyia GIF.

7 Em\é€te TIC emBUPNTEC WTOYPaieC yia va Snuioupyrnoete éva apxeio GIF kat
énerta motjote Emopevo.

+ Mnopeite va mpooOEoETe IEPIOOOTEPES EIKOVEC KAl VA TIPOCAPUOCETE TV
TaxutnTa Tou GIF, Tov Adyo 006vNn¢ Kal T O€lpd TwV apXEiwV.

A « Mmopeite va XpnOILOTOICETE AUTAV T SLVATATNTA HOVO Yia SNUOUPYIKES
16éec. Tuydv xprion autrig g Suvatdtntag mou odnyei o€ mapaiaon
TV SIKAWUATWY TPITWY, OTIWG SNAWOEIC YIal TIVEUMATIKA SIKathuaTa 1y
SUOENUIOTIKEG 1 UBPIOTIKEG SNAWOELS, SUvaTal VA EMPEPEL KUPWOELG
yla TNV anmd800n TMONTIKWY, TIOWIKWV 1) SIOIKNTIKWY uBuvV®V r/Kat
ANEC KUPWOELG CUPPWVA PE TNV IoXUoUGA VopoBeaia. Amayopeletal n
avtiypaen, n avamapaywyn, n Slavopr Kat Kabe GAAn mapdvoun xerion
OAwV TwV LAIKWV TTou SIEmovTal amd MIVEVHATIKA SIKAIWHATA XwPig ThV
A€ TOU VOUIMOU KATOXOU TOUG 1} TOU SIKAIOUXOU TIVEUHATIKNAG IG10KTN GO
370 péytoTo Babud mou emrpémetatl amd 1o Epappootéo Sikato, n LG
Electronics amomoleital Kabe pNnTr¢ Kal SlwInprg yyunong Kat UoxPEéwong
TIOU AQOPd TO TTAPOV.

« Tatn dnpiovpyia apxeiou GIF, pmopeite va xpnaotpomolroete éwg 100

EIKOVEC,
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ModtnTa KAt EMMTWOELG TOU IOV
XOPAKTNPICTIKA

DTS:X 3D Surround

Mmopeite va avamapaydyete éva tpayoldi r éva Bivteo oe tpiodidotato, {wvtavd
Kat {wvtavo ryo. MNa va Xpnotuomoli oL auTo TO XAPAKTNPIOTIKO, GUVOEDE
OKOUOTIKG, NXEIO 1) AMEG EEWTEPIKEG CUOKEVEC XOU OTN GUOKEUH GOU.

SV apxikn 086vn matriote PuBpioeig > Hyog > Motdtnta riyou Kat £@é > DTS:X
3D Surround Kal, 0TN GUVEXELQ, TIOTHOTE Y10 VOl EVEPYOTIOIOETE QUTAY TN
Aertoupyia.

PUBpion ¢ katevBuveng rixou

Mmopeite va puBpicete TV katelBuvon Tou rixou cUpYWvA Ue Ty emBupia oo

T Zmv apxikr 086vn matrote PuBpioelg > Hyog > MotdtnTa fYou Kat £é >
DTS:X 3D Surround Kal, 0T CUVEXELQ, TTATAOTE

7 Emé€te v kateuBuvon riyou.
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Floating Bar

Floating Bar - Mapouaciaon

Mriopeite va evepyoTioIOETE AEITOUPYIES TIOU XPNOIHOTIOLEITE CUXVA, OTTWG
GUVTOEVOELS, AMOTUTIWGN 08OVNE, AVAapaywyr LOUGIKAG KAt YPrYOPES EMAQEC,
matwvTag mavw oto Floating Bar otnv 08évn.

MNa va evepyormoioete T duvatotnta Floating Bar, matiote O) > PuBpioei >
Enektaoeig> Floating Bar

Avotypa kat kAgiotpo Floating Bar
- Ta va avoiéete 1o Floating Bar: Ayyi&te ta eovibia € i .
- Ta va k\eioete 10 Floating Bar: Ayyi€te ta eikovidia > i <.
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Meraklvnon ¢ Oéonc¢ tou Floating Bar
‘Otav 1o Floating Bar ivat avoiyto: matiote mavw oTnv PImapa Kat GUPETE T
otnv embupuntn Béon.

- 'Otav to Floating Bar givai KA€IGTO: TATAOTE MAVW OTNV PIAPA KAl GUPETE TN
otnv embupuntr B€on amoé v akpn g 0Bévng.

Anevepyomoinon tou Floating Bar
Mmopeite va amevepyomoinoete to Floating Bar xpnaotgomotwvtag pia amo Tig
mapakdtw pebodoug:
« Ayyi€te ka1 kpatiioTe To elkovidio € 1 To eikovidio > oto Floating Bar kat
£MeITa OUPETE TO OTNV TEPLOKH SlaypaPri¢ 0To MAvw PEPOG TNG 086VNG.
« Ayyi€te 1o ekovidio < 110 eikovidlo > oto Floating Bar kat émerta matiote
o> @®@ o010 mdvw péPog T 08évng.
- Emegre O > PuBpioeig > Enektdoelc > Floating Bar @ .
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PUBuion tou Floating Bar
Mriopeite va emAé€ete To meplexdpievo mou Ba epgavietat oo Floating Bar katva
aM3Eete T oelpd epgaviong. Ayyi€te To ikoviblo == oto Floating Bar 1 emAé€te
(> PuBpioeig > Enektdoeig > Floating Bar.
- ©éon: Mmopeite va opioeTe TV mepLoxr héoa oy omoia Ba pmopeite va
petakiveite 1o floating bar.
- Tuvtopevoelg: a ypriyopn mpdoBacn o€ eQapuoyEC 1 Aeltoupyieg mou
XPnotgomolovvTal Mo cuyvd.
« Amotunwon 006vng: TpaPr&te éva otiypdTumo 08ovNng Kal &ite KAvTe
TIEPIKOTT €iTE SNUIoupyNoTe éva apyeio GIF.

Mmopeite va xpnotpomolnoete Ty epappoyr Capture+ otnv 08évn mou

2

s BéNete.

w0 Mmopeite va Kataypapete éva oTtyMdTunio 086vng pe KUMoN Kat va To

= XPnotpomooeTe yia 1o Q Memo+ 1 va 1o amoBnKeVoETe 0T GUNOY.

ey Mmopeite va Kataypapete pia emOuunTr MEPILOXT Katvatn

= XpnotpomoloeTe yia 1o Q Memo+ fj va Tnv anoBnkeVoeTe T GUNOYN.
AmoBnkevoTe TV Tpéxouaa 086vn we apyeio GIF. Mmopeite va
TIPOCOPUOCETE TO MéyeBOC TNG EIKAVAC TTOU BENETE VA AMMOTUTIWOETE.

7 - Na va petakivnBeite otnv embupntr Tomobeoia, cUPETE TO PUOUIOTIKO

« Na va eKIvoeTe TV eyypa evog apxeiou GIF, matijote C-)

« Mo va SlakdYeTe TV eyypaepn evog apyeiou GIF, matriote (-)

- Mpdypappa avamapaywyng Houctkig: EAéyETe Tn pouaoikr mou akoUTe.
- Tpriyopn ema@n: Kaléote 1 oTeiNTe unvOpaTa 0 AT TIOU €XOUV OPLOTE! WG
YPIYOPES EMOPEC.

5

+ YTIC OUVTOUEVDEIG UMOPEITE VA TIPOOOEDETE €W 5 EQAPHOYEC I AEITOUPYIEC.

+ ZTIG YPrYOPEG EMAPEG UTOPEITE Va TTPOOOETETE EWG 5 EMAPE.

+ H kataypaen GIF ivat wia Aerroupyia mou mapéyetat yia Tov Xpriotn WoTe va
umopei va mapdyet SnUIoupYIKES elkovee. H mapapioon Sikatwpdtwy 6mwg
0 SiKaiwpa vevpaTikig IGloktoiag fi n SlaBolr) ¢ KNG GAou atépou
Xpnotgomolwvtag T Aertoupyia Kataypa@ric GIF evdéxetal va mpokahéoel
aoTiKr A ToWIK Siwén cUPPWVA LE TOUE LoXUOVTES VOLOUG. Mnv avTlypd@eTe
1} peTadiOeTe To €pyo GANOUL ATOMOU XWPIG Tponyouuevn e§ouatodotnon. H
LG Electronics Sev pépel kapiia uBUVN Yia TETOLEG EVEPYELEC AT TOUG XPIOTEG.

+ Eva apyeio GIF umopei va éxel Sidpkela €wg 15 SeutepoAenta.
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Google Assistant

Google Assistant Emokomnnon
Mriopeite va §eKIVAOETE 1) val XpNOIUOTIOINOETE TIG EPAPHOYEC TTOU BENETE PE TN
QwvA oag.

E « [l va XpnolUOTIOIOEL AUTO TO XAPAKTNPIOTIKY, TPWTA CUVOEGOU OTO
SladikTuo Kal kave €icodo pe Tov Aoyaplaoud oou oo Google.
« Auti n Aertoupyia Sev pmopei va AerToupyrnoel CwoTd O€ QUTEG TIG
TIEPIOXEG 1 N AKPIBEIa avayvwpiong Yo PMopEi va givat pikpdtepn dtav
n 10xV¢ Tou Wi-Fi 1} Tou orjpatog tou Kivntou Siktuou givat aoBevic.
+ AutA n Aerroupyia umopei va pnv umootnpietay, fj ot umooTNEI{OUEVEG
YAWOOEG evEEKeTaL va SlapEPOLY avaloya UE TV TTEPLOXT.

Ekkivnon tou Google Assistant.

1 NatAote napatetapéva O ané v Apyiki 086vn yia va ekivijoete Google
Assistant.

7 Ayyi€te to ZEKINHETE.

3 AkohouBroTe Tic 0dnyieg mou epavilovtal otnv 086vn Kai niite “Ok Google”.
+ H ouokeur amoBnkevel Ta wvnTika oag Sedopéva yia avayvwpion.

/A EmAé€te av Ba evepyomooeTe 1 Ba amevepyomoloeTe T Aertoupyia
avayvwplong optia.
« ‘Otav éyel evepyomoinBei auTr| n AEITOUPYia, UTOPEITE VOl EKTENETETE TO

Google Assistant Aéyovtag “OK Google” otnv apyixr) 086vn.
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Ekkivnon tou Google Assistant pe Tn @wvn cag

T Neite “Ok Google” dtav n 086vn ival amevepyormonpévn 1 KAEWSwpEVN.

7 6tav n oBovn eivat anevepyomoinuévn ; KAelSwpévn “Teta 6a¢, g Hmopw va
BonBrow?” epgaviletal otnv 006vN.

Ekkivnon tou Google Assistant amé tv Apxikr 006vn

1 Natiote mapatetapéva O otnv Apxiki 066vn.

7 6tav n oBovn eivat anevepyomolnuévn ; KAeldwpévn “Teia 6ag, g Hmopw va
BonBrow?” epgaviletat otnv 006vn.

E « Eav piNdte pe Sipopoupevn ewvr 1 B0pufo Tote N akpiela avayvpiong
QWVNAG UMopEi va pelwBei. Otav XpnoIomoLEiTe T AeIToupyia avayvwpiong
QWVNAG, aUENOTE TNV aKPIBELd TG MAWVTAG pE KaBapr Qwvr O€ Wia ouxn
TomoBeaia.

Nertoupyieg eyypagng nxov

Me v Eyypan fixou HD umopeite va SIapop@uveTe elpokivnta TIg puBicelg
X0V, £T01 WOTE N EYYPAPK| TOU XOU va TPooapuoleTal KAbe popd oTo
nepIBANoV oac,

Nertoupyieg eyypagng

Mriopeite va eyypdgete éva apxeio ixou uPnAng avaAuong emAéyovtag
Ka Slapop@wvovTag T Aerroupyia fixou mou BéNeTe, woTe va Taiplalel oTo
TIEQIBANNOV EYYPAPAC.

SV apyxikn 086vn, matiote Ta amapaitnta > Eyypaer iyov HD >=.

Kavoviko
Mriopeite va eyypAapeTe Y0 Xwpic va opiceTe emmAéov pUBIOELG.

Tuvavlia
Mmopeite va eyypayeTe rixo o€ pia cuvauvlia f GANN HOUGIKN eKSHAwaN.
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Mpocappoopévo
Mriopeite va SI0popPWOETE TIG MOUUNTEG PUBLICELC YIa TNV EYYPAQK XOU.

Aerroupyia ZtouvTio

Meé tn Aertoupyia ZTouvTio, Umopeite va TaiSeTe €va apyeio RXOU i HOUGIKAG

KQl TAUTOXPOVA VOl NXOYPAPEITE TN PwVr} 00, Va SUIOUPYNHCETE pia ouyxopdia
NXOYPAQWVTAG TN GwVH 0ag TOMES POPES, KAl VA NXOYPAPHOETE Ta 0XONId 0ag
TIAVW amd T0 ApXIKS APXEIO XOU TOU TAPOUCIAOTH f TOU OMIANTH.

T Zmv apxikr 066vn, matiote Ta amapaitnta > Eyypaen ixou HD > =>
Mpocappoopévn.

MotAoTe To Koupmi J 1.

EmAé€te €va apyeio r1xou mou Ba XpNOILOTOICETE WG HOUGIK POVTOU.
Ayyi€re o koupmi @ yia eyypaer fxou.

Ayyi€te to koupmi ° yla amoBriKeLON TOU NXOyPaPNHEVOU apxEiou.

b WwWwN

E «+ Havamapaywyr HOUGIKRG @ovTOoU ivat Suvath HOVO HECW OKOUGTIKWV.
BePaiwBeite OTI €(eTE OUVEEDEI TA AKOUGTIKA TIPOTOU XPNOIHOTOIOETE
auTtv T Aertoupyia.

AN XpriotuEG AelTOUPYiEG TTOU PITOPOUV Va XPnotpomotn8ouv
amo v epappoyn «Eyypaen ixov HD»

GAIN

Mriopeite va TpOGAPHOCETE TNV £VAICONGIC TOU XOU TTIOU €XEL NXOYPOPHTEL TO
HIKPOPWVO.

‘000 o VPNAG €xel optoTei n Tiur GAIN 600 o guaioBnTn €ivat n nxoypdenon
TOU NOu.

LCF

Mriopeite va QINTPAPETE TUXOV UTAGOUC XOUC OTIWG TO XaUNAG BounTod Tou
KAIHOTIOTIKOU.

‘000 vPnAdtepa €xel pubuiotei n tipr LCF (Low Cut Filter) téo0 kaAUtepa
@INTPdpovTal ot YNNG CUXVOTNTAC HXOL.
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LMT

Mriopei va amoTtpéPel TV TIEPIKOTIT Tou NXoypa@nuévou rixou. 0co uPnAdtepa
€xel oplotel n Ty LMT (Limiter) 1000 au€dvetat o aptOpog Twv Axwv XapnAig
ouyvoTtnTag mou dev Ba mepikoMTOVTAL.

E « Tla va aMd€ete Tig mpoobeteg pubpioelg, ayyifte > PuBpioeig, ka

0TN GUVEXELD TTPOCAPHACTE ToV TUTTO apyeiou, To BdBog bit, To pubud
SelypatoAniag Kat AAEG pUBHITEIC.

« ‘Otav em\éyete Aerroupyia amo To pevou Zuvaulia kat Mpocappuocpévo,
TOTE aviCeTal To elkovidio L[,],,. Avyyi&te To Koupi \D* KOl 0T OUVEXEIA
EMAEETE TO MIKPOPWVO TTOU BENETE VOl XPNOIUOTIOIOETE.

+ Mmopeite va eENEYXETE TNV TTOIGTNTA TOU YOV HE TO GUVEESEPEVO AKOUOTIKO
EVW) EYYPAPETE TOV 11X0. KaTd TV €yypagr] XoU 0 AeToupyia XTouvTio,
n Aerroupyia mapakoAoUBnong rixou Sev umootnpiletal. Mmopeite va
OKOUOETE POVO TN HOUTIKK YOVTOU.

Avayvwpion Aaktul. Amotunwpata

Avayvwpion Aaktul. Amotunwpata - Mapouaciaon

MPoToU XPNOILOTOICETE TN A&lToupyia avayvwplong AakTul. ATOTUNWHATA,
TIPETIEL VOl KATOXWPIOETE Ta SAKTUAIKA 0OC AMOTUTIWHATA OTr CUOKEUN.

Mrmopeite va XpnolOTOIRCETE TN AelToupyia avayvwplong AakTul. Amotunipata
OTIC AKOAOUBEC TTEPITTTWOELG:

Na Eexheidwpia tng 08évne.

la ipoolr Tou KAEISwEVou TIEPIEXOUEVOU TTOU BPIOKETAL 0TO ANUTIOU 1)
otnv epappoyr QuickMemo+

Mo emPePaiwon piag ayopdg péow TG 6UVOEDNG OE i Epappoyi i
TauUTomoinang Ke To SAKTUAIKG 0a¢ AmoTUNTWHA.
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5 + Houokeun umopei va xpnotpuomolei To SaKTUNKS cag amoTunwpa yia

Aoyoug tautomoinong. O atoBntripag AaKTUA. ATOTUNIWHATA UITOPE va
unv Eexwpilet SAKTUNKE QmOTUMIWUATA TTOU AVIKOUV O SIAQOPETIKOUG
XPOTEG AANG EXOUV TTOANEG OHIOIOTNTEG, Kall VAl Ta avayvwpilel wg To 510
anoTOMWHAL.

« Avn ouokeun Sev avayvwpilel ta SaxTUNKG 0ag AMOTUTIWHATA 1 av
§exaoeTe TNV KABOPIGPEVN TIUA IO TNV KATAXWPLON, EMOKEPTEITE TO
mnotéotepo Kévipo eunnpétnong mehatwv g LG mpookopifovtag
OUOKEUN Kal TV TAUTOTNTA 0ag.

Mpoguldéerg yia tnv avayvwpion AakTul. Amotunwpata
H akpipela avayvipiong SAKTUNKOU amoTUMWUATOG UMOpE( va pElwBei yia
Siapopoug Mdyouc. Na va peylotomoinBei n akpifela tng avayvwplong, eAéyEte Ta
aKOAouBa TPV XPNOIOTIOIOETE TN OUCKEUN.

+ H ouokeun| diabétel aioBntpa AakTtul. Amotuniwpata. BeBaiwbeite ot o

aeOntpag Aaktul. Amotunwpata Sev éxel UMOoTel {nia amod omolodrmoTe
UETAMIKO QVTIKEIEVO, OTTWG VopiopaTa f KAESIA.

- ‘Otav 010 M\AKTPO AloBNTHPAC AKTUA. AMOTUITOUATA 1} TO SAKTUAG

00G UTAPYEL VEPD, okAVN 1y GAAN E€vn ouaia, n kataywplon SAKTUAKOU
QIOTUTTWUATOG ) N AVaYVWPLON evEEKeTaL va U Agttoupyolv. KaBapiote

KOl OTEYVWOTE To SAKTUNG GO PV EEKIVAOETE TN SladiKacia avayvwplong
SOKTUAIKOU amOTUTTHATOC.

‘Eva SakTUNIKO amoTUnwua Sev Umopei va TauTtomoinBei owoTd £4v n em@Avela
ToU SaKTUAOU 00 éxel Wia ouAA 1y Sev gival Aeia emeldN éxel peivel TOAR wpa
UEoQ O€ VEPO.

+ Edv huyilete o SAKTUAG 0aG 1) XPNOIUOTIOLEITE HOVO TNV AKPN TOU SAKTUAOU

00, TO SAKTUAIKO amOTUMWLA 0a¢ EVOEXETAI VA NV avayvwploTel BeBatwbeite
0T1 70 GAKTUNG GO KAAUTTTEL OAOKAN PN TNV EMIPAVELD TOU aloBnTrpa AaKTUA.
Anotunwpara.

YapwoTe Povo €va SAKTUMO Yia KABe kataxwpion. H cdpwon mepIocoTepwv
SaKTUAWV POl va xel EMMTWOELG 0Tn Sladikaaia Kataxwplong Kat
EYYPAPAG.

+ H ouokeun evdéxetat va Snpioupyei oTaTikd NAEKTPLOO OE TEPIMTWon ou

Aertoupyei o€ mepIBANov pe Enpd aépa. EGv o aépag oto mepiBANov sival
&NPO¢, amoPUYETE TN 6APWON TOU SAKTUAKOU GOG AMOTUTIWHATOG 1 ayYi€Te
£Val LETANNIKO QVTIKEIPEVO, OTIWG €va VOIopa 1} éva KAESI, TV Tn 6dpwaon Tou
SAKTUAKOU OITOTUMTWATOG YIa VO EE0USETEPWOETE TOV OTATIKO NAEKTPIOMO.
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Kataywpion Aaktul. Amotunwpata

Mmopeite va kataywpioeTe Kat va amoBnKeUoeTe To SAKTUNIKO 0ag amoTunwua

OTN GUOKEUN Y10 VOl TO XPNOIHOTIOLEITE PE TNV avayvwplon AaKTuA. Amotumwuata.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
AakTtul. AmotunpaTa.

E « [la va Pmopeite va XpnolpomolroeTe auTriv Tn Aetoupyia, Ba mpémel va
0pIOTOVV Ot PUBKICELS KAEIBWHATOC TNG 080VNG.
« Edv 1o KAeidwpa 086vng Sev gival evepyomolnpévo, SIapoPPWOTE TIG
pubuioelg KAebwpaTog 006vng akoAouBwvTag Tig 0dnyieg tng 08vne. MNa
AemTopépeleg, avaTpé€Te 0TV evotnta PUBLIoN KAIdwuaTog 08ovng.

7 Evrtomiote Tov alobntripa AAKTUA. AIOTUIIWMATA OTO THOW PEPOG TNG
GUOKEUNG KAl AKOUPTTAOTE amaAd To GAKTUAO Yia va KATaXwpIoETE TO
SakTulikd oag amoTumwua.

E « Matrote eEhappd To MAfKTPO AloBNTAPAG AGKTUN. AMTOTUNWUOTA WOTE O
aebnTrpag va avayvwpioel 1o SaKTUNKO 0ag amoTUMwHa.
+ BeBaunoou 61110 akpodaxTuNG Gou KAAUTTTEL OAGKAN PN TNV EMQAVELD TOU
aebnTrpa aMoTUNIWHATOG.
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3 AkohouBAoTe Tic 0dnyiec ou epgaviloval otny 086vn.
+ Emavalapete T 6dpwon Tou SAKTUAIKOU AmOTUNIWUATOC LETAKIVWVTAG TO
SAKTUNG GaC Olya-Olyd HEXPL VA OMoKANpwBEi n kataxwplon.
/' 'Otav n kataywpion Tou SaKTUAIKOU amoTumwpatog oAokAnpwoei, matriote OK.
+ Matrjote Npoabnkn emmA. yia va kataywpioete AANO SAKTUAIKO
amotunwpa. Eav €xete kataywpioel Hovo €va GOKTUAKS amoTUmwHA Kat
T avTioTolXo SAKTUAO Sev gival o€ KATAMNAN Katdotaon yla odpwon, n
QAVayVWPLOoN EVOEXETAL VA UN AEITOUPYNOEL GWOTA. Q¢ LETPO AmOTPOTTNG
HIaG TETOLOG KATAOTAONG, CUVIOTATAL VO KATOXWPEICETE TOMA SAKTUAIKA
amoTUTIWHATA.

Awayeipion Aaktul. Amotunwparta

Mriopeite va emefepyaoTeite 1 va SlaypaPeTe Kataywplopéva SAKTUAKA

anoTunWuaATa.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
AakTtul. AoTunpATA.

7 ZekAelbWoTe GUMPWVA HE TNV KABOPIOoEVN UEBOSO KAEIGWUATOC.

3 A6 NoTa Twv AakTul. ATTOTUTIOUATA, TATHOTE TTAVW € £val SAKTUAIKO
QmoTUMWLA YA VO TO ETOVOUACETE. M va To SlaypdPeTe, TATHOTE TO KOUUT{
0

Zekheidwpa NG 006vNng pe xprion Saktulikou
ATTOTUTIWHATOG
Mriopeite va Eexheldwoete Tnv 006vn 1 va Seite To KAEIOWEVO TIEPIEXOHEVO
XPNOOMoLVTAg To SaKTUAIKS cag amoTtunwua. Evepyomoinon emOupntig
Aertoupyiag:
T Zmv apxikr 066vn, matiote Pubpioeig > Kheidwua 006vng & ac@dheia >
Aaktul. AmoTunATA.
7 ZekAelbwoTe GUMPWVA HE TNV KABOPIopEVN UéB0SO KAEIGWUATOC.
3 TV 0B6vn pubpicewv AaKTUN. ATOTUTIOHATA, EVEPYOTIOINOTE TV EMBUNTA
Aerroupyia:
+ Kheibwpa 006vng: yia va Eexheldwvete tnv 006vn He Xprion SaKTUAKOU
QmOTUNTHATOG.
+ K\eidwpa mepiegopévou: yia va EEKAEISWVETE TO TTEPIEXOMEVO HIE XPrioN
SaKTUNKOU amoTumwpaTog. Ma va o kdvete autd, PePaiwbeite 6T éxel
£QAPUOOTEL KAEISWA TIEPIEXOUEVOU.
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Avayvwpion TpocwItov

Avayvwpion ipoowmou - Mapouaoiaon
Mriopeite va {exheldwoete v 006vn xpnaotpomolwvag ta dedopéva
XOPAKTNPIOTIKWY TIPOOWTTOU TTOU EXETE AMOBNKEVTEL.

5 + Autij n Suvatdtnta pmopei va gival mo vdAwtn 6oov apopd Ty acedleia,
o€ oxéon pe AANoug TpoTouG KAEIdwpaTog 086vng, 6mwg To Knock Code, T
MoriBo, 0 Kwdikog kKhetdwpatog iy o Kwdikdg mpéoBaong.
« Ho6B6vn umopei va EekNeldwOE( Kal e éva mPAoWTTO MAPOLOLO LE TO SIKO
00 1 HE M0 QWTOYPAPIa TOU TIPOCWTTOU GOG.
« Ta 6edopéva XapaKTNPIOTIKWY TIPOCWITOU TIOU £X0UV AVAYVWPLOTE!
amoBnkevovTal e aopAAEIa OTN GUCKEN 0aG.

Av éxete EMAEEEL TNV QVaYVWPLON TTPOOWTTOU Yia PéB0S0 KAEIGWHATOG

086vng, mpénel va elodyete To Knock Code, To MoTifo, Tov Kwdikog

KAEBWHaTOG 1 Tov KwdIKOG MPAoRaong mou XpnolHomoLoate KAtd TV

KOTaxwplon TwV XOpaKTNPIoTIKWY TTPOCWTIOU LETA TNV EVEPYOTIOINGN TNG

OUOKEUNG. Mpooé€te, emiong, va pnv §exAoeTe TV KaBopiopévn TIpn.

+ Avn ouokeur 8ev avayvwpiel To TPOCWTO 0ag 1y av EEXACETE TV
KaBopIopévn TIUA VIO TNV KATAXWELON, EMOKEPTEITE TO MANCIEOTEPO
Kévtpo e§ummpétnong mehatwv g LG mpookopiovtag Tn GUOKEUH Kal Ty
TaUTOTNTA 00C.

« Tla e§oikovopnon evépyelag, n duvatdtnta avayvwpiong mpoowrou dev Ba
Aettoupyei dtav To enimedo umatapiag eivat Katw amd 5%.

Mpo@uAdagerc yia tnv Avayvwplion pocwiiou
H akpifela g Avayvwpiong mpoowmou Mmopei va PElwBEl oTIG akOAOUBEC
MeQTWOELG. Na va au€roete Ty akpiPela, eréyEte Ta akdhouba mpv
XPNOILOTIOIOETE TN CUOKEUN.
+ ‘Otav popdrte KaméNo, YUaAld 1} LAOKa TIou KAAUTTTOLV TO TIPOOWTIO 0 1 v
£xeTe €évTOVO paKIyIdd 1y yévia mou aAAa{ouv oAU To pOowmd oag.
- ‘Otav umdpyouv SayTUNKA aMOTUTIWHATA 1) §EVA CWHATA OTO UMPOOTIVO UEPOG
TOU PaKOU TNG KAMEPAG 1} €4V N ouoKeun Sev pmopei va Slakpivel To MPOowmno
060G AOyw TIOAU QWTEVOU 1} OKOTEIVOU GWTIGHOU.
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Kataywpion 6edopévwv XapakTneIGTIKWVY TTPOGWITOU

Mptv xpnotpomotoeTe Tn AgToupyia Avayvwplion TPoowou, IPEMEL va

KoTaxwpioeTe Ta SeSopEVa XAPAKTNPIOTIKWY TPOCWTTOU 0Ag 0T GUCKEUT 0.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
Avayvwpion TPOowITou.

5 « [la va XpnolpomoloeTe auTrv T duvatotnTa, Ba mpémel va opioeTe To
KAeibwpa 006vng og Knock Code, MotiBo, Kwdikog KAEGwHaTOg 1) KwOIKAG
mpoopacng.

« Av bev éxel oploTei kAeidwpa 086vng, akoAouBRoTe TG 08nyieg atnv 006vn
yla Ty Kataywplon dedopévwv. MNa AeNTopEPELES, avaTpEETE 0TV EvOTNTA
PuBuion kAslbwpatog 066vng.

7 Matiote Em6p. kat EeKNeISWOTE TN GUOKEUN OUHQWVA HE TRV KaBopIopévn
uébodo.
3 MNatAote Evapén Kat GNKWOTE TN GUCKEUR 00C MTPOOTA 0T HATIA OQC,
/I KataywpioTe Ta XapaKTnPIoTIKA TOU IPOGWTTOU Ga¢ GUUPWVA UE TIC 08nyieg
iou epgaviovtal otnv 08dvn.
+ H kataxwpnon Twv XapaktnploTIKWy Ba mpémel va yivel oe XWpo mou dev
€[Val TTONY QWTEIVOC I OKOTEIVOG,
+ TomoBetroTe 6AO TO MPAOWMO GAG EVTOE Tou 0dnyoU Mo epgavileTal oTn
006vn Kal HETA TPOoaPUAOTE TN BE0N TOU HETAKIVWVTAC TO ApYd PO Ta
TIAVW, KATw, aplotepa 1y e€id.
- Kpatrote 1o mpoownd oag eyyeypappévo. Mmopeite va tpanéete
Hia 0tabepr} pwToypaia APKETEC POPEC Yia va BeATIWOETE TO pUBPS
£yKupATNTAC.
5 'Otav ohokAnpwBE( n KaTaxwELon TwV XAPAKTNPIOTIKWVY TPoowriou, matioTe OK.

ZekAeibwpa TnG 000VNC e To MPOoW6 oag

Mmopeite va anevepyomolroeTe To KAEiGwpa 006vng XpNnotUomolwvTag To mPdowno

oag avti yia Knock Code, Motifo, Kwdikdg khetdwpatog 1 Kwdikog mpoofaong.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
Ato)é€te KAeidwpa 086vng.

7 Zexhelbwote v 000vn cUpewva pe Ty kabopiopévn pebodo.

3 Motriote Emtpémetat Xprion Avayvipion mpoowiiou TIOU 0OIG EMTPETEL
va EEKAEIBWVETE TNV 080VN XPNOILOTOLWVTAG TV QVAYVWPLON TPOCGWTTOU.
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BeAtiwon Tng avayvwpiong mpoowiou

Mriopeite va mpocbéoeTe SeSopéva XapaKTNPIOTIKWY TPOCWITOU UTIO SLAQOPES
OUVONKEC, WOTE Va BENTIVOETE TV AVayvwpIon TTPOCWTTOU.

1 Zmv apxikn 086vn, matriote PuBpioeig > Kheibwpa 006vng & ac@dheia >
Avayvwpion TPOCWITOU.

Zek\eldWoTe TNV 086vN cUpPwWVa e T KaBoplopévn uébodo.

EmAé€te BeAtiwpiévn avayvwpion mpoowriov.

KataywpioTe Ta XapaKTnpIoTIKA TOU TTPOCWTTOU 0aG CUHPWVA HE TIG 0dnyieg
iou epgaviovtal otny 08dvn.

‘Otav oAoKANPWOE( N KATAXWPLON TWV XAPOKTNPLOTIKWY TTPOCWITOU, TATAOTE
OK.

o B~ wWwN

Aaypagni Sedopévwv XapaKTNPIoTIKWV TTPOGWITOU

Av n Avayvwplon mpoowmou Sev AEITOUPYEL KAVOVIKE, Umopeite va Slaypdyete Ta

Sedopéva XapakTnPIoTIKWV TPOCWTTOU TTOU EXETE KATAXWPIOEL KAl va eMavaldpeTe

TNV KATAXWELON.

1 Zmv apxikr 086vn, matiote PuBpioeig > Kheibwpa 006vng & ac@dheia >
Avayvwpion TPoowITou.

7 Zek\eldwote Ty 006vn cUpQwva pe Ty kaBopiopévn pébodo.

3 Em\é€te Maypagn mpoowmou yia va Slaypdpete Ta SeSopéva
XOPAKTNPIOTIKWV TTPOCWTTOU.

ZekAeibwpa g 006vNng pe To mpoowné cag otav n 00dvn givat

arevepyomonuévn

Me amevepyomoinpévn tnv 00vn, CNKWOTE T GUOKEUN Kal KOITAETE 0TV

066vn. H ouokeun PMmopei va avayvwpioel To Tpoowmé 6ag otav n 006vn eivat

QTIEVEPYOTIOINUEVN.

M0l Vo amevepyomoINOETE Tn Asltoupyia, akoAoUBNOTE TIC MapaKATw odnyieg.

T Zmv apxikn 086vn, matiote PuBpioceig > Kheibwpa 006vng & acpdheia >
Avayvwpion TPocwmou.

7 Zekheldwote Ty 006vn cUpQwva pe Ty kaBopiopévn pébodo.

3 Em\é€te Na emrpémeTal To amOTUNWHA TPOOWITOU OTav n) 086vn eivat
ofnot @) yla va armeVEPYOTIOIOETE TN AetToupyia.

+ H duvardtnta Avayviplon mpoowrou eivat Slabéaotun povo otav eivat
KAedwpévn n 086vn.
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Zekheidwpa tng 000vNng pe Avayvwpion TPOCWITOU Kal GApwon
00dvng

‘Otav gival anevepyorotnpévn n 006vn, umopeite va v EeKAEIBWOETE PEow
avayvwpiong MPOOWTTOU Kal 6apwaong 086vng.

1

2
3

TV apyikn 08ovn, matiote > Pubpiceig > KAeidwpa 006vng & acpdAeia >
Avayvwpion TPOCWIToU.

Zek\eldWoTe TNV 086vN cUpPwWVa e T KaBoplopévn uébodo.

YUpete TV emoyn Z0pete yia {ekAeibwpa PeTd TNV 0AoKARPWONG TNG
avayvwpiong mpocwItou Y10 VO EVEPYOTIOINOETE TN AEITOLPYiIaL.

Evioyuon tn¢ Avayvwpiong mpoowiiou
Mmopeite va amotpéPeTe To EeKAEIBWHA TNG CUOKEUNC OO QWTOYPAPIEC, EIKOVES
1 Bivteo.

1

2
3

Yy apyikn 086vn, matriote Pubpioeig > Kheidwpa 086vng & acpdleia >
Avayvwpion TPOoWIToU.

Zex\eldwoTe TNV 086vn clpYwva pe Tnv kabopiopévn uébodo.

la va evepyomoloete T SuvatdTnTa, CUPETE TO PUOUIOTIKO OTNV EMAOYH
Avayvwpion TTPOCWITOU YIa TTPOXWPNHEVOUG

+ HrayxUtnta tng Avayvipiong mpoowrou UMopei va pelwdei otav
gvepyomolinoete autrv T duvatdtnta.
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Avayvwpion @wvig

Avayvwpion @wvnc - NMapouaciaon
Mropeite va ekAeldwoETe TNV 006V XPNOILOTIOIVTAG TN GWVH 0aG.

5

« Autij n SuvatdtnTa pmopei va gival mo uaAwtn 600V apopd Ty acedlela,

o€ oxéan pe ANoUG TPOTOUG KAEIBWHATOG 086vNG, 0mwg To Knock Code, To
Mortifo, 0 Kwdikdg khedwuartog 1 o Kwdikog mpooBaong.

+ Ho06vn umopei va EekAeldwOE( Kat pe pia pwvi mapdpola pe T SIKN oag 1y

HE TV NXOYPAPNHEVN Gwvr} 00,

+ Av éxete emAECeL TV avayvwplon ewvhg wg péBodo kAeWdwpaTog 08ovng,

nipémel va eloayete 1o Knock Code, To Mortifo, Tov Kwdikog KAeldwpatog i
Tov KwdiKog mpdafacng mou XpnolHomoloaTe KAtd TNV KATaxwplon Thg
(QPWVIC 0aG UETA TNV EVEPYOTOINGN TNG CUOKEULNG. Mpooé€Te, emiong, va pnv
Eexaoete TV kaboplopévn TIpn.

Av n ouokeur| Sev avayvwpilel T Guwvry ag r av EexAoETE TV
KaBopIopévn TIHF Yia TNV KATAXWELON, ETMOKEPTEITE TO MANCIECTEPO
Kévtpo e€umnpétnong mehatwv g LG mpookopiovTag Tn CUOKEUN Kal Thv
TAUTOTNTA OOG.

Ta SeSopéva WV TTOU £XOUV avVayVWPIOTEL amoBnKevovTal e Ao@ANEL
OTN CUOKEUN 006,

Mpo@uldéeic yia Tnv Avayvwpion @wvig

H akpifeta tng Avayviplong guwvig Umopei va pelwBei oTic akoAouBeg
TEPUTTWOELG. Ma va au€oete T akpiPela, eENéyEte Ta akoAouba mptv
XPNOILOTIOICETE TN CUOKEUN.

‘Otav WAATE SIAQOPETIKA armd T @WVNTIK EVTOAR TTOU £XETE KATAXWPIOEL

« ‘Otav pihdre og BopuPwdeg mepIBANoOV.
- ‘0Otav n o1r TOU UIKPOPWVOU Eival KAAUMHEVN KE TO XEPL oag 1 GANa Eéva
QVTIKEIPEVAL.

+ ‘Otav n ewvnTIKr VIO Tou €xel KataywpnOei eival ToA obvtoun
(ouvioTwvTag 3 pe 5 GUAAREC).
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Kataywplon @wvnTIKAG EVTOAG
Mp1v xpnolpomoIoeTe Tn AeiToupyia Avayvwplon Quvrg, TPEMEL VA KATAXWPIOETE
TIC PWVNTIKEG EVTONEG 0TI GUOKEUN GO,

1

Yy apyikn 086vn, matriote Pubpioelg > Kheidwpa 006vng & aopdheia>
Avayvwpion @wvig.

5 « [la va XpnolpomoloeTe auTrv T duvatotnTa, Ba mpémel va opioeTe To

5

KAeidwpa 006vng og Knock Code, Motifo, Kwdikog khedwpatog 1 Kwdikog
mpoopacng.

« Av bev éxel oploTei kAeidwpa 086vng, akoAouBRoTe TG 08nyieg atnv 006vn
yla Ty Kataywplon dedopévwv. MNa AeNTopEPELES, avaTpEETE 0TV EvOTNTA
PuBuion kAslbwpatog 066vng.

NatAote EMop. kat EEKAEISWOTE T GUOKELT CUMPWVA LE TNV KABOPIoEVN
uébodo.

Matriote Evapén.

AkolouBriote J Ti¢ 0dnyieg oTnv 086vn yia va KaTaxwpIOETE Mia QWVNTIKY
EVTOM).

+ [eite KABE PWVNTIKN EVTOAR 4 POPEC e KaBapr| Kat Suvath Quvn.

+ KataxwpioTe TI¢ puvnTIKES EVIONEG eV BpioKeaTe O oUYo TEPIBAANOV.

+ DPoVTIoTE 0l PWVNTIKEG EVIOAEG TTOL Ba KaTaywpioeTe va amoteholvTal
amo 2-3 Né€eig (M.x. «<LG Mobile»).

‘OTav n wvNTIKr VIO €xel KataxwploTei, matrote OK. XTn ouvéyela,

€MAECTE WG B XPNOILOTOLEITE TNV AVaYVWPLON GWVAG.

AMayn @wvnTIKAG eVToAig

Mriopeite va aMEEeTe pia 6N KaTaxwpIoHEVN QWVNTIKH EVTOAR.

1

ul B~ wWwN

TV apyikn 086vn, matriote Pubpioeig > Kheidbwpa 006vng & acpdleia >
Avayvwpion ewvig.

Zek\eldWoTe TNV 086vN cUPPwWVa e TV KaBopiopévn uébodo.

Motrote ANayr Owvic.

AkolouBriote § akoloubrioTe Tig 0dnyieg otV 086N yia va kataxwpioeTe
£ava TN WVNTIKNA EVTONN.

‘OTav n wvnTIKr VoA €xel aMGEeL, matriote OK.
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Alaypa@n @WVNTIKAG EVTOARG

Mrmiopeite va SlaypAayeTe pia idn KataywpIoUEVN GWVNTIKH EVIOAN.

T Zmv apxikr 066vn, matiote Pubpioeig > KAeidwua 006vng & ac@dheia >
Avayvwpion @wvig.

7 Zexhalbwote v 000vn cUpewva pe Ty kabopiopévn pebodo.

3 Moatfote Alaypagn Owvic.
+ Y€ QUTAV TV TEPIMTWON, Sev UIMOPEITE Va XPNOIUOTIOIOTE TN AstToupyia

EekheldwpaTog yla KAeidwua pe Avayviplon ewvig.

E « Tla va kataxwpioete Eavd Tn QuVNTIKK EVTOAR apou Tnv éxeTe Slaypdpel,
avatpé€te 0Ty evotnTta Kataxwpion ewvnTikrg EVToANG.

EmAoyn pebodou wvnTIKAG avayvwplong

Mmopeite va emAéEeTe TG Ba XPNOIUOTIOLETE TNV avVayVWPION GWVAG.

T Tty apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & acdheia >
Avayvwpion ewvig.

7 Zexheldwote Ty 000vn cUp@wva pe Ty kaBopiopévn pébodo.

3 Matfote Xpnolpomoleital avayvwpion wvAg.
+ ZeKAeid: ZeKNEIOWOTE T CUOKEUN HEOW PWVNTIKAG EVIOAAG.
- Evepyomoiote tnv 006vn: Evepyomolote T 006vn Uéow QuVNTIKAG

€VTONAC.
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Epgavion touv puBpIoTikoU KAEWdwpatog 006vng HETA TV

Avayvwpion @wvig

Akopa Kt dtav n 086vn 0ag gival oBNnoTH, UMOPEITE VA XPNOIUOTIOIOETE TV

aAVaYVWPLON GWVAG Kat va TV EEKAEIOWOETE XPNOIUOTIOIWVTAG TO PUBHIOTIKO.

1 Zmv apxikn 086vn, matiote PuBpioeig > Kheibwpa 006vng & ac@daheia >
Avayvwpion ewvig.

7 Zekheldwote Ty 006vn cUPQWva pe Thy kaBopiopévn pébodo.

3 ZUpete 10 puBIOTIKG 0TNV emAoyr ZOPETE yia EeKAeIBwHa PETA ThY
avayvwplon Qwvng Y10 VO EVEPYOTIOIOETE TN AsToupyia.

Aerroupyia moAudiepyaaoiag

066vn npoécpatwy Xpioewv
SUPETE TO APXIKO KOUUTTi — TPOG Ta MAVW Kall KPATHOTE TO yia va Oeite To
TIPOOPATO IOTOPIKO XPAONG.

Avaduopevo mapdbupo
Mmopeite va avoifete TOMNEC e@appoyég oTnv 006vn Kal va eVANACOEOTE E0KOAA
QVAUEDA TOUG O€ KAOE OTIyu.
T Z0pete Mpog Ta MAvw 0T0 = Ao TO KATW HEPOG TNG 006VNG.
7 MatioTe T0 EIKOVIBI0 TS EPAPUOYAC OTNY EMAVW APIOTEPH Ywvia TS 086vNng
NG EQappOYNG Kal EMAEETE Avaduopevo mapabupo.
+ AV TIOTAOETE TO €IKOVISI0 TNG EQAPUOYNG, EpPavifovTal oL EMAOYEC
MAnpogopieg epappoyng, MoAam\d mapdbupa, Avadudpevo mapdbupo
kat Kapegito. epap.
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3 Hepappoyn eppaviletal ue T pop@r avadudpevou mapabipou otnv 0Bévn.

E + Autij n uvatdtnTa evééxetal va pnv givat S100€01pn O OPIopEVEG
EQAPHOYEC I 0BAVEC.

Xprion Tou avaduopevou mapabipou
- —:Ehayiotomotei To avaduopevo mapdbupo. To avadudpevo mapdbupo
€ENOIOTOTTOLEITAL OTO AUWPOULEVO EIKOVISIO EPAPHOYAG 0TV 086VN, T omoio
umopei va petakivndei omoudrimote BéAeTe.

« T 1:Enexteivel v epappoyn og mijpn 086vn.

X : Kheivel tv epappioyn.

« M0 va peTaKIvioeTe To avadudpuevo mapdbupo: LUPETE TO EMAVW HEPOC TOU
avadudpievou mapabupou.

+ Mo va puBpioete To péyebog Tou avadudpevou mapaBupou: ZUPETE TV
aplotepn, T 8e€1d N TV KATw MAELPA TOU avadudEvoL TTapabupou.
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5

Mmopeite va avoiete éwg 5 EQAPLOYES XPNOILOTOIWVTAG T avadUSpEVa
mapabupa.

« Tlava emAECETE pia EQapUOYN amd TIC AVOIXTEG EQAPUOYEG, TTATHOTE O€

éva ano ta avaduodpeva mapdBupa. To emleypévo avaduopevo mapdbupo
£pXETAL OTO TIPOCKNAVIO.

« Ta avaduopeva mapabupa Sev umopolv va petakivnBolv atn ypappn

Katdotaong i oty mepLoxr TG Mpappn mMorynon.

Xpnon tou @akélou e@appoywv yia avaduopeva mapabupa
Av matjoete — o070 avaduopevo mapabupo, To avaduduevo mapabupo
€NAXIOTOTIOIETAL OTO EIKOVISIO TNG EQAPHOYNG.

Mropeite va LETAKIVATETE TO €KOViSI0 EQappoyng omoudnmoTe BENeTe, GUPOVTAG

TO.

Eav ehayiotomoinBouv SUo 1 mepioodtepa avadudpeva mapdbupa, Snpiovpyeital
0 QPAKENOC EQAPLOYWV IO VA TIEPIEXEL TA EIKOVISIA EPAPHOYWV.

5

« To &IKoviblo TNG EQapuUoynG TToU xpnatpomoliBnke mpoéoeata

XPNOpOTOLETal WG TO EIKOVISI0 TOU PakéNou Epappoywv. Edv matrioete oto
€1Koviblo, 6Aa Ta €1Kovidla yia Ta ehayloTomolnpéva avaduodpeva mapdBupa
eUpavifovTal 0To PAKENO EQAPHOYWV.

« Edv matrioete mapatetapéva Tov pAKeNo EQapUOoywV yia avaduopeva

TapAbupa Kat CUPETE TOV PAKENO EQAPHOYWY OTNV emAoyn Alaypagn, o
pdKeNog epappoywv Ba Slaypagei.

Mo va SlaypAREeTe pia amo TIC EQAPHOYEC A0 TO PAKENO EQAPHOYWY,
QVOIETE TOV PAKENO EQAPUOYWV KAl CUPETE TO EIKOVIOIO TNG EQAPUOYNE
EKTOG TOU POKENOU EQAPUOYWV.

E181kég Aertoupyieg 52



MoA\amAd mapdBupa

‘Otav XpnOIPOTOIEITE TAOIYNON HE XEPOVORIES

1 Z0pete MPOC TA MAVW 0TO — QO TO KATW MEPOC TG 006VNC.

+ Epgavilovtal ol mpdo@ata XpnolUOTIOINUEVES EPAPOYEC.

+ AV TIATAOETE TO €1KOVISI0 TNG EQAPUOYNG, ERPavi(ovTal ol EMAOYEC
MAnpogopieg epappoyrig, MoAamd mapdbupa, Avaduopevo mapdbupo
kat Kapegito. epap.

7 MatioTe T0 £IKOVIBI0 TS EPAPUOYAC OTNY EMAVW APIOTEPR Ywvia TG
€(pappoyng mpog mpoRolr) oe moMamAd mapdBupa kat emAéETe MoAamAa
mapddupa.

+ HemMeypévn epappoyn Ba epeavioTei 0To mavw Wiod g 08évng.

3 MatAote 0TV AAn epappioyr) o BéAeTe va eugaviletal ota oA\
mapdbupa.

+ HemAeypévn epappoyn Ba peavioTei 0To KATW oo TG 08dvnc.

‘Otav xpnotponolgite morjynan pe Movo Koupmad
1 Natote [ oty yoapun morynonc.

+ Epgavifovtal ol Ipdo@ata XpNnOILOTIOINUEVEG EQAPHOYEG.

AV TIOTAOETE TO €1KOVIBIO TNG EPAPHOYNAE, ERpavifovTal oL EMAOYEC
MAnpogopieg epappoynig, MoAamd mapabupa, Avaduopevo mapdbupo
kal Kapeito. epap.

7 NatroTe To €IKOVIBIO TNC EQAPHOYNC OTNV EMAVW APICTEPY Ywvia TN
£@appoyn¢ mpog mpoPoAr oe ToMam\a napdBupa kat eniééte =,

+ HemMeypévn epappoyn Ba eppavioTei 0To mavw piod tng 0Bévng.

3 Matiote oty G\ gpappoyn mou Béete va epaviletat ota moAMamd
mapdbupa.

E « [0 va TpooapUOOETE To pPéyeBOG Twv TUNUATWY 0Tn Slaywplopévn 086vn,
OUPETE TN YPAUMR 0TO KEVTPO TNG 08dvNg.
« [la va amevepyorolroete Tn Aerroupyia moAMam\wv mapaBupwy, GUPETE TV
KEVTPIKI YR TTPOG Ta TIAVW 1 KATW WG TO TENOG TG 086vVNC.
+ H duvatétnta moMamwv mapabipwy Sev umooTtnpileTal amé oplopéveg
£QappOYEC LG 1y amod epappoyEg mou kateBadete amo To Play Store.
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AOD (Always-on Display)
Mmopeite va Seite TNV nuepopNVia, TNV WEA 1 TNV UTIOYPAPY OTAV N KEVTPIKN
066vn givat opnotr.
YUpETe To KATWw PEPOG TG 086vn¢ Always-on Display yia va evepyomolroete
\erroupyieg OTwg N kapepa, To Capture+, To Wi-Fi, ot puBuioeig ixou, To Bluetooth®,
TO GAAC, N LOUCIKN Kat AN
T Zmnv apyikr 066vn, matriote PuBpioeig > MpoPoAr > AOD (always-on display).
7 EmAé€te ty eikdva mou BéleTe va epgaviletal kat atriote AmoBRKeuoN.

+ Ayyi€te Tnv emBupnTr €kdva avapecsa oto Yn@lako pohot, Avaoyikod
POAOL, AmAG polol, Yroypagn, HuepoAdyio, 1 Eikova.
YUpete TV emoyn MpryopaEpyaleia & mpodypappa avamapaywyng
HOUGIKAG Yl va TTATHOETE TA EIKOVISIA KATAGTACNC YIa Ta EpYaAEia
YPYOPNG EKTUTIONG KAl TO TIPOYPAUHA avamapaywyrg HOUGIKAG.
Mo va opioete TN xpovikr epiodo viog Tng omoiag Sev Ba evepyoroleital n
Suvardtnta Always-on Display, matrjote KaBnpepivo 6pto Miéng.

+ Tla va evioyUoeTe Tn QuTevotnTa yia tn duvatétnta Always-on Display,
emAé€Te Mo pwtevry 086vn.

E + H pmatapia evdéxetat va eavtAnBei ypnyopoTepa £V XpnOIOTOIETE TN
Aertoupyia Always-on Display. Amevepyormolrjote autrv T duvatdtnta yia

va e€olkovoprioeTe Sidpkeia {wiig TG pmatapiag.

la va amevepyomolroete T Aertoupyia Always-on display, otnv apxikr

0086vn matrote PuBpioeig > MpoPoAr > AOD (always-on display) kat otn

ouvéyelamatiote @).
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Quick Help

Mriopeite va Seite Ti¢ MAnpoopieg BoriBelag OXETIKA HE Ta KUPLO XAPAKTNPLOTIKA

TNG GUOKEUNG KA VOl QVATPEEETE OTIC GUXVEG EPWTNOELS 1} TO EYXepidlo Xpriong.

Mriopeite va avalntrioete mAinpogopieg Le xprion Aégewv-kAeidiwv. Mmopeite va

QMOKATAOTHOETE VKO KABE TMPAPBANLa TTou Ba TPOKUYEL £xovTag ameubeiog

EMKOWVWVIa LE Evav EI8IKO.

T Zmv apxikn 066vn, matiote Quick Help.

7 Avalntiote minpogopieg BoriBelac eioaydyovtac Me€eic-kheidid oto medio
avalitnong.

E + Auti n Aettoupyia evnuEPWVETAL TIEPIOSIKA CUNPWVA E TA OXOMA TOU
Xenom.
+ Ta dabéotpa oTolyeia pevol evoéxetal va Slagépouy, avahoya HE TV
TIEPLOXN 1 TOV TTAPOXO UTINPECIWV.
« a AemTopEPEIG TANPOPOPIES OXETIKA LIE TIG AEITOUPYIES TNG CUOKEUNG,
avatpé€Tte oTo eyxelpidlo Xprotn online amo v epappoyr Quick Help.

INHEIDOELC Yia TIG IBI0TNTEG AVTOXNHG OTO
VEPO

AuTO TO TIPOIOV €ival AVBEKTIKO 0T OKOVN KAl TO VEPO, CUMPWVA e TO Babuo
npootaciag ané elcxwpnon IP68.

To mpoiov oag éxel uoPAnBei oe eENéyxoug o€ eEAeyxOpEevO TiEpIBAANOV Kalt Exel
amodelyTel 0Tt gival avOEKTIKG 0T OKOVN KAl TO VEPO OE GUYKEKPILEVES GUVONKEG
(m\npoi Tig amartioeig e Katatagng IP68 cupewva pe To Siebvég mpoTumo

IEC 60529 - BaBuoi mpootaociag mapexopevng amo mepipAipata [Kwdikog IP].
TuvOnkeg ehéyyou: 15-35 °C, 86-106 kPa, 1,5 p€Tpo, yia 30 Aemtd). Mnv ekBétete
GUOKEUN 0€ SlaQOPETIKEG OUVBNKEG amd TIC SUVONKeG eNéyxou. Ta amoteréopata
evoéxeTal va S1apEPOUV KATA TV TIPAYHATIKY XPron.
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A MPOEIAOMNOIHEZH

Mapd v katnyoptomoinon IP68, n cuckeur oag dev eivat adlaPpoxn o€ CUVONKEC
mou Sev £xouv eheyxDOei oe eheyxopevo mepiBahov Tng LG. AdBete umoyn ot
TUXOV BAAREC TTOU €xouv IPOKUYEL amd TéTolou eiboug ouvBrikeg, ahalouwv To
xpwua tou LDI (Liquid Damage Indicator). Av to xpwpa tou LDI ou Bpioketat
€VTOG TOU TIPOIOVTOG aANAEEL, To Tpoidv Ba mpémel va BewpnOei akataMno yia
I SWPEAV UTINPEGIEC ETIIOKEVIG TTOU TIOPEXOVTAL CULQWVA LIE TNV TIEPIOPIOUEVN
€yyUnon Tou mPoIGVTOG,

Amo@elyeTe TV ékBeon Tou mPoiovTog oe mepIBdAovTa pe umepBolikr okdvn iy
uypaacia. Mnv xpnotporoleite To mpoidv ata mapakdtw mepiBdiiovia.

Mnv Bubiete To TPOIOV O€ LYPA XNMIKA (CATTOUVL KAL) EKTOG Ao vePO.

Mnv BubileTe To mMPOidv o€ aAaTOUXO VEPO, CUUMEPIAALBAVOUEVOL TOU
Balaootvol vepou.

Mnv Bubilete To TMPOIOV 0€ BEPPES (IAUATIKES) TINYEC.

Mnv koAupmdte padi pe autd To mpoiov.
Mnv tomoBeteite 1o Mpoidv ameubeiog mavw oTnv Appo (dmwg m.y. o€
napadia) iy otn Adomn.

Mnv BuBilete To mpoidv og vepod Pabouc mavw amd 1,5 pétpo mepimou.
Mnv BuBilete To mpoidv o€ vePo yia SidoTtnpa peyalutepo amd 30 Aentd.

RO®WOD®®

+ Av 10 TTPOIdV Bpayel, OKOUTTIOTE TO MIKPOPWVO, TO NXEIO KAl TO OTEPEOPWVIKO
Boopa pe éva oTeyvo mavi mPOToU TO XPNOLUOTIOIOETE.

« Av 10 TTPOIdV A Tal XépLa 0ag BPayoUV, OTEYVWOTE Ta TTPOTOU XEPIOTEITE TO TIPOIOV.

MnV XPnGIHOTIOLEITE TO TIPOIGV O PPN OTIOU UMOPE VAl TITGINOTEI e VEPO

uPnAng miieong (m.x. kovtd og Bpuon A TNAEPwVO vToug) Kat unv to Bubilete oe

VEPO YIa TIOPATETAREV XPOVIKA SlooTrpaTa, KaBwg Sev éxel oxedlaoTei yia va

QVTEYEL O€ VEPO Ue YN TiEon.

AuTd T TTPOiOV Sev eival avBEKTIKO OTIC KPOUGELS. Mnv piXVETE TO IPOIOV KATW Kall

unv to umoPBANAETE O KPOUOEIC. H KUpla povada evaéxeTal va umooTei {nud 1 va

TapauoP@wBE kat va mpokAnBei Siappor) vepou.
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+ O18uvaTOTNTEC AVTOXG TOU TTPOIGVTOC 0T GKAVN Kall TO VEPO evEXETal va

uroadpiotolv Adyw mTwong 1 KPoUoNG.

Av 10 ipOidV Bpayei, xpnotpomoroTe éva KaBapd, Lahako mavi yia va To

OTEYVWOETE OXONAOTIKA.

+ Ho06vn a@r¢ kat AMeg SuvatdtnTeg evEEXETAL va pnv AEITOUpYoUv WOoTd, av n
GUOKEUN XpnotpomoinBei evw eivat Bpeypévn.

+ To mpoidv eival avBekTikd 0To vepo pdvo dtav n Bkn KapTag SIM/pvAung éxet
TomoBeTnOei owoTA Péda OTO TTPOTOV.

+ Mnv avoiyete/kheivete T OrKn Kaptag SIM/uvANG eV T TPOIGV eival Bpeypévo

1} BuBiopiévo o vepo. H ékBean Tne avoixTric Brikng o€ vepo 1y uypacia evoéxetal

va ipokahéoel BAGBN 0To mPoiov.

H 6rjkn ¢ kaptag SIM/pviping mepléxel KaoUTooUK [cuoKevaoial, yia va

unv €16ENBEL OKOVI, VEPO 1) LYPasia 0To TIPOIOV. My ipoKaléoeTe (npitd 0To

KaoUToOUK [ouokeuaoial], kabBwg £Tol pmopei va 10éABEL KOV, VPO 1y uypacia

07O TPOIOV Kalt va TPOKANBEei {nptd.

A + Av bev aKoNoUBNOETE TIG TaPEXOUEVES 0ONYiES, EVOEKETAI VA KATAOTEL

AKUPN N TIEPLOPLOPEVN EYYUNON TNG CUOKEUNG.

« Edav n ouokeun ivat vypr), ToTe 10 LDI H€oa 0Tn CUOKEUN METATPEMETAL
0€ XpWHA. Z€ AUTAV TV TIEPIMTWOT, N GUCKELN Oev eival EMAESILN yia
omoleaSAMOTE UTNPETieg SwPEAV EMOKEUNC TTOU TapéxovTal BAocel TG
TIEPIOPIOUEVNG EYYUNONG TNG OUOKEUNAG.

« TMapd t Babuoloyia IP68, n cuckeun oag Sev gival EVIENDG KATAXPNOTIKN
Y10 TO VEPO OE OMOIadHTIOTE KATAoTaON.
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E€aptiparta kat a§eocovdp Tou mpoiovtog

Ta mapakdtw otolyeia mepNapBdvovTal 0Tn GUOKEUH GO,

+ ZUoKeun + QopTioTAG
+ ZTEPEOPWVIKA OKOUOTIKA + 08nydc ypriyopng ekkivnong
+ KaAwdio USB + Kapeitoa e€aywyng

A .

Ta oTolygio Tou TePIypAPoOVTal O TAVW MITOPEL VAl Eival TIPOAIPETIKG.

Ta oTolyEl0 TTOU TIAPEXOVTAL ME T OUOKEUH Kat Tuxov Slabéaipa agecoudp
umopei va SlapéPouy, avaloya UE TV TTEPLOXT KA TOV TIAPOXO UTTNPECIWV.
Na xpnotporoleite mavtote yviola ageooudp LG Electronics. H xprion
a&eooudp ANWVY KATAOKEUAOTWY EVOEXETAI VOl ETTNPEACEL TNV amoS00n
TwV KAOEWV 0TN OUOKEUN 00 1} va TIPOKAAETEL TIPOPAfaTA KATA TN
Aertoupyia. H emokeur) evog Tétolou mpoBAHaTOg EVOEXETAL VA PV
KAAUTITETAL QMO TNV UTINPEDIA EMOKEVWY TG LG.

+ MepIKd amo Tal PEPN TNG CUOKEUNG £XOUV KATAOKEUAOTE( OO EVIOUUEVO

YUoi. EGv n cuokeur| oag méoel mavw G€ pia okANpr emM@Avela i
TIPOOKPOUGEL KATTOU e SUvapn, umopei va mpokAnBei {nwud oto
OKANPUHEVO YUONL. Z€ QUTHV TV TTEPITTTWOT, SIAKOYTE AUECWGE TN XProN TNG
OUOKEUNG KAl EMKOWVWVAOTE e éva Kévtpo e§umnpétnong mehatwv tne LG.

« Edv Aeimel omolodrmote amd autd Ta BaCIKA OTOIXEID, ETMKOIVWVIOTE UE TOV

aVTITPOOWTIO Amd TOV OTI0I0 AYOPACATE TN CUCKEUH.

« Tava ayopdoete mpooBeta oToIKElD, EMKOIVWVAOTE pE éva KEvipo

e§unnpétnong mehatwv Tne LG.

+ Oplopéva atolxeia mou mepIAapBavovTal TN GUOKEUAGIO TOU TIPOIOVTOG

evoExeTal va aMd&ouv xwpig mpogidomoinon.

H gpgpavion Kat ol mpodiaypagEg TG CUOKEUNG 0ag evoéxetat va aldgouv
Xwpic mpogidomoinon.

O1mpodiaypa@ég TG GUCKEUNG EVOEXETaL va Sla@épouy, avdhoya pe TV,
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.

AQQIPEDTE TNV IPOCTATEUTIKK LEUBPAVN amd Tov aiobntripa AaKTUA.
ATIOTUTIWHATA TIPOTOU XPNCIHOTOICETE TN AEITOUpYia avayvwpiong
AakTtul. AoTuniwpaTa.
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Emokoénnon otoygiwv

LED Adptreg 1 s Mikpopwvo
.
AigbnTrpag AKouoTIKO
£yyUuTNTAG/QWTIGHOU ) ,
TrepIBaAAovVTOg &CLKE%% Errpocmvr]g
MAAKTPa évtaong rxou (+/-) -I: e loyogMAiKTpo
KAEIBWHATOG
MAAKTpo Google Assistant —s| 086vn aeng

YTT080x1 OTEPEOPVIKWV

Oupa gopTioTr/KaAwdiou
OAKOUOTIKWY usB

—
=\ YTodox1 KapTag

®hag T 4 © SIM/pvARNG
Autépartn eotiaon pe $) :H_|_, Dakodg Tow KapePag
avixveuon AéiCep ©
AioBNTAPAG SAKTUNKWY — @
ATTOTUTTWHATWY grmmm e e \
Mepioxr Kepaiag ——- ,'—— Mepioxr) NFC
acUpparng eopriong i :
Hyxeio — 1 | S Mikpodowvo
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A Mnv EMXEIPOETE VO APAIPECETE TO TMOW KAAUHAL.
AuTtr n ouokeur S106¢Tel pn agaipoUpevn pratapia. Mnv emixelprioeTe
VO 0QAIPECETE TO TTIOW KAAUPHOL. Z€ SIOPOPETIKN TTEPIMTWOTN, EVOEXETAL VA
umooTei copapr} {nuid n umatapia Kat  GUCKEUH TTou pmopei va 06nyRoeL og
unePBEpUAvVON, TUPKAYIA KA TPAUUATIOHO.

+ Alobntrpag eyyUtnTac/Qwtiopou mepiBAAhovTog
- AeBntpac eyyutnTac Katd tn Sidpkela pag KAong, o aiodntipag

€yyUTNTOG amevepyoolei Tnv 086vn Kat T duvatdtnTa agrg, dtav

1 OUOKEUN| BPIOKETAI OE MIKPT) ATOOTACN A6 TO WA TOU XPHROTH.

Evepyorotei Eavd tnv 066vn Kat T SuvatdtnTa agrg 6Tav n GUOKEUN

Bpioketal £€w amo P CUYKEKPIEVN EUPENELD.

AloONnTHPAg PWTICHOUL TTEPIBANOVTOC: 0 AIOONTHPAG PWTICHOU

TIEPIBANOVTOC AVAAUEL TNV €VTAON TOU QWTIOHOU TEPIBANOVTOC OTav €ival

EVEPYOTTOINEVN N AEITOUPYIC AUTOHATOU EAEYXOU QUITEIVOTNTAG.

« Autouatn gotiaon pe avixveuon Aéilep
- AviyveUel Tnv amooTaon Tou BEUaTtdc oag amod T KAKEPA yia QUTOHATN

eotioon.
- Eotiadel ypriyopa o€ KOVTIVA 1} HAKPIVA QVTIKEIMEVA OTAV XPNOIOTIOLETE TV
oW KAPEPQ yIa TN AYN GWTOYPAPLWY.

« TARKTpa évtaong xou
- Mmopeite va TpOoCapUOCETE TNV €VTAON TwV AXWVY KAONG, Twv KARCEWY iy

TwV €I60TOINOEWV.

Evw XpnOIUOTOLE(TE TNV KAPEPQ, TIATAOTE AMaAd KATIOLO amd Ta MARKTPA

€vTaong fXoU yla va TPAPREETE pia pwtoypaepia. MNa ouvexeic AMyelg, ayyi€te

KOl KOATAOTE TO MARKTPO €VTaong fixou.

- TMatote 10 MAAKTPO MEIWONG TNG €vTaong Xou (-) S0 PoPEC yia va
EKKIVIOETE TV £pappoyn Kapepa otav n 0Bévn ivat KAeilbwpévn 1y
amevepyorolnpévn. Matote To MAAKTPO avgnong g évtaong fxou (+) dvo
(POPEC Y10 VA EKKIVAOETE TNV @appoyr Capture+.
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+ loxu¢/MARKTPO KAEWSWHATOC
- Matiote ouvtopa 1o MAKTPO GTav BENETE Va EVEPYOTIOINOETE 1 va
QTEVEQYOTIOINOETE TNV 080VN.
- Matiote T0 MARKTPO TAPATETAMEVA OTAV BENETE Va EVEPYOTIOIOETE A
emAoyn e\éyxou Aettoupyiag.
- TARktpo Google Assistant
- H ouokeun oag éxel Tov BonBd Google evowpatwpévo. Bpeite anavtioelg
Kall Kave mpaypata otny mopeia. Na va Eekvioglg, amid mara 1o kA&
BonBd¢ Google atnv mieupd Tou TNAewvou. Mdta kat kpata o KAed{ yia
va MARCELS ypriyopa pe Tov BonBd cou. MNdta §Uo gopég yia va avoitelg To
Google Lens.
- Evepyomojote 1o Google Assistant. Ae¢ 1o Google Assistant yia
NEMTOPEPELEC.
+ Alebntpag AakTtul. Amotumwpata
- EvepyomoioTe tn Aettoupyia avayvwpiong AakTul. ATOTUTIWHATA Yia Val
amhorotrjoete T Siadikacia EekAeldwpatog T 086vne, Ma Aemtopépeteg,
avaTpéTe oTnV evotnta Avayvwplon Aaktul. Amotunwpata - [apouvoiaon .

5 + Avahoya pe TIG IPoSIaypapEg TG CUCKEUNG, EVOEXETAL VA UNV EMITPEMETAL N
TIPOOROCN O OPIOEVEG NEITOUPYIEG,

+ XT0 miow PéPog, n ouokeun S1abétel pa evowpatwpévn kepaia NFC. Na
€[0TE IPOOEKTIKOI KATA TOV XEIPIOUO TNG OUOKEUNG WOTE VA AMOPUYETE TV
mpdkAnon BAARNG otnv kepaia NFC ) tv kAU TG,

+ Mnv TomoBeteite Bapld avTIKEipEVA TTAVW 0T CUOKEUN 1} v KABeoTe Mavw
0€ QuTrVv. X avtibetn mepimwon, umopei va mpokAnBei BAGRN atnv 08évn
apnc.

« Hxprion mpootateuTikig MepBpdvng 086vng iy agecoudp evdéxetal va
TipoKaAéaouv apePBOAEG aTov alobnTripa eyyoTnTag.

+ Edv n ouokeun oag gival bypr 1| XpNOILOTIOLEITAL O€ UEPOG E LyPacia, N
086vn 1} Ta Koupmd agrg evoéxeTal va unv Aeltoupyolv owoTd.
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MidoTe GWOTA T GUOKELN, OTIWE PAIVETAL TTAPAKATW. AV KAAUTITETE TV

OTT HIKPOPWVOU HE TO XEPL, TO SAXTUAO 1y TNV IPOCTATEUTIKY Brikn 6Tav
XPNOUIOTIOLEITE Tr) GUOKEUN|, MTOPEL Va NV akoUyeTal KaBapd n @wvr 0ag Katd
S1apkela TG KAjone.

ZwoTd AdBog
e, S SIS

Mnv KaAUTITETE TO PIKPOPWVO.

Mikpdowvo
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Evepyomnoinon 1) anevepyonoinon

Evepyonoinon
‘OTav n OUCKEUN Eival ATIEVEPYOTTOLNEVN, TIATAOTE TTAPATETAUEV TO TTARKTPO
evepyomoinon/KAEIOWHATOG.

5 + 'Otav n oUOKEUR evepyomolLEiTal YIa TTPWTN POoPA, TTPAYUATOTOLETAL N
apxikn Slapopewon. H mpwtn ekkivnon tou smartphone evééxetal va
Sl0PKETEL TTEPIOOOTEPN WPA ATTO O,TL CUVIHBWG.

Amnevepyomoinon
MotAoTe mapaTeTapéva To MARKTPO AEIToupyiag/KAEISWHATOC Kat EMAEETE
Anevepyoroinon.

Emavekkivnon tng 6UoKeURG

‘Otav n cuokeur 6ev AeITOUPYE OWOTA ) GV AVTATIOKPIVETAL, EMAVEKKIVAOTE TV

aKoAoUBWVTAC TIG TAPAKATW 08nyieC.

T Notote kat kpatoTe mATNPEVO TO MAAKTPO EVEPYOTIOINONG/KAEISWUATOG
KOl TO MARKTPO MEIGCNG TNG £VTAONG X0V (-) TAUTOXPOVA LEXPL N GUOKEUN Val
amevepyomolnOei.

7 ‘Otav n ouokeun emavekkivnBei, aprioTe Ta MAAKTPA.

EmMoyéc eAéyxou Aettoupyiag
MatAoTe MapaTETAUEVA TO TARKTPO AeIToupyiag/KAESWUATOC Kal eMAEETE, 0N
GUVEXELQ, EVEPYOTIOINOTE LI ETMAOYH.

- Amevepyomoinon: ATievepYOTTOLEl T CUOKEUN.

+ Amevepyomoinon Kat EMaveKKivnon: EMaVeKKIVEL T OUOKEUH.
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Elcaywyn kaptag SIM kat Kaptag pvipung
Eloaydyete ot cuokeur) TV kapta SIM mou éxete mpopnOeuTei amd Tov mapoxo
UTINPECIAV KIVNTAG TNAEPWVIOE KOl TV KAPTA VNG TTOU £XETE ayopAoEl
Eexwplotd.

E « @ va givat n oUOKELT 00C AMTOTENEGUATIKA TTPOOTATEVEVN amtd TO VEPS Kal
TN oKOvn, Ba mpémel va TomoBeTeiTal owoTd n Brikn KAapTag,

T TomoBetiote TV Kap@itoa e§aywyrig oTn omr Tiou Bpioketal oTnv umodoxr
NG KAPTAG Kat émerta Tpar&te Tn Brikn T¢ kapTag mpog Ta é§w.

7 TomoBetriote T kdpTa SIM 1§ TV KAETA PvRAUNG 0T BAKN TG KAPTAG Kat
omPWETE TN BrKN AN Héoa 0T CUOKEUN TTIPOG TN (OPdA ToU BENOUC,

) Kapra pviung
(TTWAEITaI §EXWPIOTA, TIPOAIPETIKA)

Kapta SIM

3
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E .

Autr n ouokeur umooTnpilel povo Kapteg Nano SIM.

Nano Micro Kavovikn

o @

« Ta amedoon Xwpic MPoBAUATA, CUVIGTATAL VA XPNOILOTIOLEITE TO

TNAEQWVO HE ToV owoTd TUMO TG kdpTag SIM. Na xpnotuomoleite mavTa pia
£PYOO0TAOIAKI KAPTA SIM TOU TTAPEXETAL OO TOV TIOPOXEX UTTNPECIWV.

+ Mnv xdoete v kapta SIM. H LG Sev pépel kapia euBovn yia PAABES kat

AaMa ripoBArjuata mou mpokaAouVTaL aré TV anwAELd 1 T petaBifaon tng
Kaptag SIM.

Katd tnv eloaywyn A tnv agaipeon tng kaptag SIM mpénel va iote
TIPOCEKTIKOI yla val Unv mpokAnBei {nuid.

'Otav eloaydyete v kdpta SIM A TNV KapTa PvApnG, TomoBETAOTE TNV
0woTd oTn Brikn kdpTac,

'Otav eloaydyete T OrKkn kdptag avd otn cuokeur, TomoBeTHoTE

v op1lévTia PG TV KateuBuvaon tou BéNoug, driwg amelkoviletal.
BeBaiwBeite oTi n kdpta mou €xel TomoOeTnBel 0T Brikn KapTag dev éxel
@UyeL am6 T Béon TG

+ TomoBetriote TV kApTa SIM PE TIG XPUOEC EMAPEC OTPAUHEVES TTPOG Tal

KATW.

+ BePaiwBeite 6Tt dtav Tonmobeteite TV kdpta SIM 0Tn GUOKELN, akoAouBeite

TIG 08nyieg 0To eyxEIPISIO XPrioNnG.

« ‘Otav TomoBeTeite 1 apalpeite T OrKn KAPTAG AMd TN GUCKEUT, TPEMEL Val

TIPOGEXETE VA PNV TIEPACEL VEPO 1} AN LYPA Péoa aTnv umodoyn KapTag.
Eav n Brikn Kaptag 1 n kapta mou Ba TomoBEeTHOETE 0T GUOKEUH €ivat uypr),
TOTE eVEXETAL VA TTPOKANBEL (LA 0T GUOKEUN GG,

+ HKapta pvApng gival TPOAIPETIKT.

H ouxvi eyypaen Kat dlaypa@ri Se5opévwv pmopei va UEoEL Tn SlapKELa
QWG TNG KAPTAG UVRAHNG.

OpIOPEVEG KAPTEG LVAKING MITOPET VAl LNV €ival TARPWE CUMBOTES ME TN
ouokeur. H xprion piag pn cupBatrg Kaptag umopei mpokahéoel BAARN g
GUOKEUNG i} TG KAPTAG pvApNG, 1 va KataoTpéPel Ta dedopéva mou gival
amoBnKeupéva o€ AUTHV.
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A@aipgon TG KAPTAG UVIUNG

la AOyouc ao@aleiag, amevepyomoloTe TV KAPTA UVAKING, TIPV TNV AQAIPEDETE.

T Zmv apxikr 066vn matriote PuBpicelg > AmoBnKeuTIKOG XWwpog >

7 TomoBetriote T kap@itoa e€aywyng otnv omr mou Bpioketal oTnv umodoxn
NG KApTag Kat émetta TPAPAETE TN BrKN TG KAPTAC TTPOE Ta £§W.

3 AQaIpéoTe TNV KAPTA PVAUNG amé Tn Brkn KapTag.

/A Emotpéyte Ty umodoxn TG KAPTag oTnv apyIkn g B£on.

A + Mnv agaipeite TV KAPTA PVARNG, EVW N CUOKEUN HETAPEPEL 1} XPNOIHOTIOLE!
Sedopéva. Mmopei va mpokAnBei amwAela iy KataoTtpogr dedopévawy, i
BAGPN TG KApTAG PVAHING 1 TG ouokeunc. H LG dev euBuvetar yia amwAeleg
TIOU €ival amOTENEGHA KAKNAG ) AKATAANANG XPONG TWV KAPTWV UVAKNG,
oupmeptAapBavopévng tng anwAelag SeSopEvwy.

Mnatapia

Odption TN prarapiag
TPV XPNOILOTOICETE TN GUOKEUN, POPTIOTE APWE TNV UraTtapia.
Oopriote T ouokeun e To Kahwdio USB tumou C.

Akpodéktng KaAwdiou
dopTiong
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A + Mnv ouVOEETE TN GUOKELT O EEWTEPIKO TEPUATIKG, KAAWSIO POpTIoNG I Tav
umdipxel ypacia. Yapyet Kivouvog mupKayldg, NAeKTpomingiag, TpaupaTiopoy
1 BAABNG TNG CUOKEUNG, Z€ TIEPIMTWON LYPATIOG, OTAUATHOTE APECWG Va
XPNOIUOTIOLEITE Tr) CUOKEUN KAl AMOPAKPUVETE Tal OTOIKEID uypaoiag.

+ Opovriote va xpnotpomoleite 1o KaAwdio USB mou mapéxeTal Ue T GUOKEUN

00G.

+ Na xpnoluomolgite TAvTa QopTIoTH Kal KAAWSIO0 GOPTIoNG o €xouv eyKpIBEi
a6 Ty LG. H @6pTion TG umatapiag Le opTioTr TPITOU KATAOKELAOTH
umopei va mpokahéael €kpnén TG umatapiag i PAGAN otn cuokeur.

H ouokeun oag Stabétel eowtepikr emavagopti(opevn pmatapia. Ma ikr oag
ACPANELD, NV APAIPEITE TNV EVOWUATWHEVN MITaTAP{a.

Y€ MEPIMTWON XPONG TG CUCKEUNG EVW aUTH PopTilel, evaéxeTal va mPokAnBei
nAektpomAngia. MNa va XpnoIHOTIOICETE TN GUGKEUK, CTAHATHOTE T QOPTION.

E « AgaipéoTe Tov popTioTr amd Ty mpila agol oAokAnpwBEi n pdpTIon TG
OUOKEUNG. ETOL amoTpémeTal N AOKOTTN KATavAAwon EVEPYELQG.

+ Madi pe o mpoidv mephapBdveTal évag TPosapHOYEAS POPTIONG TTOU
umooTnpiCeL T ypriyopn @opTIon.

+ HAerroupyia Tayeiag opTiong pmopei va unv Aeitoupyei eav
XpnotpomolnOei GAANOG TPOCAPHOYEAG POPTIONG EKTOG TOU YVIGLOU
TIPOOAPLOYEX TIOU GUVOSEVE TO TIPOIOV.

+ 'Evag GAoG TpOTog Yia Va pOPTICETE TNV pratapia gival va ouvoEceTe
€va KaAwS10 USB peta&l tng GUOKELNG Kal evog emtpamédiou 1 gopntol
umoAoyloTh. H evépyela auTr| Umopei va ival TEpIocoTEPO XpovoRdpa amod
TN QOPTION TNG PmaTapiag o€ emroiyia mpila.

+ Mn gopriete Ty umatapia xpnotpomoiwvrag USB hub mou Sev
Suvarat va Slatnprioet atabepr| TNV ovopaoTIKn Téon. Eviéxetat va unv
mipaypatomoinBei popTion 1 va Slakomei.

Mpogulagerg katd ™ Xprion TNG GUCKEUNG

- BeBawwBeite oTt ypnopomoleite To mapexduevo Kahwdio USB. Mnv
Xpnotpomoteite kKaAwdia USB 1j popTIOTEG TPITWV KATAOKEUAOTWY HE TN
OUOKeUN 6a¢. H meplopiopévn eyyunon e LG Sev KaUTTel T Xprion
a€e00UAP TPITWY KATAOKEUAOTV.

Tuxdv aduvapia Thpnong Twv odnylwv mou mepthapBdvovTal oTo mapdv
€YXEIPIBI0 Xpriong Kat n akatdANAN Xprion eVEEXETAL VA EXOLV WG ATTOTENECHA
v mpdkAnon PAAPNG 0Tn GUOKeUH.
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Acuppatn @opTtion
H ouokeun umootnpiel tn Suvatdtnta acvppatng eopTions. GopTioTe T CUoKeUN
HE Evav EYKEKPIUEVO aoUppaTo @opTioTh Qi (MTPOAIPETIKE, TTWAEITAL EEXWPIOTA).

Doption pmatapiog pe acUPPATO POPTIOTH

T TomoBeTAoTE TN GLUOKELY| GOC OTO KEVTPO TOU A0UPHATOU POPTIOTH, £T0L WOTE
n Kepaia acupPATNG PAPTIONG OTO THOW MEPOG TNG OUOKEUAG KAl O POPTIOTAG
va gival eubuypappiopévol.
« Nava Bpeite v ePPENeLa TG KEPAIAg AoVPHATNG POPTIONG, AVATPEETE

OTNV eVOTNTA ETIOKOTTN 0N OTOIKEIWV.

7 'Otav n umatapia QopTioel MARPWC, aPaIPEDTE T CUOKEUN amd TOV POPTIOTH.

A .

‘Otav popTiete TNV pmatapia uéow acUPUOTOU YOPTIOTH, LNV TOMOOETEITE
MayvNTIKG, METAANIKA 1} GNAQ ay@yipa UNIKG QVAPEST 0T CUOKEUN Kal ToV
QOPTIOTH, KABWE auTd evOéxETal va Snuioupyouv MapeUBOAEG 0T @opTIoN
TNG GUOKEUNG KAl 0 POPTIOTHG Hrmopei va umepBeppavBei. L& autriv Thv
Tiepimwon evéxetal va mpokAnBei BAARN oTn GUOKEUN, TOV QOPTIOTH 1 TIG
Kapteg SIM/pvApne.

+ Avn Beppokpacia tng umatapiag unepPei 1o kaBoplopévo Oplo Katd Tn

SIAPKELD TNG POPTIONG, N POPTION EVEEXETAL VA OTAUATHOEL.

+ Av 07O TTioW PEPOG TNG CUOKEUNG EXOUV TTPOCAPTNOE! MayVNTIKG, METOANKA

1 AA\a aywypa oTolxEla, fi TPOOTATEUTIKY BrK), TOTE N GUOKELT EVOEXETaL
Va Unv @opTiCeTal Kavovikd.

+ Edv @optileTe TV pmatapia pe acUPUATO YOPTIOTH OE TIEPLOXEG OTTOU N

100G Tou orpaTog SIKTUOU €ival XapnAr, n anmddoon SIKTUOU 0T CUOKEUH
0ag evOEKETal VA HEWOE] TTEPAITEPW.

+ DoPTIOTE TN CUOKEUN LE €Vav EYKEKPIPEVO acUppaTo @opTioTh Qi

(mpoatpetika, mwheital EexwploTd). H meplopiopévn eyyonon e LG
Sev KANUTTTEL TN XPr 0N a§EoUdp TPITWV KATAOKEVOOTWV. Mol TuyOV
TIPOPAHOTA, EMKOWVWVIAOTE UE TOV EKAOTOTE KATAOKELAOTH.

+ Autd to mpoidv umooTnpilel acuppatn eopTion. PopTioTE TO MPOIGV

JE évav aoUpUaTO YopTIOTH pe motomoinon Qi (MwAeital Eexwplota).
OplopEVOL EVOUPUATOL POPTIOTEG EVOEXETAL VA UNV uTTooTNPi(ouV acupuaTh
@option. Ot acUppatol popTioTé mou umoatnpiouv EPP (Extended Power
Profile) emtpémouv tnv acuppatn @opTIoN VYNANG TaxUTNTAG.

H meploplopévn eyyonon e LG dev kaAUmTel T xprion a&ecoudp Tpitwv
KATAOKEVAOTWV. [a TUXOV TTPOPAALATA, EMKOIVWVAOTE HIE TOV EKAOTOTE
KOTAOKEVAOTH).
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Amnoteleopatiki Xprion Th¢ umatapiog

H didpketa {wng TnG Umatapiag Umopei va UelwBel av 0Tn GUOKEUR eKTENOLVTAL

TIOMNEG EQAPLIOYEG Kall AEITOUPYIE TAUTOXPOVA KAl OUVEXWG.

Ma va auvénoete tn Sldpkela (whg TNG Umatapiag, TEPUATIOTE TI AEIToupYieS Tou

EKTENOUVTAL GTO TTAPACKAVIO.

Mo va ENaKIOTOTOINOETE TNV KATAVAAWON TNG LoXVOE TNG Umatapiag, akohoubnote

TIC TAPAKATW GUUBOUAEG:

Na amevepyomoleite tn Suvatotnta Bluetooth r Siktuou Wi-Fi dtav ev Tig

XPNOIUOTIOIE(TE.

PuBpioTe To XpoviKo 6plo TNG 006vNG 0TN KIKPATEPN SuvaTh TIur.

+ PuBpiote T QwtevotTa TG 086VNG 01O EAAXIOTO.

EvepyomoirioTe To KAeidwpa TG 006vng OTav Sev XPNOILOTOIETAL I GUCKEUN.

+ ENéy&Te Tn 0TdBun pmatapiog evw XPnOIUOTIOLETE EQAPHOYEG TTOU EXETE
KateBAceL.

006vn apni¢

Mriopeite va e§oikelwBeite Pe TOV ENeYXO TNG CUOKEUAC GAG XPNOILOTOIWVTAG TIG
KIVI|OEIG TTOU UMTOPE(TE VA KAVETE e Ta SAKTUAG 0aG 0TV 086VN aprG.
Matnpa

Motrote eENappd 1o SAKTUNS GaC yia va KAveTe pia emhoyn fj va emAEEETE kat va
EKTENEDETE IO EQAPMOYN.
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Mapatetapévo natnua
Mo va ERPAVIOTEL TO PeVOU e TIC SLaBEteg EMAOYEG, N EVEPYELD TIOU amalITE(Tal
€lval TO dyylypa Kol To KpATNHA YIa APKETA SEUTEPONETTAL.

A\ matnua

MatAoTe ypriyopa SU0 GOPEC yia va LEYEDUVETE 1} va OUIKPUVETE Jia LlOTOOEAISA 1y

Evav xaptn.

Metakivnon

Ayyi€te kat KpatoTe éva oTolxEio, OTTWG M epappoyn i éva widget kal, 0T
OUVEXELD, METOKIVAOTE TO SAXTUNG 0ag og Ao onueio akolouBwvTag pia
e\eyxopevn kivnon. Mmopeite va xpnotpomoloeTe auTrv Ty Kivnon yla va
METAKIVAOETE £Va OTOIXEIO.
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KaBetn kOhion

Ayyi€te TNV 086vn pe To SAXTUAO 0aG Kat HETAKIVAOTE TO YPrYopa XWPIG Kapia
mavon. Mmopeite va XpnoILOTOICETE QUTH TNV Kivnon yla va UETaKIvNOeiTe Ot pia
NioTa, pia 1oTooeNiBa, TIC WTOYPAPIE, TIC 0BOVES Kat GAAa.

Avolypa Kat KAgio1po Twv SaKTUAWV

K\eiote Ta 6U0 SAKTUAA 0OC Yia va PUYETE MO [Ia EQappoyr, OTIwE yia
TapAdelypa amd pia ewtoypagia ri évav xaptn. MNa va pueyeBOveTe KAmolo oTolyeio,
avoi€te ta SAKTUAA oac.

/,'

A « Mnv exBétete TV 086vn agrg o€ umepBoAikd duvatolc kpadaopoug.
Mrmiopei va mpokAnOei BAGBN otov alodntripa agnic.
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.

Y€ EPIMTWON XPHONG TNG OUOKEUNG KOVTA O€ MaYVNTIKOG, HETAANIKS iy
aywylHo LAIKO, n 086V agrig eVEEXETAL va unv amoKpiveTal.

Y& MePIMTWON XPrioNG TNG CUOKEURG KATW OO £VTOVO PWTIOHO, OTIWG TO

aueco NAIakd ewg, n 086vn pmopei va pny givat opatr), avaloya pe  6éon
0aG. XpNOIHOTIOLEITE TN GUOKEUN OE pial OKIEPH TomoBeaia iy pia TomoBecia
JE HETPIO QWTIONO, O€ EVTAON TIOU APKEL yia TNV avdyvwon evog BiAiou.

+ Mnv matdre mdvw otnv 086vn pe umepBoNikr Svvapn.

Motrote amald pe 1o SAKTUNG 6ag TV MOy TIoU BENETE.

O éNeyx0G aPriG EVOEXETAL VAl UNV AEITOUPYOEL CWOTA OE TIEPITTWON TTOU

(QPOPATE YAVTIA 1} TTATATE IE TO AKPO TOU VUXIOU 0a.

+ O éNeyx0G aprig EVOEXETAL VA UNV AEITOUPYHOEL OWOTA €AV OTNV 006V EXElL

oXNMaTIOTEl bypacia.

+ H 08dvn agrg evdéxetal va pnv AeTtoupyei owoTd €V 0T OUCKEUN €XElL

TomoBeTnBel MPOOTATEVTIKNA HEUBPAVN 1) a§ECOUAP TIOU TIPOUNOEVTAKATE
amné TpiTo KATaoTNHa.

+ HeppAavion piag oTaTIKiG EIKOVAG Yia TTAPATETAPEVA XPOVIKA SlaoTApaTA

umopei va 08nyroel 0tn Snpioupyia HETEIKAOHATOG 1 E6WAOL 0TV 086V,
AmevepyoroljoTte Tnv 086vn 1) amo@UyeTe Tnv mPoBoAr Tng idlag eikévag
yiat peydho Slaotnpa otav Gev XpnOILOTIOIETE T CUOKEU.

Apxikn 086vn

Emokonnon apxiking 006vng

H apykr) 086vn gival To onpieio ekkivnong yia tnv mpooRaon o S1apopeg
NEITOUPYIEC KAt EPAPLOYEC 0T GUOKEUR 0aC. ZUPETE TO SAKTUAO Ao TO KATW
uépog omoladnmote 08OvNG yia va petapeite aneubeiag otnv apxik 0Bovn.
Mriopeite va SlaxelploTeite ONEG TIC EQAPUOYES Kat T widget otnv apykr 08dvn.
SUpeTe T0 SAKTUNG 0ag 0TV 0B6VN TIPOC T apIoTEPd 1y IPOG Tat Se€1d yia va Seite
ONEG TIG EYKATEOTNHEVEG EQAPHOYES HE HIOL HOTIA.
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Adra&n apxikng 086vng
Mmopeite va Seite ONeG TIC EQAPHOYEG KAl VO OpYaVWOETE Ta widget Kat Toug
(pakéNOUG 0NV apyxIKr) 08dvn.

Baoikég Aertoupyieg

pappn katdoTaong — Al SRR

e
Hidgetatpod H_

+ fe— [pa@ikd oToIXEID
Avadntnong Google

Ddkehog —e

Eikovidio ogAidag

Mepioxn yprivopng
Tpappr TAoAynong Tpdopaang

+ Hapyikr 086vn evoéxetat va Slapépetl avaloya pe TV TTOAITIKF Tou
KATAOKEVAOTH, TIG PUBHIOELG XPrOTN, TNV €KS00N TOU AOYIGHIKOU I} TOV
TIGPOXO UTINPECIWV.

Tpappn Katdotaong: epeavifel eikovidla KATAoTACNE, TNV WEA KAl TN 0TA0UN
™G pratapiog.

Widget katpoU: pavion mnpo@opiiV Kalpol Kat XpOVOoU Yia GUYKEKPIHEVN
TIEPLOXN.

pagiko atoiyeio Avalritnong Google: Aaktuhoypdgnaoe iy pika yia va
avoi€elc v Avadrjtnon Google.

Dakelog: Mmopeite va Snioupyeite akENoUG yia va TomoBeTe(Te TNV
€Qappoyn He Baon Ta emBuuntd Kpitrpla.

Ekovibio oehidag: ppavion Tou GUVOAIKoU aplBpoU Twv KapBadwy otnv
apxikri 086vn. Mrmopeite va ayyi&ete To emBupnTo €lkovidio oeNidag yia va
petapeite otn oeNiba Tng emAoyng oac. Oa emonuavoei To elkovidio mou
eppaviCel Toug KapBASEC eKeivnG TG OTLYUNG.
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- Meproxn ypriyopng mpoopacng: TomoBetrote BaoikéG EQapPHOYES OTO KATW
uépog T 08évng yia va gival duvati n mpdoPaon oe AUTEG amd omoloveAToTe
KapBd g apxikng 08dvng.

- Tpappn monynon: Mmopeite va petapeite otnv mponyoUpevn 08évn A tnv
apyxIKr 086vn v XPNOIHOTOIEITE TNV EPAPHOYA Kat va eEAéyEeTe T NioTa Twv
EQUPHOYWV TTOU XPNOIUOTIOICATE TPOoPATAL.

Xprion lpappn moriynon
AkolouBei 0 08nyd¢ xelpovopwy yia Tov éAeyxo Tng Mpappr morynon.
+ Tava petafeite otnv Apxikr 086vn, oUPETE MPOG Ta MAVW amd TV KATw Ywvia
NG oBovng.
+ [0 va EMOTPEPETE 0TNV TTPONYOUHEVN 006VN, GUPETE TIPOG T Héoa amod TV
aplotepn i v Se€id dxpn TG 006vNC.
« Tava petafeite otnv 006vn Emokomnong, oUpeTe mPOog Ta MAVW Kal KPATHOTE
amo TNV KATw MAEUPA TNG 006vVNC.
« Ta ypriyopn evaiayr HeTagy Twv epappoywy, oUpeTe pog Ta de&id and To
KATW PEPOG TNG 086VNG yia va LETABEITE OTIC EQAPHOYEC TIOU XPNCILOTION0aTE
TIPONYOUHEVWC.

E + Ot Xelpovopieg ival n mpoemAoyn yla T ypaupr morynong. la va to
aMaEete oe Movo koupma <]/ O/ E] otV apxIkn 086vn, maTioTe
PuBuioeig> MpoPoAr > Mpapun mhonynong, otn cuvéxela emié€te Movo
Koupma.
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Ewkovidia katdotaong

Otav umdpyel pia idomoinon yia éva adidaoTo privuua, éva cuppav
nuepoloyiou 1 umvntripy, N ypappn katdotaong epgaviel To avtiotolyo
elkoviblo eidomoinong. EAéy&Te TNV KaTAoTaon TNG GUOKEUAG 0OC UECW TWV
elkoviSiwv e1domoinong mou eppavifovtal 0T ypauur Katdotaong.

“ll Aev unidipyel orpa

H petadoon Sedopévwy mpaypatonoteital jéow Siktiou

[c] ‘Exet pubpiotei unvntrpt

ng ‘Exel evepyoroinOei n Aerroupyia ddvnong

b4 ‘Exel evepyoroindei 1o Bluetooth

YUvdeon pe umohoyloTh péow USB

Y140un unatapiag

AerToupyia TACNG EvepyoToiNpévn

AvamdvnTteg KAAOELG

‘Exet ouvdeBei To Wi-Fi

‘Exel evepyoroinBei n Aerroupyia oiyaong

' ‘Exel evepyoroinOei 1o GPS

(0] ‘Exel evepyoroindei To gpopnTto onueio mpdoBaong

N Aev undpyel kdpta SIM

N ‘Exel evepyoroindei n Aerroupyia eyypagric/avayvwong NFC oe Siktuo
P2P

E « Oplopéva amd autd ta eikovibla evoéxetal va epgavifovtat S10QopeTika iy
va pnv epgavifovtat kaBolou, avahoya PE TV KATAOTACKN TNG CUOKEUNG.
AlaBaoTe Ty meplypagn Twv ikoviSiwv avaloya He To mEPIBANOV Kat Ty
TIEPLOXT) OTTOU XPNOIHOTIOIETE TN GUOKEUN KOl TOV TIAPOXO UTTNPETIWV.

« Ta ekovibla mou epgavifovtal voéxetal va Slagépouv avaloya Le Thv
TIEPLOXI) KOl TOV TIAPOXO UTINPECIWV KIVNTHAG TNAEPWVIAG.
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Mivakag eldomoioewv
Mmopeite va avoiete Tov mivaka e60moIoewv CUPOVTAG T YPAUU KATAOTAONG
TIPOG Ta KATW 0TNV KUpla 08dvn.

« Mmopeite va oUpEeTE MPOE T KATW TO APdBupo E160MOICEWVY 1 VO TIATAOETE
T0 €IKovidlo BENoug yia va avoifete T AioTa pe Ta elkovibia ypriyopwv
pubuioswv.

Mnopeite va matroete /9 yia va mipocbEoeTe, SlaypaypeTe 1 TAKTOMOOETE Ta
elkovibla 0To mapabupo eI8OTOICEWV.

Edv matroete mapatetapéva 1o €ikovidlo, Ba eppavioTei n 006vn pubuicewv
yla TV avtioTolyn AtToupyia.

np

E «  Mmopeite va XpnOoILOTOICETE TOV TivaKa EI60TOICEWY aKOUA Kal dTav
n 086vn eivat KAelSwpévn. ZUPETE Tov Tivaka EI50MOIRCEWVY VW N 086vN
eivat KAeldwuévn, yla va amoKTHoETE ypriyopn mpooRacn oTig SuvatotnTeg
TIou BéNeTE.

Baoikég Aertoupyieg 77



Evalayn otov mpocavatoAoué g o0dévng

Mriopeite va opioete va aAAalel auTOpaTa 0 TPOCAVATONOMOC TG 086vNng
QVANOYQ [IE TOV UOIKO TIPOCAVOTONGHO TNG CUCKEUNG.

2oV mivaka eidomotjogwy, emAEETe Mepiotpo@n amd tn Aiota Twv elkoviSiwv
ypryopnc mpoéofaong.

Mropeite emiong va matrioete Pubpiceig > MpoBoAn Kal va evepyomoloeTe Ty
emAoyr Autopatn mePLoTPOPr 000vVNG.

Ene€epyacia tng apxikng 00ovng
TNV Apxikr) 086vn, ayyi€Te Kal KpATAOTE O€ éva KEVO ONKEIO KA, OTN GUVEXELD,
€MAEETE TNV EMBUUINTI EVEPYELD OO TIC TIOPOKATW.

- Ta va aMagete ™ didtaén Twv kapPddwv otnv apxikr 086vn, matioTe
TaPATETAPEVA TAVW OF évav KAUBA Kal CUPETE Tov O€ pia AN Béon.

la va mpooBéoete éva widget atnv Apxikry 006vn, ayyi€te €va kevo onueio TG
ApxIKG 086vng kal kpatroTe To emiéyovtag Widgets.

Mo va aMaéete Tametoapieg, O¢pata, ikovidia kat AOD, ayyite mapatetapéva
i Kevi TiEpLoxH TG apxIKnG 08dvng kal, oTn ouvéxela, emiécte Povto &
Oépa.

Mmopeite emiong va matroete PuBpiogic > MpofoAr > Apxikr 066vn

> OovTo kat va emAECeTe TameToapieg, povTa, ewovidia kat AOD yia va
XPNOIHOTIOIOETE 0T CUOKELN.
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+ Ta va Slapop@uoEeTe TIC pUBHIoEIS TNG APXIKNG 006vNG, ayyi€Te €va kevo
onueio TG ApXIKiG 006vNG KAl KPATAOTE TO EMAEYOVTAG OTN CUVEXELD
PuBpioeig apyikrig 006vng. Mo Aemtopépeleg, avatpé€te oTnv evotnTta
PuBuioeic apyikric 086vng.

« T va Seite i va eYKATAOTAOETE EAVA TIG N EYKATECTNUEVES EQAPHOVEC,
ayyi€te éva kevo onpeio TG ApxIKing 086vNng Kal KPATAOTE TO EMAEYOVTAG
Tkoumibia e@appoy. Na AemTopépeleg, avatpé€te otnv evotnta Zkouridia
EQapLOY. .

« Ta va aAagete v mpoemAeypévn 006vn, ayyi€Te Kat KPATHOTE HId KEVR

meploxn TG ApXIKNE 006vNg, UeTakivnOeite otnv emBupnTr 086vn, ayyi€te 1o

koupi 1Y, Kal 0N ouvéxela ayyi€Te TRy 086vn yia AN Wia Gopd.

L —— [poeTTIAeypévn 086vn
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MpofBoAn Tov Béuarog pévtou
H mpoBoAi TG EIKGVAC POVTOU €ivat SuvaTr LOVO e TNV amdKpuyn Twv
€QapHoywV Kal Twv widget otnv apxikr 086vn.
AmA\WOTE Ta SUO SAKTUAG 0ag OTNV apXIKr 08N,
- T va emoTpéPeTe 0TNV apxIKr 000VN LE TIG EQAPUOYEC Kal Ta widget, evioTe
70 SAKTUAG 0aG EVW) T OKOUPTTIATE 0TV APKIKI 086VN 1 GUPETE TTIPOG TA TIAVW
— amé TV KATw AKpn TG 080vng.

Metakivnon e@appoywv aTnv apxikn 006vn
3TNV apxikn 006V, TaTHOTE MAPATETAUEVA TTAVW GE L0l EQAPHIOYT KOl CUPETE TV
o€ Jia GA\n Béon.

+ [0 va KOPPITOWOETE TIG EPAPHOYEG TIOU XPNOIOTOI00VTAL CUXVE OTO KATW
UEPOG TNG APXIKAG 0BOVNG, TIATAOTE MTAPATETAMEVA TIAVW OF [I0 EQAPLOYH, Kal
GUPETE TNV 0TNV TEPILOXT| YPIYOPNE MPOGRaoNG 0To KATw PEPOG TNG 006VNG.

- Ta va a@aipéoete €va €lkovidlo amd Tnv EPLOX YPrYopNnE mpooBacng, oUPETe
0 €1KOVibIo 0TV apyIkr} 086vn.
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Xprion @akéAwv amd Tnv apyIikni 086vn
Anuovpyia akélwv

TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF MOl EQAPHOYI KOl CUPETE TV
TIAVW OE [t GAAN EQAPHOYN.
+ Anuioupyeital évag vEog PAKeNOG KAl Ol EQAPHOYEC TPOOTIOEVTAL OTOV PAKENO.

Ene€epyacia pakélwv
TNV apxIKf 006vn, ayyi€te £vav GAKENO Kal, EMEITA, EKTENEDTE pia amd TIG
OKONOUOEG EVEPYELEG.
« a va enegepyaoTeite To Gvoua KAl TO XPWHA TOU QAKENO, TATHOTE 0TO GVoUa
@aKéhou.

+ [0 va mpooBEoETe EQAPHOYES, AyYIETE KAl KPATAOTE TO EIKOVIOIO HIag

£(QAPHOYNG, CUPETE TO TIAVW AT TO PAKENO Kall, OTN GUVEXELD, AQHOTE TO.

+ [0 va aQaIPECETE JIa EPAPHOYR ammd TOV QAKENO, TATAOTE APATETAPEVA
TIAVW O0TNV EQAPHOYN KAl CUPETE TNV £§w amod Tov PakeMo. Eav n katapynOeica
€pappoyn givat n Hovadikn epappoyr oTo QAkeNo, o pdakehog Ba Katapynbei
autopara.

Emiong, umopeite va mpooBETETE 1 va aQaIPECETE EQOPHOYEC TTATWVTAG OTO
Koupri (+) Tou @akélou.

E « Aev pmopeite va aANAEETE TO XPWHO TOU GAKENOU GTAV XPNOIUOTIOIETE
Kamolo Bépa mmou €xeTe KaTePATEL

PuBuioeig apxikig 006vng
Mriopeite va TPOCAPHOCETE TI PUBHITELS TG aPXIKNG 08dvNG.
T Zmv apxir 066vn matriote PuBpioeig > MpoBoAr > Apxikr 086vn.
7 MpooappéoTe TIC TapaKATw puBpicelc:
- EmAé€te Apxikn oghiba: emAE€Te pia Aettoupyia amo v apyikr 08dvn.
+ OOvto: aMdETe TV TameToapia YOVTOU TNG ApXIKHG 08dvNc.
« E@é 006vng: emAéETe TO €€ TIou Ba epappdleTal KaTd Ty evalhayr Kappd
otV apylkr 08ovn.
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+ IxnHata eikovidiwy: emMAECTE £Gv OENETE Ta €lkovidla va éxouv
TETPAYWVIOHEVEG I} OTPOYYUNEHEVEG AKPEG.

Ta&wopnon epappoywv avd: Seite pe molov Tpdmo TaivopouvTal oL
EQAPHOYEG OTNV apXIKr 006vn.

+ MAéypa: aMGETe T Asttoupyia avadiatagng EQapHOYwY yia TNV apxIKr
o0ovn.

AnOKpuYN EPAPHOYWV: EMAEETE TIC EQAPHOYEC TIOU BENETE VA AMOKPUYETE
amoé v apxIkr 08ovn.

+ Na emrpénetat KUKAIKN emavaAnyn ApXIKwv 08ovwv: evepyorolioTte
QUTAY TNV EMAOYN YA VO EMTPEPETE TN OLVEXH KUAION 0TV apxIKn 006vn
(emoTpéPTe Péow BPOXOL oTNV MPWTN 006V YETA TNV TEAEUTAia 006vN).

+ Smart Bulletin: ypnowomojote v apyikr 08évn yia va Seite
TIANPOYOPIEC TPOOAPUOCUEVES OTIG AVAYKES OAG,

+ Avalit.: kavte avaTnon oépvovTag mMPOog Ta KATw oTnv ApxIkr} 086vn.

+ Kheibwpa Apxikr 086vn: EvepyomoiioTe To yia va pnv yivetat avadidtaén
1) AMOPAKPUVO EQapHOYwV Kal widget.

KAeidwpa 006vng

Mapouaiaon kKAelbwpatog 006vng

H 0086vn Tng OUOKEUNG 0OC ATEVEPYOTIOLEITAL KAl KAEIGWVEL AUTOUATA OV TIATHOETE
10 MMiKTPO Asrtoupyiag/kAeldwuatog. To idlo cupBaivel mmiong Kat GTav n CUOKELR
Tapapeivel og adpavela yia éva KaBoplopévo Xpovikd Sldotnua.

Edv motroeTe 10 MANKTPO EvePYOTIOINoNG/KAEIOWHATOC XWPIG Val EXEL
evepyomolnOei To Kheibwpa 086vng, Ba eppavioTei autopata n apxikr 0Bdvn.

Mo va e€ao@aNoeTe TNV A0PAAEIQ TNG GUOKEUNG KAl VOl AMTOTPEPETE AVEMOUUINTN
npdoBaon o€ autr, evepyomolroTe To KAeibwua 086vnc.

E « To kAeidwua 006VNG AMOTPEMEL TNV TIEPITTH EI0AYWYI| EVIOADV ARG OTN
GUOKEUN Kal MELWVEL TNV KaTavaAwon 1ox00g TG Umatapiag. Zuviotdtal
VOl EVEPYOTIOINOETE TO KAEISWHa TG 006vNG GTav Sev XPnOILOTOIETE TN
OUOKEUN.

Baoikég Aertoupyieg 82



PUBuIoN KAE1dWaTog 006vNng
AlatiBevTal apKeTEC EMAOYEC Yia TN SIOUOPPWON TwV PUBUICEWY KAEWSWUATOC TG
0Bovng.
T Zmv apxir 066vn matrote PuBpioelg > Kheidwpa 006vng & acpdheia
> AloAé€te KAeidwpa 080vNG Ka, 0T OUVEXELD, EMAEETE TN pEBoSO TTou
TIPOTIMATE.
7 MpooappooTE TIC TAPaKATW PUBICEIC:
- Kavéva: amevepyomoinon Aertoupyiag KAeldwpatog 08ovng.
TUPETE: COPWOTE TNV 006VN yia va EEKAEIBWOETE TV 080vn.

Knock Code: la va Eekheldwoete Ty 0806vn, oxnuatioTe pe 1o SAXTUAS oag

70 potifo mavw otnv 086vn.

+ Morifo: oxediaote éva poTifo yia va EeKAeldwVeTE TV 006vn.

+ Kwdkog KAEISwpaTog: €l0ayayeTe évav aplOunTikd Kwdikd mpoofaong yia
va EeKAeOWOoETE TNV 006V

+ Kwdikog mpoopaong: eloaydyete évav aA@aptBunTiko Kwdiko mpoofacng
yia va EeKAeISWOETE TV 086vn.

+ AakTtul Amotunwparta: EEKAEISWOTE TV 006V XPNOIUOTIOIWVTAG TO
SaKTUAIKO oag amoTUmwa.

- Emtpémetan xprion Avayvwpion mpoownou: ZekAEIOWaoTe Ty 086vn
XPNOILOTIOIWVTAG TV AvVaYVWPLON TIPOCWITOU.

+ Amodoyn avayvwpiong @wvig: ZeKAeISwaTe TNV 086vN XPNOIHOTOIVTAG

OUYKEKPIHEVEC QWVNTIKEG EVTONEC.

5 + Metd amo 5 eo@alpéve amomelpe EEKAEISWHATOG TG OUOKEUNG, N 086vn
um\okdpel yia 30 SeutepolenTa.

PUBuon acpalol¢ ekkivnong

Otav, we pébodo Kheldwuatog 08ovng, emiéyete Motifo, Kwdikog KAeldbwpatog

1 Kwdikd¢ mpooBaong, Umopeite va SIapop@WOETE T CUOKEUN 0O¢ WOTE Va

KAEISWVEL OTIOTE TNV EVEPYOTIOLEITE WOTE VA IPOOTATEVOETE Ta Sedopéva oag.

+ Méxptva EekAEIOWOETE TN OUOKEUN 0ag, €V UITOPEITE VA XPNOIHOTIONOETE TIG
AEIToUPYiEC TNG EKTOC MO TIC KANOELG EKTAKTNG AVAYKNG.

« Yemepimwon mou EexdoeTe Tov KwdIKO mpooBacng ya v
anokpuntoypdenan, Sev Ba UMopE(Te va EMAVAPEPETE Ta KPUTITOYPAPNHEVA
Sedopéva Kal T TPOOWTTIKA OTOIYElD 0C.
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Mpouldaéeig yia T Suvatdtnta ac@alol¢ EKKIvong
« e mepimtwon mou EexAoeTe Tov KWSIKO MPdoRaong yia
anokpurrtoypdenarn, ev Ba UMOpE(Te va EMAVAPEPETE TA KPUTTTOYPAPNHEVAL
Sedopéva Kal Ta TTPOOWTTIKA OTOIElD 00C.
Duldooete Toug Kwdikoug mpooBaong yia To KAeidwpa 086vng EexwploTa.
+ Av ANKTPOAOYHOETE EGQOAUEVO KWSIKO TPOORACNC TTEPIOOOTEPES
(POPEC OO AUTEC TIOU €XOUV OPIOTEL, N GUOKEUN TIPAYUATOTOLEL AUTOHATA
EMAVAPOPA OTIC EPYOOTACIAKEG PUBHITELS Kal SlaypdgovTal autouata
TUXOV KpunToypagnuéva SeSopéva Kal IPOOWTTIKEG 0aG TTANPOPOPIES, XWPIG
Suvatdtnta avaktnong.
+ Na iote mpooeyTIKoi Katd TNV €loaywyr Tou Kwdikou mpdofaong yia To
KAeibwpa kat To EekAeidwpa TG 086vVNG, £T01 WOTE Va UNV EI0AYAYETE
€0QANUEVO KWOIKO TIEPIOTATEPEG POPEC ATTO AUTEC TIOU £XOUV OPIOTEL
‘Otav EVEPYOTIOLE(TE TN OUOKEUN YA TPWTN YOPA AUECWE META TNV EMAVAPOPA,
EeKIvael TauTOKpOvVa Kal n KpUtoypd@non. Av SIAKOWETE TV KPUTTTOYPAPNnon
auBaipeta, evdéxetal va mpokAnBei opahua os Sedopéva. BeBaiwbeite Ot €xel
olokAnpwOei n emavagopd.

Mapapetpomoinon kKAedwpatog 006vng KAeIdwaTtog
Mmopeite va mpooapudoeTe Tnv 086vn KAEISWUOTOC.
1 Zmv apxikn 086vn, matfiote PuBpioeig > Kheibwpa 006vng & ac@daheia >

Mapapetpomoinon kAeidbwpatog 006vng.

7 EmAé€te pa Aerroupyia ou Béhete va puBpioete.

+ DOVTO: Z0¢ EMTPEMEL VA OPIOETE TO PAVTO YIa TV 086V KAEISWHATOC G0IC.

+ Po)Ot: Zag emitpénel va opioeTe OV val TOMOBETAOETE TO PONdL TNV 006vNn
KAedwpaTog.

+ ZUVTOUEUOEIC: XaG EMTPEMEL VAl EMAEEETE TNV EQAPUOYN TTOU Ol EKTENEDTEI
otnv 086vn KAedWHaTog oac. AuTr n pUBHION gival opatr POvVo 6Tav xel
oploTei To KAeidwua 08évne.

+ E@é 006vng: Zag Sivel Tn Suvatotnta va publiceTe To epé petapaong
006vng mou epappoletal otav n 08évn eivat EeKAedwévn.

+ Kivoupevn eikova Kaipou: Evepyormolrote auTrv Tnv emAoyn yla va
EUPAVIOETE KIVOUpEVa oxéSia kalpoU yia Tnv Tpéxouca Béan atnv 006vn
KAeLdWpaTOC,

« ZTolKEl0 EMAPNG OTNV TEPITTWON AMWAELAG TOU TNAEPWVOU: Zag Sivel
n SuvatdTNTa va OpisETe Keipevo oTnv 086vn KAEWSWATOC Yia Vo
TIPOOSIOPICETE TOV KATOXO TOU TNAEQWVOU.
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PuBpioeic ao@alol¢ KAEIdbwuaTog
Mriopeite va opioete aopaleic pubpioelC KAeWGWPATOC,
T Tt apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & acpaleiag

ao@alela > Pubpioeig ac@aloug KAeIdwpatog.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.

+ Na @aivovtat ta potifa (eppavietal povo otav to Motifo éxel oploTei wg
KAeibwpa 006vnc): EvepyomoloTe yia va KAVETe To poTifo opato.

+ Xpovodiakdmtng KAEWSWHATOG: Xag emtpémel va pubuileTe To XpovIkd
S1a0TnUa TPV To AUTOHATO KAEIBWa TNG 080VNG aou KAEIOETE ToV
omioB1o PWTIoUO (xPOVIKS 6plo Adyw adpdvelag).

+ To koupmi Tpoodoaiag kKAeWdwvel ottypaia: Evepyomoriote autr Ty
emAoyn yla va KAESWOETE apéowg TNV 006vn 6Tav MECETE TO KOUWTI
evepyomoinong / KAeWdwpatog. Autr n puBIon umepLoxUEl TG pUBIONG
XPOVOSIOKOTTN KAEIOWHATOG ao@aAeiag.

- Epgavion emhoyng kKAeldwpatog (epgavietal pdvo otav €xel
oploTei KAeidwpa 006vN¢): EvepyomotrioTe autrv Tnv emAoyr yia va
gp@aviCeTal T0 €IKOVISIO KAEIOWHATOG OTAV KPATATE TTATNHEVO TO
TMARKTPO loxVo/KAEWSWHATOC, MaTAOTE TO £1KOVISIO KAEISWUATOC Yia val
OmEVEPYOTTOINOETE TO £§UTTVO KAEISWA, TO BIOMETPIKS EeKAEIBWUA KAl TIG
e1domolnoelg oTnv 006vn KAEISWUATOC.

+ Smart Lock: Zag ivel tn Suvatdtnta va opioete afldmoTn CUOKELN,
TomoBeaia, Guwvr Kat / ) avixveuon oTo owHa Tou Ba eMTPEPEL 0TO
TNAEQWVO 0OC VA TIAPAEVEL EEKAEIOWEVO.

« O18100¢01pec emOYEG pevol evogxeTal va Slapépouv avaloya Ke Ty
emheypévn péBodo 0BévNng KAeldwpaToc.
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Evepyomoinan 00dvng
MropEiTe va EVEPYOTIOINTETE I VA ATIEVEPYOTIOINTETE TNV 006VN pe SIMAS matnua
Tavw TG

E + Auti n emoyn givat Slabéotun pdvo otnv apxikr 086vn TN LG. Aev
\erToupyei owoTd o€ KAmola E181KN EQapuoyn EKKIVNONG 1] 0TNV apxIKn

086vn mou éxel eykataoTabei amd Tov Xprotn.

Ma va matioete Tv 006vn agrig, xpnotpomoloTe To SAKTUAG oag. Mnv

XPNOIHOTIOIEITE TO VUXI 0OC.

Mo va xpnotpomoloeTe Tn Aeitoupyia Evepyomoinon 08ovng, PePaiwbeite

6T 0 ALoONTAPAG EYYUTNTAY/PWTIOHOV eV epmodieTal amod kamolo

QUTOKONANTO 1 GAAN §évn ouaia.

Evepyomoinon 00dvng
MotAote pe 1o SAKTUNS oag SU0 PopEC 0TN péan TG 086vNG.
« Edv natioete 010 emdvw 1 0TO KATW PEPOG TNG 006VNG, 0 Babudg avayvwplong
NG Kivnong evEEXETaL va NV €ival EMOPKNAG.

Anevepyomnoinon 006vng

Ayyi€te pe 1o SAKTUNG 6a SU0 PoPEC TAVW O€ €va KEVO onueio oTnv ApXIKH
0006vn kat otnv KAelbwpévn 0Bovn.

Eva\akTIkd, matrote 500 gopég o€ évav KEVO XWPO OTN YPauHr KATdoTaong.

Knock Code

Mropeite va Eexheidwoete Tnv 006vn Snuioupywvtag Tov Siko oag Knock
Code.Otav n 0086vn €ivat KAelbwpévn, pumopeite va €xete ameubeiag mpoopaon
0TV apxIKr 006vn maTWVTACG MAvw 0TV 086V ia CUYKEKPIUEVN akohoubia
XTUTTNUATWV.

E «+ Mmopeite va xpnotpomoiroete 1o Knock Code padi pe Tn Asttoupyia

Evepyomoinon 08évng.
« Mnv &exvdre va xpnotpomoleite To SAKTUAG 0aE yia To TTATNa TG 006vng.
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Anpovpyia Knock Code

T Zmv apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & ac@dheia >
Awalé€te kAeibwpa 006vng > Knock Code.

7 Ayyi€te Ta TETpdywva Pe T Oelpd o BENETE yia va SnUIoVpyHOETE évay
Knock Code kay, émerta, ayyi€te Emopevo.

3 Kataywpiote Eavd tov Knock Code mou dnpiioupyroate yia va tov
enaAnBevoete kat ayyi€te EmBeBaiwon.

Zekheidwpa tng 000vng pe Knock Code

Zexhetdwote v 086vn mMinktpohoywvtag Tov Knock Code mou éxete
Snuioupynoel.

MAnktpoloyrote Tov Knock Code otnv 086vn agrig dtav n 08évn givat
QTTEVEQYOTIOINHEVN.

- Mmopeite emiong va elcayayete évav Knock Code 6tav n 086vn kAeldwpaTtog
€ival evepyomoinpévn.

Kpunrroypagnon kaptag pvipng
Mrmiopeite va KpUTTTOYPa@rOETE Kal Va TTPOOTATEVCETE Ta Sedopéva Tou
amoBnkevovTal 0TV KAETA puvAUNG. Agv givat Suvatr n mpooRacn amé AN
GUOKEUN 0T KPUTTTOypa@npéva SeSopéva oTnv KAPTA WVApNG.
T Zmv apxikr 086vn, matiote Pubpioeig > KAeidwpa 006vng & ac@dheia >
Kpuntoypagnon & diamoteutripia > Kpunrtoypdgnon kdptag SD.
7 NoBaoTe Ty apousiaon yia Ty KpUntoypa@naon The KAPTAE JVHUNG Tou
epaviCetal otnv 006vn Kal TATHOTE ZUVEXELD VIO VO GUVEYIOETE.
3 Evepyomolote pia emoyn kai ayyiéte Kpunrtoypagnon:
+ Kpumrtoypd@nan véou apyeiou: yia va KPUTITOYPAPHOETE HOVO
Ta SeSopéva Tou amoBnKeUTNKAV 0TV KAPTA PVARNG META TNV
Kpumtoypagenon.
+ MAfipPNE KPUTTTOYPAPNON: YIa VO KPUTTTOYpa@rioeTe OAa Ta Sedopéva mou
glval amoBnkeupéva oTnv KAapTa pvrpng tn dedopévn oTiyun.

E€aipeon apxeiwv MOANUPESWV: yia VO KPUTTTOYPAQHOETE ONA TA APXEID,
EKTOG AMO ap)Eia TTONUPESWY, OTIWG APXEIQ LOUOIKAG, PUTOYPAPIWY Kal
Bivteo.
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5 + MONG §eKIVOEL N KPUTTTOYPAPNGN TNG KAPTAG UVAHING, OPIOHEVEG AEITOUPYIES
kaBiotavral pn Slabéotpeg,

« Edav n ouokeun amevepyorolnBei evw n kpurrtoypdenon Bpioketal og eEENEN,
n Sladikacia kpUMTOYPAPNONG Ba AMOTUXEL KAl EVOEXETAI VA KATACTPAPOUV
oplopéva dedopéva. MNa autd, IV EEKIVATETE TNV KPUITTOYPAPNON, EAEYETE
KaTd OO0V N 0Tabun TG pmatapiag eivat EmapKic.

+ Takpurrtoypagnuéva apxeia eival TpooBAaotpa LOVO amo Th GUOKELK TNV
omoia ylve n KPUITOypAPNOr TOUG.

+ H kpuntoypa@npévn kapta pvipng Sev pmopei va xpnotpomnoinBei oe
@M\ ouokeur LG. MNa va pnoIHOTIOIOETE TNV KPUITTOYPa@npévVn Kapta
MVAUNG O€ Kamola GAAN GUOKEUR KIVATOU TNAEPWVOU, TIPEMEL VOl EKTENETETE
pop@oroinon Tng KAPTaC.

+ Mmopeite va EVEPYOTIOINCETE TNV KPUTITOYPAPNON TNG KAPTAG UVAKNG OKOHA
KL Otav Sev umdpyel KapTa Vg otn ouokeur). Kabe kdpta pviung mou 6a
TomoBetnOei ueTd TV KpumToypdpnon Ba KpumToypaPEiTal AUTOUATA.

AQYn oTiypotunwy

Mrmiopeite va SnpioupynoeTe oTyoTuUTIa TG 006vnG mou BAEmeTe.

Méow ouvtopeuong
MaTAOTE TAPATETAUEVA TO TARKTPO EVEPYOTIOINONG/KAEIOWHATOG KAL TO TTARKTPO
MEIWONG TNG €VTaoNG XOU TAUTAXPOovA Yia TouAdxloTov SUo SeutepoAemTa.
- Mmopeite va Seite Ta oTiypdTUna 086vng mou €xeTe TpaPrel oTov QAKeNo
Screenshots 070 pevoly ANUmOU.

Méow tnG epappoyn¢ Capture+
Evw BpiokeoTte otnv 006vn To oTtyIdTumo Tne omoiag Oéhete va Tpaprtete,
OUPETE Tr YPaWHI KATAGTAONG TIPOG TA KATW KAt TTATHOTE (2.

E + ‘Otav n 086vn €ival amevepyomoinpévn 1 KAESwévn, Pmopeite va
QMOKTAOETE MPOGRacN oTnV pappoyr Capture+ matwvtag SU0 PoPEG

TO MARKTPO aENONG TG EVTaong rou. Na va XpnGCILOTOICETE AUTHY

N Aertoupyia, 0TnV apykr 08évn matrote PuBpioelg > Enektdoeig>

JuvTtopeloelg kal evepyoroljote To Open Capture+.

MNa Aemrtopépeleg, avatpé€te oty evotnta Anuioupyia ONUEIDOEWY O€ Eva

oTlypiétumo o0ovng.
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Elcaywyn keipévou

Xprion Tn¢ Ypaupne epyaleiwv Smart

Mriopeite va xpnotpomotrioete Slapopeg peBoSoUG e10aywynG MANKTPOAOYiou OE

éva pépog. Mmopeite va emAé€ete Ty emBuunTtr péBodo eloaywyng amo To endvw

U€POG TOU MANKTPOAOYIOU.

1 EmAéEre n péBodo sioaywync minktpoloyiou ou BENeTe amo T ypauun
epyoheiwv Smart.

2 Matiote \V kat emAé€te T pebodo eloaywyng mou BéNeTe va epgpaviletal
OTNV YPOun epyoleiwv Smart i aMa&te n S1atagn twv ueBddwv elcaywync.

Tpopufi —& @ % % & @ B -

epyaAgiwv
Smart

i - —

E «  Mmopeite va mpoobéoete €wg 6 epyaleia 0T ypauun epyaleiwv Smart.
+ Oplopéveg umooTtnpi(opeves pEBodol eloaywyng evaéxeTal va Slagépouv
QVANOYa L€ TN GUCKEUN 0aG.
«  MMopEiTe Vo EVEPYOTIOIOETE 1) VOl AMEVEPYOTTOINOETE TN AerToupyia
YPOUUAG epyaleiwv Smart amd Tig pubuioelg mAnkTpooyiou.
+ Mmopeite emiong va XpnoILOTIOOETE TI HEBOSOUG EICAYWYNG
m\nktpohoyiou matkvTag oo §63.

« ©:Npoobrikn emajis.
« 22 :Avolyua ouvopihiag Draw.
- §63: NMpodoBaon ot pubpioeig mMnktpooyiou.
- :Natjote § yia eloaywyr Kelpévou pe T Xpron ewvic.
- [l va PeyIoTOTOICETE TV AVAYVWPLON GWVNTIKWY EVIOAWY, TIPETTEL VA
WiNate kabapd.
- Ta e1l0aywyn KEWEVOU XPNOILOTIOIWVTAG TN Gwvr 0ag, Peaiwbeite 6Tin
OUOKELN 00 eival ouvdedepévn oe Siktuo.
- Tia va emhé€eTe YAWOOO yia TN QwVNTIKY avayvaplon, atriote X% >
M\waooeg oTNV 006VN PWVNTIKAE AvayvwpeLone.
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- Auti n Aertoupyia pmopei va pnv urootnpiletal, fj ot umooTNEI(OLEVES
YAMDOOEG EVOEXETAL VA SIaPEPOUV aVANOYa HE TNV TIEPLOXT.
. :Avotypa tou Clip Tray.
. : Evepyomoinon Tou aiwpoUpevou TANKTPOAOYIOU 6TV XPNOIHOTOLETE
N Aertoupyia moANam\wv mapabupwv. MITopE(Te MoNG va LETAKIVIOETE TO
TANKTPOAOYI0 oTNV EmMBuNTH Béon.

Méow Tou Aertoupyia Smart Keyboard

Mriopeite va xpnolpomoloeTe To MANKTPOAGYI0 Smart yia va eloaydyeTe kat va
EMECEPYOOTEITE KEilIEVO.

Meé To mAnkTpoAdylo Smart, Umopeite va BAEMETE To Keipievo kaBuwg mMAnKTpoAoyeite
Xwpig va xpelaletal va evaA\AooeoTE avapesa oTny 086vn Kal To GUpBaTIKG
TIANKTPOAOYI0. ME QUTOV ToV TPOTIO, PMTOPE(TE EUKOAA VA EVTOTTIOETE Kall va
S10pBwoete A\aBn evw TANKTPONOYEITE.

Metakivnon tov dpopéa

Meé to MAnKTPOAOGYI0 Smart, UOpE(TE VOl LETAKIVEITE TOV Spopiéa akpIBWE 0N
Béon mou Béhete. Otav MANKTPONOYEITE KEiPEVO, ayYiETE KAl KPATAOTE TO MARKTPO
S100TAHATOG KAt TN oUVEXEla oUpeTe Se€Id iy aploTepd.

< Smart keyboard >

I_;'] « Auti n emoyn SlatiBetat povo yia to minktpoAdylo QWERTY.
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Mpotdoeig Aé§ewv
To mMAnKTpoAdylo Smart avalVel auTopaTa Ta HoTiBa Xpriong 0ag yia va oag
TpoTeivel KaBW¢ MinkTpoloyeite AEEeIG TTou xpnotpomoleite cuyvd. Ooo
TIEPIOOATEPO XPNOILOTIOLEITE TN OUCKEUN 0aG, TOOO TIO AKPIBE(C gival oL
TIPOTEIVOUEVEG AECELC.

MANKTPOAOYNOTE KEIUEVO KAl TTATAOTE TIAVW OF L0 TIPOTEIVOUEVN AéEN 1y oUpETE
amald v aplotepn 1 T Se€1d MAeuPA TOU TANKTPOAOYIOU TIPOG Ta TAVW.

- Eloayayetat autopata n Aé€n mou eméyete. Aev xpetdletat va

TIANKTPOAOYNOETE £0EiG KAOE YpAupa auThG TG AEENG.

Smartphone |; o smarphone_ Smari| SMartphones

l'flllllll lllllllrfl
= - . E
(] ] |
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Avtiypagn Kot emKOANGN

Mmopeite va amoKOYETE 1 va avTlypaPETE KEIEVO amo pia EQAPHOYH Kal, 0Tn

OUVEXELD, Va EMKONMAOETE TO Keipevo otnv ila epappoyn. H, umopeite va avoiete

ANNEC EQAPOYEC KAl VL ETIIKOMNIOETE TO KEIMEVO OE AUTEC.

1 Natote mapatetapéva og £va onueEio KOVTA oTo Keipevo mou BéAeTe yia
avTlypa®n iy amokor.

7 Zopeteta bpla @/ B yia va oploBetroete Ty epLoxr Tou Tipoopiletat yia
QvTlypaqr 1 amoKoTTH.

3 Em\éCe eite Aokon eite AvTiypagn.
+ To Keipevo mou éxel eMAeYei yla avTlypagr| 1} AmOKOTT POoTiOETal

autopata oto Clip Tray.

/' Natiote napateTapéva 1o mapabupo eloaywync KEMEVOU, Kal eMNEETE

EmkoAnon.

E - Edv ev undpyel aTotyeio Tou éxel emheyei yia avTypagn 1y amokor, n
emMoyr EmkoAAnon Sev Ba epgavietar.

Eicaywyn Kepévou pe T Xprion @wvig

T10 minktpodyio, matrote &.

E « 1@ va YEYIOTOMOINCETE TNV QVAYVWPLON QWVNTIKWY EVTOAWVY, TIPETEL VA

WiNate kaBapa.

« Ta eloaywyn KEWEVOU XPNOILOTOLWVTAG T Gwvr oag, BeBatwbeite otin
OUOKEeUN 0ag ival cuvdedepévn oe Siktuo.

+ Tava emAé€ete y\dooa yia T ewvnTiki avayvapion, matiote % >
M\waogg oTnv 086V PWVNTIKAG avayvwpiong.

« Auti n Aertoupyia pmopei va pnv umoatnpiletay, fj ol umoaTnPI{OUEVES
YAWOOEG evExeTal va SIapEPOLY avaNoya UE TV TTEPLOXT).
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Clip Tray

Otav éxete eMAEEEL pia £IKOVA 1 €va KEIPEVO YA avTlypa@r 1 AmoKoTT, TO
oTolyeio autod amobnkevetal autopata oto Clip Tray kat pmopei va emkoNnBei oe
omol081TOTE ONEI0 avd TAoa OTIYU.

1 Zto minktpoAdylo, matrore [iZ).

EvaA\akTIkd, TaTioTe mapateTapéva To mapdBupo Eloaywyng KELEVOU, Kal

emAé€Te Mpoyeipo.

7 Em\é€te kal emkoAote éva otolyeio amd to Clip Tray.

+ X710 Clip Tray umopolv va amoBnkeutolv éwg 20 oTolyEia.

- matfjote o Koupni L3 yia va KAelboeTe Ta anobnkeupéva oTolygia 1oL
WOTE Va N Slaypagouy, akoua Kal OTav UTepREITe Tov péyloTo aptBpud
otolxeiwv. Mmopeite va Kheldwoete éwg 10 oTolkeia. MNa va dlaypdpete ta
KAEIOWHEV OTOIKEID, TTPEMEL TPWTA VOl Ta EEKAEISWOETE.

- Matiote To koupn [if] yia va Slaypayete Ta oTolyela mou éxouv
amoOnkeutei oo Clip Tray.

E « H\erroupyia Clip Tray evoéxetat va pnv umootnpiCetal amd oplopEVEG
AnpOeioeg epappoyEq.

Kowvn xprion mepiexopévou

Avamnapaywyn meplexopévou anmod AAAn cuokeun

Mrmopeite va TPAYLOTOMOICETE QVATAPAYWYH GWTOYPAPIWY, BIVTEOD 1] LOUCIKAG

TIOU €XOUV AMOBNKEUTE! 0T CUCKEUT O pia TNAEOPAON.

1 Zuvdéote v TnAedpaon Kai T cuokeur| oo idio Siktuo Wi-Fi.

7 Evw yivetai mpoBol mepiexopévou amd Ty e@appoyr AAUToup i MouoikR
natiote o koupni Cg R > Avamapaywyr o GAAR GUOKEUN..
'H, otV apykr 086vn, matiote > Pubuioelg Zuvdedepéveg ouokevég > Kown
XPrion 086vng kat petd matioTe L0 VO TNV EVEPYOTIOINOETE.

3 EmAé€re v TAedpacn otnv omoia BéNeTe va ouvSeDeite.

« Ta xpron pe ouokeury Chromecast, ot unpecieg Google Play mpémet va givat
EVNUEPWHEVEG.
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MpoBoAn eplEXOUEVOU AMIO KOVTIVEC GUOKEVEC
Mmopeite va Seite TepIEKOHEVO amd SIAQOPEG CUOKEVEG, TX. UTIONOYIOTH), CUOKEUN
NAS 1 popnTH GUGKEUT, XPNOIHOTIOIWVTAS TIG EQAPHOYEG AMUTIOUN 1} MOUGIKH).

ZUVOEON TWV GUOKEUWV

YUVOEOTE TN GUOKEUH GaG Kall Hitat GANAn CUOKEUT TTou umooTnpilel Tnv urnpeaia
DLNA o7o0 i610 acUpparto Siktuo.

E « BeBawBeite 611 n Aettoupyia koG xpriong apxeiwv (DLNA) ival
€EVEQYOTIOINUEVN KAl 0TN SIKK 0OC CUOKEUN KAl 0T CUVOESEUEVN OUOKELN.

Avaltnon KovTIVWV GUCKEUWV

Mmopeite va Seite pa Aiota pe Tic ouokeuég DLNA mou ival ouvedepéve oto
{610 SikTUO EMAEYOVTAG TO pevOU = > KovTIvéG GUOKEUEG OE KABE EQapLOYY).
XpnotpomolioTe To MEPLEXOUEVO AMO TIG KOVTIVEG GUOKEVEC Omw¢ Ba To
XPnotpomolovoate v BpLokdTav oTn SIKH 0aG CUCKEUN.

Anootoli N AjYn apxeiwv
Mrmopeite va KAVETE Kowvn xprion apxeiwv LETA&Y TG OUOKEUNG 0aC Kal AMNNG
OUOKELNG LG 1 evdg tablet.

AmooToAn apyeiwv
An6 to Ahuroup 1y ané GAn epappioyn, tatiote + > Kown xprion 1 &< kat
€MAECETE 10 CUOKELN amo TN NOTa KOWVIG XProNG apxEiov.

AAqYn apyeinv

ZUPETE TN YPOAUU KATAOTAONG TPOG Ta KATW Kal TaTHoTe To Koupri Kowvi Xprion
Apxeiou.

Eav n ouokeun oag Sev umootnpilel TV Kowvr Xprion apxeiwy, oTnv apxikr
066vn, matrjote Pubpioeig > Tuvdedepéveg cuokeuég > Koviy Xprion Apyeiov >
SmartShare Beam

E + Mnopeite va polpaleoTe apyeia |ie CUYKEKPIEVEG GUOKEVEC TTOU
unootnpiCouv DLNA.
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Mnv evoxAeite
Mmopeite va TepLopIOETE ) va ameVEQYOTTOINOETE TIC EGOTTOIATEIS YIA VA NV 0ag
€VOXAOUV Y10 €VOl GUYKEKPIUEVO XPOVIKO SIdoTnua.
SV apxikr 086vn, matriote PuBpioelg > Hyog > Mnv evoyAeite.
- Aerroupyia kat emAEETe T Aertoupyia mou BéeTe:
- Mdvo nmpotepatotnTa: mpaypatonoteitat Ajyn idomotrioewy Ke fxo i
86vNnon yia TIG EMAEYUEVES EQAPUOYEC. AKON Ki GTaV €ival evepyomoinuévn
n emoyr Mdvo mpotepaldtnTa, e§akohouBolv va nxouv ei50moINCELG.
- Zuvolikd aBo6pufo: amevepyorolei Kal Tov o Kat Tn dovnon.
- Emoyn mpotepatotritwv: AdBeTe £160mOINTELC Kal TIG EI5OTOINTELS YIa TIC
EMAEYHEVEC EQAPHOYEC,
- K\ijoeig amo: Pubpiote pia oglpd eidomomrioewv Katd T Agn KAogwv.

E « Emavalappavopevn KAjon: Méoa oe 15 Aemtd, n Sevtepn kKAon amd tov
{510 kahoUvTa Sev gival olwmnEn.

- Mnvopara ané: PuBpiote pia oglpd eidomoroewy Katd T Ajpn UnNvUpATwy.
+ Xprion Mnv evoyAeite: Evepyomoinote tn Aettoupyia Mnv evoxAeite.
+ Ynvog: OpioTe To MPAYPAUUA Yia TO oTToio BENETE va EvEPYOTTOIOETE TN
Aettoupyia Mnv evoyAeite.
- BonBeia: MpoPohn T forBeiag yia ™ Aettoupyia Mnv evoyAeite.
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Xpnoipeg
EPAPHOYEG



Eykatdaotaon Kal aneykataotacn
EPUPHOYWV

Eykatdotaon epapuoywv
Mrieite o€ éva KATAoTNHA EQAPHOYWV Yia va avalnTAOETE KAl Va KATERAOETE
EQAPHOYEG.
« Mropeite va xpnotporotfjoete 1o SmartWorld, To Play Store fj To katdotnpa
EQAPHOYWV TOU TIAPOXOU UTINPECIWV.

E + [lo opIopEVa KATAOTHHATA EQAPHOYWY EVEEXKETAL VA AmaITETaAL N

Snuioupyia Aoyaptacpou Kat n o0vSEan O QUTOV.

+ Tl0 OPIOPEVEG EQOPHOYEG EVOEXETAL VA UTIAPXEL XPEWDT.

« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN Xprion Sedopévwy, avaloya HE To TPOYPAUMA XPEWTEWY
TIOU €XETE EMMEEEL

+ HAerroupyia SmartWorld evééxetat va pnv umootnpietat avaloya pe Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Katdpynon eyKatdotaong eQappoywv
Katapynote amo Tn OUOKEUN 0ag TNV EYKATACTAC EQAPHOYWV TIoU Sev
XPNOUOTOLOUVTAL TIAEOV.

AMEYKATAOTOON PE MAPATETAMEVO AT A
MoTAoTE TAPATETAMEVA OF HI0L KEVE TIEPLOXT) OTNV 08OV KAl 0TN OUVEXELD TIOTAOTE
10 € TG £Qappoyn¢ o BéAeTe va SlaypayeTe.

Ameykatdotaon He XPron Tou pevol pubpicewv
v apxikn 086vn, matriote PuBpioeig > Epappoyég & eidomoioeig >

MAnpogopieg epappoyng, emMAECTE pia epappoyn Kal matrhote Katdapynon
£YKATAOTAONG.

E «Aev gival Suvatr| n KATAPYNON OPICHEVWY EGAPHOYWV QIO TOUG XPHOTEG.
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Katdpynon eykatdotaong epappoywy amd 1o Katdotnpa
EQAPHOYWV

Mo va KaTapyHOETE TNV EYKATACTACN HIAG EQAPHOYAG, UMEITE OTO KATAOTNHA
EQAPHOYWV ATTO TO OTTO{0 KATEBACATE TNV EQAPHOYN KAl KATAPYAOTE TV
€yKATAoTAOH TNC.

Eykatdotaon Kat Katapynon eyKataotaong EQapUoywyv
KaTd T pLOuIon

‘OTaV EVEPYOTTIOIEITE T GUOKEUN IO TIPWTN YOPJ, UMOPE(TE va KATERAOETE TIG
TIPOTEIVOUEVEC EQAPOYEC.

Mmopeite va TapaKAUYETE AUTO TO BrKA KAl VA TIPOXWPNOETE OTO EMOUEVO XWPIG
V0l EXETE OAOKANPWOEL TNV EYKATACTACH.

Zkoumibia epappoy.
Mriopeite va SeiTe TIC AMEYKATETTNUEVEC EQAPUOYEG OTNV apXIKr 08dvn. Emiong,
UTOPEITE VOl EMAVEYKOTAOTHOETE TIG EPAPHOYEC TIOU £XOUV MEYKATAOTADEL TG
TeheuTaieg 24 WPEC.
T Zmv 0bovn apykn, matiote Alayeipion > Zkouridia pappoy..
Mmopeite akopa va ayyi€eTe pia Kevr TIEPLOXH 0TNV apxIKr) 086vn Kat va thv
Kpatroete ayyi(ovtag To Kouuni Zkoumidia epappoy.
7 Evepyoroinon emBuuntric Aertoupyiag:
+ Emavagopd: emaveykataotaon eMAEyUEVNG EQAPOYAC.
- {II] : KATAPYNOTE MOVIPIA TIG OMEYKATETTNLEVES EQAPUOYEC ATTO TN GUOKEUN.

E + Ol ameyKaTeEOTNUEVEG EQAPHOYEG KATAPYOUVTAL QUTOUOTA OO T CUCKEUN
24 MPEC UETA TNV ameyKaTdoTaor) Toug. Edv BéAeTe va eykataoTroete Eava
TIC AITEYKATEOTNHEVES EQApPLOYEC, Ba mpémel va Ti¢ katefdoete Eava amod To
KOTAOTNUO EQOPHOYWV.

+ Auti n Aettoupyia givat evepyomoinpévn HOVO 0TV MPOEMAEYHEVN APXIK

006vn. Edv ameykabloTdte eQappoyEG Katd tn xprion tng 08évng EasyHome
1) GANOU TTPOYPANHOTOG EKKIVNONG, AUTEG KATAPYOUVTAL ad T GUCKEUN
QMEOWG KA HOVIPAL.
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ZUVTOUEUCELG EQAPHOYWV
TNV apxIkr 086vn, ayyi€Te Kat KpATHOTE MATNHEVO £val €IKOVISIO EQaPHOYNG,
onw¢ Ta eikovidia KAron, Mrivupa, Kapepa, ANumouy, PUBICELG, yia va eavioTei
10 avtioTolo pevol ypriyopng mpooBaonc. Kavte mo evkohn ) xprion
EPAPHOYWV AEIOTTOIWVTAG TIG CUVTOUEVOELC EPOPHUOYWV.

- Natfote ] yia va pubpIoETE TIC TapapéTpou yia Ty emBupnT epappoyn

Tou widget.
- Natfote ) yia va Seite Tig AN PoPOpIEC yia TV eMBUUNTH EYAPHOYY.

E « Autij n SuvatdtnTa givat S1aB€o1UN MOVO Yia GUYKEKPILEVES EQOPHOYEG.
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TnAépwvo

OwvnTikn KAjon

MpaypatomoloeTe TNAEQWVIKY KAON XENOILOTTOIWVTAG KATTOLA OO TIG
Slabéoipeg peBddoug, Gmwg TNV MNKTPOAOYNoN Tou aplBoU TNAEPWVOU HE TO
XEPL, Kat emAéyovTag pia emagr amd tn Aiota enagwv 1 T Aiota mpdo@atwy
KA OEWV.

Mpayuatomoinon KAGng amo 1o MANKTPoAGylo
1 Zmv apxiki 086vn, matriote (B> KAfjon.
7 MpaypatonolfoTte pia KAon xpnotpomolovTag t uébodo e emhoyrg oag:
« TAnktpoloyaTe évav apiBud TAe@wvou kai matiote To koupri (®.
« Ayyi€te Kat kpatoTe €vav apiBpd taxeiag KAong.
+ AvalnTAOTE Hia EMOQH TTATWVTAG TO APXIKO YPALA TOU OVOUATOG TG
EMAQPNE 0TN NOTA EMAPWY, KAl TIATAOTE TO KOUTT Q

E « [la va eloaydyete 1o oUPPOMO «+» OTav mpaypatomoleite SieBveic KAOELS,
TIOTAOTE MAPATETAPEVA TOV APIOPO 0.

« BA. [lpoafikn ema@wv yio NemTOUEPELEG OXETIKA LE TOV TPATIO TPOOBRKNG
apIBuWV TNAEPWVOL GTN NioTa HE TIG Taxeieg KAOELC.

Mpayparomoinon KAoEwVY amo emagEg

1 v apxii 086vn, matote (B> Enagéc,

7 A@oU emAéEeTe Tov apIBPO TIoU BENETE val KAONEDETE a6 TN AioTa EMOPQY,
natiote &..
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Amndavtnon o€ KA\fjon

M0l VOl amaVTAOETE O€ Jia KAON, CUPETE TO KOUWTTE Q 0NV 006VN EL0EPXOUEVNG
Khnonc

‘Otav gival ouvSedepéva Ta OTEPEOPWVIKA AKOUOTIKE, UMTOPEITE va
TIPAYHATOTOIEITE KAOEIG XPNOUOTIOIWVTAG TO KOUTT KAYONG/TEPHATIOHOU
0TO OKOUOTIKG.

Mo va TeppatioeTe pia KAon xwpig va k\eioete Tv 08vn, matrote Sladoxika
PuBpiogig> Aiktuo & Internet > PuBpioceig kK\jogwv > Aavtnon kat
TEPUATIOHOG KAJOEWV Kall, 0TN CUVEXELD, EVEPYOTTOIOTE TN SuvaTtotnTa
Teppatiopdg KAjoNnG pe To mMAKTpo Tpopodoaiag.

E « Xtnv apxikr 086vn, matrote PuBpioeic > Aiktuo & Internet > Pubpioeig
KAOEWV > ATAVTNON KAl TEPUATIONOG KARGEWV > TEPUATIONOG
KAjoNnG pe To MARKTPO Tpogodoaiag kal Ba umopeite va Teppatioste
ot KAjon mativTag To MARKTPO KAEIGWHATOG/evepyomoinong 600 &ival
evepyomoinuévn n 08évn kKA\ong o€ EENEN.

Anéppupn KArjong
Mo va amoppiPete pia el0epXOMEVN KAON, CUPETE TO KOUTT ° otnv 0Bovn
E€10EPKOHEVNG KAONG.
Mo va oteilete éva privupa amdppiyng, CUPETE TV EMAOYH PNVOHOTOG
anoppltl)nc o€ OAn TNV 086vN.

« TampooBrikn n eme§epyacia pnvupatog améppupng, oTnv apxikr 086vn
matrote Pubpiceig> Aiktuo & Internet > PuBpioeig kAfjoewv > Opayn
KAoNg Kat amoppPn HE PAVUHA.

« Katd tnv eloepyopevn KAon, MAtoTe To MARKTPO alénong Tne évtaong
X0V, TO MAKTPO HEIWONG TNG €VTAONE XOU 1) TO MARKTPO evepyomoinong/
KAEISWUATOG Yial Giyacn Tou fXou KARoNg 1 tng 66vnong 1y yia 6éon g kAfong
o€ avapovh.

'EAeyxo¢ E10€pXOMEVNG KANGNG EVW N e@appoyn BpiokeTal
o€ Aertoupyia

OTav €XETE 0 EI0EPXOUEVN KAON EVW XPNOILOTIOLEITE Hia Epappoyr, Ba
EUPAVIOTEL i avaduopievn €160moinon 0To EMAvw PEPOC TG 006vng. Mmopeite
va SeTElTe TNV KAON, VAl TV amoppieTe 1 va OTENETE purivupa amd Ty
avaduopevn 00ovn.
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E TV apxiki 086vn, matrote > Pubioceig Aiktuo & Internet > Pubpiceig
kAnogwv > MNpoobeteg pubpioelg> Eupavion @uvnTikwv KAjoewv 6tav
(0T O pua e@appoyn kal emAEETE Tov Tpomo mou BéNeTe va epgpaviletal n
€10€PXOHEVN KAON OTAV XPNOIHOTOIETE IO EQAPHUOYN.

MpoBoAr avamdvinTwv KAoEWV

Edv undpyxel avamavtntn KAjon, n YPOr Katdotaong 0To EMavw PEPOG TG
086vng eppaviCel v €vdeitn X,

lNa va Seite oToIXEl YIa TIC AVATTAVTNTEC KA OELG, GUPETE TN YPAULUF KATAOTAONG
TIPO¢ Ta kdtw. Mrmopeite emiong va matrioete (9 > Apxeia katayp. KAjG. ot
apxIkn 00ovn.

MpoaoBdoiueg Aertoupyieg kKatd T didpKela KAoNG
Katd n Sidpketa piag kKA\jong, pmopeite va éxete mpdoPaon og mABo¢
AEITOUPYIWV TTATWVTAC TA KOUMTTLA TIo epgpavifovtal otnv 08ovn:

- Emagéc: Seite Tn NioTa emapwv Katd tn SIApKELa piag KAong.

« Avapovn: Balet v tpéxouca KAAON O€ avapovn.
MANKTP: yla va eUQaVioETE 1 va KPUYETE TO TANKTPOAGYIO KAONG.
+ Hyeio: yia va evepyomoloete Tn Aeltoupyia Nyeiwv.
Ziyaon: yla va TpayuaTomoloeTe olyaon 0To MIKPO@wVE 0ag €101 WOTE N
@WVN} G0G VA UNV OKOVYETAL OTOV CUVOUIANTH 0QG.
Bluetooth: mpowBnote Tnv kArjon o€ pia ouleuypévn kat ouvSeSepévn
ouokeun Bluetooth.
« @ :yiava teppartioets TV KON,
+ 1 Mmopeite va petafeite o fivteokArion amd ewvnTikr KAjon.
.+ :mpdoPaon o MPAoBeTeC EMMOYEC KAONG.

E « Kdmoteg Aerroupyieg Sev eival SlaBéatpieg Katd tn SidpKela piag
BvteokAnone.
+ Ta dabéoipa otolyeia pubpioewv evdéxetal va Slagépouv avaloya Ue Tnv
TIEPIOXT 1) TOV TTAPOXO UTINPECIWV.
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Mpayuaromoinon TpiUePoUE KARONG
Mriopeite va mpayUaTomoIoETe KAMON G€ AN EMAQR Katd T SIGEKELD oG
KAjong mou Bpioketat o€ eEENEN.
1 Katén 8idpketa piag kAfong, matfote to koupni = > Mpoobrikn kKAjong.
2 Mnktpohoynote évav apiBpd TAepwvou kat athote To koupri .

+ O16vo K\joelg eppavifovtal oTny 086vn TauToXPOVa Kal N TPWTN KAjon

Umaivel o€ avapovn.

3 Tiava EekivAoeTe pia kAo ouvSIdokePng, ayyi€te Zuyxwveuon.

E « Ta kaBe KArjon evdExeTal va IoXVEL XpEwan. MNa TIEPIOOOTEPEG TANPOYOPIES,
OUMPBOUNEUTEITE TOV TAPOXO UTINPECIWV.

MpofBoAn apxeiwv KAfoEWV
Mo v mpoBoAr) Twv apxeiwv MPAoPaTWV KAGEWY, 0TNV apxIKf 006vn TaTHoTE
> Apxeia katayp. KAAo.. Emerta, pmopeite va XpnolOTMOIOETE TIG TOPAKATW
\ertoupyieg:
« Tava Seite AemtopepéC I0TOPIKS KAoEwy, eMAEETE ia emagn. MNa va
TIPOYMATOTIOICETE Ia KAON TTPOC TNV EMAEYMEVN EMAPH, TIATHAOTE TO KOUTTE

- T va Slaypaete apyeia KAjoewy, TOTHOTE + > Alaypagn.

E + H Sidpketa K\jong mou epgaviletal evoéxeTat va Slagépel armo Tn SIdpKela
L0l TV OTToial XPEWVEDTE. [1a TIEPICOATEPES TTANPOPOPIES, CUMBOUNEUTEITE
TOV TIAPOYO UTTNPETLWV.

« Aev gival Suvatr N amoKaTAoTaAoN TOU SIAYPAUUEVOU IOTOPIKOU KANOEWV.
« [la va TpocapUOOETE To péyeBOG YPAHOTOOEIPAG TwV NUEPONOYiwV
KAOEWV 1} TwV EMaQWY, TETE pe SUo SayTula fj am\woTe Ta SAXTUNA oag.

Alopdép@waon Twv emMAOYWV KARONG

Mrmiopeite va puBpioeTe Ti SiIdQopeg emAoyEC KAONG.

T Zmv apxikr 0066vn, matiote (> Khjon 1y Apxeia katayp. KAAG..

7 Natiote 1o koupni + > PuBpioeig KANfoEWY Kay, EMElTa, SIapopeUOTE TI
EMAOYEC CUUPWVA LE TIG TIPOTIUINCELG 0AG.
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Mivupa

AMOOTOAA UNVUHATOG

Mriopeite va SnIoupynoETE Kal va OTEINETE UNVUHATA OTIC EMAPES 0O
XPNOIHOTIOIVTAG TV epappoy «Mnvopatan.

E « Matnv amooTol INVUPATWY 0TO EEWTEPIKO EVOEXETAL VAl LOXUOUV EMMAéOV
XPEWOELG, M0l TEPIOCOTEPES TANPOPOPIES, CUMPBOUNEUTEITE TOV TIAPOYO
UTTNPECIWV.

1 Zmv apxikn 066vn, matriote (.
2 Natiote o koupn! G-
3 Opiote mapahITTn Kat SnUIOUPYNOTE éva Prvupa.
- Tiava pnotponotoete Ti¢ emhoyé molupéowy, matiote @.
+ Ta va amoktioete mpdoPaon og MPOAIPETIKE OTOIKEID EVOD, TATAOTE TO
Kouun s .
/' EmAéEte To B> (AMooTOM) yia va OTEINETE TO urvupa.

Avayvwon pnvopatog
Mrmiopeite va Seite Ta pnvupaTa mou €XeTe avTaANAEEL avd emar).
1 Zmv apxixr 066vn, matriote ©).
7 Em\é€te wia ema@r armé tn \ioTa pnvupatwy.
« ‘Otav Bpiokeote 0T AioTa pnvupdtwy ri o€ éva mapabupo cuvopiNiag,

umopeite va puBpiceTe To PéyeBOG TNG YPAUHATOOEIPAG av BaleTe SUo
Saytula otnv 086vN Kal T AMOUAKPUVETE ) TANGLACETE PETAEY TOUG,
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Alapdpewaon Twv pUBUIcEWY PNVUHATWV

Mrmopeite va aM3EeTe TIC pUBITELC aVTAMAYNG UNVULATWY TOL WOTE VAl
QVTOTTOKPIVOVTAL OTIG TIPOTIUACELG.

1 Zmv apxixr 066vn, matriote ).

7 Natiote 1o koupni + > PuBpioeig amd Tn NoTa MnvupdTwV.

E « Mmopeite va em\é€ete puBpITELC yia To TapaBupo E150TOINCEWY, TOV
amoKAEIOS KAOEWY, TNV EI80TTOINGN KATAGTPOPNAG, TA NvUKATa
TIONUUEOWY, KT,

Kapepa

Ekkivnon ¢ kapepag

Mriopeite va TpaPriete pwtoypagia ry va eyypavete Bivieo yia va anabavartioete
OMeG TIG a€€XQOTEC OTIYUEG OQG.

TV apyikr 066vn, matriote ().

E « Tlpv amd T Aqyn HIag puwToypagiag 1 Tnv eyypaer evog Bivieo, okoumiote
TOV QOKO TNG KAUEPAG HE Eva amalo mavi.

+ TPpooéTe va pnv AeKIACETE TOV QAKO TNG KAHEPAG HE Ta SAXTUAG oag 1) GNn
&évn ouoia.

« Ot IKOveg ou mepIAapBavovTal G€ auTd To EYXEPIBIOo XPriong MMopEi va
Sla@éPouV amod TNV MPAYHATIK) GUOKEUN).

« Mmopeite va mpoBANETE Kal va EMEEEPYAOTEITE TIC YWTOYPAPIEG KL TAL
Bivteo péow Tou ANumoU. Mo AemTopEPELES, VaTPEETE 0TV EVOTNTA
Aertoupyieg e epappoyri¢ AAumouu .

+ Mnv XpNnOIHOTIOIEITE AUTO TO TIPOIGV VIOl GKOTIOUG TIOU EVOEXOHEVWG
mapaptalouy To ISIWTIKG andpenTo 1 Ta SiKatwpata GAAwV.
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Aqn ewtoypapiog
Mriopeite va TpaPrEeTe QTOYPAPIES HE TV KALEPA GTO TIPOIOV.
1 NatAote (5) kat e0TidoTe 070 Bépa oag.
« Mmopeite va ayyi&ete T 086vn 0To B€pa yia va £0TIAOETE € QUTO.
+ Mmopeite va avoiete 1 va evwoete Vo ddyTula yla peyébuvon f
Opikpuvon.
7 Matote  yia va BydheTe pia pwrtoypagia.
+ Mmopeite emiong va matroeTe To MAKTPO avénong TG EVtaong fxou 1y 1o
TIANAKTPO HEiwong TG évtaong fXoU yia va TPaPHEETE pia wToypapia.
+ Mnopeite va TparEeTe pia wToypagia eVw YPAPETE BivTEO TATWVTAC TO
© oTnVv 0Bévn.
Ot emhoyég mou epgaviovtal otnv 086vn AjPng evdéxetat va Slapépouv
avahoya e TV EMAEYUEVN KAPEPA (UMPOOTIV 1) TTHOW) Kal TN A&ttoupyia
Kduepag.
+ Hkapepa Ba anevepyomoinOei autdpata av Sev TV XPNOIHOTOIOETE yia
Niyo HETA TNV eKTENEDN TNG EPappoyic Kapepa.

EkkivijoTe 10 Google
Lens

Tpéxouoa Aerroupyia
Kapepag

EmAoyi/AkUpwon —3)

PUBuIONS XPOVOLETPOU. lox, — Eyu)\)\uvﬁ euTTPOG/TioW
EmAoyry/AkUpwon —3 Kapepag
pUBHIONG PAag

[ 15— i gwroypagia
EmAoyn peyéBuvong
b — MpocTriokémnon

| — Autéparn BeAtiwon

oKnvAg

Egappoyn eg¢ giipou —¢

PuBuion kdpepag —9

XPAOIUEG EPAPHOYEC 106



5 + Mmopeite va eKTENETETE TNV EQapUOYH KAUEPAG TTATWVTAG Ypryopa SUo
(QOPEG TO TIAKTPO TPOYodoaiag. ETnv apyikr 08ovn matrote Pubpiceig
> EmeKTao€1g > ZUVTONEVOEIG Kall, 0T OUVEXELD, TATHOTE Avolypa
Qwtoypa@ikiig MnXaviig yia va Ty EVEPYOTIOIOETE.

+ ‘Otav n 086vn €ivat amevepyomolnuévn 1 KANESwEVN, HOpE(Te va
EKKIVIOETE TNV KAUEPA TTATWVTAG SU0 POPEG TO TMARKTPO MEIWONG TNG
€vtaonge.

TV apxiki 006vn, matrotePubpioelg > EMEKTATELG > ZUVTOUEVTELC Kal,
07T ouvéxela, matriote Avotypa Owtoypa@ikic Mnxavic -~ @ ylava v
EVEPYOTIOINOETE.

Mpocappoyn Twv eMAOYWV TG KAUEPAS

Mriopeite va TpocappoceTe MANBOC EMAOYWV KAUEPAS AVANOYA HIE TIC
TIPOTIUACELG 0OC.

Ayyi&te To koupmi 33 oTnv 086vN.

« O18100é01pec emMoyég Slapépouv avaloya Ke TV EMAeYpEVN (UMPooTvA iy
Tow) KAUEPa Kal TV emMAeypévn AelToupyia KapePag.

- [2: Népre pia pwroypagia oo FullVision (avaloyia eikévag 18,9:9).

+ [0]: EmAéyerTic Tipég Tou Adyou SlaoTdoewv Kai To PEyeBog yia tn Ayn
PWTOYPAPIWV.

+ [X: EmAéyel Tig Tipég yia Ty avaluon Kat To péyebog yia tnv eyypaen Bivteo.

+ (©): Opiote Tov XpOVOSIAKATN Yia AUTOUATN AU GWTOYPAPIOV
Kataypa@n Bivieo HETA amo éva KaBopPIoHEVO XPOVIKO SldoTnpa.

ByAATE MO QWTEIVEC KO TIEPIOOOTEPO EUKPIVEIC
QWTOYPAYieC € GUVONKES XaunAoL ewtiopov. (Otav
emAeyei n e§AUPETIKA PWTEIVH KALEPQ, EVEPYOTTOLETAL
1] ATMEVEPYOTTOLETAL AUTOMATA AVAAOYQ HE TIG OUVORKEC
QWTIOMOU TOU TTEPIBANOVTOQ).

ZoUmep PWTEIVA
Kdpepa

Tpafd eutoypagieg pe {wnpd XpWHOTA Kat Snutoupyei
€€ QVTIOTABIONG OKOMA KL OTAV Ol PWTOYPAPIEG

HDR TpaBlolvTal Ye KOVTPpa QuwG. AUTEG Ot AerToupyieg
mapéyovtal amd Ty TexvoAoyia upnhou Suvapikol eupoug
(HDR) pe TV omoia givat EomA\iopévn n Kapepa.
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Zwvtavi
puwroypagia

Kataypdyte tn §pdon mpiv kat MeTd Tn Mjun piag
PWTOYPAPIaC.

Egappoyn 'Cheese’

TpaPn&Te YWTOYPAPIES LE PUVNTIKEG EVTONEC,

TomoBsaia eTIKETAC

AmoBnkeVel T ekova el0dyovTag Ta Sedopéva
TomoBeaiag GPS.

Eugpaviote otnv 086vn kaBodnyntikd méypata yia Mjun

MAéypa QWTOYPAPIWV fj eyypaen Pivieo BAoel Twv opt{ovTiwy Kat
KATAKOPUQWV YPAUUWY avapopd.
Mpoabiikn Epgaviel pwa umoypa@n oTiC puToypapieg.
unoypaprc ! HavTov YPAPIES
EmAé€te edv BéNeTe va amoBnKeVETE TIC PWTOYPAPIE Kal
Amnobrkeuon 1a Bivteo otov Eowtep. amob. xwpog iy otnv Kapta SD.
(AlatiBeTan otav €xel TomoBeTNBel KAPTA UVAKNG).
Bonfsia Mapéxel BorBeta yia kdBe pevou Tng Kapepag.

Mpo60BetTeg emMAoyéG 0TNV PMPOOTIVI KAPEPT

TpaPnéte pia selfie emAéyovtag eite AN pe xeipovopia

Selfie XEPLOU ite AuTOpaTn AqYn.
AnoBrikeuon AMOONKEVEL TIC EIKOVES W AVOOTPAUMEVES APOU TPABAEEL
avaoTPOYNG selfie.

E + 'OTav XPNOIOTIOIETE TNV PUMPOCTIVA KAUEPQ, UTTOPEITE VO TIPOOAPUOCETE TO
@INTPO, TO EQE PWTIGHOU KAl TN XPEOLE.

XpriolpeG papuoyeg
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EmAoyn Aettoupyiag

Mriopeite va eméyete UKONA TN AelToupyia mou BéNeTe amo TIC Aertoupyieg mou
eppavifovtal otnv 08évn, ot omoie EMAEyoVTal GUUPWVA HE TO TTEPIBANOV
Myne.

Natiote (=) kat 00peTe TIC AerToupyieg TG KApePag aplotepd r 8e€1d 1 0UpETE TV
086vn aplotepd 1y Se€1d yia va emAECeTE pia AerToupyia KAPEPAG.

AeIToupyieg KAPEPAG
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Xprion Aertoupylwv Kapepag
Eyypaon Bivieo

1 Natiote (2) kat emé€te Biveo o0povTag TG AerToupyieg g Kapepac.
7 MNatiote @ yia va eyypaypete éva Bivteo.

PUBpion kGpepag —el& E— Emioyn piBpiong
XPOVOUETPOU
Eg@appoyn epé @iAtpou —I l— ET[eI)\OVI"]/AKUprII']
pUBHIONG QAag
Evepyotroinon /

ATtrevepyotroinon
oTabepng KApepPag

e —— ETTIAOYI pey£Buvong
1— EvaAhayr) eutrpog/miow
Kapepag

l— Eyypaen Bivreo

+ Ta va TpaPnéete pia puToypagia Katd Ty eyypaen Bivieo, matiote To
Koupri ® .

MPOETTIOKOTINGN ——==ety,

- Tiava Slak6Yete Mpoowpvd v eyypagr| Bivieo, matioTe To KOUmi (11).
la va ouveyioeTe TV eyypan Pivieo, MaTHOTE TO Kouuri e .

+ Katd tnv eyypagn evog Bivteo, pmopeite va Teviwoete f va mdoete Vo
Saytula yia peyéBuvon 1 opikpuvon.

Katd v eyypaen Bivteo, pmopeite va ayyi€ete Tnv emBuuntr meploxr yia
va puBpioete T wteVOTNTA.
3 TMaTAoTE TO KOUUT | ) yia va TEPUATIOETE TNV eyypagn Pivteo.
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Myn pwtoypaepiag
Natiote (=) kat emhé§te PwToypagia GUPOVTAC TIG AEITOUPYIEC TNG KAUEPAG,
BA. Arjn gwtoypagiac ylo epIooOTEPEG AEMTOEPELEC.

Aqyn Moptpaito
Mrmiopeite va TpaPriete pwtoypagieg iy Bivieo mou Kavouv To Bépa meplocdTepo
SiakpItd Kat §€xov pe BGAwanN Tou PovVToL.
1 Natiote (5) kat em)é€te NMoptpaito 0UPOVTAG TIG NEITOUPYiEG TNG KALEPAC.
+ EmAéETe To emMBUUNTO £é 0UPOVTAC TIG EMAOYEC £QE Yia MopTpaito.
7 Matiote () yia va ByaheTe pia pwtoypagia.

PuBpion kapepag — <— EmAoynA pubuiong

II XPOVOUETPOU
—

EmAoyri/AkUpwon
pUBuIONG PAag

Eg@appoyn epé @iATpou —
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3 TatAOTE TO KOU (= yial va TEPUATIOETE TV £yypadn Bivteo.

E « ‘Otav eite o privupa «H Aertoupyia moptpaitou gival Stabéoun.»,

EekviioTe T AYin pwrtoypagiag.

+ HA\erroupyia Moptpaito evexeTal va pn Aeltoupynoel €av n Kapepa dev
UMOpE( val avayvwpioel To Béua.

« Katam Myn ewtoypagiag, diatnpeite pa andotacn 0,5 pe 1,5 pétpo amd
10 Bépa oag.

« Auti n Aertoupyia Sev eivat S1aBEatun oe Mo oKoTeo mepIBAANoV.

« Heyypagn evég Bivreo gival Suvatr pévo pe epé B\wong. Kpatriote
TATNPEVO TO () Y10l VA TO EVEPYOTIOIOETE.

Xprion mpocOeTwv AelTOUPYIWV KAUEPAC
MNatrAote (&) kat emAé€te MeproodTepa 00POVTAC TIC AETOUPYIES TG KAKEPQ,
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Mavépapa
Mropeite va SnUIoUPYNCETE pLd TTAVOPAMIKE QWTOYPAPIa METOKIVWVTAG TNV

KAUEPQ TTPOG piat KATEVOBUVON YIa AP PWTOYPAPIWV KAl CUPPAPH TWV CUVEXWY

MUewv piag evpuywviag MPoBoAng.

1 Natiote (5) kat emé€te NeproodTepa o0POVTAG TIG NerToupYieg TG KAUEPQC.

NatrioTe To Koupmi 4.

2

3 TatAoTE To KoUK (| Kal, £MENTQ, PETAKIVOTE TNV KAWEPQ TIPOG pia
KatevBuvon.

4

Avyyi&te 1o koupni @ yia va SIaKOYETE TV TTAVOPAIKA AN,

PUBION KEpag H’_ﬁ% Emovi poBpions
Egapuoyn £g¢ giktpou EmAoyri/AkUpwon
pUBuIONG PAag

« ‘Otav UETAKIVELTE TNV KAPEPQ TTPOG pia KatevBuvon, Befaiwbeite 6tin
0006vn otnv omoia Kavete TNV AjPn dev BpioKeTal EKTOC TNG YPAUUNG
kaBodrynong.

XpriolpeG papuoyeg
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Xepokivntn Kapepa
Mropeite va SnIoUPYHOETE PWTOYPAPIEG EMAYYENUATIKNG TTOIOTNTAG
XPNOMOTIOLWVTAE TTAHBOG TIPONYHEVWVY AETOUPYIWV.
1 NatAote (5) kat emé€te Xetpokivitn KapEePa 0UPOVTAG TIG AerToupyieg TG
KApEePag.
7 MpooappooTE TIC TAPAKATW PUBLICEIC TNC KAMEPAC.
+ Av opioeTe TV TIur Auto yia emAoyE, ot emAoyég mpooappdloval
AUTOpATWG avaAoya Ke ToV 0TOX0 APNG Kal To TTEPIBAAAOV.

« Edv opiotei n emAoyn Focus peaking, n meployn £0Tiaong emonpaivetat
e xpwua. Autr n duvatdtnta sivat Stabéotun pdvo otn Aettoupyia
Xepokivntn Eatiaon (Manual Focus - MF).

PuUBpion kapepag —3el -—— EmAoyn pubuiong

XPOVOUETPOU

EmiAoyi/AkUpwan

pUBuIoNG Aag

Eg@appoyn epé @iATpou

@ EHoavileiig

SIGPopES
€TTIAOYEG
G Graphy
Mpooappoyr I
i0oppoTTiag Mpocappoyn
AeukoU C TaxUTNTOG
MpooaproyA KAgioTpoOU
€oTiaong Mpooapuoyn
Mpooapuoynr TaxuTnTag ISO

PWTEIVOTNTAG

3 MatAote To Koupmi(  yia va TpaBAgete wa puwtoypagia.
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5 -

Edv matfioete (&) kat emhé€ete éva £gé Graphy, 8a epgaviote] pia Nota pe
OUVIOTWUEVEG PWTOYPAPIES LIE SIAQOPEC PUBITELC.

« Em\éyovtag Ta @é Graphy, umopeite va AaPeTe pwtoypapieg

XPNOILOTIOIWVTAG TNV I00PPEOTTIA AEUKOU, TNV TaXUTNTA KAEIGTPOU KAl TIG
TIEG pubpicewv I1SO mou epapudloval 0TV IPOTEIVOUEVN (puTOoypaPpia.

« Auti n Suvatdtnta eivat Slabéoiun udvo o Xelpokivntn Aettoupyia

KAUEPQG,

« Mmopeite va bite SIGPOPES IPOTEWOLEVEG PWTOYPAPIES AV NABETE TV

epappoyn Graphy amd to Google Play Store.

Eav xpnotpomoleite Sedopéva KivnTrg TNAEQwviag, umopei va empBapuvBeite
ME XPEWOELG Y1a TN Xprion SeSopévuwy, avaloya HE TO TTPOYPAHHA XPEWOEWY
TIOU €XETE EMAEEEL

« Ayyi€re £83, otn ouvéxela matrote ( () amd To pevol Graphy @wtoypaeia

YLOl VOl QTTEVEPYOTTOICETE AUTH T duvatoTnTa.

Mpocappoyn Twv eMAOYWV TG KAPEPQS

Mmopeite va mpooappdoete MARB0E EMAOYWV KAUEQAG AvAAOYa LE TIG
TIPOTIUNCEI 0QG.

Matiote §63 otnv Xepokivntn Kapepa.

Graph Mpooappdote TV Iooppormia Aeukou, Ty Tipr 1SO kat v
raphy , TaxUTNTa KAEIOTPOU YIal TNV TIPOTEWVOUEVN GWTOYPAPIaL

pwroypapia , . . . .
Mo AemTopépeleg, avatpéTe oty evotnTta Xelpokivntn Kduepa.
H ewova amoBnkevetal og poper apxeiov RAW wote va

i UMOPEITE VOl TNV TPOTIOTOIOETE.

Al

Rz‘t’)venksuon “$ | Kard ™ MYn ewtoypagiag Snpioupyouvtal ta apyeia DNG
Kat JPEG Kal, 0Tn OuVExELa, amoBnKeUOVTal WG U CUMTTIEGHEVN
£lkdva uPNANG avéuonc.

Epappoyn i . . .

‘Cheese' TpaPréTe WTOYPAPIES HE PUVNTIKEG EVTONEC.

TomnoBeoia AmoBnkevel Ty ekova elodyovtag Ta Sedopéva Tomobeaiag

ETIKETAC GPS.
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Epgaviote otnv 006vn kaBodnyntikd miéypata yia Ajpn

0dnyog PWTOYPAPLDV BACEL TWV 0PI{OVTIWY KAl KATAKOPUPWY
YPOAUHWV avapopdg.

Mpoodikn EpgaviCel pia umoypagr oTiC gwToypapies,

umoypagng '
Em\é€te edv BéNeTe va amoBNKEVETE TIC YWTOYPAPIEC KAl TAL

Anobrkeuon Bivteo otov Eowtep. amob. xwpog i otnv Kédpta SD. (AwatiBetat
otav éxel tomoBetnBei kapTa PvAUNg).

Bonfsia Mapéxet BorBeia yia kABe pevou TG KAUEPAG.

Apyn kivnon

Anpioupynote éva SlaokedaoTiko Bivieo petaBaiovtag thv Taxltnta g
kivnong. Autr n Aettoupyia givat xpriotpn otav BéAeTe va avanapdyete éva Bivieo
ME XapnAGTEPN TaXUTNTA O€ OXE0N ME TNV TIPAYHATIKH TAXUTNTA TOU 0PXIKOU

Bivteo.

1 Natiote (5) kat emé€te NeploodTepa 00POVTAG TIG NerTOUPYieg TNG KAUEPQS.
7 Matiote 10 Kouumi @.

3 EmAéCteTpApa =) )ARONa = )yiava EQOPUOCETE TO EQE APYNG

Kivnong o€ autd.
+ TprRpo: Zog emTpenel va eQapOOETE éva €@ apyng Kivnong o€ éva
OUYKEKPIUEVO TURA TOU Bivteo.
- Matiote © dtav BéNeTe va eQapuooTei T £QE apyng kivnong. Me
€va 0UVTOUO TIATN A, TO EQE apYRG Kivnong epapudletat yia 0,5
SeutepdhenTa. Me éva mapateTapévo MATNHA, TO EQE apyrG Kivnong
€QapUOTETaL PEXPL VO AP OETE TO SAXTUAG 0aG.
+ 'ONa: Z0¢ EMTPEMEL VA EQAPHOTETE Eva EQE ApyNG Kivnong o€ OAOKANPO To
Bivteo.
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PUBpIon kapepag — e—— EmAoyn puBuiong

XPOVOUETPOU
E@apuoyn £@é @iATpou =i =

EmAoyri/AkUpwon
pUBHIONG PAag

/4 Matote o yiava tpaPnhgete Bivteo.
- Tiava Slak6Yete Mpoowpvd T eyypagr Bivieo, matioTe To Koupmi (11).
[0 va ouveyioeTe T eyypaer Bivieo, TATHOTE TO KOUWT ® .
5 Edv Béhete va ohokAnpwoete T Mjyn, matroTe (= .

YouTube Live

Mriopeite va kataypAyete éva Bivieo kal va To amooTeileTe ameubeiag oTo
YouTube.

Mo va XpnotpomoloeTe auth TRV SuvatoTnTa, MEEMEL Va TTANPEITE TIC
nipoUmoBéoelg emheipotnTag. Emkovwviote pe 1o YouTube yia Ti¢ mpoimoBéaeic.
1 Zmv apxikr 066vn, matrote ().

7 Emére Neproodtepa aMdlovtag Aertoupyieg TG KAUEPAG KAl TTIATHOTE ((o).

E « To YouTube Live givat StaBéotpo pévo 6tav n cuokeun oag sivat
ouvdedepévn ato Sladiktuo. Edv xpnotpomoleite Sedopéva Kivntig
TNAEQWVIaC, UMopEi val eMPBAPUVOELTE [E XPEWTELS yia T Xprion dedopévawy,
QVANOYQ E TO TIPOYPAUMA XPEWOEWY TTOU EXETE EMAECEL.
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XpNolua XapaKTNPIOTIKA KAEPOG

K\eidwpa autdpatng ékBeong/autopatng eotiaong

Mriopeite va mpocappooeTe T0 Tpéxov eminedo ékBeong kat Tn B¢on eotiaong
TIOTWVTOC TAPATETAUEVA TIAVW 0TV 086vn oTnv Autdpatn Asrtoupyia. MNa va
amevepyorolrioeTe TN AerToupyia, ayyi&Te pia Kevr epLoxr TG 086vNng.

PuBpion kapepag —ela e—— EmAoynA pubuiong

- [ XPOVOUETPOU

- EmiAoyA/AkUpwan
pUBuIoNG PAag

Eg@appoyn ¢ @iATpou

KAgidwpa

¥ QUTOHATNG
€kBeang/auTtopar
ng €aTiaong

E + AutA n duvatotnta gival SlaBéotun POVO O CUYKEKPIUEVES AEITOUPYIEC.
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EvaAhayn petadi Kapepwv
Mriopeite va evaANAooETe T Aettoupyia HeTady TG EPMPAC Kall TTow KAUEPAG yia
va Taipladel oto mepIBANov AMjung.
+ T evalayn HETAgY TNG UMPOGTIVAG Kall TNE TTiOW KAMEPAC, OUPETE TV 08dvn
TAvW 1 KATw 0Ty 086vn AYng otnv epappoyr Kaupepa.

E + XpnolHomoIOTE TV UMPooTIviy Kapepa yia va tpaPri&ete selfie. Na
Aemtopépeleg, avatpé€te oty evotnta Selfie.

MeyéBuvon i opikpuvon
Mmopeite va avoi€ete 1y va evwoete §0o SdyTula yia peyéBuvon 1 opikpuvon dtav
AapPdvete pwtoypaeieg i Bivteo.

« H\erroupyia peyéBuvong/opikpuvong Sev sivai Slabéoiun otn Aerroupyia

selfie (umpoaoTviy KApePa).
+ Auti n Aertoupyia Sev umooTnpileTal o€ APKETEG KATAOTAOEIG AEIToUpYiaC.
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Xpnon e Aetroupyiag MoAamhi Aqyn
Mriopeite va TpaPr&ete GUVEXOLEVEC PUITOYPAPIEC Kall VAl TIG SEITE WG KIVOUUEVES
€IKOVEG 0TO ANUTTOUH.
1 Natiote (&) katem\éére Owtoypaepia.
7 Matiote maparetapéva 1o
+ Evw kpatdrte matnpévo 1o AapPdvovtal TOMNEC, OuVEKOEVES
PWTOYPaPIEC.

AAQYN pe xerpovopia xeptov
Mmopeite va tpapriéete selfie Sivovtag eVTONEG pe AMAEG KIVIOELG TWV XEPIWV OO,
Avoi€Te TV MAAAUN 0O OTPAMEVN TTPOG TV UITPOCTIVA KAKEPA Kal, EMELTA,
KAeioTE Ta SAKTUAG 0ag o€ ypobid.
Mriopeite akopun va kAeioeTe Ta SAXTUAG 0ag o YpoBid Kal va Ta avoifeTe mpog TN
UMPOOTIVA KAUEPQ.

. YeTpia SeutepdAemta mpaypatomoleital AN ewtoypagiag.

( »

"

E « Tla va xpnolpomoloeTe autrv Tn Aeitoupyia, petapeite otn Aertoupyia
HITPOOTIVIG KAPEPQG KA, OTN GUVEXELD, ayyiETe Sladoxika §63 > Selfie >
AAYN pe xelpovopia xeptov.
+ BeBawbeite ot n mahdun oag Kat n ypobid oag Bpiokovtal eviog g
YPOUUAG QVa®OPAC YI0l VO UTTOPEL N KAPEPX VA TIG AVaYVWPIOEL
+ Auth n Asttoupyia evéxetal va pnv givat SIaBEoipn 6tav XpnotUoToIETe
OPIOPEVEG aTTd TIC AEITOUPYIEC TNG KAUEPAG.

XPAOIUEG EPAPHOYEC 120



Autopatn Aqgn

Mropeite va XpnOILOTIOIOETE TN AEITOUPYIQ AViXVEUONG TIPOCWITOU YIa VAl

Tpapnéete selfie ypriyopa ki ebkoha. Mmopeite va puBpiceTe Tn GUOKEUR £TOL

WOTE, OTAV KOITATE TNV 086VN, N UMPOCTIVH KAUEPQ QVIXVEVEL TO TIPAOWIO GAG Kt

Tpafdel autopata pia selfie.

+ MONG n pmpooTivi KApEPa avixveloel To IPOOWO oag, epgaviletat éva

Aeukd maiolo-o8nyoc. Eav o Bépa evtdg Tou mhaiciou-o06nyol otapatrioel
Va KIVEITAL, TO XpWHa TOU MAQLGIoU-08nyoU YIVETaL KITPIVO, KAt TOTE N KAUEPQ
Tpapdel pwToypaPia.

E « Ayyi€re S1a801kd $33 > Selfie > Autépatn Aqyn yia va evepyonolioeTe T
Aertoupyia «Autopatn Ajdny.

MeooSiaotnua AqPng
Mrniopeite va tpapriéete selfie pe xpovikr amootaon Hetaly Touc.
Evw xpnotuomoleite T PmpooTivi KApePa, avoi&Te Ty MAAApN 6ag 0TnV KApePa
Kal, €merta, KAeioTe Ta SAKTUNG oag ypriyopa o€ ypobid emavalapavovtag Ty
id1a kivnon 800 popéc.
+ ©a \neOolv TéooEPIC PWTOYPAPiEC S1adOKIKA HETA amd KaBuoTEPNON TPIWV
SeuTEPONEMTWVY Yo KaBepiaL.

AmoOriKeuon avacTpoPn¢
Mpwv TPAPAEETE Lia GWTOYPAPIal LUE TNV UTPOCTIVI KAEPQ, AYYIETE TO Ko §G3 >
AnoBrikeuon avasTpo@nc. H eikova avaotpépetat og optl{ovTio afova.

E + Katam xprion TG HmpoaTiviG KAUEPAG, UMOpEiTe va aAEEETE Tov TPOTIO
MUng Twv selfie oTig emMoyég Kapepag. MNa AemTopépeleg, avatpé&te oty
evotnTa [pooapuoyr] Twv EMAOYWVY NG KAUEPAG .

Selfie
Mriopeite va XpnOIHOTIOICETE TV UMPOOTIVI KAUEPA Yia Val S€iTE TO TPOoWMd
oag otnv 084vn kai va tpaPriéete selfie.
1 Natiote (&) kat emdé€re Dwtoypagia cOPoVTAG TIG Nertoupyieg TG KAUEPAS.
7 Natiote {0 yia evalayr otV pmpooTtivi Kapepa.
3 Matfote  yiava tpapréete pwtoypagia.

- NMatrote §) yia va epapudoeTe S1apopa GHOPPa EPE.
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ANuUTTOUM
Emokomnnon epappoync AApmoup

Mo TIG pwToyPaie Kal Ta Bivieo mMou €xouv amoBNKEUTEN 0TN GUOKEUN 0O
napéyovtat Suvatdtnteg mPoPoAng kal Slaxeiplong Toug.

MpofoAR pwTtoypaPlwWV

Mriopeite va SeiTe TIC pWTOYPaPIES TTOU EXOUV AMOBNKEUTEL 0TO TTPOIOV.
1 NatAote @ kat emé€te Tov emBupnTd @akeho.

7 Matiote oty emBupnTA wToypaPia.

+ O @dakehog Ahumoup mepiéxel Aumoup, Dwtoypaeia, Egé Avapvioeig kat
Avarmap.

— EkkivijoTe T0 Google Lens.

&— lMpooBaon oe GAAeg

ETTIAOYEG.

‘Evapén Tng Kduepag.

EmoTtpogr otnv —=&
TrponyoUpevn 0Bovn.

Mpoobrkn f katdpynon
aTré Ta AYATINUEVA.

Anpioupyia GNUEIWOEWY — o
o€ HIa uTOYpaPia.
MpoBoAn oxeTikoU 41
TIEPIEXOPEVOU
Eme€epyaaia eikovwy.

E «+ To pevou Aemtopepeliv eppaviletat dtav ayyilete Ehappwg tnv 08vn. Av
ayyi€ete Tv 086vn akopa pia gopd, To pevou Ba e€apavioTei.

e — Alaypa@r] EIKOVWY.

Koivr) xprion €Ikovwy.
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Avamnapaywyn Bivteo
Mmopeite va Seite Ta Bivieo mou éouv amobnKeuTel 0TO MPOIOV.

~— [MpooBaon o€

[ BGAAeg eTTIAOYEG.
‘Evapgn g

KAUEPAG

MpoaBnkn 1 kardpynon
aTré Ta AYATINUEVT

Emotpogpn oty —X
TTPONYOUHEVN
0Bdvn.

Malon N —esmmmms
avaTapaywyn
Bivteo.

O — ———— S
TIEPIEXOHEVOU |—]—]—l ypagr

Emegepyaoia eIkOVwy.

KoIviA xpron eIkovwy.

5 « Tla va puBpioete TV évtaon tou o, TpaPrte T 6eid meupd otnv
0006vn evog Bivteo mPog Ta KATW 1 TIPOE Ta MAvw.
« [la va puBHIoETE TN PWTEIVATNTA TNG 006VNG, CUPETE TNV APLOTEPK TTAEUPA
otV 086vn P0G Ta ENAVW I TTPOG TA KATW.
+ Av oUpete TV 086vn Tpog Ta aploTepd atnv 086vn avanapaywyng Bivieo,
7o Bivteo Kiveital mpog Ta miow (REW) kat av oUpete mpog Ta Se€14, Umopeite
Val KIVAGETE TO BivTeD TIPOG Tal EUMPOG Kalt ypriyopa (FF).
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Awaypagn apxeiwv

Mmopeite va SiaypAaeTe apxeia XpNOILOTOIWVTAC Ui ard TIG TAPAKATW EMAOYEG:
- Matiote mopatetapéva mavw o€ éva apxeio amd T NioTa apxeiwv kay, émetta,
em\é€te Alaypagn.

Ta Slaypappéva apyeia petagépoviat autdpata otov + > Kado amoppippdtwv
Kall Wrmopo0v va avaktnBolv MOTPEPOVTAC 0TO ANUTTOU EVTOG 7 NUEPWV.
MatAoTe T0 Ko [x] yia va SlaypAageTe povIpa Ta apyeia. T€ auTAv TV

mepimTwon, Ta apxeia dev umopolv va avaktnBolv.

Kown xprion apxeiwv
MmopeiTe val KOIVOTIOIOETE £Val APXEIO XPNOILOTOIWVTAG Mol oo TIG TApaKATw
emAoyéc:
« Evi BNémete pia gwtoypagia A Bivieo, matAote To koupni o< yia va
KOIVOTIOIOETE TO APXEIO XPNOIHOTOIWVTAG TN HEB0SO mou BéNETE.

E + Edv tpapnéete pwtoypagics A Bivieo agol matroete () > $63 > TomoBeaia
etikétag @, SnUIoupYEiTal AUTOUATO TO GAUTTOUW QVOLVIOEWY
OUYKEKPIUEVNG TOTOBEGIOG UETA MmO éva OPIOMEVO XPOVIKO SIAoTNHA 0TV
KapTENA AVAUVIOELG TOU ANUTTOU.

+ Mmopeite va avalnTroeTe TIC pwToypagieg 1 Ta Bivteo ue Bdon Ty Béon,
TNV ETKETA, TV AETOUPYIa KAUEPAG KATT. TIOTWVTOG Q 0TO GAUTOU.

+ Oplopéveg HOPPEG apyeiwv evdéxeTal va unv umootnpifovtal avdhoya pe To
EYKATEOTNUEVO AOYIOUIKO.

« Evdéxetat va pnv ivat Suvatd to dvolyua oplopévwy apyeiwv e€artiog Tg
KwSIKOToiNar¢ TouG.

+ Apyxeia mou umepPaivouv To EMTPEMOHEVO Oplo PeYEBOUG evOéxeTal va
TIPOKAAETOUV GQANUATA.

« [pémel va evepyorolroete T Aertoupyia GPS yia va dnuioupyroete éva
GATTOU PVAHNG.

Anovupyia KOAG

Mriopeite va Snpioupynoete éva KoAAL XpNOILOTOIWVTAG OXETIKO TIEPIEXOUEVO.

1 Noatiote @Y katemé€te 2 > Anpioupyia KoAad.

7 Em\é€te TIC e1kveC Tou BéNeTE va TIPo0oBETETE 0TO KOAAL Kal EMErTa TTaTHOTE
Emopevo.

« EmAé€te ™ Sidtagn mou BéNeTe amd To KATw PEPOG TNG 006VNG.
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3 MNatfote Anpiovpyia.

5 « Tlatn Snpiovpyia KONAC, UMOPEITE VAl XPNOIOTIOIOETE £WG 9 EIKOVEC.

Anpioupyia Tawieg

Mriopeite va dnpioupynoeTe pia véa tavia cuvéualovTag eikoveg kat Bivteo.

1 Natiote € ke em\é€te = > Anpioupyia Tawieg,

7 Em\é€te TiC eikdveg iy Ta Bivieo mou BéAeTe va oupmepINIBETE 0TV Tawvia oag
Kat matrjote Emépevo.

3 EnefepyaoTeite TIC EIKOVEC Kall Ta BIVTED TIOU £XETE EMAECEL KA TTIATHOTE
AmoBrikeuon.

Eg@appoyn ¢ o€
apyeia

Emavagpopd
apyeiwv

MpoemokdéTNon
apyeiou

Alaypa@r) apxeiwv

Mpoobrkn apxeiwv

E + Ta Tt Anpioupyia Tawieg, pmopeite va xpnotpomolrnoeTe éwg 50 Bivteo.
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Anovpyia GIF

Mmopeite ebkoha va SnuoupynoeTe éva apyeio GIF xpnotpomolwvag
nxoypagnuévo Bivteo.

Natiote (Y ka em\é€e ¢ > Anpioupyia GIF.

Anuovpyia Bivteo
T Tnonypr mou Ba emé€ete otV apyr) TS MPoBoAAG evéc Bivteo, matioTe @),
7 Em\é€te 1o prikog Tou GIF miou OéAeTe va SnuioupynoeTe.
+ To GIF dnuioupyeitat yia o Xpovikd S1dotnpa mou éxel emAeYei amé To
KaBoPIoPEVO XPOVIKO ONpEio Evapéng.
« Na Bivteo pe Sidpkela Aiydtepo amo 5 SeutepoAemta, ot ikoveg GIF
SnoupyouvTal QUTOHATA YIa TV UTIOAOITTN WPa.

Anpovpyia pwrtoypagiwv GIF

T Zm Nota wtoypagiiv ot cuMoyr, matote - > Anwoupyia GIF.

7 Em\EETe pia eKOVa Yia va TN HETATPEYETE O wToypagia GIF kat émerta
natriote Emopevo.

+ Mmopeite va mpooBéoeTe/SlaypAPeTe pia pwToypapia, Vo TPOCAPHOCETE
TNV TaxUTnNTa 1 Tov Adyo 08vng Kat va 0pIoETE TN OELPA TWV QWTOYPAPIWV.

E + Hénpioupyia pwtoypagiwv GIF givat pia AerToupyia ou mapéxetal yla Tov
XPOTN WOTE VO UMOPEL va TIAPAYEL SNUIOUPYIKES lKOVES. H mapaiaon
SIKalwPATWY OTIWG To SIKaiwpa TVEVHATIKAG IGloKTnaiag fi n SlafoAr
NG PANG GANOU ATOLIOU XPNOIUOTIOWWVTAS TN AetToupyia Snpoupyiag
pwtoypaplwv GIF evdéxetal va mPoKaAEGEL AOTIKI 1 TTOWVIKK Siwén
OUMQWVA JE TOUG LOXUOVTEG VOpOUG. Mnv avTypdpeTe i petadidete To £pyo
AaMou atdpou xwpic mponyoupevn eovatodétnon. H LG Electronics dev
@épel Kapia uBuvnN yla TETOIEG EVEPYELEG ATTO TOUG XPHOTEG.

+ Mmopeite va emMé€eTe éwg 100 pwToypapies OTav SNUIOUPYEITE pia EIKOVA
GIF.
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Emagég

Enagéc - Mapouoiaon
Mriopeite va amoBnKeVoETe Kal va SIAXEIPIOTEITE TIC EMOAPES.
SV apyxikn 086vn, matrjote Ta amapaitnta > Emagéc.

MpocOnkn emagwv

MpooBnkn véwv emapwv
T Zv 0B6vn e Niotag Mgy, mathoTe To KOUUTT—-.
+ Oa gppaviotei éva avadudpevo mapdBupo yia va emiéEete T Béon
amoBriKeuong yla va Tnv Kovorolroete. EmAEETe Tn B€on mou BéheTe.

7 Eloaydyete ta otolyeia enmkowwviag kai matote AmoBrikevon.

Eicaywyn emagpwv

Mmopeite va eloayayeTe emagég amo i GAAn GUOKEUN amoBrikeuonc.

T Zmv 086vn ¢ Niotag emagav, ayyi€te iadoyikd - > Alaxeipion enagwv >
Ewcaywyn.

7 Em)\é€te TIc TomoBeaieC poEAELONC Kal TTPOOPICHOU Yia TV EMAQH TV
mipoopiletal yla elcaywyn kai matriote OK.

3 EmMé€te TIc emagéc kat ayyi€te Eloaywyn.
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Mpoobrkn emagwv otn Aiota Tayeiag KAjong

T Zmv 086vn e Niotag enagav, TatioTe 1o koupni + > Tayeia KAjon.
7 Ayyi&te Mpoodrkn emagrg amd évav apibud Taxeiag KAGong.

3 Em\é€te pia emagn.

+ ‘Otav mPOOoBETETE pia KaVoUPYLa ETOQY, TTATAOTE (313 yia va mpooBéoete
€vav aplBuo Tayeiag KAong.

Avalntnon emagwv
Mriopeite va mpaypatomoloeTe avalfitnon EMaQwv XPNOILOTOIWVTAG Wia amd Tig
TIOPAKATW EMAOYEG:

+ Matjote T ypappr avaltnong oTo Kdtw pépog Tg 086vng Emapég kat
€10AYETE TNV EMOUUNTA EMAQR 1} TOV APIBUO TNAEPWVOU TToU BENeTE val
avalntroeTe.

- Mpaypatomorote KUAIoN TS NOTAC EMAQWY TTPOG T TTAVW 1 TTPOC TA KATW.

- A6 10 EUPETPIO 0TNV 006VN TNG NOTAG EMAPWY, EMAECTE TO APXIKO YPAppa
ylo pia magn).

E « Av matioete T ypappr avaditnong oto KATw péPog TG 08ovng Emageg
Kal El0GyeTe pia emagn fj aplBpo TNAepwvou epgavifovtal Ta vomoinpéva
anoteléopata avalitnong amo To IOTOPIKO KAFOEWV Kat TN NioTa EMaQwy,
OMWE LTIAPXOLV ATTOBNKEVHEVA OTO TIPOIOV.
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Niota ema@wv

Eneepyacia emapuwv

1 Zmv 086vn e NoTag emapwy, emMAEETE pia emagn.

7 v 0B6vn Twv OTOIXEIWV WOG EMAQAC, TIATAGTE TO Kouuni /° Kat
€MECEPYAOTEITE Ta OTOIYE(QL

3 MNatfote AMoBAKELVON Yia va anoBnKeUoeTe TIC AANAQYEC.

Awaypa@n emapwv
Mrmiopeite va SlaypAYEeTe EMAPEC XPNOILOTIOLWVTAC Lial a6 TIG TAPAKATW
EMMOYEC:
+ XV 08dvn Tng NioTag EMagy, ayyi§Te Kal KPOTHOTE TV EMAPH TIou BENETE va
Slaypayete Kay, 0Tn oLVEELD, ayyiETe [ii].
- Ayyi€te iadoxika : > Alaypagn ou Bpioketat atnv 086vn Notag enagwv.

E Ol amOMAKPUOHEVEG ETTAPES EVOEXETAL VA NV AITOKATACTABOUV.

Mpoobrkn ayammpévwv

Mmopeite va KATaXWPICETE TIG EMAPES TTOU XPNOLUOTIOLEITE GUXVA WG AYATTNEVEG.
1 Zv 086vn e NoTag ema@uwy, emMAEETE pia emagn.

7 TtV 0B6vn TwV OTOIKEIWV MIag EMAQHC, TOTHOTE TO KOUPT 17

Anpovpyia Opddeg

T Zm Nota tg opadag enagv, natiote —-.

2 MAnktpoloyroTe éva véo dvopa yia Ty opdda.

3 NatAote MpooBkn pehiv, em\é€Te emagéc kat atrote MpooBRkn.
A Natfote AmoBrKeuon yia va amobnkeVoeTe T véa opada.
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QuickMemo+

Mapouaiaon TG epappoyng QuickMemo+

Mriopeite va @TIAEETE SNUIOUPYIKES ONUEIWOELS XPNOILOTIOIWVTAG TV YKAUA
emAoywv mou S1aBETEL AUTA N TIPONYUEVN SUVATOTNTA TOU GNUEIWHATAPIOU, OTTWG
n Siaxeipion ekévwv Kat otiypdtunwy. Ot emioyég auté Sev umootnpilovtat amd
TO GUUPBATIKO CNUEWHATAPLO.

Anuoupyia onpeiwong
1 Zmv apxikn 086vn, matjote QuickMemo+.
7 TNatrote o koupni @ yia va Snuioupynoete pia onpeiwon.
@ : anobrikeuon onpeiwong.
+ < Avaipeon tng mponyoUHEVNG evépyelag eme€epyaciac.
+ 7 : EmavéAnyn twv mo mpoo@atwy vepyelwv Slaypaprc.
- (T): e1l0aywy ONUEIWONG XPNOIHOTIOLWVTAG TO TTANKTPOASYLO.
+ / : Snioupyia XEIPOYPagwWY ONUEWOEWV.
- & iaypagn XEpOYPAPWY ONUEIDCEWV.
- {): ueyéBuvon 1y opikpuvon, TEPIOTPO®R 1 Slaypagr onueiwy piag
XELPOYPAPNC ONUEIWONC.
: :Mp6oPacn oe AAEG EMAOYEC.
3 MatAote To Koupmi Q yla va amoBnkeVoETe Tn onpeiwon.
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Anuiovpyia onuelcEWY o€ éva oTIyOTUNIO 006VNG
T Katdmv mpoBoAr Tng 086vng mou BENETE va amOTUNIWOETE, GUPETE TN YPAUUN
KATAOTAONG TTPOG T KATW KAtl, 0T GUVEXELD, aYYIETE TO Koupri (7,
+ To otiypotumo 086vng eppavifetal we O€pa AVToU 0To ONUEIWUATAPLO.
Ta epyaleia onpewoewv eppavifovtal oTo mavw PEPOS NG 086vNG.
7 Kavte mepikomt Tng ekovac (av xpelaletat) Kat TPOoOEOTE TIC ONUEIDOELC TTOU
BéNete.
+ Snpioupyia XEIPOYPUPWY CNUEIWOEWY 0T PWTOYPAPIa.
3 MatAoTe To Koupmi Q Kall amoBnKeVoTE TIC ONUEIWOELG 0TV TomoBEdia Tou
BéNete.
« Mmopeite va Seite Ti¢ onewaelg mou amoBnkeloarte gite 01o QuickMemo+
€ite 010 AAUMOU.
- [a va anoBnkeVoeTe ONUEIWOEIS TNV iSla TomoBeaia pe Thv iponyouevn
(POPA, EVEPYOTTOINOTE TO TIAAioL0 EAéyXou Xpron amé mpoemAoyn yia
AUTHVY TNV EVEPYELD. KOl EMAECTE IO EQOAPHOYT.

5 + Mmopeite va amotunwoete 0AOKANEN TV 080vN XPNOIHOTIOIWVTAG TN

SuvatétnTa KUNoNG.

« Evw xpnotporoleite kamola epappoyr, 6mwg yla mapddetypa ta Mnvopata
1 1o Chrome, 6UpETE Tov Tivaka EI00TOICEWV TPOG Tt KATW Kat TOTHOTE
Capture+ > Eméktaon, yla va anotunwoete oOAOkAnpn tv 066vn mou
BAémete T Sedopévn OTIYHNA WG Eva APXEID ATTEIKOVIONG.

« Auti n SuvatdtnTa eivat S1a0£01Un HOVO YIa OPICHEVEG EQAPHOYEG TTOU
umootnpiCouv T SuvatdtnTa KUNONG.

« Midote 6Uo Sdytula 1y amioTe Ta SAxTUAG oag yia va aA\agete T Siataén
TWV Onyeiwv.
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PoAot

A@unvion

Mriopeite va opioete va xtummoet To umvntript pia kaBopiopévn wpa.

T Zmv apxikr 086vn, matote PoAdL> Agunvian.

7 TlaTAoTe To Koupni —- yia va mpoaBEoeTe éva kaolpylo EumvntipL.
3 Alapop@woTe TIG pUBICEIS apUMVIONG Kat TIaTroTe ATToBAKEUON.

E « EQv em\é€eTe pia Kataywpion apumviong mou &ixe puBpIoTEl aTo TTAPENBOV,

UMOPEITE Va EMEEEPYAOTEITE Tal OTOIXEID TNG.

Maykooio poAot

Mriopeite va Seite TNV TPEXOUOA WPA OTIG TIOAELG GE OAO TOV KOGHO.
T Zmv apxikr 086vn, matote PoAdtL> Maykdopio poAdt.

7 Matiote 1o Koupmi + Kall TPOCOE0TE i TTOAN,

AvTtioTtp. Xpovop.
Mrmiopeite va opioeTe va XTUMM gL To UMVNTHPL META Mo €va KaBoplopévo
XPOVIKO SidoTtnua.
T Zmv apxikr 066vn, matiote PoAGL > Avtiotp. Xpovo.
7 Pubpiote v wpa kai matiote Evapén.
+ Ta avaotoAr Tou xpovodiakdmn, matiote Maven. a cuvéyion Tou
XPOVOSIAKOTTN, TTATAOTE ZUVEKELQ.
3 MatAote AlKOTH yia va SIOKOYETE TOV XPOVOSIOKOTTH.

XpriolpeG papuoyeg
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Xpovopetpo
Mmopeite va XpnOIOTIOIOETE TO XPOVOUETPO YIa VO LETPHOETE TOV XPOVO yla
£vav yupo.
T Zmv apxikr 066vn, matiote PoAdL > Xpovopetpo.
7 Matiote 1o Kouuri Evapé&n yia va EEKIVHOEL TO XPOVOUETPO.
+ Tova PETPROETE TOV XPOVO yia €vav YUpo, TaToTe Lap.
3 Matfote Mavon yia va avacTe\eTe TO XPOVOUETPO.
+ [0l va OLVEXIOEL TO XPOVOUETPO, IATAOTE ZUVEXELQD.

+ Ta va dlaypdpete ONeG TIG £YYPAPES KAl VA EEKIVAOETE TO XPOVOUETPO OO
v apxn, ayyi€te Emavagopd.

HpepoAadyto

HuepoAoyio - Mapouaiaon
Mrmiopeite va XpnolUOTOLEITE TO NPEPOAGYIO Yia TN SlayEipton CUUBAVTWY Kal
EPYOACIWV.

Mpocdrikn cupfaviwv

T Zmv apxir 066vn, matiote Ta anapaitnta > Huepohdyto.

7 EmAé€te pia nuepopinvia kat matiote To koupri €.

3 E1o0aydyeTe Ta OTOIXED TOU GUMBAVTOC Kat TTIaTroTe ATTOBAKEUON.

ZuyxpovIopog cuppdaviwy
MatioTe 1o Koupni + > Hpepohdyla yia cuyXpoviopd Kat emMEETe éva
NUEPOAGYIO VIOt GUYXPOVIOWO.

5 « ‘Otav o1 ekdNAWOELG oou amoBnKeVOVTAL Ad TN CUCKEUN GTOV Aoyaplacuod
oou 1o Google, autépata cuyxpovifovtat pe To HuepoAdyto Google,
eniong. TOTE, UMOPEIC VA OLYXPOVIOELG ANNEG CUOKEVEG piE TO HEPONGYIO
Google yia va KAVEIG QUTEG TIG CUOKEVEG Val £XOLV TIG {S1EG EKSNAWOELG TTou
£€XEL N OUOKEUN 00U Kal yla va SlayelpiCeaat TiG EKSNAWOELG 6ou TTAvw o'
QUTEC TIC OUOKEUVEC.
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Epyaoieg

Mriopeite va KataxwpioeTe EpYAOieC 0TN CUOKEUN 0ag yla EVKOAOTEPN Slayeipion
TWV XPOVOSIayPapHATWY 0ag.

T Zmv apyiki 086vn, matiote Ta amapaitnta > Epyaoiec.

7 Matiote 1o Koupmi e yla va pooBéceTe ia epyacia.

3 El00yAyeTe TIC TANPOPOPIEC yia TNV epyacia Kal iatrote ATOBARKEUOT.

Movuoikn

Mriopeite va akoUoETE Kal va SIaXEIPLOTEITE TPAYOUSIA ) LOUCIKA AAUTTOUL.
T Zmv apxikr 086vn, matiote Ta anapaitnta > MouGIK.

7 Em\é€te wia katnyopia.

3 EmAé€te éva apyEeio MOUOIKAC.

,— PUBION NXNTIKWV EQE.

.« TpdoBaon o€ GAEG eMAOYEG.

EmoTpogr oTnv TTponyoUpevn —s
06ovn.

—— MetdBaon otn AioTa
QAVaTTOPAYWYAG.

Avoige/KAeioe To Boombox ——
how.

—— MMavon A avamapaywyn.

—— Avoige/Kheioe 1o g DAag.

MaToTe yia avamapaywyr
Q17O TNV apXr| TOU TPEXKOVTOG

apxeiou / Matote d0o gopég = MaroTe yia avamapaywyr Tou
Yia avaTrapaywyn Tou l l €mopevou apyeiou / MarfoTe
TTPONYOUpEVOU pxEiou / TIAPOTETAPEVA VI YPriyopn
Mamote TAPATETAEVA VIOt X e P om Tpowdnan.
ETMOTPOPH OTNV APXH.
Av ,p N fl pxr’] _] L— Emidoyn Aemoupyiag
aTmapaywyr o€ Tuxaia ogipd. ——— emavaAnyng.
Mpooappoyn TG €viaong ———ea 3 «—— AMhayn BripaTog Kai TaxuTnTag.
fxou. 0
Mpoa6rikn i Siaypaen atd Ta [
ayaTnpéva.
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5 + OplopéVEG MOPPEG apXEiwv evOExeTal va unv urtooTtnpilovTat avdhoya pe To
EYKATEOTNUEVO AOYIOUIKO.

Apyeia mou umepBaivouy To EMTPEMOPEVO OpIO HeEYEBOUG EVOEXETAL VA

TIPOKAAEGOUV GQANUATA.

+ Ta apxeia pousIKiG evoéxeTal va mpoaotatevovTal amd Siebveic katdyoug
TIVEUUOTIKWV SIKAUWUATWY 1} TOUG VOHOUG TIEQT TIVEUUATIKWV SIKAUWUATWV.
Mo va avTlypAapeTe KAmolo apxeio MOUGIKNG, UMOPE( va XPelaoTel va AaPeTe
vopipn adeia. Na va mpayatomnoloete AjPn i avtypagr vog apyeiou
MOUGIKNG, ENéYETE TPWTA TN VOLOBEDIia TTEP TIVEUUATIKWY SIKAIWUATWY 0T
XWpa 6mmou BpioKeoTe.

+ Autd to povtého umooTnpilel avamapaywyn fxou Hi-Fi. Ta apyeia rixou Hi-Fi
epgavifovral pe To ekovidio Hi-Fi.

+ ‘Otav 10 XapaktnploTiké Boombox Show eival evepyomoinuévo, n 086vn
OeixVEL OTITIKA EPE OTN MOUGIK).

ApiBpopnyaviy
Mriopeite va xpnotpomolroete U0 TUTTOUG UTOAOYIOTWV: TO AMTAG KOUTTIOUTEPAKI
KOl TN MNXAVIKK apIOHOUNXavh.
T Zmv apxikr 066vn, matiote ApiBpopnxavi.
7 XpnoomotioTe To MANKTPOAGYIO YIa VA KAVETE £VaV UTIONOYIGHO.
« Edv Bé\ete va yivel véog umohoyiopdc, atroTe mapartetapéva o {XJ.

Mpoypappa Exkiv. Mayvid.

Mmopeite va emAé€ete av Ba xpnoipomoteitat To Mpoypappa Ekkiv. Maixvid. dmou
umopeite va Seite T AioTa pe Ta maixvibia mou éxouv eykatacTabei oTo mpoiov
Kol va emAéyeTe pubuioelq yia Ta matgvidla, dmwg amevepyomoinon Tou AXOU Twv
TIOAUHECWVY, TIEPLOPIOHO EIGOTTOICEWY, KA.

T Zmv apxikr 086vn, matiote Ta anapaitnta > Mpdypappa Ekkiv. Maixvid..
7 Em\é€te tnv emoyr ou BéAeTe.
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LG Health

Emokomnnon tn¢ epappoyng LG Health

Mriopeite va SlaxelploTeite Bépata mou agopouv T Lyeia 0ag Kal va UIoBETHoETE
KOAEC OUVIHBEIEC OWUATIKIG GOKNONG TAPAKOAOUBWVTAC TIC AOKICELG TTOU
EKTENEITE.

Elocaywyn otn Xxprion g epappoyn¢ LG Health

Mriopeite va TpoGapHOCETE TIG pUBUioELS TNG eQappoyrs LG Health dtav ekkiveite

TNV EQAPUOYH Y10 TIPWTN POPA LETA TNV EMAVAPOPA TNG.

1 v apyiki 086vn, matriote Ta amapaitnta > LG Health.

7 AkolouBroTe Tic 08nyieg mou epgavifovTal 0TV 086vn yia va OMNoKANPWOETE
N Slapopewon.

Xpnon ¢ epappoync LG Health

v epappoyn LG Health pmopeite va Seite Baoikég minpogopieg kat va
SIOXEIPIOTEITE TO EUPOG TWV TTANPOPOPIWV UYEIDG KAl QUOIKAG AOKNONG.
1 Zmv apxikn 086vn, matijote Ta amapaitnta > LG Health.

7 DAiatiBeval ol Tapakatw eMAOYEG.
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= :Oeite To apyxEio KATAYPAPHC TWV CWHATIKWY OOKACEWY 060G TN
OUYKEKPIUEVN NUEPa TIOU BEAETE Va eNéyEeTe.

- Q : &exiote va mapakolouBeite pia doknon. Kataypagetat n Sladpoun
Kall N V100N TG OWHUATIKIAG AOKNONG Yial KABE TUTTO AOKNONG TTOU EKTENEITE.

.+ :0piOTE TOUG NUEPHOIOUC OTEXOUC OWHATIKAC AoKNONG, T Beppideg ou
BéNeTe va KatavohwVveTe kai Ta Bripata 1y opioTe Sid@opeg pubpioeig otnv
gpappoyn LG Health.

E « Otm\npogopieg o€ BEpata vyeiag mou mapéxovTal amod Ty Epapuoyn
LG Health mpoopiCovtal yia tnv eukolia Tou XprioTn Kai Sev mpémel
va xpnotpomoinBouv yia v mpoAnyn, Tn Bepaneia kat T Siayvwon
aoBevelv 1 AMwv MPoBANUATWY 1ATPIKAG PUONG.

« Hegpappoyn LG Health evdéxetat va Slagépet iy va pny eivat Slabéatpn,
avaloya HE T XwPa Kal Tov Tapoxo umnpeativ. Ot Aettoupyieg ou
SuatiBevtat yia Ty epappoyn LG Health, kaBwg kat AANEG eQappoYEG
TIOU UMOPOUV va TpooTeBouv oty epappoyr LG Health, evdéxetal va
S1apépouv avaoya pe Tn xwpa. Autd oeileTal GTOUG SIAPOPETIKOUG
VOUOUG KAl KAVOVIGHOUG TTOU [OXUOUV.
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E-mail

Email - Napouciaon
Mriopeite va Kataywpioete €va hoyaptaopud email 0T cUOKeU 0ag Kay, 0Tn
GUVEXELQ, MTTOPEITE VO TAPAKOAOUBEITE Kall val 0TéNVETE email ammd Tn GuoKeur oag.

5 « Eav xpnotpomoleite Sedopéva Kivntrig TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN XPrion SeSopévwy, avaloya HE TO TPOYPAUHA XPEWOEWY
TIoU éXeTe EMAEEEL N0 TTEPIOOOTEPEG TANPOPOPIES, CUMPBOUNEUTEITE TOV
TIGPOXO UTINPECIWV.

Kataywpion Aoyapiacpwv email

‘OTav XPNOIUOTOIETE TNV EQapHOYr email yia TpwTn Qopd, TpEmel va

KataxwpioeTe Tov Aoyaplaopo email oac,

T Zmv apxikr 086vn, matiote Ta anapaitnta > E-mail.

7 Emé€te évamdpoyo unnpeotiv e-mail.

3 Ewaydyete T SieuBuvon email oag kat Tov KwSIKO TPOGRACNC, Kal TOTHOTE
Emopevo yia va kataywpioeTe Tov Aoyaplacuo oag.
+ [0 va KOTOKWPIOETE PE P QUTOMATO TPOTTO vav Aoyaplaouo email, ayyi€te

Mn autépatn pUBpion (E4v KpiveTal amapaitnTo).

Awayeipion Aoyaplacpwv email
Mo va Seite 1y va emeepyaoTeite TIC puBHIoELS yia Tov Aoyaplaopd email oag,
TIOTAOTE T Koupni & > PuBpioelc.
- Ta va mpooBéoete évav hoyaplaopo, matriote Mpoabrikn Aoyaplacuov.
- Tava dlaypdyete évav Aoyaplaops, matfote To koupri = > Katdpynon
Aoyapiacpov.

Avotypa dAhou Aoyaplacpov email

Eav éxouv Kataywptotei moAoi hoyaptaopoi email kat BéNeTe va Seite évav ahho
Noyaplacud, TatroTe To Koupri == Kalt EMAEETE Tov GAAO Aoyaplacud amé
Nota.
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'EAeyxog email
T Natiote To Koupmi == kat emMETE €va YPapUATOKIBWTIO.
7 Em\é€te éva email am6 tn Aiota email.

+ EpgaviCetat to privupa email.

AmootoAr email

1 NarAote to koupmi @.

7 Tupmnpwote Tn SieuBuvon email Tou TAPANATTY.

3 MANKTPOAOYAOTE TO O£ KAl TO KEILEVO TOU UNVUUATOC,
+ Na va emouvayete apyxeia, TatioTe 1o Kouuni (.

- Ta va anokTtoete mpdoPaon og MPOAIPETIKA OTOIKEID IEVOU, TATAHOTE TO
Koupri : .

4 NartAote To koupni B> yia va oteilete To email.

E « [0 va IpoCapUOOETE TO pPéYEDOG TG YPAUMATOOEIPAG TG AioTag
nAextpovikou Taxudpopeiou, méoTe pe dUo SayxTula fi amwoTe Ta SAXTUNG
0ag.

Padiopwvo FM

Mriopeite va akouote padioewvo FM.
v apxiki 086vn, matriote Ta amapaitnta > Padiogwvo FM.

E « [0 va XpnOILOTOICETE QUTAV TV EQAPHOYN, TIPETEL TTPWTA VAl CUVOECETE
TA AKOUOTIKA 0T GUOKEUK. Tl 0KOUGTIKA AEITOUPYOUV GaV Kepalial
padlowvou.

+ Auti n Aetrtoupyia evaéxetal va unv umooTnPi(ETal O€ OPIOUEVES TTEPIOXEG.
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Awayeipion apyeiwv

Mo Ta apyeia ou €xouv amoBnKeUTel 0Tn CUOKEUR oag 1 oTo cloud mapéyovTal
Suvatdtnteg mpoPolig kat Staxeipiong.

T Zmv apxikr 086vn, matiote Alayeipion > Alayeipion apxeiwv.

7 Natote o Koupmi == kat emA&ETe TV emBupnTr TomoBecia amobrikeuong.

LG Mobile Switch

Méow Tou LG Mobile Switch petagépete elkola Sedopéva amod Hia HETOXEIPIOHEVN
OUOKEUN O€ L0 VEQ CUOKEUN.

T v apyiki 086vn, matfiote Alayeipion > LG Mobile Switch.

Mmopeite emiong va matrioete PuBpiceig > Zvotnua > Avtiypag@o ac@aleiag
> LG Mobile Switch.

7 AkolouBroTe TIC 08nyieg Tn¢ 006vNg yia va emAéEeTe TV emBuunTr péBodo
UETAPOPAC.

E + Agev Ba dnpoupynBouv avtiypaga aopaleiag yia ta dedopéva ot Evav

Noyaptaopd Google. Otav cuyxpovilelg Tov Aoyaplaoud cou oo Google, ot
gpappoyég Google, ot emapég Google, To Huepohdyio Google, Ta Sedopéva
NG EQAPUOYNG ONpEWdTWY Google Kal ot EQapLOoyEG TTou KateRaivouv
amo To Play Store amoBnkevovtal otnv epappoyr Drive autépata.
DopTioTe MVPWE TNV UmaTapia TPV aré Tn HETAPOpA Twv SeSopEVwY yia
Va amo@eUXBEi n AoKOTN amevepyomnoinon TnG CUOKEURG KaTd Tn SldpKela
g Sladikaoiag,

Anyeic

Mriopeite va mpoBANETE, va SlaypAWETE 1 va HOIPACTEITE apXEia TTOU EXETE
KateBdoel amd To Internet ) amo TIC EQAPOYES.
SV apxikn 086vn, matriote Ataxeipion > AfPeic.
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SmartWorld

Mriopeite va KatePACETE pia PEYAAN YKApA TIAKVISIWY, NXNTIKOU TIEPIEXOMEVOU,
EQAPHOYWV KAl YPAUUATOCEIPWY TIou TiapéxovTal and tnv LG Electronics.
MpPocappdOTE T GUOKELR AVANOYA HE TIC TTPOTIUATELS GOC XPNOIHOTOLWVTAG T
Béuarta g apyIkng oBévne.

E « Edv xpnotpomoleite Sedopéva Kivntrig TNAepwviag, pmopei va emPBapuvBeite
ME XPEWOELG Yia TN XPrion SeSopévwy, avaloya HE TO TPOYPAUHA XPEWOEWY
TIOU £€XETE EMAEEEL
+ Auti n Aertoupyia pmopei va pnv umoatnpiCeTal, avahoya e TV TIEPLOXA 1
TOV TIAPOYO UTTNPETIWV.

TV apyikn 086vn, matriote Yinpeoieg> SmartWorld.
Matiote : > Aoyaplaopoi LG kat ouvdedeite.

EmAéETE Kat IPayHATOTIONOTE AN TWV OTOIXEIWY TEPIEXOUEVOU TNG
QPEOKEIOG 0aG.

WN -

NQYN TG e@appoyng SmartWorld

Eav n epappoyn SmartWorld dev éxel eykataotabei, akohouBriote autd ta frpata

yla va v KateBAoETe.

T Zmv apxir 066vn, matiote Pubpioeig > Zootnpa > Kévpo evhuépwong >
Evnuépwon epappoyrc.

7 Ano6n Nota, emMé€te SmartWorld kai matiote ARYN.
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RemoteCall Service

Mmopei va yivel amopakpuouévn Sidyvwon Tng GUOKEUNE 0aE yia TV emAuon
Twv mpoBAnpaTwv. ApxIkd, KahéoTe To Kévtpo e§umnpétnong mehatwv tne LG
aKoAoUBWVTAC T TAPAKATW BripaTa:

E « Ta va XpnolMOToIOETE auTHV TN Aetoupyia, mpémel mpwTa va
OUMQWVIOETE HE TOUG OPOUE XPONG TNG AetToupyiag.
« Edv xpnotuomoleite Sedopéva Kivntrg tTnAepwviag, prmopei va emPBapuvBeite
E XPEWOELG Yia TN XPrion Sedopévwy, avaloya LE To TPOYPAUMA XPEWOEWY
TIOU éXETE EMMEEEL

T Zmv apxikr 066vn, matiote Ynnpeaieg > RemoteCall Service.
7 Mpaypartomnoifjote kKAjon mpog to Kévtpo e€unnpétnong mehatwv g LG.
3 'Otav amavtnBei n kAo, akoAoUBHOTE TIC 08NyieC TOU GLVEPYATN EMOKEVWY
Yla va eloayayeTe évav e§aPnelo apiBpo.
« Exteleital amopakpuopévn oUVEEDN 0T GUOKEUN 0aG Kat EeKIVAeL n
QMOUOKPUOMEVN UTTOOTAPIEN.

Exmopmn KupéAng

Mrmiopeite va SE(Te TIC EKTOUTTE KEIEVOU GE TIPAYHATIKO XPOVO OE KATAOTACEIG
€KTOKTNG QVAYKNG, OTIWG TUQWVES, TANUUUPEG KAl GEIGHOUG.

SV apxikn 086vn, matiote Yrnpeoieg > EKkmopmn KuPEAnG.

Epappoyéc Google

Mriopeite va xpnotpomolrioete epappoyég Google opilovtag éva hoyaplaoud
Google. Otav xpnaotpomoleite pia epappoyr Google yia mpwtn gopd, epgavifetat
éva mapabupo kataxwplong Aoyaplacpou Google. Edv Sev éxete Aoyaplaopd
Google, SnploupynoTe Evav amd Tn CLUOKEUN 0ag. Ma AEMTOUEPELEG OXETIKA E TN
XPrion HIag eappoyng, cupBouleuTeite Tn BorBela otny idia v epappoyn.

E « Oplopéveg EpappoYEG evEEXeTal va NV AelToupyolv, avaloya HE Thv
TIEQLOXN 1 TOV TTAPOXO UTTNPECIWV.
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Chrome
‘Evag ypriyopog, am\og, Kt ac@alng mepinynTig, @TIayUEVOG yia TOV GUYXPOVO 1OTO.

Eyypaga

To Docs ival éva cuNoyIkd epyaleio eme§epyaciag KelpEvou TOU EVIOXVEL
TNV MOPAYWYIKOTNTA. XpnolomoloTe To Docs yia va SnuioupynoeTe, va
EMECEPYOOTEITE KO VO GUVEPYUOTEITE OE TIPAYUATIKO XPOVO.

Google Drive

To Drive gival wpog amoBrKeuong apxeiwv Kat KOG EQAPHUOYRG TToU O€
S1eUKONUVEL VO BPELC, Va MOLPACTEIC KAl CUVEQYAOTEIC O projects SOUAELAC amo
navtou, dpeoa.

Duo
Kdve amég, upnAri¢ molotnTtag BIVTEOKARTELG GTOUG PIAOUG GOU Kal 0TV
OlKOY£VeLd pe Ta TNAé@wva Android kat iPhones.

Gmail

To Gmail eivat pia eUkoAn oTn xprion epappoyr email mou Siatnpei Ta pnvopatd
00U a0Qar, KAVEL TO YPApHATOKIBWTIO cou e§UMVOTEPO Kal o€ BonBdet va gioal
OPYAVWHEVOC.

Google

H epappoyr Google o€ KpaTdel EVALEPO YO T TIPAYHATA TIOU OE EVOIAPEPOUV.
Bpeite ypriyope amavtioelC, eEepeuVHOTE Ta EVOLOPEPOVTA 0ag, Kal PdBeTe
LOTOPIEC KOl TIAPTE EVNEPWOELS YIa BEATA TTOU GOC EVOIAPEPOUV.

Xapteg

Mdte kamov; Mnyaivete pe Toug XAPTES, N EPAPKOYH OTNV OTOoia PMOPE(TE
va BaoloTETe Yio TAOynon o€ TpayHaTikd xpdvo, yia Thv Kukhogopia, Tn
GUYKOWVWVIQ, Kl Y10l AETTTOUEPELEC VIOl EKATOUUUPLA MEPN, OTIWE KPITIKEC Kall
SnUOoPINEIC WPEC.
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Owroypagieg
To omiTl yla OAEG TIC QWTOYPAYIES Kal Ta BiVTES GOV, AUTOPATA OPYAVWLEVA £TOL
WOTE Vol PITopEic va potpadeoat Kalt va amoBnKeVELG 6,Tt EKEL ONPAoiaL.

Tawieg Play
XpnotpomolioTe Tov Aoyaplacuéd oag Google yia evoikiaon r ayopd Taviwy.
Mmopeite va ayopAoeTe mEPIEXOLEVO yia avamapaywyr mavtou.

Mouaikn Play
Ayopaoe pouaikr amd to Play Store. Maie T pouoikr mou eivat amoBnkeupévn
0TN OUCKEUN oou.

YnoAoyloTIKA QUANG

To Sheets gival éva cuNoYIKO epyaleio eme€epyaoiag UTOAOYIOTIKWV QUANwY
TIOU EVIOKVEL TNV TTAPAYWYIKOTNTA. XpNnolpomoljote To Sheets yia va el0AyeTe, va
OPYOVWOETE Kat va avaAUOETE MANPOPOpIES Hali O€ MPAYUATIKO XPOVO.

Mapouaidoeig

To Google Slides €ivat éva cuNoyiKo pyaleio Snpioupyiag mapouaiaong mou
EVIOXVEL TNV TTapaywylKoTnTa. Xpnotpornotjote to Slides yia va opyavwoete
TIANPOPOPIEC, VO TTAPOUCIACETE AMOTENETHATA, KAl v TTaipveTe amo@doelg padi og
TIPAYHOATIKO XPOVO.

YouTube

MapakoAouBnoe Ta ayarmnpéva cou Kavahia, GKOUOE Tr LOUCIKH TTou ayarmdg, Kat
avéBaoe PIVTEOD Yia VA LOIPAOTEIC e avBpWMoug amd GAO ToV KOGHO.

Google Assistant

H ouokeun oag €xel Tov BonB6 Google evowpatwpévo. Bpeite amavroelg Kat Kave
mipdypata ot mopeia. MNa va Eekvioelg, amd mdta 1o kAei Bonbog Google oty
TINEUPA TOU TNAEPWVOU 1 AYYIEE Kal KOATA TO APXIKO KOUMTTi TOU TNAEQWVOU.

E « O BonBd¢ Google dev gival S1aBETIHOC 0E GUYKEKPILEVEG YAWOOES Kal
XWPEC.
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PuBpiosig

Mmopeite va TpooapUAOETE TIC PUOUITELS TNG CUOKEURC CUUPWVA HE TIC
TIPOTIUNCEIG 0QG.

SV apxikr 086vn, matrjote PuBpioeic.

L;'] « Edv ei0ayete Mé€n kheidi oto mapdbupo avaditnong 0To enavw pépog
NG 006VNG, UMOPEITE va EKTENECETE TTO EUKOAA TOL OTOIXEID TIOU TIPETTEL VOl
puBuioTOLV.

Aixtuo & Internet

Wi-Fi

Mriopeite va ouvOEDEiTe e KOVTIVEC OUOKEVEC PEow SikTuou Wi-Fi.

Z0vdeon oe diktuo Wi-Fi
1 Zmv 0Bo6vn pubuicewy, matijote Aiktuo & Internet > Wi-Fi.
7 Matiote 1o Koupmi yla evepyomoinaon.
+ TadaBéoua diktua Wi-Fi epgaviovtal autopata.
3 EmAéETe éva Siktuo.

+ Mmopei va XPp€ElaoTEl va El0ayAyeTe Tov KwdIKO TPooRacng Tou SIKTuou
Wi-Fi.

+ H ouokeun mapaleinet autrv ™ Stadikacia yia diktua WI-Fl ota omoia
elye ouvdeDei oTo MaPeNBOV. Av Sev BéNeTe va ouVEEDTE aUTOPATA OE
£€va ouykekplpévo Siktuo Wi-Fi, matrote To SiKTuo Kal, 0T GUVEXELD,
MapdPAeyn.
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PuBpioeig Siktoou Wi-Fi
SV 086vn pubpioswy, matrote Aiktuo & Internet > Wi-Fi.

- Metdfaon oe diktuo KivnTA¢ ThAe@wviag: edv n Aeltoupyia tng ouvdeong
Sedopiévwv KvnTrig TNAEPwVIaE ivat evepyomoinuévn, aANG n CUCKeUN
Sev pmopei va ouvdebei oo Internet péow g olvdeoncg Wi-Fi, n cuokeun
ouvdEeTal autopata oo Internet péow tng ouvEeong SeSopéVwY KIVNTAG
AEQwviag.

E + Autij n SuvatdtnTa e€aptdTal amod ToV TAPOXO UTINPESILV.

- :TMpocappodote Ti¢ pubpioel; Tou Siktuou Wi-Fi.

Wi-Fi Direct

Mrmiopeite va GUVOEDETE T GUOKEUN 060G 0 GANEG OUOKEUEG TIOL UMooTnpi{ouv
Wi-Fi Direct yia ameuBeiag kowvr xprion Sedopévwy Ue autég. Agv gival amapaitntn
n xprion onueiov mpdoPaonc. Mmopeite va cuvdebeite e meploodTepeg amd SUo
OUOKEVEG xpnotpomolwvtag Wi-Fi Direct.

1 Zmv 0B6vn pubpicewy, matriote Aiktuo & Internet > Wi-Fi> ¢ > Wi-Fi yia
nipoxwpnpévoug > Wi-Fi Direct.
+ Ot kovTIvéG ouokeuég mou umoatnpiouv Wi-Fi Direct epgavifovtat
autépara.

7 Em\éETe Wi GUOKEUN.
+ YUvdeon mpaypaTomoLEiTal GTav n CUOKELN amodexTel To aitnpa ouvdeong.

E « Hpmatapia evdéxetat va e§avtAnBei ypnyopotepa dtav XpnollomoLeTtal
Wi-Fi Direct.
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Agdopéva KIvnTAG ThAEQwviag

MopEiTe va EVEPYOTIOLEITE Kall VO AMTEVEQYOTTOLEITE Ta SeSOpEVA KIVNTAC
Aepwviag. Mmopeite emiong va SlaxelploTeite Tn xprion dedopévwv KIvnTrg
AgQwviac.

Evepyomoinon 6edopévwv KIvntig ThAe@wviag

1 Zmv 0B6vn pubuicewy, matfjote Aiktuo & Internet > AsSopéva KIvNTHG
TAgpwviag.

7 Natote To Kouumi yla evepyormoinon.

Mpoocappoyn Twv pubpicewv dedopévwv KivnTAG TNAEQWVIaG
1 Zmv 086vn pubuicewy, matijote Aiktuo & Internet > AsSopéva KIvNTHG
TAepwviag.
2 MpocappooTe TIG TapaKATW puBpicel:
« Evepy.: pubuion yla xprion ouvdéoewv Sedopévwy o€ Kivntd Siktua.
« Teproplopdg xprong peradoong dedopévwv: B£0Te va GpIo yia TN Xpron
SeboPEVWY KIVNTAC TNAEQWVIAC. Z€ TIEPITTTWON TIOU PTACETE AUTO TO OPIO,
Sev Oa emtpémetal mAéov n xprion Sedopévwy KIvNTAG TNAEQWVIAG.

: :TIpoCApPOYH TwV PUBHIoEWY SeSopEVWY KIVNTAG TNAEPWVIAC,
+ 0 6ykog xpriong 6edopévwy umoloyiletal e FAcn To mPoidv kat 0 dyKog
o urtohoyilel 0 IAPOYOG 0ag EVEEXETAL VA SIOPEPEL

PuBpioceic KAjoswv

Mriopeite va TIPOGAPHOCETE TIC PUBHITEIC KA OEWY, OTIWE Y10 TIC PWVNTIKEG
KANOELG Kal TIG EMAOYEC S1EBVWY KAOEWV.

+ Oplopéveg Aettoupyieg evdéxetal va unv umoatnpifovtal, avahoya e TV
TIEQLOXN 1 TOV TTAPOXO UTTNPECIWV.

T Zwnv oBovn pubuicewy, matjote Aiktuo & Internet > Pubpioeig KAfjogwv.
2 MpocappdoTe TG pubicelg
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Tethering

Z0vbeon Péow KIVNTNG OUOKEVRG e USB

Mriopeite va uvOEDETE T CUOKEUN 0€ AAN cuokeun péow USB yia kovA xprion
Sedopévwv KIvnTrig TNAEPWVIaG.

1
2

YUvOEOTE T OUOKEUN 00C e AANEC CUOKEVES péow kalwdiou USB.

Ynv 08dvn pubpicswy, matriote Aiktuo & Internet > Tethering > Z0vdeon
péow KivnTtiig sUoKeUnG pe USB kal 0Tn ouvéxela maToTe To Koupmi ya
gvepyomoinon.

E « Ta autv Ty emdoyn xpnotpomototvtal Sedopéva KIvNTHG TNAEQWVIOG

Kal Umopei va emBapuvOEiTe e XPEWTELS yia TN Xprion Sedopévwy,
QVANOYQ E TO TIPOYPAUMA XPEWOEWY TTOU £XETE EMAEEEL M TEPIOTOTEPES
TIANPOYOPIES, CULBOUNEVTEITE TOV TTAPOYO UTINPETIWV.

« [la oUvdeon og umooyioTH, KATeRAOTE To POypapua odrynong USB amd
TNV TomoBecia Www.lg.com Kalt YKATAOTHOTE TO OTOV UTIOAOYIOTH.

« Aev givat Suvatr n amootolr i N AYn apxeiwv PETagl TG CUOKEUNG
00C Kal VOG UTIOAOYIOTH OTav €ival vepyomoinuévn n ouveon USB.
Amevepyorotjote T ouvdeon USB yia tnv amootoAr i Aqiin apxeiwv.

+ Ta Aerroupyikd ouoTHATA TTOU UTTOOTNPI(OUV AUTOV TOV TUTTO OUVOEDNC
eivai ta Windows XP | petayevéatepn ékdoon, fj To Linux.

®opntd anpeio mpdaPaong Wi-Fi

Mriopeite va 0pioETE TN GUOKEUN WG AOUPHATO SPOHOAOYNTH, £T0L WOTE Ol ANNEG
GUOKEVEG va umopolv va ouvdeBouv oo Internet xpnotpomolwvtag ta dedopéva
KIVNTAG TNAEQWVIOC TNG GUOKEUNG 0OG.

1

2
3
4

Ynv 086vn puBpiogwy, matrote Aiktuo & Internet > Tethering > ®opntd
onueio mpdopaong Wi-Fi kat émerta matrote yla evepyormoinon.

Ayyi€te PUBuIoN @opnTou onpeiov mpooPaacng Wi-Fi kat kataywpiote To
aAVayvwpLoTIKO Kai Tov kwdikd mpdoPaong tou Ovopa Wi-Fi (SSID).
Evepyomotriote 1o Wi-Fi otnv AMn cuokeur Kat emAEETE TO OVopa Tou SIKTUOU
NG ouoKeunG otn Aiota Wi-Fi.

MAnktpoAoynote Tov kwdikd mpdoPaong Siktvou.
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5 « Ta autv Ty emoyn xpnotpomolobvtal Sedopéva KIvnTHiG TNAEQwVIag
Kal propei va emPBapuvBEeiTe Pe XPEWOELS yia Tn xprion dedopévay,
QVANOYQ HE TO TIPOYPAUMA XPEWOEWV TTOU £XETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIEC, CUMBOUAEUTEITE TOV TAPOXO UTINPECIWV.

« Mmopeite va Bpeite mepIoodTEPES TTANPOPOPIE OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#wifi

Xpovodiakomng amevepyomnoinong opntou onpeiov mpocPaong Wi-Fi

'Otav 1o onpeio mpoopacng Wi-Fi dev €xel xpnotpomolnei yia oplopévn mepiodo,
amevepyomoleital autopata. Mmopeite va opioeTe Ty wpa Tou BENETE va
EKTENEOTEL AUTOMATN AMTOOUVOEDH.

Bluetooth tethering

Mia ouvSebepévn pe Bluetooth cuokeun pmopei va cuvdebei oto Internet

XPnotuomolvTag ta Sedopéva KIvnTrig TNAEPWVIAE TNG CUOKEUNE 00C,

T Zmv 0B6vn puBpicewy, matiote Aiktuo & Internet > Tethering > Bluetooth
tethering Kat 0T ouvéxela matrote To koupri () ) yla evepyoroinon.

7 Evepyorolrote To Bluetooth kai 0TIC 500 GUOKEUEC, Kal TIPAYUATOTIONOTE
Ceoén.

E + Ta autrv Ty emAoyn xpnotpomolovvratl dedopéva KIvnTrG TNAEQWVIag
Kal Umopei va emBapuVOE(Te pe XPEWTELS yia TN Xprion Gedopévwy,
avANoYa HE TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAEEEL Ma TEPIOTATEPES
TIANPOYOPIES, CULBOUNEUTEITE TOV TTIAPOYO UTINPETLWV.

« Mmopeite va Bpeite mepIoodTEPES TANPOYOPIEG GE AUTOV TOV IOTATOTIO:
http://www.android.com/tether#Bluetooth_tethering

Bonfeia
Mropeite va mpoaAete T BoriBeta oxeTIKA pe TN Xprion ouvdéoewv kat hotspot.
TV 086vn pubpioswy, matrote Aiktuo & Internet > Tethering > BorBela.
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Nertoupyia mtiong

Mriopeite va amevepyomolfoeTe TIC Aettoupyieg KAong kat SeSopévawv KivnTig
Aepwviag. Otav auth n Aertoupyia givat evepyomoinpévn, ot Aeltoupyieg mou
Sev amartolv T Xprion Sedopévwy, OTwg matkvidia Kat avamapaywyr HOUCIKAG,
Tapapévouy SlaBEoIpEC.

T Zmv 0B6vn pubpicewy, matriote Aiktuo & Internet > Aertoupyia mriong.

7 Matote Evepyomnoinon otnv 086vn empBeBaiwong.

Aiktua KIvn TG TNAEQWViag

Mrmiopeite va TPOCAPHOCETE TIC PUBKITELS SIKTOWV KIVNTAC TNAEQWVIAC,

T Zmv 0B6vn pubpicewy, matiote Aiktuo & Internet > Aiktua KivnTrg
mAepuwviag.

7 Mpooapp6oTe TIC TapaKATW pUBpIcEI:

- Mepraywyn dedopévwv: Ma mepirjynon oto Internet, xprion email,
UNvOpaTa TOAURESWV Kat GANEG UTTN peaieq dedopEVwY OTO EEWTEPIKO.

+ Nerroupyia Siktvou: EmAECTe TUMO SIKTUOU.

+ Ovdpata onpeiov mpooPaong: Na epedavion 1 aAayr Tou onpeiov
TIPOGaONG yia TN XPron UnpEeatwv SeSopévwy KIvNTAC TNAEQviac. Na
va aMGEeTe To onpeio mpooBaong, emAégTe éva atolyeio amd tn Aiota
onueiwv mpooBaong.

Etaupeieg Siktoou: Ma avalritnon mapdxwv SIKTUOU Kat autopath cuveon
o€ Kamolo SikTuo.
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VPN

Mmopeite va ouvdebeite o€ éva ao@aNég eIKOVIKO SiKTUO, TIX. O EVa ECWTEPIKO
€TAPIKO SiKTUO. MMTOpE(TE £MONG Vol SIOKEIPIOTEITE TA GUVSESEPEVA EIKOVIKA
1SlwTiKa SikTua.

Mpoaodnkn VPN

1 ZmvoBdvn pubuicewy, matfjote Aiktuo & Internet > VPN.

2 TatoTe 1o Koupmi .

3 Ewaydyete ta otoixeia tg ouvdeong VPN kat matriote AmoBrkeuon.

Aapoppwon twv pubuicswv VPN
1 % Niota VPNS, em\é€te éva VPN.
7 Ewoaydyete ta otolyeia hoyapiacpol xpriotn VPN kai atiote ZovSeon.

- Ta va anoBnkeVoeTe Ta oTOIXEIQ TOU Aoyaplacpioy, emAEETe To mAaiclo
ehéyyou AmoBrikeuan aTolxeiwv Aoyaplacuov.

I61wTiké DNS

Mriopeite va Slapopewoete TiG emhoyég IS1wTikoy DNS (Domain Name System).
1 Zmv 0B6vn pubuicewy, matfiote Aiktuo & Internet > I81wtikd DNS.

7 Kavte v emhoyr mou Bé\ete kai motriote AmoBrikevon.

PuBuioeig 152



Tuvdedepéveg CUOKEVEG

Bluetooth

Mriopeite va GUVOEDETE T GUOKEUN GOG O€ KOVTIVEG CUOKEUEG TIou umtooTnpilouv
Bluetooth yia avtaMayr SeSopévwv e QUTEC. ZUVOEDTE T GUOKELN 00 O éva
OKOUOTIKS Kat éva MANKTPOAOGYI0 He Suvatdtnta Bluetooth. Etot o éNeyxog Tng
OUOKELNC Bal gival EUKONOTEPOC,

Z0Ceuén pe AN cuokeun
1 Zmv 0B6vn pubuicewy, matiote Zuvdedepéveg ouokevéc > Bluetooth.
7 Matiote 1o Koupmi yla evepyomoinaon.

+ O18100¢01pEC OUOKEVEC ppavifovTal auTopaTa.

- Tava avaveqoete  Nota ouokeuwy, atfote ().

E + Movo 01 GUOKEUEG TTOU €XOULV OPIOTE! WG 0paTEC EPaviCovTal ot AioTa.

3 EmAé€Te pia ouokeur amd tn Aiota.

/I AkohouBroTe TIC 08nyie¢ Tou pgavifovtal atny 006vN yia va
TIPOYHOTOTIOIOETE EAEYXO TAUTOTNTOC.

E + Autd T0 Bripa TAPCAAEITETAL YIa CUOKEVEG OTIG OTIOIEG EXEL UTTAPEEL
TP6oPaon oTo MaPeNBoV.

Anootoln edopévwy péow Bluetooth
T EmAé€te éva apyeio.
« Mmopeite va oteilete apyeia MOAUPESWY 1) OTOIXEIQ EMAPWV.
7 Natote < > Bluetooth.
3 EmAEETE ot GUOKELK TIPOOPIGHOU VLA TO apXEiD.
+ To apyeio amooTENETAL LONIG YiVeEL AOSEKTO A Tr CUOKEUK TTPOOPICHOU.

E «+ O181ad1Kacieg Kovrg xpriong apxeiwv evoéxetat va Slapépouv avahoya e
TO apxeio.
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Kowvn xprion 0066vng
Mmopeite va avamapaydyete Tnv 08vn Kal Tov X0 TG OUOKEUNG OF i
Sl0(OPETIKI) GUOKELN, OTIWE Jia TNAEOPacn, Tou umooTnpilel Tn Aettoupyia
Miracast.
T Zmv 0Bovn pubpiccwy, matriote Tuvdedepéveg cuakevég > Ko xprion
006vnc.
7 Matiote 1o Koupmi yla evepyomoinon.
3 EmAéETe pia GUOKEUR a6 Tn Ai0Ta TWV KOVTIVGV GUCKEUWV.
+ Edv n ouokeun mou Béete Sev epgaviletar, matriote Avalitnon yia va
QVAVEWOETE TN NioTa.
« Agou emteuyOei oUvdeon, oTn ouokeun Ba eppavioTei n 08évn Tou
TNAEPWVOU 0aC.

E « H epappoyn Kovig xpriong 086vng amevepyomoleital autopata eav dev
UTTAPXEL KOVTA CUOKEUH GUUBATH HE TN SuVaTOTNTA KOG XPHONG.

NFC
Mriopeite va XpnOIOTIOICETE TN GUOKEUH WG I KAPTA Yia Ta Uéoa MalIKNG
METOQOPAE 1 WG TMOTWTIKA KApTa. Emiong, umopeite va kotvomolroete Sedopéva
o€ AN\EC CUOKEUEC,
1 Zmv 006vn pubuicewy, matiote Zuvdedepéve ouokeuég > NFC.
7 Matiote 1o Koupmni yla evepyomoinaon.

« Ayyi€te ™ ouokeun oag pe AMn cuokeun iou umooTnpilet NFC yia

avtoAayr dedopévwv.

E « Hkepaia NFC umopei va Bpioketat o€ SIaQopeTIkd onpeio avaloya Ue Tov

TUMO GUOKEUNG. MO AETTTOEPELEG OXETIKA E TNV TIEPLOXT TG Kepaiag NFC,
avatpé€te 0NV evotnTa EMOKOTNON OTOoIXEWV.

PuBuioeig 154



Android Beam

Mmopeite va avtald€ete apyeia ayyi{ovtag To miow péPog TG GUCKEUNG OE
AN ouokeun. Mmopeite emiong va avtoAd&eTe apyeia, Omwe Houoikn, Bivieo

1 EMAPEC, KAl VOl AVOIEETE ia LIoTOOENSA 1y va EEKIVATETE pia epappoyn anod Ty
AN\ ouoKeun.

T Zmv 086vn pubpicewy, matriote Zuvdedepéveg ouokevég. > Android Beam.
7 Ayyi€te To miow péPOC TNC OUOKEVAC e TNV GAAN GUOKEUN.

E + Hkepaia NFC umopei va Bpioketat o€ S1aQopeTIkd onueio avaloya Ue Tov
TUMO GUOKEUNG. Mol AETTTOEPELEG OXETIKA e TV TIEPLOXT TG Kepaiag NFC,
avatpé€te oty evotnta EmMoKomnon otolxeiwv.

Mivakag kolvomoioewv

MmopeiTe va KOIVOTIOINOETE TIEPLEXOUEVO aTd TO AAUTTOUY, TN MOUGIKY Kat T

Alayeipion apyeiwv oag og KOVTIVEG OUOKEVEC. Mmopeite emiong va KovomoloeTe

TO TIEPIEXOHEVO OE CUYKEKPILEVA ATOMA OE EQAPHOYEG TTOU uTooTnpiouv T

Suvardtnta dueong kotvomoinong tng Google (Google Direct Share).

1 Zmv 086vn pubuicswy, matfote Tuvdedepéve ouokevéC > Mivakag
KOIVOTIOINCEWV.

7 Anevepyornomjote kdOe emoyn xpnotponotwvtag 1o puduoTikd @ .

+ KovTtivég ouokeuég: MMopEiTe va EPQAVIOETE TIG KOVTIVEG CUOKEVEG LIE TIC
OTIOIEC UMOPEITE VA IOIPAOTEITE TIEPIEXOHEVO OO TIG EPOPHOYEG ANUTTOUY,
Mouoaikn kat Alaygipion apxeiwy,

« AmeuBeiag Ko Xprion: Amié pia egappoyr mou urootnpilel
Suvatotnta dueong kovoroinon tng Google (Google Direct Share),
UTTOPEITE VA EPPAVIOETE €val EIKOVISIO TTOU 0O EMTPEMEL Va PoLpAleoTe
TIEPIEXOHEVO LIE OUYKEKPIUEVOUC avBpWTOUC.
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Kowvii Xprion Apxeiou
Mriopeite va oTeileTe 1 va NABETE apxEid AVAUETT OTN GUOKEUN GOC Kal € AN
ouokeun 1 tablet g LG.

1 Zmv 00vn pubuicswy, matfote Tuvdedepéve ouokevé > Kov XpRon
Apxeiou.
7 Mpocapp6oTe TIG TapaKATw pudpicel:
+ G7 ThinQ: y1a va oMAEETE TO GVOpA TNG CUOKEVAC.
+ AmoBrKeuon o&: 0pioTE TOV YAKENO TIPOOPICHOU Yia TNV AmoBriKeuon Twv
apyxeiwv mou amooTéENoVTaL amd ANNEG GUOKEVEC,
+ Kown Xprion Apxeiou: yia va emtpéPete Tn An apxeiwv mou
anmootéNovtal and ANNEC GUOKEUEC.

- SmartShare Beam: yia va HOIpAOTE(TE AP)Eia e ANAEG CUOKEVEC LECW TOU
SmartShare Beam.

- BonBeia: umopeite va Seite T BoriBeta yia TV Kowvomoinon apxeiwv.

Alakopioti¢ mMoAUpéowy

Mriopeite va polpaoTeite mepIEXOUEVO TTOAUMESWY OTr CUOKEUN| 0AG PE KOVTIVEG
OUOKeVEG Tou umooTnpiCouv DLNA.

T Zmv 06ovn pubpioewy, matriote ZuvBeSepéveq CUOKEVEG > AIOKOMIOTHG
TIOAUHEOWV.

7 MpooappooTe TIC TapaKATw PuBpIcElC:
+ Kot xprion meplexopévou: LOIPAOTEITE TIEPIEXOMEVO TTOU BPIoKETAL OTN
GUOKEUN 00 e ANNEC KOVTIVEC GUOKEVEC.
+ G7 ThinQ: opioTe T0 dvopa TG CUOKEUNG 0ag

E + Avaloya e To TIPOI6V TOU XPrOTN, T OVOATA TWV UEVOU EVOEKETAL VA
Sla@épouv.

- To MEPIEXOHEVO MOV OE KOIVH) XPrION: EMAEETE TOV TUTIO TOU TIEPIEXOHEVOU
TIOAUMECWV TIOL Bt OLPATEDTE |ie ANNEC GUOKEUVEC,

+ E€oualodotnpéveg ouokevég: Seite pia NiOTa e TIC CUOKEVEC TIOU
EMTPEMETAL VA £XOUV IPOGRAON OTO TIEPIEXOEVO TNG OUOKEUNG 00IC.

+ Mn-eyKeKPIPEVEG CUOKEVEG: SeiTe Lial NioTal LIE TIG OUOKEUEG TToU Sev
EMTPEMETAL VA £XOUV TIPAORAON OTO TIEPIEXOUEVO TNG OUOKEUNG OOIC.
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MirrorLink

Mriopeite va GUVOEOETE T GUOKELN O€ éva auToKivnTo péow USB yia va
XPNOIHOTIOIOETE TNV EYKATEGTNHEVN 0T CUOKeUN @appoyn MirrorLink amé to
ovotnpa infotainment 1 TV KEVTPIKI HovAda TOU AUTOKIVATOU.

E « Auti n egapuoyn Siatibetat pévo o€ autokivnta mou umooTnPilouv
MirrorLink.
« KateBaote v epappoyr MirrorLink amé éva katdotnpa epappoywv. Ma
TIEQIOOOTEPES MANPOYOPIEC, EMOKEPTEITE https.//mirrorlink.com/apps.
+ Oplopéveg Aettoupyieg evdéxetal va meplopioval 0Tny mpooTacia Tou
TIPOYPApHaATog 0drynong 6tav xpnotpomnoleite T Aettoupyia MirrorLink.

1 Zmv 0Bdévn pubuicewy, matote Zuvdedepéveg ouokevEG > MirrorLink.

7 TUvB£0Te TN OUOKEUN O QUTOKIVITTO XPNotpomolovTag To KaAodio USB kat
evepyorolwvtag TV emAoyr ZUvdeon péow Kahwdio USB.

E « Edv n ouokeun oag ival cuvdedepévn og Gxnua mou umootnpiCel
autoépatn ovvdeon MirrorLink, n Aerroupyia oUvdeonc péow karwdiov USB
EVEPYOTIOIEITAL QUTOPATA OTN GUOKEUN OO,

+ Matrote yla va Slapop@uoeTe Ty autdpatn ouvdeon MirrorLink USB.

ExtOnmwaon

Mrmiopeite va GUVOECETE T GUOKEUN 0aG O évav eKTumwTr Bluetooth kat va
EKTUTTWOETE TIG WTOYPAPIES 1} TA EyYPOPA TTOU £XOUV ATTOONKEVTEL 0T GUOKEUN.
3TNV 086vn pubpicewy, matrote Zuvedepéveq CUOKEVEG > EKTUTIWON.

- Matriote NpoemAeypévn UTINPEGia EKTUTIWONG Yia va yivel avaltnon
EKTUTIWTAQV LE TOUG OTT0{oUG popeite va ouvdeBeite. H matiote + >
MpooBKn eKTUMWTWV yia va TPOCBETETE XEIPOKIVNTA évav EKTUTTWTH.

- NatAote (+) NMpoobrikn unnpeoiag yia va ANaPete TV epappoyn Tou EKTUNWTA
TIou BéNeTE.

E + Auti n duvatdtnta eivat Slabéoiun udvo dtav To Siktua KIvNTrG
Ae@wviag 1 n Aerroupyia Bluetooth gival vepyormoinpévn.

+ Tava AdBete Tv epappoyn ektunwtr oto (+) Mpoadrikn umnpeaiag, Oa
TIpEMeL TPWTa va ouvdebeite aTov Aoyaplaopo oag Google.
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'Hxog

Mriopeite va TpooapHOCETE TIG PUBIOELS ixou, SGvnong kal eildomotiogwv.

SV 086vn pubuiogwy, matriote HYog Kal TPOCUPHOGTE TIG TAPAKATW PUOLICEIG:
+ Hynmikd mpo@ik: aAd€te T Aettoupyia fixou o€ ‘Hxog, Mévo dévnaon, ry

Tiyaon.
‘Evtaon;: puBpion tng évtaong fixou yia ta Sidopa oTolyeia.

+ 'Hyog kAong: EmAE€Te évav xo KAong yia eloepxopeves KAoELS. MpooBéote

1) SlaypayTe rixoug KAjong.

« 'Hyog ei8omomoewv: EmAéCTe évav fixo eidomoinong. OpioTe éva pouaiko

KOMMATI TTOU €XEl amoBNKEUTEL 0TN GUCKELN WG X0 E18omoinoNG.

+ 'HYoc¢ kAfjong pe d6vnon: Pubpiote Tn ouokeur yia dévnon Kat avamopaywyn

XOU KAONG TauToXpova.

« Ringtone ID: Snpioupyei évav rxo KAong yla pia El0EpXOEVN KARON amé pia

OUYKEKPIUEVN EMTAQN.

+ To @Mag avapet otav umdpyxet eloepXopevn kKArjon: Pubpiote va avaBooprivet

TO QAAG CUUPWVA PE TOV X0 KAonG TG LG.

+ Mnv evoyAeite: OpioTe TV wpa, T SIAPKELD Kal Tov TUTTO EQappoYG yia Ta

omoia 6a AapBavete unvopata eidomoinong. Mmopeite va AapBavete unvopata

€160TOINOEWV POVO OE GUYKEKPIPEVEG NUEPEC TNG ERGOUASAC.

ModTnTa RXOU Kat £pE: XpNnoIUOTIoIoTe TN AgIToupyia yia va pubuioeTe TNV

TOIOTNTA X0V Kal TA EPE KATA TNV avarmapaywyr vog Tpayoudiou 1y Biveo.

- ‘Evtaon: puBpion e évtaong rixou yia ta Sidgopa oTolyeia.

Kavovikomoinon évraong: Xpnotpomoljote tn Asitoupyia yia va

OMaAOTIOINCETE TNV TTOCOTNTA SIAPOPETIKWV TINYWV 1XOU.

- loooTabuIeTAG: XpNnolUomoloTe T AEIToupyia yia va MPOCapUOCETE TIG
pubpioel loooTabuIoTH.

- DTS:X 3D Surround: Xpnotpomoinoe Ty A&ttoupyia yia va mai€elg Louoiki 1
Bivteo oe TplodiaoTato, pPUBIOTIKS Kat {wvTavd fxo 6Tav aKouoTIKd, nxeio
1] AMEC EEWTEPIKEC CUOKEVEG YOV eivat ouvSedepéva. MNa AemTopépeleg,
avatpé€te otnv evdtnta DTS:X 3D Surround .

- Hi-Fi Quad DAC: Z0v8e0e aKOUGOTIKE, NYEIO ) AMEC EEWTEPIKEG CUOKEVEC
1XOU 0T BUPA TWV GTEPEOPWVIKWY OKOUGTIKWV KAl XPNOILOTOINCE
omnolodnmote a6 autd w¢ Hi-Fi Quad DAC.
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- NpokaBopio. Hxog: Xpnoipomotiote T Aertoupyia yia va emAEEeTe TNV
TIPOEMAEYUEVN PUBIION HXOU.

- Wneiako @iktpo: XpnoluomoloTe T A&rtoupyia yia va pubpicete tnv
oW KAl TNV NYXW TTPOG T EUTTPOG YIa VA QVOTTAPAYETE Tr) LOUGIKI OTWG
emOupeite.

- looppomia: XpnolomoloTe T Aertoupyia yia va pubLiceTe To aploTEPO Kal
70 6€i aKouoTIKO.

‘Evtaon 66vnong: mpooapprooTe Ty €vtaon g S6vnong.

« Tumog 66vnong: pumopeite va emAé€eTe Tov TUMTO S6vnong mou Ba

EVEPYOTIOLETAL KATA TN AYN KA OEWV.

+ Advnon Katd o matna: opioTe TN CUOKEUH va Soveital dtav ayyilete

0pIloUEVa oTolYElD OTNV 0006V,

+ 'Hxo¢ mAinktpoAoyiou KAjogwv: EMAEETE TO NXNTIKO €€ yia TO TANKTPOASYLO.

"Hxo¢ mAnktpoloyiou LG: EmAEETE To NYNTIKO ¢ yia TO MANKTPOAGYLO LG.

+ 'Hoc apn¢: EmMAEETE éva €€ fiyou yla 6Tav TATATE O€ éva OTOIXE(O.

"Hxo¢ kKAeldwpatog 000vng: EmMAEETE €va epé xou yia otav KAeISwveL
Eekheldwvel n 0Bovn.

MpofoAn
Mrmiopeite va TpooapHOCETE AeMTOPEPEIG PUBLITELS yia KABE TUTO 066VNG.

SV 086vn pubpicswy, matrote MpoBon Kal TPOGAPHOCTE TIG TAPAKATW
pubpioelC:

ApxiKr 000vn: TPOCAPUOOTE TIC PUBKICELS yia TV apxikr 08dvn. Na
Aemtopépeleg, avatpé€te otnv evdtnta Pubpioeic apyiknc 086vnc.

Oovto & Oépa: EmAéCTe pia tametoapia 086vng, éva Bépa, éva eikovidlo Kat
¢va AOD yla tn cuokeun oag.

lpapparooeipd: ANGETe To péyeBog TG YPaUMATOOEIPAC, TNV €VTAoN TNG
YPAPAG 1} TN YPAHHATOOEIPA.

New Second Screen: EmiAe§e WG N ypappr KATAOTAONG KAt Ot YWViEG TNG
epappoyn¢ Ba eaivovtal.

Fpapun mhoriynon: Opiote To oTuA TG Mpappr mMorynon o Xelpovoylieg fy
Mévo koupmid. Mmopeite emiong va aAAEETE TO GUVEUAOHO KOUUTIWY 6TaV
opioete MOvo Koupmid we oTuA Tng Mpappr morynon. Na Aemtopépeleg, PAéme
lpappr Moriynong.
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AOD (Always-on Display): va eugaviovtal mavta minpopopieg 6mwg

N NUEPOUNVIa, N WPA KAl Ol EI50TOINCELS, aKOUa Kat 6Tav n 08dvn sival
amevepyomoinpévn. Na Aemropépeteg BAéme AOD (Always-on Display)

Avetn mpoBolr: pUOLIOTE TN CUOKEUN TOL WOTE VA PEIWOETE TNV TTOCOTNTA
TOU UIAE QWTOG 0TV 00VN Kal va TIEPIOPICETE TNV KATATTOVNON TWV HOTIWV.
Nuxtepviy Aqn: Mmopeite va e@apooeTe éva ayvo Bépa 006vng yia va
amo@UYeTe Thv €vtovn Apyn tng 08évng katd T Sidpkela TG VOXTOC.
Xpwpa 080vng: Pubpiote To xpwia, T Beppokpacia xpwHaTog yia Tnv
emBuuntr 08dvn.

E « Matote O IO VO EMAVOPEPETE TIG PUOLITELG.

+ KMpdkwon epappoyng: mpoosapHooTe To péyefog 08Ovng Twv EQAPHOYWY.

Noyog SlaoTacewv
+ Auti n ouokeur éxel Aoyo Slaotaoewv 19,5:9.

- Evdéxetat kamoleg An@Beioeg epappoyEg va pnv umootnpifouv tov Aoyo
Slaotdoewv 19,5:9.

Y€ QUTAV TNV TEPIMTWOon, EMAEETE TIG PENTIOTEG avaloyieg 086vng yia T
£pappoyn 1 amoTtadeite 0Tov MAPOXO TNG EPAPHOYNAG IO TTEPIOCOTEPES
TIANPOYOPIES.

- Mmopeite va emAéeTe TV avaloyia EIKOVAG yia EEXWPIOTES EQAPUOYEG
natwvtag oto () > Pubpiceic > MpoBolr > Khipdkwon epappoync.
EmAé€Te Tov Aoyo Slaotdoswv mou Bélete: ZupParotnra (16:9), Tumikn
(16.7:9) kat MAripng 086vN.

- MéyeBog 006vng: Opiote To péyebog Twv oTolxEiwv 0TV 006VN OTTWE 6
BoAevel. Kdmota otolyeia evééxetal va ald€ouv B¢on.
- Avaluon 006vng: PuBpiote Tnv avdhuon tng 08évng.

E + ‘Otav aMadete Ty avaluon TG 086vng, KAEIVOUV Kal Ot EQAPHOYEG TIOU
€KTENOUVTAL EKEIVN TN OTIYHA.

+ QwTEoTNTA: XPNOIHOTOIOTE TN YPAUUH KUMONG yia va oAEEeTe T
QWTEVOTNTA TNG 086VNE TNG ouoKeUNG. MNa va pubpiceTe autdpata ™
QWTEVOTNTA TNG 086VNG avdoya e TV £VTaon TOU GWTICHOU TTEPIRAAOVTOG,
ayyi€te v emAoyr} Autéparto.
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AuTopaTo: pUBIOTE T CUOKEUN £TOL WOTE N PWTEVOTNTA TNG 086VNG va
puBpieTal auTOHOTA CUPPWVA LUE TNV EVTACT GWTOE TOU TTEPIBANOVTOC.
Evioxuon @wtevotntag xpovikn Mién: Pubpiote T cuokeun wote va
QITEVEPYOTIOLEL AUTOMATA TNV EvioXuon QuTevoTnTaG META TOV KaBOoPIOoUEVO
Xpovo.

ARén Xpovikou opiou 084vNG: AmevepyoToIEiTal AUTOMATA N GUOKEUT OTaV
TIOPAPEVEL OE a8PAVELD Yia éva KaBopPIoUEVO XPOVIKS S1doTnpa.

AuTopaTn TEPIOTPOPT} 080VNG: VA TTEPIOTPEPETAL AUTOMATA ) 086V avaloya
€ TOV TPOCAVATONOUS TNG CUOKEUNC.

Mpoguhagn 006vng: Epgpavietal mpo@uAagn 0B6vng 6Tav n oUoKeUN €xel
ouvdeBei otn Paon i Tov popTioT. EmAEETe Tov TUMO TTPoUAAgNC 086vNng
miou Béete va epgavietat.

+ 080vn pe 1o éva xépt: MikpUVeTe To PEyeBOG TG 08OVNG, £TOL WOTE Val

UTOPEITE VA XPNOIOTIOIEITE T CUOKEUN LIE TO éval XEPL. LUPETE KAl KPATHOTE TO
aploTepd/Seéi dkpo otn péon.

KAgidwpa 006vng & ac@paleia
Mriopeite va TPOCAPHOCETE TIC PUBKITEL TG 08OVNE KAEISWHATOC KAl TNG
ac@eAahelag.

- Google Play Protect: Yapwvel Tn cuokeur cou kabnuepva yia moavég

BAapepéc epappoyEc.

- EVpeon ouokeung : MapakohouBRoTe Tnv TomoBesia TG CUOKEUN

amopakpuopéva. Mmopeite emiong va mpootaTtéPeTe pe ao@alela ta dedopéva
00 €4V X4oaTe TN CUOKELH 0ag.

Evnuépwon aopahelag: EAeyxog yia evnpépuwon AoyiopikoU kat Stlapdpeuwon
PUBUICEWV AUTOUATNG EYKATACTAONG,

Ata)é€te KAeidwpa 006vng: EMAEETE T pébodo Kheldwuatog 086vng mou
BéNete. MNa AemTopépeleg, avatpé€te 0Tny voTnTa PUBLION KAEIOWATOG
006vng.

Mapapetpomoinon kAeldwpatog 006vng KAeldwpatog: ANayr Twv
TMANPOPOPIWV TTOU epPavilovTal aTnv KAEISwpEévn 0Bvn.

PuBpioeig ac@ahoug kKAeldwpatog: ANAETE TIC puBHioEIG KAEIBWHATO
aopaleiag,

AakTUN ATOTUTIWHOTA: XPNOILOTIOINOTE TO SAKTUNKO 0QG AmOTUMIWHA Yid Val
Eexkheldwoete TNV 006vN A To TIEPLEXOMEVO. MNal AeTTTOPEPELEC, avaTPECTE OTNV
evotnTa Avayvwpion Aaktud. Amotunuarta - lNapouvaoiaon .
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+ Avayvwpion mpoowmou: Yag emtpénel va EekAeISWOETe v 08ovn pe
TO TTPOOWTO GG, MNal AETTOUEPELEC, AVATPESTE 0TV EVOTNTA Avayvwplon
npoowmou - lMapouaiaon .

+ Avayvwpion wvig ZekAEIOWOTE TNV 080VN XPNOILOTOLWVTAG QWVNTIKY
EVTONN.

- Kheibwpa mepiexopiévou: Tag emrpénel va opioeTe TUMO KAEISWUATOG (KWSIKO
npdofaong i potiBo) yia ta apxeia QuickMemo+ Kat ZuMoyrc.

- Kpurmrtoypdgnon & Siamoteutrpia: Alapop@woTe TIC pUBHICELS yia TNV
KPUTITOypd®non Kai Ta SlamaoTteuTtrpla TG kdptag SD.

Kpuntoypdegnon kaptag SD: Kpuntoypa@roTe TV KAPTA MVAKNG yla va

AMOTPEPETE TN XPHON TNG 0€ AN cuokeun. MNa AemTopépELES, avaTPESTE

otV evoTtnTa Kpurroypdgnon Kaptag Lviung.

- Ac@aliG EKKivnON: TTPOCTATEVOTE Tr) GUCKEUT 0a¢ opifovTag va givat

KAeldwpEvVn Katd T evepyoroinor| Tng. Na Aemtopépeleg, avatpé€te ot

evotnta PUBuIon aopalous ekkivnong.

Mpootacia Stamoteutnpiou: MPOBoAr TUTTOU TOU XWPOU ATTOBKEVONG

6mou Ba amoBNKEUTE TO MOTOTMOINTIKG ACQOAAEIQC,

- A§iomota Samoteutrpia: MpoBoAr Twv pi{ikwv motomoinTikwy CA Tou

OUOTHHATAC 0aG Kal Twv moTtomoinTikwv CA Tiou éxouv eykataoTabei amd

TO XPHOTN.

AomoTeutipia Xpriotn: MpoBoAr kat alayn Twv ac@aiwv TANEOPOPILV

TIOTOTOINTIKOU TTOU €ival amoBnKEVUEVES TN GUOKELH 00IC.
- Eykatdotacn amo Tov amoBnKeuTiko xwpo: Eykatdotaon evog aopaolg

TIOTOTOINTIKOUL amo pia povada anoBbrikeuong.
- ExkaBdapion Samoteutnpiwv: Alaypa®r ao@oAwV MOTOMOINTIKWY TOU
€XEL EYKOATAOTAOEL O XPr0TN KL TWV OXETIKWVY SIAMOTEUTNPIWV.

- PUBpion kAeldwpatog kaptag SIM: kKheldwoTe 1 Eekheldwote v kapta USIM,
1 aAa€te Tov kwdikd mpdoPaong (PIN).

+ DIaXEIPIOTEC CUOKEVWV: L0C EMTPETEL VA EKXWPNOETE SIKAIWUATA yia va
TIEPIOPIOETE TOV EAEYXO 1| TN XPION TNG CUOKEUNG OE GUYKEKPIHEVEG EQAPUOYEG.

+ Trust agents: Eugaviote kat xpnolpomorote Ta trust agent mou £xouv
€YKATOOTAOE! OTN OUOKELN.

+ Kapgitoa 086vng: PuBpiote Tnv 006vn epappoywy £T01 woTe va sival duvath
HOVO N XPrON TG EQAPHOYAG TTOU Eival EVEPYN TNV EKACTOTE OTIYMN.

- MpodoPacn xpriong: deite AeMTOPEPELEG OXETIKA HIE TN XPNON EQAPUOYWY OTN
OUOKEUN.
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Anoppnto

- SlayelploTrigAdeia: Zag emrpémel va Seite Kat va aAAEETe Ta SiKalwpaTa oy
£XETE SWOEL OTIC EQUPLOYEC.

+ Epgavion kwdikdg mpoopaong: Epedavion twv xapaktripwy cUvTopa Katd Ty

TANKTPOAGYNON.

+ Khetbwpévn 080vn: Zag emtpémnel va opioeTe TIC el60MOIRoELS Tou Ba

epgavifovtal otny 086vn KAeldwparog,

+ Na @aivovtat ot KwdiKoi TpdaPacng: Evepyomolnote autryv Ty emAoyn

yla va epeavifetal yio cUVTopo SiaoTnpa Kabe XapakTripag Tou Kwdikou
mPdoPaong kabwg Tov MANKTPONOYEITE WOTE Va PAETETE T EICAYETE.

Aut. ZupmARpwon amé v Google : EvepyomoloTe autrv Ty emAoyn yia va
YIVETAIL EL0AYWY TWV TTANPOPOPLWY TTOU Eival amoBnKeUpEVES 0TO Aoyaplaopd
00, Omwe kwdiko mpdoPaong, Sieubuvon 1y apIBUOL TOTWTIKAS KAPTAG e
€V LOVo AT Ha. MmopeiTe £Mmiong va amevepyoToICETE AQUTIVY TNV EMAOYN,
VO XPNOILOTIOIACETE T AetToupyia Autdpatng cupminpwong tng Google r va
TIPOOOETETE éva VEO AOYapLaopO UTTNPEGIaC.

- loTopiko TomoBeciag Google: ag eMTPEMEL VA EVEPYOTIOIOETE 1y va

amevepyomoloeTe To loTopiko TomoBeaiwv. Otav £xel evepyomoinOei, n
Google amoBnkevel meplodika Kat xpnotpomolei ta mo mpdogata dedopéva
TomoBeaiag Tou TNAEPWVOU 0ag 0g GUVSUACHO HE TO AOYapLaoHS 0aC
Google. Ztnv 086vn loTopikd Tomobecdv, TaToTe + yia va Seite kavi va
Slayelploteite Ta Sedopéva TomoBeIV 0O,

Ttolxeia eNéyxou Spactnpiotntag: EmAECTe TIC SpaoTNPIOTNTES KAt TIC
TAnpogopieg Tou BéAeTe va amobnkelel n Google.

Ala@npicelg: ag emrpénel va SeTe To avayvwploTIKS Slagnuicewy Kat va
opioeTe EEATOUIKEVPEVES SlaPNUIOELC.

Xprion kat S1ayvwoTiKd: Evepyomolr|oTe autiv Tnv €MAOYN Yia va OUVTEAECETE
o1 Betiwon g epmelpiag Tou Android PESW TNG AUTOUATNG OMOGTONAG
SlayvwoTiKwv Sedopévwy, SSopEVWY GUOKEUNG Kal XPONG EQAPUOYWY OTN
Google.

PuBuioeig 163



TonmoBeoia

Mmopeite va eENéyEETe TOV TPOTIO TTOU KOVOTIOIOUVTAL Ot TTANPOYOpiES TomoBeaiag
00 KAl VO pUBHICETE Ta SIKAIWHATA TPOGRACNE OTIC TANPOPOpIES TOMOBETIAG
0ag. Ztnv 086vn pubpioswy, matrote TomoBeaia Kat pubuioTe T Aettoupyia mou
Béhete.

Enextaosig

Smart Doctor

Mriopeite va xpnotpomnotrjoete 1o Smart Doctor yia va SlayvwoeTe Ty KataoTtaon
TNG OUOKEUNG Kall VAl TN BENTIOTOTIONOETE.

3V 086vn pubpioswy, matrote Emektdoelg > Smart Doctor.

Context Awareness

Mropeite va aAdleTe autopaTa TIC pUBHICEIG TNG CUOKEUNG 00G avAAoya e TO

poTtifo xpriong kat Tnv tomoBeoia.

T Zv 0B6vn puBpicewy, matiote Emektaoelg > Context Awareness.

7 EvepyoroloTe Ta oTolxeia yia ta omoia OéAeTe ot pubuioelg va aANalouv
autopara.

- AYTOMATA: Mmopeite va puBicETE T GUOKEUN £TOL WOTE Val AANAG{ouvV
autdpata ol emoyEg mpo@il nxov, Bluetooth kat Wi-Fi oe Slagopetikd
nepiBaMovta, dmwg Oikia, EkToc olkiag, Epyacia, Ektoc epyaciog. Mmopeite
emiong va pubuioete va avoiyel pia epappoyn dtav cuvéeBolv aKouoTIKA 1
Hia ouokeun Bluetooth.

E « Tlava XpnoIHOMOINCETE AUTHY T SuVaTOTNTA, TTPEMEL VA EXETE OPIOEL OTN
pUBHIoN Ta uépn pou TNV TomoBeaia TnE oIkiag 1y TG Epyaciag oag. Ty
006vn pubuioswy, matriote TomoBeaia > Ta pépn pou yia va pubicETE TIG
Tomobeoiec.
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Mawyvidt

Mmopeite va Slapop@UOETE TIG PUBITELC yia epYalEia Kal Ypa@Ikd matxviSiwy,
KaBw¢ Kat yia tn SuvatdtnTa 0IKOVOUINONG UMATAPIAG.

T Zmv o0Bovn pubpicewy, matriote Enektdoelg > Mayvidt.

7 MpooappéoTe TIC TapaKATW puBpIcEIC:

- Mpodypappa Ekkiv. Nouxvid.: Matriote Y10 VOl XPNOIOTIOIOETE TO
Mpdypapua Ekkiv. Maigvid..

+ Epyaleia magvidio0: Mmopeite va ektehéoete T Aettoupyia otav mailete
matgvidia matwvTag Ta epyaleia maiviSiol amod Ta KOUKA agnc NG
apXIKRG 006vNG

« Tpagika matxvidiou: Pubpiote ta ypagikd Tou maixvidiov.

5 « Eav aMd€ete v avdhuon og oplopéva maiyvidia, n Suvatdtnta mpoRoArg
0006vn¢ evdéxetal va unv Aertoupyei owoTta.
+ Auti n Aertoupyia evoéxetal va unv gival S1aB€o1pn o€ EQPHOYES
TIAKVISIWV.

+ Aldheppa: MeloTe T QuTEVOTNTA TG 006VNG Kal Ty amodoon Kabe
©OPA TTOU SIOKOTITETE TO MalYVIOL Yia TEPIOGATEPO AMO 5 NemTd.

Eyypagn 086vne
Mrmopeite va Slapop@woeTe Tig pubuicelC yia Eyypagr 0Bévnc.
T Zmv 066vn pubuicewy, matriote Enektaoeig > Eyypagr 006vng.
7 MpooappdoTE TIC TAPaKATW PUBIcEIC:
+ TupmepINGBETe TOV £0UTO 0aG 0T Bivteo: KAvTe pia amo TIg mapakdTtw
€MAOYEC Kal TaTr\oTe ATTOBRKEUON.

- Ekéva: Mephappavel v eikdva mpo@ik oag oto Bivieo Katd Ty
Kataypa@r. ApoTou KAVETE auTrv TNV emoyn, matroTe @) kat emAé€te
pia eova mPo@il. Xn cuvéxela, pubuioTe To PEyeBOE TG EIKOVAC
XPNOOTOIVTAG TO PUBHIOTIKO.

- MmpooTivii Kdpepa: ZupmepMapBAvel Kataypagr Tou EUToU 6ag
XPNOILOTIOWWVTAC TV MMPOOTIVH KAKEPQ, KATA TNV KATAypar TG 006vnG.

- Moté: Aev mepihapBavetal Timota.

+ Mnyn Axou: EmA&Te Ty minyA fxou petady Mikpogpwvou kat Mepiexopévwy.
+ Avdluon Bivteo: EmAé€te TV avaluon yia v Eyypaer 08évnc.
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NMa kataypagn ¢ 00dvng

T Metagépete T ypappn KATAoTaonS oG Ta KATW yia va avoi&ete T Aiota
elkoviSiwv ypriyopng mpoéofacnc.

7 (EQv xpelaoTei, mepdoete To SAKTUAO OPIOTEPE EMAVW OO TNV TIEPIOXH TWV
eikovidiwv ypriyopng mpéoBacnc.) Matiote 1o koupri @.

3 AaBdote T S\Awon amomoinong eudivng kai matrote Evapén. H kataypagr
Ba Eexviioel o 3 Seutepolema.

/A TNava Slakéyete v Kataypar, matiote to (=) ou Bpioketal oTo Katw Sedi
uépog TG 086vng. To Katayeypaupévo Bivieo Ba amobnkeuTei 0To AAUTOUH.

5 « Eav mapapiacete ta Sikaiwpata Ghou atdpou, omwg To Sikaiwpa
Moptpaitou j To SiKaiwpa MVELUATIKAG IB1OKTNGIOG 1] SIaBANNETE T QRN
AM\OU aTOHOU XPNOILOTIOIWVTAG TIG AEITOUPYIES TTOL TTAPEXOVTAL Yia TV
UTINPEcia Katayparg 086vNG, EVOEXETAL VA UTIOOTEITE AOTIKN 1} TTOWVIKI
Siwén 1 S10IKNTIKO TPOOTIHO CUMPWVA UE TOUG IoXVOVTEG VOpOUG. H LG
Electronics 8ev @épel Kapia uBUVN yia TIG EVEPYELEG TWV XPNOTWV.

AR E@appoyn

Mmopeite va eykataotioete SU0 Popég pia epappoyr avtoAayfig UNVURATWY

0TO TPOIOV Kal va Xpnotpomoleite SU0 AoyaplacpoUg Tautdxpova.

T Zmv 0bovn pubpicewy, matriote Enektaoelg > Aumhr epappoyr.

7 Metd v avdyvwon ¢ SA\wong amornoinong, matote EmpPefaiwon.

3 2 Niota Slabéoipwv epappoywy, matiote EykatdoTaon yia va
EYKATAOTAOETE £va QVTiypaPo TNG EQapUoyn¢ Kat akoAoubroTe Tic 0dnyieg
ou epgaviovtal otnv 08dvn.

+ XV 08dvn gpgavietal n Niota Twv Slabéotpwv Stmwv epappoywv. Katd
Tn SIGPKELD TNG EYKATACTAONG, OTNV apxIKr 006vn mpooTiBevTat gikovidia
TWV EQOPHOYWV.

Mpotaon epappoyng
Mmopeite va TIPOOTTIENITETE YPIYOPa EQAPUOYEC TIOU UMOpE( va XpelaleoTe ekeivn
™ otiypr} otnv 086vn Emokomnnon.
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Floating Bar

Mmopeite va eveQYOTIOIOETE AEITOUPYIEG TTOU XPNOIHOTIOIEITE CUXVE, OTTWG
GUVTOUEVDELG, OTIYUIOTUTTA 086VNG, HOUCIKN KAl EMAYEC, TATWVTAG TTAVW OTO
Floating Bar atnv 086vn kat o0povTdc To yia va Bpeite Tn Asttoupyia mou BéNeTe.
MNa Aemtopiépeleg, avatpéte otnv evotnta Floating Bar - [lapouaiaon .

JUVTOMEVCEIG

Mriopeite va xpnolpomoLEiTe KOUUTIA GTTWG TO KOUITTE evepyomoinong /
KAEISWUATOC, TO KOUTTE évTaong Xou kat To Google Assistant yla ApEo eTéNeon
GUYKEKPILEVWY EQAPHOYWV 1) AETOUPYIWV.

T Zmv 0Bovn pubuicgwy, matrote EMeKTAoEL > SUVTOUEUOELC,

7 MpooappooTE TIC TAPAKATW PUBICEIC.

+ Avoiypa Owtoypagikig Mnxaviig: Matriote 5Uo Popég To MARKTPO
EVEPYOTIOINONG Y10l VA QVOIEETE TNV KAMEPA.

+ Avotypa Capture+: Matriote 5U0 POPEC TO MARKTPO AUENONG TNG
£VTOONG X0V Yia va avoiete Tn Aertoupyia Capture+ dtav 1o KAeldi givat
KAELOWHEVO 1) QTTEVEPYOTIOINHEVO.

+ Avoiypa Owtoypagikic Mnxaviig: Matiote to miiiktpo Meiwong évtaong
00 Popéq yla va avoiete Tn Asttoupyia Kapepa dtav 1o kAedi eivat
KAELOWHEVO 1) aTTEVEPYOTIOINHEVO.

- Avolypa Google Bon04g¢: Matriote To mAKktpo Tou Google Assistant oTo
TIAGL TOU TNAEQWVOU.

- Milfjote oto Google Bon8o¢: Kpatriote matnuévo 1o miriktpo tou Google
Assistant yia va LA oETE ypriyopa e Tov BonBo oag.

E « To Google Assistant 6ev umootnpiCel OAEG TIG YAWOOEG.
Evepyomoinon 086vn¢
Kdvte Stm\o mdtnpa otnv 006vn yia Vo EVEPYOTIOIOETE 1) VOl ATEVEQYOTTIOIOETE

v 0Bovn.
la AemTopépELES, avaTpéLTE 0TV evoTnTa Evepyorroinon odovng.
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Digital Wellbeing kot yovikoi é\eyyot
Mriopeite va Seite Tov Xpdvo Xpriong Tou mpoidvTog Kat va pubpiceTe 1o
XPOVOUETPO Yla KABe epapuoyn.

Mriopeite emiong va SIaxelpIOTEITE TOV XPOVO XPONG TOU KIVTOU TNAEQWVOU
XPNOWWOMOLWVTAE TN A&rtoupyia 'Yrvou Kai Eotiaonc.

EmAé€te Digital Wellbeing kat yovikoi é\eyyot otnv 006vn pubuicewv kat
puBpiote Tn Aertoupyia mou BéNeTe.

Epappoyéc & eidomoinoeig

Mriopeite va Seite pia NioTa yKaTaoTNHEVWY EQAPHOYWY KAl VA SIAHOPQWOETE
TIC PUBICELC V1o EL60TTOINTELS, SIKAIWHATWY EQAPHOYWY Kat AAAa.

1 Zmv oBo6vn pubuicewy, matriote EQappoyég & E160MOINOE,

7 MpocappooTe TG pUOKIoELC.
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Mnatapia

Mriopeite va Seite TIC TPXOUTEC TANPOYOPIES YA TNV prmaTapia 1 val
EVEPYOTIOINOETE TN AEITOUpYia £E0IKOVOUNONG EVEPYELQG.

T Zmv 066vn pubpicewy, matriote Mmatapia.

7 MpooappooTE TIC TaPaKATW PUBIcEIC:

Xprion pmatapiog: G&ite AeMTOREPELES Yia T XPAoN TNG umatapiad. Ma va
Oeite MEPIOOOTEPEG NEMTOUEPELEC, EMAECTE £VA OUYKEKPIUEVO OTOIXEIO.

+ Z1a6pn pmatapiog ot ypappn Katdotaong: Epgavifetal n otddun tng

Hmatapiag wg Moot 0T YPOUMI KATACTACNG.

+ PuBui{opevn pmatapia: Meplopiote T pmatapia yio pappoyEg mou Sev

Xpnotporoleite ouxva meptopiovtag T §pactnEIdTNTA TOug To PAVTO.
Meplopiopioi govTou: EvepyomoloTe autriv TV EMAOYI YIa VA TIEPIOPIOETE
TNV EKTENECT EQAPHOYWV OTO TTAPACKIVIO YA EE0IKOVOUNTN EVEPYELAG
KOTd TN XPrion TG cuokeuns. Ot epappoyEg mou meplopifovTat yia Adyoug
£€0IKOVOUNONG EVEPYELAG EVOEKETAL VA UNV AEITOUPYOUV OWOTA 1 va Unv
00¢ 0TEAVOUV EIGOTIOINCELG,

- E§olkovopnon evépyetag: MeloTe Tnv KatavaAwaon 1ox00g TG pmatapiog

eMAéyovTag XapnAATEPN TIUN O€ OPIOPEVES PUBLICELS TG GUOKEUNG, OTTWG
TN QWTEVOTNTA TNG 08GVNG, TNV TAXUTNTA TOU AEITOUPYIKOU CUGTHLATOG
Kat v évtaon g 66vnone.

E€aipéoeig e§oikovopnong evépyetag: EmAECTe TIC epappoyég mou

B€NeTE va XPNOIHOTIOLEITE XWPIG KAVEVAV AEITOUPYIKO TIEPLOPIOHS TIOPA TN
Aertoupyia §oikovopnong loxvoc 1y BeAtioTomoinong umatapiag.
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AmoONKEVTIKOC XWPOG
Mriopeite va mpoBAAeTe Kall va SLOXEIPIOTEITE TOV ECWTEPIKO XWPO ATOONKEUONG
0TI OUOKEUN 1} TOV OMOBNKEUTIKS XWPO 0NV KAPTA UVAMNG.
T Zmv 066vn pubpicewy, matriote AMOBNKEUTIKOG XWPOC,
7 MpooappooTE TIC TAPaKATW PUBIcEIC:
+ EowTePIKAG amoOnKEVTIKOG XWPOG: AEITE TOV GUVOAIKO XWPO
amoBKeVONG Kal ToV ENEVOEPO XWPO OTOV ECWTEPIKS XWPO amoBrikeuong

TNG OUOKEUNG. Agite pia NoTa e TIC EQapUOYEC TIOU XPNCIoToLoUVTaL Kall
TOV XWPO amoBrKeuong mou KatavaAwvel n kabepia.

Kapta SD: Agite Tov OUVOAIKO XWwpo amoBrikeuong kal Tov eAelBepo
XWPO OTNV KAPTA PviuNG. AUTr n emhoyn eppavietal ovo oTav €xel
TomoBeTnBei kApTA PvARNG. Ma Va ameEVEPYOTTOICETE TNV KAPTA PVAKING,
TIATAOTE

Xpnoteg & Aoyaplacpoi

Mriopeite va mpocB£oeTe prOTEC HE TOUG omoioug Ba XPnOIHOTIOLELTE A6 KOlvoU
TN GUOKEUN Kalt va SnptoupynoeTe €va hoyaplacud oto cloud.

T Zmv 0Bovn pubpicewy, matriote XprioTeg & Aoyaplacpoi.

7 MpooappooTe TIC PUBKITELC.

Google

Mriopeite va xpnotpomoloeTe Ti¢ pubpioel; Tou Google yia va SIaxEIPIOTEITE TIG
epappoyéc Google Kat Tig pUBLICELS TOu AoyapLaouoU.
2V 086vn pubpioswy, matrote Google.
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Zuothua

Kévtpo evnpépwong
Mriopeite va TpOoBANETE Kall Vo YKATAOTAHOETE TNV TEAeUTaia €KSoon NG
€QAPUOYNG 1} TOU AOYIGHIKOU TToU TTapéxel n LG.
T Zmv 066vn pubuicewy, matriote ZuoTnua > Kévtpo evnpépwong.
7 NpooapudoTe TIC Tapakdtw pubpiceIC:
- Evnpépwon epappoync: EAeyxog dv undpxel Stabéotun evnuépwon

£QAPPOYNG. EGv umdipyel, UmopEiTe va EYKATACTHOETE TV EVNUEPWHEVN
ékdoon.

+ Evnpépwaon NoyiopikoU: Eheyxog edv umdpyel S1abéoiun evnpépwon

NoytopkoU. EQv umdpyel, LmOpE(Te va yKOTAOTAOETE TNV EVNHEPWHEVN
£kdoon.

Mwooa & MAnkTpoAdylo

Mriopeite va TPOGAPHOCETE TI PUBHIOELG YAWOGAC KOl TANKTPOAOYIOU Yia TN
OUOKEUN 0aC.

1 Zmv oboévn pubuicewy, matote Zootnpa > NMwooa & mMAnKtpoAdyto.

7 MpocappooTe TIG TapaKATW PUBpIcEL:
+ Mwooa: EmAéCte YAWOOO yla TN GUOKEU.
« Aiayeipion mAnktpoloyiwv: Mropeite va aMdeTe tn pUBpIoN yla 1o

Baoikd MinkTPOAOYLo Tou TTPOIOVTOG, Va pubpiceTe Ta mepIBalovTa
XPAoNG yta To TANKTPOAGYI0 LG 1y GANa yKaTETTNHEVA TTANKTPOAYLA Kall vl
puBpioeTe TN Aertoupyia avayvwplong opiag yia €ioodo pe Ty epappoyn
Google Voice. Mmopeite emiong va emAECeTe av TO Ko TANKTPOAOYioU
Ba epgavileTal oTnv MEPIOYN TWV KOUPTIWY a@r¢ TNV apxIKr 08vn, wote
Val UITopeite va HeTaBeite ypriyopa o€ AAO MANKTPOAOYLO.

Mpaypatiké mAnktpoldyto: EMAEETE yia va XpnOILOTOICETE TO KAVOVIKO
TANKTPOAOYIO 1) Y1a va TIPOBAANETE TIC CUVTOEVTELG TANKTPOAOYIOU.

+ Ynnpeoia autdpatng supminpwaong: Evepyomolnote autryv thv emAoyn

yla va yivetal eloaywyn Twv MANPOoQopLWV TIOU €ival amoBnKEUUEVEG

0TO Aoyaplaouo 6ag, Onwe KwdKo mpdaBacnc, Sievbuvon iy

apIOPOL TMOTWTIKAG KAPTAG ME Eva pdvo mdtnua. Mmopeite emiong va
QITEVEQPYOTIOIOETE AUTHY TNV EMAOYK, VA XPNOILOTOCETE TNV AUTOHATN
oupmiijpwon g Google 1y va mpocbéoete éva véo Aoyaplaopd umnpeoiag.
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+ Metatpomnn Kelpévou o€ pwvr: AlapopPWOTE TIC PUBLICELS Yia METATPOTT
KEIEVOU O OMINIaL.

+ Tayutnta tou Seiktn: PuBpioTe Ty TaxUtnta Tou Seiktn Tou TOVTIKIOU i
Tou trackpad.

+ AvTioTpo@ MARKTPWV 0TO TOVTIKL: avTIOTPEWYTE TO Se&i Koupmi Tou
TIOVTIKIOU Y10 VA EKTEEL PACIKEG EVEQYELEG ALIETOU XEIPIOHOU.

Huepopnvia & wpa

Mrmiopeite va TPOCAPHOCETE TIC PUBHIOELG NUEPOUNVIAG KAt WEAG YL TN CUOKEUN
oag.

1 Zmv 006vn pubuicewy, matote ZooTnua > Hugpopnvia & wpa.

7 Mpooapp6oTe TIG pUBKITELC.

Mvriun

Mmopeite va Seite évav Héoo 6po yia TNV KaTavaAwan MVANG Yia Va GUYKEKPILEVO
XPOVIKS S140TNHa, KABWG Kal TV TOGATNTA VANG TTOU KATAVOAWVEL HLaL EQOPHOYN.
T Zmv 0Bovn pubuicewy, matjote ZooTnpHa > Mvipn.

7 MatioTe To Koupri w yia va opioeTe pia xpovoBupiba yia avaktnon Sedopévwy.

Avtiypago ao@aleiag

Mriopeite va dnpioupynoete avtiypaga acpaleiag yia Sedopéva mou givat
amoBNKEVPEVA OTN GUOKEUN 0OG O€ pid GAAN GUOKEUN 1] A\oYapLaoo.

T Zmv 066vn pubuicewy, matriote ZuoTtnua > Avtiypago ac@aleiag.

7 NpooapudoTe TIC Tapakdtw pubpiceIC:

+ LG Mobile Switch: Zag emtpémel va petagépete Sedopéva amo pia malid
ouokeun LG oe pia véa ouokeun LG. Na Aentopépeleg, avatpédte otnv
evotnta LG Mobile Switch .

+ Anuioupyia avtypd@wv ac@aleiag Kot emava@opd: Snpiouvpynote
avTiypaga ao@aleioag Twv GeS0HEVWY TNG GUOKEUNG 1 EMAVAPEPETE
Sedopéva 0T CUOKEUT 0aC AMO KATTOLO AVTiypapo Ao@aEiag.

A + Me v emavagopd NG CUOKELRG EVEEXETAL Va Slaypapoly apyeia
avTIypa@wv acpaleiag mou éxouv amobnKeUTEN 0TV XWPO amoBriKEUONG.
BePaiwBeite oT1 éxeTe avTlypdPel Kat amoBnKeVCEL 0TOV UTOAOYIOTH 0ag T
avTiypapa ao@oAEG Twv ONUAVTIKWVY apxEiwv oo,
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+ Avtiypago ac@. Google: ANayr Twv pubuicewv avtypd@ou ac@aleiog
Tou Google drive. Mmopeite emiong va mpoPdAeTe Tov Aoyaplaoud
Snuioupyiag avTypdewv ac@aleiog mou XpnolMoTIoLETal ) va TPooBEoETe
£vav véo hoyaplaopo dnpioupyiag avtypdgwy acpaleiag.

Emavekkivnon & Emavagopd
Mriopeite va KAVETe EMaVAQOPA TNG CUOKEUNC TEPAUBAVOLEVWY TwV PUBHIcEWY
SIKTUOU KAl EQAPUOYWV.
1 Zmv 086vn pubuicewy, matote Zootnpa > Emavekkivnon & Emavagopd.
7 Mpooapp6oTe TIC TapaKATw puBpIcelC:
+ Autopatn emavekkivnon: AutoUaTn EMAVEKKivVNON Kal Tpocappoyn
TOU TNAEQWVOU O€ KaBopIopEVO XpOvo. MaTAoTe To Koupi ylava
€EVEPYOTIOINOETE AUTH TN AetToupyia. H GUOKEUN EMaVEKKIVELTAL AUTOpATA
o€ KaBoplopévo xpdvo kat BeXtiotomoleital autdpata. EmAégte v
NUEPOUNVIO Kal TV WPa Yia T BIoypa@Iko onueiwpa.

Mmopeite va pubuioete Tn ouokeun va Eekiva Eavd pia @opd tnv eBdoudda.
H ouokeur emavekkIveital QUTOPATA OF pia WPa amd Ty Mpokaboplopévn
wpa.

+ METa TV eMavekkivnon TnG GUOKEUNG, ot EI50TOINCEIC Kal Ta EUPAipaTa
Katapyouvtal. AmoBnkeloTe onpavTikd Sedopéva mptv amd thv
mpokaBoplopévn wpa.

« HAeroupyia autopatng emavekkivnong Sev eivat evepyr 0TI akOAOUBEG

nepMTWoelG: Otav n 08dévn givat evepyomoinpévn, 6Tav N CUOKEUR ival o€

Xprion, 6tav n otadun tng pumatapiag givat 30% r Ayotepo 1 6tav n Kapta

USIM givat KAelbwuévn.

- Avdloya e ToV TTAPOYO UTINPEDLWV TNAETIKOIVWVIQY, N AElToupyia
QUTOHOTNG EMAVEKKIVNONG EVOEXETAL VA LNV gival SlaBéatun.

i

Emava@opd Twv pubpicewv SikTUou: emavagépel Ti¢ pubpioelg Wi-Fi,
Bluetooth kat d\\eg pubpioeig Siktuou.

Mn&eviopog mpotiuioewy epappoyng: Emavagopd twv pubpicswy yia pia
epappoyn. Aev Ba Siaypagouv ta dedopéva mou ivat amobnkeupéva otny
£pappoyn.

Emava@opd epyooTactakwy SES0PEVWV: EMAVAPEPEL ONEC TIG PUBLITELG
yla T cuokeun Kat Staypagel ta dedopiéval.
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5 « H emavekkivnon Kai n mavagopa TG GUOKEURG 00U Slaypdpel ONeG Ta
Sedopéva mavw ¢' auTrv. BANTE To Gvopa TNG GUOKEURG 0aC, TOV AoYaplaopd
Google kat AMeG apyIkéG MAnpoopieg Eava.
« Meta v apyikomoinon twv Sedopévwy, Sev eivai Suvarn n emavagopd Toug.

ZYETIKA pE To TNAEPwVO

Mmopeite va Seite TANPOPOPIEC OXETIKA HIE TN GUCKELT 0aC, OTIWG TO GVOUA TNG,
TNV KATAOTAON, TA OTOIYEID Yial TO AOYIGUIKO Kall VOUIKEG TANPOQOPIE.

SNV 086vn pubpiocwy, matote ZVOTNHA > ZXETIKA Me TO TNAEPWVO Kal SEiTe TIG
TIANPOPOPIEC TIOU 0AC EVOIAPEPOUV.

PuBuioTiko maicio & Aopdlela

Mrmiopeite va SeiTe TIC PUBIOTIKEC ETIKETEG TIC OXETIKEG TANPOPOPIES TN CUOKEUN
oag,

3TNV 086vn pubpicswy, matrote 0oTnpa > PuBpoTIKG mhaioto & AogpdAeia.

Mpoofacipotnta
Mriopeite va Sl0xelPIOTELTE TIG TPOCONKES TPOORACIUATNTAG TTOU £XOULV
€yKataoTabel 0T OUCKEUN 0aC,
1 Zmv 066vn puBpicewy, matiote MpoopacipdtnTa.
7 MpooappdoTE TIC TAPaKATW PUBIcEIC:

- 'Opaon > TalkBack: Pubpiote T cuokeun va oag eldomole éow VG yia
TNV KATAOTAON TNG 006VNG 1) Yia EVEPYELEC.
‘Opaon > Owvntikég eidomotjoelg: Pubpiote tn cuokeur va dlafdlel ta
OTOIXElO EI0EPXOMEVNG KAONG HEOW QWVNAG.
+ 'Opaon> lpappatooelpd: ANGETE To péyebog TG YPAUUATOOEIPAG, TNV
£VTaon NG YPAPAG N TN YPAUUATOOEIPA.
‘Opaon > MéyeBog 006vng: Opiote 1o péyebog Twv oTolxeiwv atnv 086vn
omwe oag BoAevel. Kdmota otolyeia evdéxetal va aMd&ouv Béon.

+ 'Opacn > MeyéBuvon a@ig: yia ueyéBuvon 1y GUIKPUVON TTATWVTAC OTNY
0006V TPEIC POPEC.

- 'Opacn > Meyébuvon mapabupou: TPAYUATOTOINOTE Peyébuvon 1y
OiKpLVON EVTOG TOU TTAPABUPOU KAl AVTIOTPEWTE TO XPWHA.
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+ 'Opaon > Meyalog Seiktng movTikioU: peyeBuvete Tov Seiktn Tou
TIOVTIKIOU.

+ 'Opacn > 006vn uPnAiig avTiBeang: OKOUPUVETE TO XPWHA YOVTOU Yia
006vn uPnArg avtiBeonc.

+ ‘Opaon > Avtiotpo@n Xpwpdtwv 006vnG: Au§iote v avtifeon
XPWHUATWY TNG 086VNE 1o ATOMA PE TIEPIOPIOHEVN Opach.

+ 'Opaon > PUBon xpwpdtwv 080vng: MpooapuooTe To XpWHA TG
oBovne.

+ 'Opaon > Movoypwpn: aMaEte Tn Aertoupyia tng 006vng o KAipaka Tou
YKPL

- 'Opaon > TeppaTiopog KAoNG He To MAKTPO TPO@POod0osiag: TEpUATIoTE
Mo KAon e To TATNA TOU TTARKTPOU EVEPYOTIOINCNG/KAEISWHATOC.

+ Akon > Ne{dvteg: EvepyomolioTe Tnv Umnpeacia UMOTITAWY KATA TV
avamapaywyn BIvteo yia dtopa pe mpoBAUaTa akong.

« Akon > LED avaBoafrver: Pubpiote v evepyomoinon tg Auyviag LED yia
E10EPXOUEVEC KN TELC Kall EISOTIONTELC.

+ Akon} > Eidomotjoeig @Aag: pubLioTe T GUOKEUN VA 0OG EVNUEPWVEL LE
PWG IOV avaBooPrVeL Yia EI0EPXOUEVEG KAATELS, UNVUUATO KOl AQUTTVIOELG.

+ Akor > ATopovWwon GAWV TWV AXWV: AOOVWon OAWV Twv AWV Kal
XOUNAGTEPN OTABKN évTaong fixou oTov SéKTN.

+ Akon} > Kavahi fou: emAEETe Tov TUTTO rXOU.

- Akor} > loopporia fYou: TpoCGapUOCTE TV IooppoTia 65ou ryou.
XPNOIHOTIOOTE TN YPAUMI KUNONG yia va aAAEeTe Ty 1oopporria.

+ Kwvnuikétnta kat yvwon > Touch assistant: evepyomolr|ote Tov mivaka
ARG Yla EVKONGTEPN XPON TWV KOUHTIWV KAl TWV KIVIOEWV.

+ Kwvntikétnta kau yvwon > Eloaywyn a@ig: KataxwpnoTe Keipevo
TIOTWVTOG TAPATETAUEVA TNV 080VN 1) TPOTIOTOIOTE TO TIATWVTAG OMAG TV
o8ovn.

+ Kivntikétnta kot yvwon > Mpaypatikd mAnKTpoAdyLo: mpoosaprOoTE TIG
pUBpioElG Tou MAnKTPOAOYiOU.

KivntikotnTa Kat yvwon > Autopato KAIK TovTikou: Snuoupynote
auTdpaTa KNIK Tou G€IKTN TOU TTOVTIKIOU O€ TIEQIMTWON amouaiag kivnong.
+ Kivnuikétnta kat yvwaon > Ayyi§te mopatetapéva yla va KAVeTe KAon:
QMAVTAOTE 1) AMoPPIYTE KAOELS TTOTWVTAC TAPATETAMEVA TO KOUMTT
KAjong, Kat Ox1 e 0apwary Tou.
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Kivntikotnta kat yvwon > AREn xpovikou opiov 086vng: va
QTEVEPYOTTOLEITAL AUTOUATA N CUOKEUN OTaV TTapapével og adpdvela yia éva
KaBopIoPEVO XPOVIKO SIdoTnpa.

KivnTikétnta kat yvaon > Mepioxr ENéyxou apnc: meplopioTe v meploxn
APNG £TOL WOTE 0 EAEYXOG APNG Va Eival SuvaTOG LOVO OF £VA GUYKEKPIUEVO
TUAUA TG 006vNG.

+ ZuvTtopEUaN AEITOUPYIWY TTPOCRACIHATNTAG: Yia Ypryopn Tpdoacn oe
NETOUPYIEC TIOL XPNCIUOTIOLELTE CUXVA IATOVTAG TPEIS POPEG To koupmi Q).

Autopatn mepiotpoPr} 086vng: aMAlel auTOPATA 0 TPOCAVATONOHOG TG
006vng avaloya e TovV IPOsavATONOUO TNG CUOKEUAG.

+ EmAé€Te yia ekpuvnon: Zag emrpénel va matdte mavw og OpIopéva
oTolxeia yia va MNABETe TPOPOPIKN avatpo@odotnon.

MpooBaon pe S1akdmT: Anuioupynote 6uvSUACKOUS TARKTPWY Yia val
ENEYXETE TN OUOKELN 0OG.
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Mapaptnua



PuOpiosic y\wooag LG
Em\é€te Y\OOA yla TN GUOKEU.
« XV apyikn 08ovn, matriote Pubpioei > Luotnpa > Nwooa & MAnKTpoAoyio
> MNwoaoa > MpocOrikn yYAwooag kat mAEETE pia YAwooa.
- Ayyi€Te Kal KPATAOTE TO KOUMTTI == Kal GUPETE TO OTO EMAVW PEPOG TNG
NoTaG Y\wOoOoWV Yia Vo TO 0PIOETE WG T YAWOOoa POEMAOYNG.

LG Bridge

LG Bridge - Mapouaiaon

Mrmiopeite va SnIoUpYHOETE QVTiyPaQa AOPANEIRS TWV EMAPWY, TWV
QWTOYPAPIWV KAt GAWV OTOIKEIWV OTOV UTTONOYIOTH 1} VO EVNUEPWOETE TO
MOYIOUIKO TNC OUOKEUNG.

E « [la mepLoooTePEG MAnpogopie BorBelag, avatpé€te oty evotnta LG
Bridge.
Ot umootnpI{OuEeVeC AerToupyieg eVOEXETaL va Sla@éPOouV avAaloya HE TN
OUOKEUN.
« To mpoypappa odrynong USB LG gival amapaitnto yia va ouvSéoeTe To
smartphone LG pie Tov umoAoyloTr Kat ykabiotartal Katd Ty eyKataotacn
Tou LG Bridge.

Netroupyieg Tng e@appoyng LG Bridge
+ AnpoupynoTe avtiypaga ao@aleiag Twv SeSopévwy amod T GUOKEUH Ot évav
umohoyloTh 1} emava@épete Ta Sedopéva amd évav UMOAOYIOTH OTN GUCKEUN
péow ouvdeong kawdiov USB.
+ Evnuépwan AoyiopikoU TnG GUOKEUNE amd évav UMOAOYLOTH Héow oUvEeon(
kaAwdiou USB.
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Eykatdotaon epappoync LG Bridge og umoloyloth

T MetaBeite otn SiebBuvon www.lg.com amé Tov umoAoyIoTH 0aG.

7 Em\é€te v mepioxn oac.

3 MatAote YIooTthpi€n > AOYIOUIKO Kat UNIKOAOYIGMIKO.

/' TANKTPONOYAOTE TO OVOUA TNG GUOKEUNC 0ag.
H
EmAé€te TV katnyopia mpoiovToc.

5 Tava kateBdoete 1o apyeio puBiong, emAéCte Zuyxpoviopog PC> LG Bridge.
« EmAé€Te Aemropépeleg yia va Seite TIG ENAXIOTES OMAITATELS Yia TV

£yKaTAoTaON TNG EPapHoy¢ LG Bridge.

Evnuépwon AoylGHIKOU THAEQWVOU

Evnuépwan Aoyilopikou Kivntol TnAepwvou LG améd 1o
Internet

M0l TEPIOCATEPES TANPOPOPIES OXETIKA HIE TN XPr|0N AUTAG TG AelToupyiag,
emoke@Oeite Tn dievbuvon http://www.lg.com/common/index.jsp kat emAEETe T
XWpa Kat T yAwooad 6.

Meé autrjv Tn Aertoupyia pmopeite e0koAa va evnUEPWVETE Péow Internet To
UANIKONOYIOMIKO OTO TNAEPWVO 0aG OE HIat TTO TIPOoPATN €kS0on XWwpic va
XPEdleTal va eMOKePOEITE KATTOLO KEVTPO EMOKEVWV. AUTH N Aeltoupyia

Ba eivat Slabéoiun edv kat 6tav n LG diabéoet otny ayopd veotepn ékdoon
UNIKOAOYIGHIKOU Yla TN GUCKEUN G0,

Eme16n n evnpépwaon Tou UNIKOAOYIGHIKOU TOU TNAEQWVOU TIpoUmoBETEL

TNV E0TIOOPEVN TTPOCOKN TOU XPNOTN KaBOAN TN Sidpkela Tng Stadikaciag
evnuépwong, PePatwbeite 6Tt SraBalete mpooeyTIKA ONeC TIG 08NYiES KAl TIC
ONUEIWOELS TTOU epgavi{ovTal oe KABe Bripa PV MPOKwPENOETE TNV EKTENEDH
Tou. Adfete umoYn 6T edv agatpéoete To kahwdio USB katd tn Sidpkela tng
Sladikaoiag avaBabpiong, evoéxetat va mpokAnBouv coBapd mpoBAfjuata oto
TAéQWVO 0ag.

E + HLG em@uldooetal Tou Sikaiwpatog va S1abétel, katd tn SlakpiTikn
TNG EVXEPELD, TIG EVNUEPWOELG TOU UNKOAOYIGHIKOU MOVO Yia EMAEYUéVa
povtéha kai Sev eyyudral Tn S1aBeoiudTNTA TG VEOTEPNC £KSOONG
UANIKOAOYIGHIKOU Y10l OAG TOl LOVTEAD TNAEPWVWV.
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Evnuépwan Aoylopikou Kivntol ThAe@uwvou LG péow
Over-the-Air (OTA)

AuTH N AeToupyia 0AG EMTPETEL VA EVNUEPWVETE EVKOAA TO AOYIOMIKS TOU
TNAEPWVOU 0ag o€ pia o mPooath ékdoon péow OTA, xwpic ouvdeon Kahwbdiou
USB. Auth n Aertoupyia Ba givat StaBéoiun eav kat 6tav n LG diabéoel otnv ayopd
VEOTEPN €KOOGT UNKONOYIOHIKOU YL TN GUCKEUN 0OC,

M0 Vol EKTENEOETE EVNUEPWOT TOU AOYIGHIKOU TOU TNAEQWVOU, aKOAOUBAOTE TV
€€nc Sladpoun:

PuBpioeig > Z0otnua > Kévipo evnuépwong > Evnuépwon Aoyiopikou >
‘EAeyxog evnpépwong Aoylopikou.

5 + Katd  1ad1kaoia evnpépwong Tou AOYIGHIKOU TOU TNAEQWVOU Gag
evdéxeTal va xaBolv Ta poowmika oag SeSopéva amo Tov ECWTEPIKO
XWPO amobrjKELONG TOU TNAEPWVOU, OTIWG YIal TAPASEIYUA, OL TTANPOPOPIES
OXETIKA UE TOV TIPOOWTTIKO 0ag Aoyaplacpd Google Kat GANoug
Aoyaplaopoug, Ta Sedopéva Kat ot PUBHICEIC TOU CUCTAKATOC KAl TWV
EQAPHOYWV 0aG, Ol amoBnNKEUpEVES EQappoyEC amo To Internet kai n ddeia
xprionc DRM. Emopéviwg, n LG 0dg ouviotd va dnpioupyeite avtiypapa
ao@aleiag Twv MPOCWTIKWY 6ag SeS0HEVWV TIPIV aTtd TV EVNUEPWON TOU
MoyiopikoU Tou ThAEpwvou oag. H LG ev pépel euBuvn yia evdexdpevn
QMWAELD TIPOCWTTIKWY SESOpEVWV.

« Auti n Aertoupyia eaptatal amd v mEPLOKT 1) TOV TAPOXO UTINPECIAV.
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06nyo¢ kata NG KAOmNG

PuBpiote Tn ouokeun oag va Pnv eMTPEMEL TN XEroN amd dANa ATopa £4v Exel
TIPAYHATOTOINOEL EMAVAPOPA EPYOCTACIOKWY PUBHICEWV XWwpig TV Adeld oag. MNa
TaPASELYHa, EQV N OUOKELR oa¢ xabei i KAamei, 1 edv Slaypagpolv ta dedopéva
NG, HOVO KATolog ke Aoyaplaopo Google fy Minpogopieg yia To KAEidwua Tng
086vn¢ Ba pmopei va xpnoIUOTOIOEL TN GUCKEUH.
To povo mou ypetdletat va Kavete yia va Befatwbeite 61 n cuokeur oag gival
TIPOCTOTEVPEVN €ival Ta E§1G:

+ Na opioete KAeibwpa 086vnc: dv n cuokeur oag xabei fy kKharmei, al\d éxete
opioel kAeidwpa 086vng, Sev gival duvatn n Slaypaer Twv dedopévwy
TIou BpIOKOVTAI OTN CUOKEUT HEOW TOU pevoU pubpioewv mapd pévo v
EekheldwOei n 0Bovn.

Na mpooBéate Tov Aoyaplacpd oag oto Google 0T cuoKeLr 0ag: £Gv Ta
Sedopiéva TG UOKEUNG oag Slaypapoly alAd ExeTe opioel Aoyaplaopo
Google, n cuokeur gv umopei va oAokANpwael Tn Sladikacia pUBUIONG UEXPL
va gloayBouv avd ta oTolxgia Tou Aoyaplacpou oag oto Google.
A@OU TIAPETE TA AMOPAITNTA HETPA VIO TV TIPOOTAGHA TNG CUOKEUNG 0ag, £4v
XPELOOTE VO TIPAYMATOTIOIOETE EMAVAPOPA TNG OTIC EPYOOTACIAKEC PUBicELS, Oa
Tipémel va EeKAEIOWOETE TV 086vN 0ag ) va EloaydyeTe Tov KwdIKO TpooBaong
yia Tov Aoyaplaopd oag 0to Google. Me autév tov Tpdmo Siacpahiletal 6T n
EMAVOPOPA UTTOPE( VO EKTENETTEI IOVO QMO KATTOIOV TTOU EUMIOTEVEDTE.

E « Tpwv ekteNéoETe EMaVaPOPd TwV EpYOoTaCIaKwY pubpicewy, Befaiwbeite
6T BupdoTe Tov Aoyaplacpo oag oto Google Kat Tov KwdIKo mpooBaong
TIoU éXETE MPOOBETEL OTr GUOKELN 0ag, EQv Sev Umopeite va mapéxete autd
Ta oTolkEia Aoyaplacpou katd T Sladikacia puBpiong, Sev Ba umopeite
VOl XPNOILOTIONOETE T CUOKEUT KaBONOU HETE amd TNV eKTENEON TNG
ENAVAPOPAG EPYOCTACIAKWY PUBHICEWV.
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MAnpo@opisg onueiwong yia to
AOYIGHIKO AVOIKTOU KWOIKA

MNa ™ AN Tou mnyaiou kwSika mou Siémetat amd TG adeleg xpriong GPL, LGPL,
MPL kat GAeG adeteg xpriong avolytou Kwdika, o omoiog mepthapBavetat 6To
Tipoidv, emoKeTeite Tn SlelBuvon http://opensource.lge.com.

Ext0¢ amo Tov mnyaio Kwdika, Slatibevtat mpog An 6Aot ot avapepdpevol 6pot adelmv
XPONG, Ol AMOTOICEIG EYYUOEWV KAl Ol ONPEIGELG TIVEUHATIKWV SIKAWHATWV.

H LG Electronics Ba oag mapéxel emiong Tov Kwka avolx g mnyng o poperi CD-
ROM évavtt xpéwaong mou Ba kaAumTel Ta €€06a TG Slavopnic (OMwe To KHOTOC Twv
TIOAUHECWVY, TNG AIMOOTOAG Kalt TNG SLayeiplong), KATomy artuatog Yéow email
otn SievBuvaon opensource@lge.com.

H mpoopopd 1oxUEL yia TEPInS0 TPIWV ETWV amd TNV TEAEUTAIN LA ATOCTOAN
auTou To TTPOIGVTOG. H poo@opd 1oXVEL yia GAOUG TOUG TTAPAAATITES AUTHG TG
TIANPOYOpIaC.

MAnpo@opieg OXETIKA UE TOUG
KaVOVIOHOUG (ApIOROC avayvwploTIKOU
KAVOVIOMOU, NAEKTPOVIKEG ETIKETEC KAL)

Mol NeTTTOPEPELEC OXETIKA LE TOUG KAVOVIOpOUG, emAEETe Sladoyikda PuBpioeig >
Y0oTnua > PubpioTiko maicio & Ac@alela.
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Epnopu(a onfpara

Mo matévteg Hyoouotnpdtwy (DTS:Dedicated To Sound=A@iepwpévo Ztov
'Hxo), 6¢¢ http://patents.dts.com. Kataokeuaopévo umo v ddeta amd DTS
Licensing Limited. To DTS, To Z0ufoAo, & DTS kat 1o ZupBolo 6Aa padi, DTS:
X kat To Aoyoturo DTS: X gival orjpata KaTateévTa 1 UMopIKA OHaTA TG
DTS, Inc. o1 Hvwpéveg MoAreieg kat / 1y og GAeg xwpeg. © DTS, Inc. Oha ta
Akaiwpata Mpootatevoval.

LG Boombox Edition

« Mvevpatika Sikaiwpata ©2020 LG Electronics Inc. Oha ta Sikaiwpata

npootatevovTal H emwvupia LG kat To Aoyoturo LG givat orjpata Katatefévta

Tou Opilou LG Kal Twv OXETIKWY OVIOTATWY TOU.

To G7 ThinQ givat éva epmopikoé orjpa g LG Electronics, Inc.

+ Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,

Chrome, wtoypagiec Google, Google Play Protect, Hugpohdyio Google,

Google Docs, Google Drive, Google Sheets kit GA\a oxeTika orjuata kat

Noydtuma eival epmopikd orjpata tng Google LLC.

To Bluetooth® amotelei ofjua katateBév tng Bluetooth SIG, Inc. maykoopiwg.

+ H enwvupia Wi-Fi® kat To Aoyétumo Wi-Fi eivat orjpata katatedévta e Wi-Fi
Electronics.

+ 'ONa T UTTOAOITAl EUTTOPIKA CHMATA KAl TIVEUHATIKA SIKaWATA amoTteholv
1510KTN G0 TWV QVTIOTOLWVY KATOXWVY TOUG,

HE HEVCAdvance”

‘E Covered by Patents at patentlist.hevcadvance.com
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AnAwon acpaleiag Aélep
Mpoooxn!

Auto To Tpoidv xpnaoiuomolei cloTnpa Aéilep. MNa va BePaiwbeite mwg
XPNOlHoToLEiTe KATANNAa AUTO To TTPOTOY, SIaBAOTE MPOTEKTIKA TO EYXEIPISIO
XPOTN Kat QUAGETE TO yia HENOVTIKH ava@opd. Ze mepimTwaon mou n povada
XPEIOOTE GUVTAPNON, EMKOIVWVACTE PE E§0UCIOSOTNHEVO KEVTPO ETIOKEVWV.
H xprion otolxeiwv eAéyxou, pubpicewv r n ektéAeon Sladikaotwy mou dev
TIEPYPAPOVTAL 0TO TTAPOV EVOEXETAL VA EMPEPOLV eMmKivouvN €kBeon o
padievépyela.

Mo va amo@UYeTe Tnv dpeon €kBeon otnv aktiva Aéilep, unv mpoomabroeTe va
avoiete To mePiBAnUa fy va ExETeE APEDN EMAQN Ue TO AéIlep.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

AHAQZH ZYMMOPOQXHX

Meé 1o mapdv, n LG Electronics SnAwvel oti To mpoidv LM-G710EM cuppop@wveTal
HE TIG BACIKEG QMAITHAOELG KAl LE TIG UTTONOTEC OXETIKEC Slatdelg Tng Odnyiag
2014/53/EU.

‘Eva avtiypago tng Afdwong Zuppdpewong SatiBetal otn Sievbuvon
http://www.lg.com/global/declaration
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AevOuvon evnpépwong yla Oépata
GUHHOPPWONE WG TTPOC TN XPHON TOU
TPOIOVTOG

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

H ouyxvétnta 5150 - 5350 MHz mpoopileTat amoKAEIOTIKA yia Xprion O
EOWTEPIKOUG XWPOUG.

AT |BE |BG|CH|CY|CZ|DE|DK|EE|EL|ES|FI|FR

QHR HU[IE | IS|IT| L |LT|LU|LV|MT|NL|NO|PL

PT|RO|[SE | SI [ SK|UK|AL|ME|RS [MK]|TR |BA]|XK
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Meproootepeg MAnpoopicg

E€aptipara and okAnpupévo yuai

Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUEVO Yuai Sev xouv SIdpKela ¢’

6pou {wrig, CUVETWC, EvOEXETAL Va BAPOUV e TNV TTdPodo Tou xpdvou.

+ Edv n ouokeun oag méoel TAvw O€ pia OKANPN EMEAVELD 1) TPOOKPOUGTEL KATTOU
e Svvapn, wmopei va mpokAnBei {nptd 6To oKANPUHEVO YUaA.
Ye QuTAv TV TePImTwan, SIaKOYTE APESWE TN XPHON TNG CUCKEUNG Kall
EMKOWVWVAOTE PE éva Kévtpo e§umnpétnong mehatwv tng LG.

TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPEITE Va
TIPOUNOEUTEITE YIa VA TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOYN OTL AUTEC OL TTPOOTATEUTIKES Brikeg Sev KaAUTTOVTAL amd TV
€yyunon ¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@alela.

Noyo¢ Slaotdoewv
AuTA n ouoKeun €xel Adyo Slaotacewv 19.5:9.

« Evéxeta kdmoteg \n@Oeioeg epappoyég va pnv umootnpifouv tov Adyo
Slaotaoewv 19.5:9.

Ye autrv TV mepimwon, emAEETe TI¢ BEATIOTEG avahoyieg 006vng yia v
gpappoyn 1 anotabeite oTov MAPOYKO TNG EPAPHOYAG Y10l TIEPIOTATEPES
TIANPOPOPIEC.

TNa mep1ocoTEPEG MANPOPOPIEC

mAepwviiote oto: 801 11 200 900

i and Kwnto oto: 210 4800564
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06nydc yia petagopd dedopévwv
+ Ta Sedopéva mou Pmopouy va LETaPepBouv PETay cuokevwy LG iy petay
Uiag ouokeung LG Kal piog GUOKEUNG TPITOU KATAOKEUAOTH, GUUBOUAEUTEITE

Tov mapakdTw mivaka.
ZuoKeur Tpitou
SUOKEUH LG KatooKeuaoT ZugKeun
e AerToupyIko i0S
Tumog Nemtopépeleg oTOIXEIOU — Android .
Zuokevn LG - Zuokeun LG
Tuokeu LG
Emagéc, unvopata, apxeia
KAOEWV, NUEPOAOYIO, @) O O
Mpocwmka PWVNTIKEG EYYPAPES
Sedoptva 2nUEWUATAPIO X O
=umvntipla X X
Agdopéva | Dwroypagieg, Pivteo, o o o
mohupéowv | Tpayoudia, éyypaga
PU’QHIOEIC apiknc 066vng o X X
(pakehot kat widget)
PU?““’E'C PUBpioEIC KAEIS(PATOC
086vng ¢ 086vNC (e€apouvTat o X X
ol puBpioelC KAeldwuatog
006vng)
An@Beioec epappoyég @) e)
Egappoyéc Mpoowmika dedopéva yia .
. . @) X
™ An@Beioa epappoyn
Anpdoto moTtomoNTIKd O @) X
PuBpioeig (Wi-Fi,
ANa Bluetooth, kAroelig,
X0 Kat E80TTONCELG, @) X X
mpooBacipotnta,
umatapia)
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E « Evdéxetal va pnv ivat QIKTr N HETAQopd oplopévwy dedopévwy avaloya
ME TV €KE0ON AOYIOUIKOU Kal EQAPOYNE, TO AEITOUPYIKO 0UOTNA, TOV
KATAOKEVAOTH 1) TNV TTONTIKY) TOU TIAPAXOU UTTNPECIAV.

Ymootnpi{opeveg {WVEG CUXVOTHTWV loxug e€680u mopmou

GSM 900 34,0dBm

GSM 1800 31,0dBm

WCDMA B1 23,5dBm

WCDMA B8 24,8dBm

LTEB1 23,5dBm

LTE B3 24,2dBm

LTE B7 24,5 dBm

LTE B8 24,8dBm

LTE B20 24,8 dBm

LTE B28 24,8 dBm

LTE B38 24,5dBm

LTE B40 24,5 dBm

BT 2,4GHz 11,0dBm

WLAN 2,4GHz 15,5dBm

WLAN 5,150~5,350GHz 15,0dBm

WLAN 5,470~5,725GHz 15,0dBm

WLAN 5,725~5,875GHz 10,5 dBm
NFC -22 dBuA/m

Mropeite va Bpeite minpo@opieg yia 1o @optioT Tagidiou otn SievBuvon
http://www.lg.com/global/support/cedoc/cedoc
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUPBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL OTL
Ta amoBANTA NAEKTPIKWV Kat NAEKTPOVIKWY TTpoiovTwy (AHHE) mpémetva
amopP{MTOVTAl XWPIOTA OO Ta YEVIKA OIKIAKA AmoppipuaTa.

B 2 TanaNd NAeKTPIKA TPOIGVTa UMOPE( va TIEPIEXOUV EMIKIVOUVEG
0UOIEC KAl WG EK TOUTOU N 0WOTH AmoppiPn TG MaNAG 0ag GUOKEUNG
QMOTPEMEL EVEEKOUEVEC APVNTIKEG CUVETTELEG Yiat TO TIEPIBANOV
Kat v avBpwmivn uyeia. H maAid 6ag GUOKEUR PMOPE( va TIEPIEKEL
EMAVOXPNCIUOTIOOIA AVTAMAKTIKE TTou Ba pmopouoav va
XPnotpomonBouy yia Ty MoKeur GAwV TPoIOVTwWY, KaBWE Kat GMa
UAIKA a&iag mou umopouv va avakukAwBoLv yia e§oikovopunon Twv
TIEPIOPIOUEVWY PUOIKWVY TIOPWV.

3. Mmopeite va TTATE TN CUOKEUR 00, iTE 0TO KATAOTNO amd TO
0TI0i{0 AyOPACATE TO TIPOIGV, I} Va EMKOIVWVAOETE TO TOTIKS YpaPEio
AMOPPIUUATWV Yia AETTOPEPELEC OXETIKA HE TO TTANCLETTEPO EYKEKPILEVO
onueio ouloync AHHE (AnépAnTa HAektpikwv kat HAEKTpOVIKWV
JUOKEUWV). M0 TIG TTIO TPOOPATES TTANPOPOPIES YIA TN XWPA 0AG
emokepOeite T SievBuvon www.lg.com/global/recycling

AmoppPn TWV XPNOIUOTTOINMEVWY prrataplwv/
CUCCWPEUTWY

1.To oOpBolo autd pmopei va cuvdualetal pe Ta XnUikd cupBoAa yia
Tov udpdpyupo (Hg), To kadpo (Cd) rj To pdAuBso (Pb), av n pmatapia
TIEPIEXEL TOOOTNTEG PEYaNUTEPES a6 0,0005% udpdapyupo, 0,002%
Kadpio 1} 0,004% poAupso.

2. H améppun OAwv Twv PIaTaplwv/CUCoWPEUTWY TTPEMEL vVal
YIVETOL XWPIOTA A0 TA YEVIKA OIKIAKA AMOPIpaTa, HEow EISIKWY
EYKATAOTACEWY CUNOYIG AOPPIUHATWY TTou €xouv kaBoploTei amd v
KUB£€PVNON 1 amo TIG TOTTIKEG APXEC.

3. H owotr andppipn Twv maNwy HmaTapiwv/cCUCowPEUTWY AITOTPETEL
EVOEXOUEVES OPVNTIKEG CUVETTELEC VIO TO TIEPIBANOV, KABWE Kal yia Thv
uyeia Twv {Wwv Kal Twv avBpwmwv.

4. Na Mo avaAUTIKEG TTANPOPOPIES OXETIKA LE TNV amoppIPn Twv MV
UMTOTAPIWV/CUCOWPEUTWY, EMKOIVWVAOTE WE TO TOTIKO YPaQEio, TNV
apuodia umnpeaia SIGBETNC OIKIOKWY AMOPPIMUATWY 1} TO KATAoTNHA
amné to omoio ayopdoate To TPoidv.
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LUXVEG EPWTIOELG

370 KEQAAILO QUTS avaPEPOVTAL OPLopEVA TIPOPBAUATA TTOU EVOEXETAL Va
QVTILETWTTIOETE KATA TN XPrioN TNG OUOKEUNG 0aC. Na optopéva mpoPAruata Oa
XPELOOTE VOl EMKOWWVHOETE LIE TOV TTAPOYKO UTNPECLWV 0ag, AANG Ta TTEPIOCOTEPA
pmopeite va Ta S1opBwoETe Kal HOvol 0.

Z@ahpa kaptag SIM

BeBaiwOeite 6T n kdpta SIM gival owoTa TomoBeTnpévn.

Agv uniapyel ouvdeon SiktUou 1 undpxel anwAela SIKTUOU
XapnAd orjua. MetakivnBeite kovtd og mapabupo 1y o€ avoiyxTd Xwpo.

Eiote extog TG meploxng kahung diktuou tou médpoyou. ANAETe Béon kat eNéyEte
70 SikTuo.

Aev givan S1a0£o1peg ol KAAoEIg

To véo iktuo Sev eival e§ouaiodotnpévo.

S 1lyOUpEUTEITE TIWG SV EXETE OPIOEL PPayr KNOEWV yIa TOV EI0EPKOHEVO aPIOUO.
S1youpeuTEiTe WG Sev EXeTe OpioEl Ppayr KAOEWV yia TOV apIBUO TTOU KOAEITE.

Aev givat Suvatn n evepyomnoinon TG CUOKEVNG

Otav n pmatapia €xel amo@optioet Mpw¢, Sev Ba givat Suvatr n evepyomoinon
TNG GUOKEUNG 00,
DopTtiote MAMPWG TN UMATAPIA TIPLV VA EVEPYOTTOI\OETE TN GUCKEUH.

ZPAaApa eopTiong

BeBauwbeite 61 n cuokeur @optiletal o€ KavoVIKr Beppokpacia.

ENéy€Te TOV QOPTIOTH Kalt TN GUVOEDT) TOU OTN GUOKELN).

Na xpnotuomoleite pdvo ta e§aptripata mou mepIAapBAvovTal 0T CUCKEVAGIA Kal
eivat e€ovotodotnuéva amd v LG.
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H pmatapia teAewwvel mo ypriyopa o€ oxéon pe 6tav aydpaca
OPXIKA TN CUCKEUN

'Otav ekTiBETAL N GUCKELN 1 N Umatapia og TOA) UYNAEG 1 xapnAég Bepuokpaaieg,
evdéyetal va pelwbei n Sidpketa (wng NG pmatapiag.

H katavéAwon pmatapiog a au§nbei dtav xpnotoToLETE OPIoHEVES
XOPOKTNPLOTIKA 1 EQAPHOYEC, OTwE To GPS, maikvidia i 1o Internet.

H pmatapia ivat avaAwotpo kat n {wn tg pmatapiog 6a petvetal pe tnv mapodo
Tou Xpdvou.

Epgavi{ovtal pnvopota 6AAHaTog Katd T KKivnon tng
KAMEPG

Oopriote TV umatapia.

AmeNeuBEPWOTE VAN LETAPEPOVTAC apxEia O Evav uTToAoyloTh f Staypdgovtag
apyxeia amd T ouokeun oag.

ETOVEKKIVE( TN GUOKEUN.

Eav e€akohouBeite va avtipetwmifete mpdBAnUa Ke TNV QapOoYR TG KAUEPAS
0QOTOU AKONOUBNOETE AUTEC TIC GUUBOUAEG, EMKOIVWVHOTE e €va Kévtpo Z€pPIg
NG LG Electronics.

H moiétnta tn¢ pwtoypagiag givat Kakn

H mo1dtnTa Twv QuToypagiwy 0ag VOEXETAI VA TIOIKIAEL avahoya pe Tov
TEPIBAANOVTA XWPO KAl TNV TEXVIKI GUTOYPAPNONG TTOU XPNOILOTOIE(TE.
'Otav Bydlete pwtoypagieg kal Bivteo, n molotnTa anod otabepr ywvia givat
KOAUTEPN OE OXEON HE TNV QVTIOTOIYN QMO EUPEIA ywvia.

Edv Bydlete putoypaieg o€ OKOTEVA PEPN, TO BPASU 1 O€ ECWTEPIKO XWPO,
evdeyetal va umdpyel 00puBog oTIC pwToypagieg i va givat Boléc.

Edv avtipetwnilete mpoBAUOTa, KAVTE EMAVAPOPA TWV EMAOYWV.
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H 00dvn agng avtamokpivetat apyd i AavOaopéva

Edv TomoBetrioeTe mpooTaTeuTIKO 006VNG 1 TPOAIPETIKA €€APTARATA OTNY 08dVN
AQPAG, AUTH EVOEXETAL VO NV AEITOUPYEL OWOTA.

Eav @opare yavtia, €dv Ta xépla oag Sev eival kaBapd 6tav ayyilete Tnv 08ovn
ARG A €av ayyigete Tnv 006vN PE aiUnEA AVTIKEILEVA 1) L Ta akpoSAKTUAG oag,
QUTH EVOEXETAL VA NV AEITOUPYNOEL GWOTA.

H 0086vn agn¢ evoéxeTal va unv Aerroupyrogl owoTd og ouvBrKeg uYNARiG
uypaoiag ry étav ektedei oe vepo.

EmavekKIVOTE T 6UOKEUN 060G yla va §lopBwBolv Tuxov mpoowptva mpoBArata
Aoylopikou.

Edv n 086vn agrq éxel ypatoouvioTei ) umooTel {Nd, EMOKePTEiTE éva Kévtpo
Y£€pPig TG LG Electronics.

KaBuotepei i) koAdel

EmavekKivijoTe T oUOKEUR
+ Av n ouokeun oag KoMdeL i kaBuoTepei, pmopei va XpelaoTei va kheioete
KATTOLEG EQAPHOYEG 1) VO ATIEVEQYOTTOIOETE T GUOKEUN Kal Vol ThV
evepyoroloete {ava.

EKKIVAOTE TN OUOKEUR
- Hemavagopd umopei va xpnotpomolndei av n 086vn maywael, 1) av Ta Koupmd,
n 086vn agnic fi n ouokeun Sev avtamokpivovTal Tma.
- [l va EnavagépETe T GUOKELN 0G, TATAOTE TAUTOXPOVA T TIARKTPA HEiwoNg
£VTOONG X0V Kal AEITOUPYIaG LEXPL N CUCKEU Vol EMAVEKKIVNOEL.

Emavagopd tng cUoKeung
+ Edv n xprion twv mapandvw pefodwv Sev amokataotrioel To mpoBAnua,

EKTENEDTE EMAVAPOPE EQYOOTACIAKWY SESOUEVWV.

+ XV 08dvn pubpicewv, ayyi€te Sladoxikd Zuotnua > Emavekkivnon &

Emavagopd > Emavagopd epyooTtaclakwv Sedopévuwv.

- Emavagépet ONeg TIG pUBLIoELC yia TN ouokeun Kat Slaypdgel Ta Sedopéva.
Mpwv MPOXWPNOETE 0NV EMava@opd epyooTactakwv Sedopévwy, Bupnbeite
va SnuoupynoeTe avtiypapo ac@aleiag yia 0Aa ta onuavtika dedopéva
TIOU €XETE AmOONKEVPEVA OTN GUOKEUN.

- Av Kataywpnoeg évav hoyaplaopo Google 0T OUOKEUN, TTPEMEL v KAVEL
€i0060 pe Tov (610 Moyapiaoud Google LETA TV EMAVAPOPA TNG CUOKEUNG.
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Agv BpéBnke ouokeur Bluetooth
Y1youpeuTeite mwg n Aertoupyia Bluetooth €xel evepyomoinBei otn cuokeur oag.

TlyoupeuTeite wg n Aettoupyia Bluetooth €xel evepyomoinBei otn cuokeun pe T
omoia BéAete va ouvdeDeite.

BePaiwbeite 611 n cuokeur) oag kat n dAAn ouokeun Bluetooth gival vtog tng
péylotng epPéhelag Bluetooth (10 m).

Edv ot mapamdvw cupBoulég Gev Auoouv To IPARANUA GaG, EMKOIVWVACTE HE Eva
Kévtpo ZépPig ¢ LG Electronics.

Aev mpaypatomoleital 0vOEDn OTaV CUVOEETE TN GUCKEUN O€
évav umohoyloTh

Y1youpeuTeite mwg to KaAwdio USB mou xpnotuomoleite givatl oupBato pe
OUOKEUN 00,

S IYOUPEUTEITE TIWG EiVal EYKATAOTNEVO Kall £XEL EVNUEPWOEL TO KATAANAO
TIPOYPALLA 08ryNONG GUCKELNG OTOV UTTOAOYIOTH GOIC.

H e@appoyn mou Aj@Onke mpokalei moANd o@aApata
H epappoyn mapouatalel mpoPAfuata.
AQaIPEOTE KAl EYKATAOTAOTE EaVA TNV EQAPUOYH.
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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ This device is not suitable for people who have a visual impairment due
to the touchscreen keyboard.

« Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

- Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.244 W/kg
(10 g) and when worn on the body is 1.466 W/kg (10 g).

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.



Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.

Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user's body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user’s body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.

Guidelines for safe and efficient use 7



Part 15.105 Statement
This equipment has been tested and found to comply with the limits for a class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

+ Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

+ Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.
+ Do not drop.
+ Do not subject this unit to mechanical vibration or shock.

+ Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

Guidelines for safe and efficient use 8



Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not charge the device when it is on soft furnishings.

The device should be charged in a well ventilated area.

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

Guidelines for safe and efficient use 9



+ The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A mobile device requires proper air circulation in order to dissipate heat. Direct
skin contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the user's
body.

+ Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

- Avoid exposing the device to low air pressure at high altitude.

Do not expose the device to extremely low air pressure. Otherwise, it can cause
explosion of the battery or leakage of flammable liquid or gas.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.

+ Minor interference may affect TVs, radios, PCs etc.

Use your device in temperatures between 0 °C and 35 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.
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Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
- Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
SO require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E + Excessive sound pressure from earphones and headphones can cause
hearing loss.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.
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Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

+ Power Consumption (Networked Standby Mode) : 0.4 W

Securing personal information

Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

Always back up important data while using the device. LG is not responsible for
any data loss.

Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.
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+ Read the permission screen carefully while downloading applications.

+ Be cautious using the applications that have access to multiple functions or to
your personal information.

+ Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

+ If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.

A Notice for Battery replacement

Li-lon Battery is a hazardous component which can cause injury.

- Battery replacement by a non-qualified professional can cause damage

to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/ contacts, and careful extraction of
the battery cell using specialised tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwi.ge.com/global/sustainability/environment/take-back-recycling.
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Custom-designed
Features



Video recording features

Wide-angle camera
You can take photos or record videos with a wider range than your actual
field of vision by using the wide-angle on the rear camera.

Tap (2), then tap @ / (&%) to switch between the standard and wide-
angle.

Standard angle Wide-angle

E « See Starting the camera for details.

+ You can switch between the standard and wide-angle camera lenses on
the rear camera only.
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Google Lens

You can get more information or take action on items around you using
Google Lens, like landmarks, posters, restaurant menus, animals, flowers,
or barcodes, directly in your device.

For example, when you use Google Lens on a:

+ Business card: You can save the phone number or address to a contact.
- Book: You can get reviews and other details about it.

+ Landmark or building: You can get more details about it.

- Painting in @ museum: You can get details about it.

- Aplant or animal: You can learn more about it.

- Aflyer or event billboard: You can add that event to your calendar.

E + Google Lens is available only when your device is connected to the
internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.

- This function may be not supported, or the supported languages may
differ depending on the service area.

Use Google Lens
1 Tap@> (e,
7 Point your camera at an item.
3 To get details or take action:
- Tap the item on your screen.
- To select text: Tap a word, then tap it again and drag the blue dots.
Ask a question or say a command, like:
+ Whatis this?
- Callthis
+ Add this to Google Keep
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Portrait
You can take a sharp portrait by applying the camera lens blur effect.

1 Tap (&) then tap Portrait.

2 Tap O to take a photo.
+ To adjust blur strength, drag the slide bar to the left or right.

E - Keep the distance to your subject within 1.3 ~ 5.0 feet when using the
rear camera.
« This feature is not available If the surroundings are too dark.
« After applying this feature, tap the desired position on the preview
screen to automatically apply the exposure value and focus when using
the rear camera, or exposure value only when using the front camera.
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Al CAM

You can effectively take photos or record videos since the camera
recognizes the object when taking a photo or recording a video.

1 Tap () then tap Al CAM.
72 When the object is recognized, the best effect for the scene is applied.
- To apply other effects, tap the scene icon.

« Portrait, pets, foods, sunrise, sunset, scenery, city view, flowers,
babies, sky, beach, et total 19 categories can be recognized
automatically.

E « The result of the scene recognition may differ depending on the
illumination or the location of the subject while taking photos. Keywords
do not appear on the actual photos or videos.

- This feature is available only when the front and rear cameras are in the
Auto mode.
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Cine Video

You can record a movie-like video.

1 Tap (@) then tap More > Cine Video &
2 Tap @ torecord a video.

+ & :Record a video by selecting the point zoom feature to zoom in/
out around a specific desired area.

. :Select an effect to apply to the recording. You can also adjust
the vignette and strength for each Cine effect. This feature cannot
be changed after you have started recording.

E + The Point zoom feature supports a zoom speed of up to 3x.
« This feature only supports video recordings in standard angle.
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Cine shot

You can record a moment and make a video with only a part of the scene
in motion.

While recording a video, hold the device steady. After recorded, rub an area
in the video you want in motion. The selected area starts moving and the
rest of the video remains still.

1 Tap(®, then tap More >k,

2 Tap @ to record a 3 second video.
+ Hold the device steady while recording the video.

3 Tap (¢) and rub the area you want in motion with the Cine shot effect.

Undo —
Redo

& —— Play forward and backward
repeatedly.

Play forward repeatedly.

Select the area to move. — s e Crase the selected area.

« Tap (®) to erase the selected area.
- Tap D to play the selected area in motion forward repeatedly.

- Tap @) to play the selected area in mation forward and backward
repeatedly.

4 Tap SAVE.
+ The selected area will be in motion.

Custom-designed Features 21



Flash Jump-Cut
Photos taken at a reqular interval are saved as GIF files.
1 Tap (&) then tap More > Flash Jump-Cut )=}
2 Tap O to take a photo.
+ Photos are taken every 3 seconds and saved as a GIF file.
- Tap (@] on the screen to select the number of photos you want to
take.
+ While taking photos, tap = to create GIF files with previously taken
photos.

5 - The flash automatically turns on to act as a timer:

+ The shots taken this time and the total number of shots are displayed
at the bottom of the screen.

- All taken photos are saved as GIF files only.
+ You may not change the GIF speed nor image order.
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Graphy
You can apply the recommended values for the white balance, ISO and
shutter speed as if taken by an expert.

1 Tap (@) then tap Manual Camera.

2 Tap$c3 and then tap Graphy photos (D to activate the feature.

3 Tap @ and select the desired scene from the recommended images.
4 Tap © to take a photo.

E - This feature is available only in Manual camera mode.

« You can add more scenes by tapping i and downloading the Graphy
app from the Play Store. You may be charged for data usage, depending
on your pricing plan.

- Tap £33 then tap @) from the Graphy menu to deactivate this feature.

Hi-Fi video recording
You can record a high quality video with Hi-Fi sound.
Tap (), then tap More > Manual Video ((X) > ¢5; > Hi-Fi.

+ See Starting the camera for details.
+ Hi-Fi videos can only be played in apps that support Hi-Fi.
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Al Composition

While taking portraits, Al engine allows you to automatically edit the
position of the subject and find the optimal picture composition. Both the
original photo and Al Composition photo are saved.

1 While taking a photo with rear camera, tap Al CAM.
72 When the camera detects the subject, recommended [£3] and Al
Composition will be applied on the top of the screen.
+ The subject must be fewer than three people.
« The subject is recognised when the subject is placed on the top of
the screen.
3 When Al Composition icon appears, tap O to take a photo.
- Tap the thumbnail with [£3] from the Gallery to view the photo.
+ Photos with [_]are the original photos taken by you.
+ Photos with [£3] are Al Composition photos.
« Tap[]and[E£3]to compare them.

Original photo Al Composition photo
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The result of the scene recognition may differ depending on the
illumination or the location of the subject while taking photos.

i

While taking a photo, related keywords to the subject appear on the
screen. Keywords do not appear on the actual photos.

.

This feature is only available on the rear camera.

Gallery features

Related content
You can edit and customise related content in the Gallery.
T While viewing a picture preview, tap &.

2 When the icon related with the date or location where you took the
photo appears, touch the screen.

+ You can view the photos related with the date or location where
you chose.
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+ Tap : to access additional options.

Making a GIF
You can create a GIF file from the Gallery.
T While viewing an album, tap ¢ > Create GIF.

2 Select the desired photos and videos to create a GIF file and then tap
Next.

+ You can add more images and adjust the GIF speed, screen ratio,
and file order.

3 Tap Save.

E + A maximum of 100 images can be used to create a GIF file.
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Making a collage

You can make a collage from the associated content.

T While viewing an album, tap : > Make collage.

2 Select the desired images to add to the a collage and then tap Next.
+ Select the desired layout from the bottom of the screen.

3 Tap Make.

E A maximum of 9 images can be used to create a collage.

Making a video from the related content

You can gather related content to make a video clip by tapping (») on the
video displaying the date or location.

Select the theme and background music, adjust caption effects and order
or add date and your signature and then tap Save.

- &% Select the video theme.
- To download the theme, tap ¥ .
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+ Jd:Add background music or adjust the playback time.
- To select a file for the background music, tap 4
- To download a file for the background music, tap .
- To adjust the volume of background music and original video, tap ==
+ A :Select a font type.
- To download a font, tap .
* % :Add the author's name on the video.
- I :Change the order of files to play as a video.
- To add files, tap +.

E + Download the VASSET app from the Play Store to add video themes,
background music or font types.

If you use mobile data without Wi-Fi connection, you may be charged
for data usage.
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Creating a movie
You can create a new movie by putting images and videos together.

1 Tap @3> Photos tab, then tap : > Create movie.
You can also tap €8> Play tab, then tap : > Create movie.

2 Select images or videos for your movie and tap Next.

3 Edit the selected images and videos and then tap Save.
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Deleting files

You can select images or videos to delete from your video by tapping €
at the top right corner of its thumbnail

Adding files

You can select images or videos to add after tapping -+ at the bottom
of the screen. You can also select the images or videos you have already
previously added.

E + Touch and hold a file, and then tap another file for multiple selection.

Rearranging files

To rearrange the images and videos, touch and hold the file you want to
move, then dragging it to the desired location.

Adding file effects

Tap 7 to add a theme or background music, change the font.

Resetting the movie edits
You can reset the edits made to the movie (e.g. play time) by tapping .

Previewing a file

Check your new video before saving it by tapping . After the playback
time elapses, the next file is played automatically.

A maximum of 50 images and videos can be used to create a video.

+ The playback time for an image is 3 seconds by default and it cannot be
changed. Videos can be trimmed down to a minimum of 1 second.

« This feature may not support some image or video formats.
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Making a GIF

You can easily make a GIF file using recorded videos or photos.

Making a GIF by using recorded videos
T At the desired starting point while watching a video, tap @e.

2 Select the length of the GIF you want to create.
- GIF is generated for the time selected from the current time.

« For videos less than 5 seconds, GIF images are automatically
generated for the remaining time.

Making a GIF by using photos
1 While viewing an album, tap : > Create GIF.

2 Select the desired photos to create a GIF file and then tap Next.

+ You can add more images and adjust the GIF speed, screen ratio,
and file order.

A + You may use this feature solely for creative purposes. The use of this
feature involving infringement of any other person's rights, such as
copyright or defamatory or offensive statements, may be subject to civil,
criminal, or administrative liabilities and/or penalties under applicable
laws. You shall not copy, reproduce, distribute, or otherwise make illegal
use of any copyrighted materials without permission of the rightful
owner or copyright holder. To the fullest extent permitted by applicable
law, LG Electronics disclaims all expressed and implied warranties as well
as liabilities associated thereto.

+ A maximum of 100 images can be used to create a GIF file.
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Sound quality and effects
features

DTS:X 3D Surround

You can play a song or video in three-dimensional, immersive and vivid
sound. To use this feature, connect earphones, speaker or other external
audio devices to your device.

On the homescreen, tap Settings > Sound > Sound quality and effects >
DTS:X 3D Surround, then tap QD to activate this feature.

Adjusting the sound direction
You can adjust the sound direction as desired.

T On the homescreen, tap Settings > Sound > Sound quality and
effects > DTS:X 3D Surround, then tap OD.

7 Select sound direction.
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Floating Bar

Floating Bar overview

You can activate frequently used features, including shortcuts, screen
capture, music player, and quick contacts, by touching and then swiping
the Floating Bar on the screen.

To enable the Floating Bar feature, tap O > Settings > Extensions >
Floating Bar Q).

Opening and closing the Floating Bar
- To open the Floating Bar:Tap < or >.
+ To close the Floating Bar. Tap > or <.
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Moving the Floating Bar position
- Floating Bar open: Touch and hold the Floating Bar, then drag it to the
desired location.

- Floating Bar closed: Touch and hold the Floating Bar, then drag it to
the desired location along the edge of the screen.

Disabling the Floating Bar
You can disable the Floating Bar by using one of the following methods:
- Touchand hold < or » on the Floating Bar and then drag it to the
delete area at the top of the screen.
- Tap < or > on the Floating Bar, and then tap G=» > @ ) at the top of
the screen.
« Tap O > Settings > Extensions > Floating Bar @ .
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Setting the Floating Bar

You can select the content to display on the Floating Bar and change
its display order. Tap &= from the Floating Bar or tap O > Settings >
Extensions > Floating Bar.
+ Position: You can set an area within which you can move the floating
bar.

Shortcuts: Quickly access frequently used apps or features.

Screen capture: Capture the screen to crop the desired part or to
create a GIF file.

r o

Nz You can use Capture+ on the desired screen.

o You can capture a scrolling screenshot and use it for Q Memo+ or
- save it in the Gallery.

) You can capture a desired area and use it for Q Memo+ or save it in
L

the Gallery.

Save the current screen as a GIF file. You can adjust the size of the
image you want to capture.

E»" + To move to the desired location, drag —.

- To start recording a GIF, tap (o).

- To stop recording a GIF, tap ().

+ Music player: Control the music you are listening to.
- Quick contacts: Call or message people set as quick contacts.

E + Amaximum of 5 apps or features can be added to the shortcuts.
+ Amaximum of 5 contacts can be added as quick contacts.

+ GIF capture is a function provided for the user to produce creative
images. Violating rights such as intellectual property right or defaming
the reputation of another person by using the GIF capture function may
lead to a civil or criminal liability in accordance with the related laws.

Be cautious not to copy or transmit another person's work without
authorization. LG Electronics is not liable in any way for such acts by
users.

+ AGIF can be created up to 15 seconds long.
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Google Assistant

Google Assistant overview
You can launch or use desired apps with your voice.

E - To use this feature, first connect to the network and sign in to your
Google Account.

« This feature may not work properly or voice recognition accuracy may
decrease in areas where Wi-Fi or mobile network signal strength is weak.

+ This function may be not supported, or the supported languages may
differ depending on the service area.

Launching Google Assistant
1 Press and hold O from the Home screen to launch Google Assistant.
2 Tap GET STARTED.
3 Follow the on-screen instructions and say “Ok Google”.
« The device saves your voice data for recognition.
4 Select whether to enable or disable the Speech Recognition feature.

+ When this feature is activated, you can run Google Assistant by
saying “OK Google” on the Home screen.
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Launching Google Assistant with your voice
1 Say “Ok Google” when the screen is turned off or locked.

2 Say a command or question when “Hi, how can | help?” appears on
the screen.

Launching Google Assistant from the Home
screen

1 Touch and hold O on the Home screen.

2 Say a command or question when “Hi, how can | help?” appears on
the screen.

« Voice recognition accuracy may decrease if you speak with an unclear
voice or in a noisy place. WWhen you use the voice recognition feature,
increase its accuracy by speaking with a clear voice in a quiet place.

Audio recording features

The HD Audio Recorder allows you to configure the audio settings
manually so that you can record audio based on your environment.

Recording modes

You can record a high definition audio file by selecting and configuring the
desired audio mode to suit the recording environment.

On the homescreen, tap Essentials > HD Audio Recorder >=.

Normal
You can record audio without extra settings.

Concert
You can record audio in a concert or other music event.
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Custom
You can manually configure the desired settings to record audio.

Studio Mode

With Studio mode, you can play an audio file or music and record your
voice at the same time, create a chord by recording your voice multiple
times, and record your comments over the presenter’s or speaker's original
audio file.

1 On the homescreen, tap Essentials > HD Audio Recorder >=>
Custom.

Tap J+
Select an audio file to use as background music.

Tap @ to record voice.

u b W N

Tap @ to save the recorded file.

5 « Background music can only be played through earphones. Make sure to
plug in earphones before using this feature.

Other useful features for use of the HD Audio
Recorder app

GAIN
You can adjust the sensitivity of the sound recorded by the microphone.

The higher the GAIN value is set, the more sensitively the sound is
recorded.

LCF

You can filter any low-pitched noises such as the low hum of the air
conditioner.

The higher the LCF (Low Cut Filter) value is set, the better high-frequency
noises are filtered.
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LMT

It can prevent clipping of the recorded sound. The higher the LMT (Limiter)
value is set, the more low frequency sounds that will not get clipped.

E « To change additional settings, tap = > Settings, then customise the file
type, bit depth, sampling rate and other settings.
- When you select a mode from Concert and Custom, Ug appears. Tap Qg
and then select the microphone to use.

You can monitor sound quality with the connected earpiece while
recording audio. While recording audio in Studio mode, sound
monitoring is not supported. You can hear only the background music.

Fingerprint recognition

Fingerprint recognition overview
You must register your fingerprint on your device first before using the
fingerprint recognition function.
You can use the fingerprint recognition function in the following cases:
+ To unlock the screen.
- To view the locked content in the Gallery or QuickMemo-+.

- Confirm a purchase by signing in to an app or identifying yourself with
your fingerprint.

« Your fingerprint can be used by the device for user identification. Very
similar fingerprints from different users may be recognised by the
fingerprint sensor as the same fingerprint.

« If the device cannot detect your fingerprint, or you forgot the value
specified for registration, visit the nearest LG Customer Service Centre
with your device and ID card.
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Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of
reasons. To maximise the recognition accuracy, check the following before
using the device.

The device has a fingerprint sensor. Ensure that the fingerprint sensor
is not damaged by a metallic object, such as coin or key.

\When water, dust or other foreign substance is on the fingerprint
sensor or your finger, the fingerprint registration or recognition may
not work. Clean and dry your finger before having the fingerprint
recognised.

A fingerprint may not be recognised properly if the surface of your
finger has a scar or is not smooth due to being soaked in water.

« If you bend your finger or use the fingertip only, your fingerprint may
not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

The device may generate static electricity if the surrounding air is
dry. If the surrounding air is dry, avoid scanning fingerprints, or touch
a metallic object such as coin or key before scanning fingerprints to
remove static electricity.
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Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

7 On the homescreen, tap Settings > Lock screen & security >
Fingerprints.

« Alock screen must be set in order to be able to use this feature.

« If the screen lock is not active, configure the lock screen by following the
on-screen instructions. See Setting a screen lock for details.

2 Locate the fingerprint sensor on the back of the device and gently put
your finger on it to register the fingerprint.

E - Gently press the fingerprint sensor so that the sensor can recognise
your fingerprint.

« Ensure that your fingertip covers the entire surface of the fingerprint
sensor.
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3 Follow the on-screen instructions.
+ Repeat scanning the fingerprint by moving your finger little by little
until the fingerprint registers.
/4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. If you register only
one fingerprint and the corresponding finger is not in a good
condition, the fingerprint recognition may not work well. As the
preventive measure against this kind of situation, register multiple
fingerprints.

Managing fingerprints
You can edit or delete registered fingerprints.

7 On the homescreen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
[}

Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your
fingerprint. Activate the desired function:

1 On the homescreen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
+ Screen lock: Unlock the screen with a fingerprint.

+ Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.
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Face Recognition

Face Recognition overview
You can unlock the screen lock by using the saved facial data.

E « This feature may be more vulnerable to security than the other screen
locks, such as Knock Code, Pattern, PIN, and Password.

+ When a similar face or a photo of your face is used, the screen may be
unlocked.

« The recognised facial data is securely stored in your device.

+ When the face recognition is selected for screen lock, you must enter
the Knock Code, Pattern, PIN, or Password that has been used for face
registration without directly using the face recognition after the power
is turned on. Accordingly, be careful not to forget the specified value.

« If the device cannot detect your face, or you forgot the value specified
for registration, visit the nearest LG Customer Service Centre with your
device and ID card.

« To save power, the Face Recognition feature will not work when the
battery level is below 5 %.

Precautions for Face Recognition

Face Recognition accuracy may decrease in the following cases. To

increase its accuracy, check the following before using the device.

+ When your face is covered with a hat, eyeglasses, or mask, or your face
is significantly different due to heavy makeup or beard.

+ When there are fingerprints or foreign substances on the front of the

camera lens, or your device cannot detect your face due to a too bright
or dark light.
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Registering facial data
Before using the Face Recognition feature, register your facial data on
your device.

7 On the homescreen, tap Settings > Lock screen & security > Face
Recognition.

E « To use this feature, the screen lock must be set with a Knock Code,
Pattern, PIN, or Password.

+ When the screen lock is not set, register the data by following the
on-screen instructions. See Setting a screen lock for details.

2 Tap Next and unlock the device according to the specified method.
3 Tap Start and raise your device in the front of your eyes.

4 Register your face by following the on-screen instructions.
+ Register your face in a room that is not too bright or dark.

- Position your entire face inside the guideline on the screen, and then
adjust it by slowly moving up, down, left, or right.

- Keep still while registering your face. You can improve recognition
rate by taking steady photos multiple times.

5 When the face registration is done, tap OK.

Unlocking the screen with your face

You can release the screen lock with your face instead of a Knock Code,
Pattern, PIN, or Password.

1 On the homescreen, tap Settings > Lock screen & security > Select
screen lock.

2 Unlock the screen according to the specified method.

3 Tap Allow face recognition D to allow you to unlock the screen
using facial recognition.
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Improving the Face Recognition
You can add facial data in various conditions to improve Face Recognition.

1 On the homescreen, tap Settings > Lock screen & security > Face
Recognition.

Unlock the screen according to the specified method.
Select Improve face recognition.

Register your face by following on-screen instructions.

u b~ W N

\When the face registration is done, tap OK.

Deleting facial data

You can delete the registered facial data and register it again if the Face
Recognition does not work properly.

1 On the homescreen, tap Settings > Lock screen & security > Face
Recognition.

2 Unlock the screen according to the specified method.

3 Select Delete face to delete the facial data.

Unlocking the screen with your face when the screen
is turned off

With the screen turned off, raise your device and look at the front of the
screen. The device can detect your face and the screen is unlocked.

To deactivate this feature, follow the instruction below.

71 On the homescreen, tap Settings > Lock screen & security > Face
Recognition.

2 Unlock the screen according to the specified method.

3 Drag Allow when screen is off @  to deactivate the feature.
« Face Recognition feature is available only when the screen is locked.
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Unlocking the screen with Face Recognition and then
screen swiping

With the screen turned off, you can unlock the screen by performing Face
Recognition and then swiping the screen.

1 On the homescreen, tap > Settings > Lock screen & security > Face
Recognition.

2 Unlock the screen according to the specified method.

3 Drag Swipe to unlock after face recognized O to activate the
feature.

Enhancing the Face Recognition

You can prevent your device from being unlocked by photos, images, or
videos.

71 Onthe homescreen, tap Settings > Lock screen & security > Face
Recognition.

2 Unlock the screen according to the specified method.

3 Drag Advanced face recognition QD to activate the feature.

E « Face Recognition speed may decrease when you activate this feature.
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Voice Recognition

Voice Recognition overview
You can unlock the screen by using your voice.

I_;r] « This feature may be more vulnerable to security than the other screen
locks, such as Knock Code, Pattern, PIN, and Password.

+ When a similar voice or your recorded voice is used, the screen may be
unlocked.

+ \When the voice recognition is selected for screen lock, enter the Knock
Code, Pattern, PIN or Password that has been used for voice registration
instead of voice recognition after your device is turned on. Accordingly,
be careful not to forget the specified value.

« If the device cannot detect your voice or you forgot the value specified
for registration, visit the nearest LG Customer Service Centre with your
device and ID card.

+ The recognised voice data is securely stored in your device.

Precautions for Voice Recognition

Voice Recognition accuracy may decrease in the following cases. To
increase its accuracy, check the following before using the device.

\When you speak different from the registered voice command.

\When you speak in a noisy place.

When the microphone hole is covered with your hand or any foreign
substances.

When the registered voice command is too short (3 to 5 syllables are
recommended).
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Registering a voice command

Before using the Voice Recognition feature, you must register your voice
commands on your device.

1

On the homescreen, tap Settings > Lock screen & security > Voice
Recognition.

E « To use this feature, the screen lock must be set with a Knock Code,

w

Pattern, PIN, or Password.

+ When the screen lock is not set, register the data by following the on-
screen instructions. See Setting a screen lock for details.

Tap Next and unlock the device according to the specified method.
Tap Start.

Tap 0, then follow the on-screen instructions to register a voice
command.

+ Say a voice command 4 times with a clear and loud voice.

- Register the voice command in a quiet place.

+ Register a voice command within 2 - 3 words. (e.g. LG Mobile')

When the voice command has been registered, tap OK. Then, select
how to use the voice recognition.

Changing a voice command
You can change the previously registered voice command.

1

w

On the homescreen, tap Settings > Lock screen & security > Voice
Recognition.

Unlock the screen according to the specified method.
Tap Change voice.

Tap 0, then follow the on-screen instructions to register the voice
command again.

When the voice command has been changed, tap OK.
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Deleting a voice command
You can delete a registered voice command.

1 On the homescreen, tap Settings > Lock screen & security > Voice
Recognition.

2 Unlock the screen according to the specified method.

3 Tap Delete voice.

+ In this case, you cannot use the unlock function for Voice
Recognition lock.

- To register the voice command again after you have deleted it, see
Registering a voice command.

Selecting the voice recognition method
You can select how to use the voice recognition.

7 On the homescreen, tap Settings > Lock screen & security > Voice
Recognition.

2 Unlock the screen according to the specified method.

3 Tap Voice recognition used to.
- Unlock: Unlock the device via voice command.
- Turn on screen: Turn on the screen via voice command.

Displaying the slide lock screen after Voice
Recognition

Even with the screen off, you can recognise your voice and then release
the lock screen by swiping.

1 On the homescreen, tap Settings > Lock screen & security > Voice
Recognition.

2 Unlock the screen according to the specified method.

3 Drag Swipe to unlock after voice recognized Q) to activate the
feature.
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Multi-tasking feature

Recent Uses Screen
Swipe the Home button — upward and hold to view the recent use
history.

Pop-up window
You can open multiple apps on the screen and easily switch between
them at any time.

1 Swipe up on — from the bottom of the screen.

2 Tap the app icon on the top left of the app screen and select Pop-up
window.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.

3 The app appears in the form of a pop-up window on the screen.

np

E « This feature may not be available in some apps or screens.
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Using the pop-up window

+ — :Minimises the pop-up window. The pop-up window is minimised
into the app icon floating on the screen, which can be moved anywhere
you want.

U :Expands the app to full screen.
X :Closes the app.

- To move the pop-up window: Drag the top of the pop-up window.

To adjust the size of the pop-up window: Drag the left, right or

bottom edge of the pop-up window.

5

+ You can open up to 5 apps using the pop-up windows.
« To select an app from the opened apps, tap one of the pop-up windows.

The selected pop-up window comes to the front.

« Pop-up windows cannot be moved to the status bar or navigation bar area.

Using the app folder for pop-up windows
If you tap — on the pop-up window, the pop-up window is minimised into
the app icon.

You can move the app icon anywhere you want by dragging it.

If two or more pop-up windows are minimised, the app folder is created to
contain the app icons.

5

« The recently-used app icon is used as the app folder icon. If you tab the

icon, all the icons for the minimised pop-up windows appear in the app
folder.

+ If you touch and hold the app folder for pop-up windows and drag the

app folder into Remove, the app folder will be removed.

To remove one of the apps from the app folder, open the app folder and
drag the app icon out of the app folder.
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Multi window

When using gesture navigation

1 Swipe up on — from the bottom of the screen.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select Multi window.
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.
+ The selected app appears at the bottom half of the screen.

When using Buttons only navigation

1 Tap[Jon the navigation bar.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select =,
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.

E - To adjust the size of the split screen, drag the bar on the centre of the
screen.

+ To deactivate the multi window feature, drag the centre bar up or down
to the end of the screen.

+ The multi window feature is not supported in some LG apps or apps
downloaded from the Play Store.
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AOD (always-on display)
You can view the date, time or signature when the main screen is turned
off.

Swipe the bottom of the Always-on display screen to activate features
including Camera, Capture+, Wi-Fi, sound settings, Bluetooth®, Flash,
Music and more.

T On the homescreen, tap Settings > Display > AOD (always-on
display).
2 Select the image you want to display and tap Save.

- Tap on the desired image among Digital clock, Analog clock, Dual
clock, Signature, Calendar, or Image.

+ Drag Quick tools & music player () to swipe over the status
icons for Quick tools and the music player.

- To set the time period not to activate Always-on display feature, tap
Daily timeout.

- To enhance brightness for the Always-on display feature, tap
Brighter display.

E + The battery may drain faster when you use Always-on display. Turn this
feature off to save battery power.

+ To deactivate Always-on display feature, on the homescreen, tap
Settings > Display > AOD (always-on display), and then tap @ ).
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Quick Help

You can view help information about the main features of the device,
frequently asked questions or the user guide. Search for help information
using keywords. You can solve your problems quickly by consulting
one-on-one with a specialist.

7 Onthe homescreen, tap Quick Help.

2 Search for help information by entering keywords in the search field.

« This feature is periodically updated utilising user feedback.
+ Available menu items may vary depending on the area or service
provider.

+ You can view the user manual online from the Quick Help app to view
detailed information about the device's features.

Notes on Water Resistant
Properties

This product is water and dust resistant in compliance with the Ingress
Protection rating IP68.

Your product has undergone testing in a controlled environment and is
proven to be water and dust resistant in certain circumstances (meets
the requirements of classification IP68 as described by the international
standard IEC 60529 - Degrees of Protection provided by Enclosures [IP
Code]; test conditions: 15-35 °C, 86-106kPa, 1.5 meter, for 30 minutes).
Do not expose the device in conditions that are different from the test
conditions. Results may vary in actual use.
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/\ WARNING

Despite a rating of IP68, your device is not impervious to conditions not
tested in LG's controlled environment. Please note that any damages that
occur due to such causes changes the colour of the LDI (Liquid Damage
Indicator). If the colour of LDI located inside the product changes, the
product is to be considered ineligible for any free-of-charge repair services
provided under the product’s limited warranty.

Avoid exposing the product to environments with excessive dust or
moisture. Do not use the product in the following environments.

Do not immerse the product in any liquid chemicals (soap, etc.)
other than water.

Do not immerse the product in salt water, including seawater.
Do not immerse the product in a hot spring.

Do not swim with this product.

Do not place the product directly on sand (such as at a beach) or
mud.

Do not immerse your product in water deeper than approximately
1.5 meters.
Do not immerse your product in water for longer than 30 minutes.

RO®WOD®®

« If your product becomes wet be sure to wipe the microphone, speaker,
and stereo jack with a dry cloth before use.

+ Should your product or your hands become wet, dry them before
handling the product.

+ Do not use the product in places where it may be sprayed with high
pressure water (e.g. near a faucet or shower head) or submerge it in
water for extended periods of time, as the product is not designed to
withstand high water pressure.
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This product is not resistant to shock. Do not drop the product or
subject it to shock. Doing so might damage or deform the main unit,
causing water leakage.

The product’s water and dust resistant features may be damaged by
dropping or receiving an impact.

If the product gets wet, use a clean, soft cloth to dry it thoroughly.

The touch screen and other features may not work properly if the
device is used while wet.

Your product is water resistant only when the SIM/Memory card tray is
properly inserted into the product.

Do not open or close the SIM/Memory card tray while the product is
wet or immersed in water. Exposing the open tray to water or moisture
may damage the product.

The SIM/Memory card tray contains rubber [packing] to help prevent
dust, water, or moisture from entering the product. Do not damage the
rubber [packing] as this may allow dust, water, or moisture to enter
your product and cause damage.

A « Failure to follow the provided instructions may invalidate your device's
limited warranty.

- If the device is wet, the LDl located inside the device changes in color. In
this case, the device is ineligible for any free-of-charge repair services
provided under the device's limited warranty.

- Despite a rating of IP68, your device is not completely impervious to
water in any situation.
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Product components and
accessories

The following items are included with your device.

+ Device + Charger
- Stereo headset - Quick Start Guide
+ USB cable + Ejection pin

A .

« The items supplied with the device and any available accessories may

The items described above may be optional.

vary depending on the area and service provider.

Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your

device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.

Some items in the product box are subject to change without notice.

- The appearance and specifications of your device are subject to change

without notice.
Device specifications may vary depending on the area or service provider.

Remove the protective film from the Fingerprint sensor before use of
the fingerprint recognition feature.
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Parts overview
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—)

d

I

Microphone

Proximity/Ambient light
sensor
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Laser detection auto-focus

Fingerprint sensor —

! t Charger/USB cable port
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A Do NOT attempt to remove the back cover.

This device has a non-removable battery. Do not attempt to remove the
back cover. Doing so may severely damage the battery and device, which
could cause overheating, fire, and injury.

+ Proximity/Ambient light sensor

- Proximity sensor: During a call, the proximity sensor turns off the
screen and disables touch functionality when the device is in close
proximity to the human body. It turns the screen back on and enables
touch functionality when the device is outside a specific range.

- Ambient light sensor. The ambient light sensor analyses the ambient
light intensity when the auto-brightness control mode is turned on.

« Laser detection auto-focus

- Detect the distance from the camera to your subject for automatic
focusing.

- Quickly focus on closer or farther objects when you use the rear
camera to take photos.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down (-) key twice to launch the Camera app
when the screen is locked or turned off. Press the Volume Up (+) key
twice to launch Capture+.
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« Power/Lock key
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
+ Google Assistant key
- Your device has the Google Assistant built-in. Find answers and get
things done while on-the-go. To get started, just tap the Google
Assistant key on the side of the phone. Press and hold the key to
quickly talk to your Assistant. Double tap to open Google Lens.
- Activate Google Assistant. See the Google Assistant for details.
+ Fingerprint sensor
- Turn on the fingerprint recognition feature to simplify the process
of unlocking the screen. See Fingerprint recognition overview for
details.

I_;'] + Some functions may be restricted for access, depending on the device
specifications.

« The rear of the device includes a built-in NFC antenna. Be cautious when
handling the device to avoid damaging or covering the NFC antenna.

+ Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

« Screen-protective film or accessories may interfere with the proximity
sensor.

« If your device is wet or is being used in a humid place, the touch screen
or buttons may not function properly.
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Hold the device correctly as shown below. If you cover the microphone
hole with a hand, finger, or protective case while using the device, you may
sound unclear during a call.

Good example Bad example
AT — S0

O dX

™~

Microphone Do not cover the microphone

Q
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Pressand hold the Power/Lock key and the Volume Down (-) key at
the same time until the power is turned off.

2 When the device is restarted, release the key.

Power control options

Press and hold the Power/Lock key, then select an option.
« Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card and
memory card

Insert the SIM card from your mobile service provider and the separately
purchased memory card into the device.

5 « In order for the water-resistant and dust-resistant features to work
effectively, the card tray must be inserted correctly.

7 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

2 Place the SIM card or memory card on the card tray and then insert
the card tray into the device in the direction of the arrow.

Memory card

(optional-sold separately)

SIM card
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This device supports only Nano SIM cards.

i

Nano Micro Standard

e @

For problem-free performance, it is recommended to use the phone
with the correct type of SIM card. Always use a factory-made SIM card
supplied by the service provider.

.

.

Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

Be careful not to damage the SIM card when you insert or remove it.

.

When you insert the SIM card or memory card, place it on the card tray
correctly.

\When you insert the card tray back into the device, insert it horizontally
in the direction of arrow as shown in the figure. Make sure that the card
placed on the card tray does not move out of its position.

Insert the SIM card with the gold-colored contacts facing downwards.

Be sure to insert the SIM card into the device by following the
instructions in the user manual.

.

If you insert to or remove the card tray from the device, be careful not
to let water or other liquids enter into the card tray. If a wet card tray or
card is inserted into the device, your device may get damaged.

Memory card is an optional item.

Frequent writing and erasing of data may shorten the memory card
lifespan.

.

Some memory cards may not be fully compatible with the device. If you
use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.
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Removing the memory card
Unmount the memory card before removing it for safety.
71 Onthe homescreen, tap Settings > Storage > /..

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

=~ Charging cable terminal
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A « Do not use the external terminal, charging cable or gender for the
device in presence of moisture. This may cause fire, electric shock,
injury, or device malfunction. If there is moisture, stop using the device
immediately and remove the moisture completely.

« Make sure to use the USB cable provided with your device.

« Make sure to use an LG-approved charger and charging cable. Charging
the battery with a third-party charger may cause the battery to explode
or may damage the device.

+ Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

« Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

E « Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

.

A charging adapter that supports fast charging is included with the
product.

« The fast charging feature may not work if a fast charging adapter other
than the genuine adapter provided with the product is used.

« Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer. This may take a
longer time than plugging the adapter to a wall outlet.

« Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

Precautions when using the device

- Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

+ Failure to follow the instructions in this guide and improper use may
damage the device.
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Wireless charging

This device supports wireless charging feature. Charge the device with a
Qi certified wireless charger (optional, sold separately).

Charging the battery with a wireless charger

1 Place your device on the centre of the wireless charger aligned with
the wireless charging antenna on the back of the device.

+ To check the wireless charging antenna area, see Parts overview.

2 When the battery is fully charged, remove the device from the charger.

A .

\When you charge the battery with a wireless charger, do not put a
magnetic, metallic or conductive materials between the device and the
charger. This may disturb charging or the device and the charger may
become heated. In this case, the device, charger or SIM/Memory cards
may be damaged.

- If the battery temperature exceeds a certain level while charging the

device, charging may be stopped.

If magnetic, metallic or conductive materials are attached on the back
of the device or a protective case is inserted, the device may not charge
properly.

If you charge the battery with a wireless charger in areas where the
network signal strength is weak, the network performance of your
device may be further degraded.

« Charge the device with a Qi certified wireless charger (optional, sold

separately). Because the LG limited warranty does not cover the use of
third party accessories, contact the third party manufacturer.

« This product supports wireless charging. Use a Qi certified wireless

charger (sold separately) to charge the product. Some coiled wireless
chargers may not support wireless charging. Wireless chargers that
support EPP (Extended Power Profile) allow high-speed wireless
charging.

« Because the LG limited warranty does not cover the use of third party

accessories, contact the third party manufacturer.
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Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.
To minimise battery consumption, follow these tips:

« Turn off the Bluetooth or Wi-Fi network function when not using
them.

- Set the screen timeout to as short a time as possible.

+ Minimise the screen brightness.

- Set a screen lock when the device is not used.

+ Check the battery level while using any downloaded apps.

Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping
Lightly tap with your fingertip to select or run an app or option.
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Touching and holding
Touch and hold for several seconds to display a menu with available
options.

Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.
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Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.

Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

O

/,'

- Do not expose the touch screen to excessive physical shock. You might
damage the touch sensor.
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A touch screen failure may occur if you use the device near a magnetic,
metallic or conductive material.

i

If you use the device under bright lights, such as direct sunlight, the
screen may not be visible, depending on your position. Use the device
in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

.

Do not press the screen with excessive force.

.

Gently tap with your fingertip on the option you want.

.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

.

Touch control may not work properly if the screen is moist or wet.

The touch screen may not function properly if a screen-protective film
or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.

.

Home screen

Home screen overview

The Home screen is the starting point for accessing various functions and
apps on your device. Swipe up from the bottom edge of any screen to
directly go to the Home screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.
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Home screen layout

You can view all apps and organise widgets and folders on the Home
screen.

Status bar — SIS EEESEER
e

eather W‘dQEt _._

+ f— Google Search widget

Folder —- S 20

Page icon

" Quick access area
Navigation bar

+ The Home screen may differ depending on the manufacturer policy, user
settings, software version or service provider.

- Status bar: View status icons, the time and the battery level.

Weather widget: View the information of weather and time for a
specific area.

Google Search widget: Type or speak to pull open Google Search.

Folder: You can create folders to classify the app based on desired
criteria.

Page icon: Display the total number of Home screen canvases. You
can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.
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- Navigation bar: You can go to the previous screen or home screen
while using the app, and check the list of apps you used recently.

Using Navigation bar
Here is the gestures guide to control the Navigation bar.
To go to Home screen, swipe up from the bottom edge of the screen.

To go back to the previous screen, swipe in from the left or right edge
of the screen.

To go to Overview screen, swipe up and hold from the bottom edge of
the screen.

To quickly switch between apps, swipe right at the bottom edge of the
screen to go to previously used apps.

E + Gestures is the default for the Navigation bar. To change it to Buttons

only<]/Q/ E] on the home screen, tap Settings > Display >
Navigation bar, then select Buttons only.
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Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status

bar.
ll No signal
Data is being transmitted over the network
® Alarm is set
i Vibrate mode is on

Bluetooth is on

Connected to a computer via USB

Battery level

Airplane mode is on

Missed calls

Wi-Fiis connected

Mute mode is on

GPSison

(0} Hotspot is on
N | NoSIMcard
[N The NFC read/write P2P mode is on

«+ Some of these icons may appear differently or may not appear at all,

depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

Displayed icons may vary, depending on the area or service provider.

Basic Functions 75



Notifications panel

You can open the notifications panel by dragging the status bar
downward on the main screen.

+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

- You can tap ~® to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

E + You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.
You can also tap Settings > Display and activate Auto-rotate screen.

Editing the Home screen

On the Home screen, touch and hold on an empty space, then select the
desired action from below.

- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

+ To change wallpapers, themes, icons, and AOD, touch and hold on a
blank area of the Home screen, then select Wallpaper & theme.

You can also tap Settings > Display > Home screen > Wallpaper.
then select wallpapers, themes, icons, and AOD, to apply to the device.
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- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- Toview or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.
+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap £}, then tap the screen once
more.

Ll — Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.

Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or drag up — from the bottom edge
of the screen.

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

« To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

- To remove an icon from the quick access areg, drag the icon to the
Home screen.
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Using folders from the Home screen

Creating folders
On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders
On the Home screen, tap a folder and do one of the following actions.
- To edit the folder name and colour, tap the folder name.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

+ To remove an app from the folder, touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

- You can also add or remove apps after tapping (+) in the folder.

I_;'] + You cannot change the folder colour while using downloaded theme.

Home screen settings
You can customise the Home screen settings.
7 Onthe homescreen, tap Settings > Display > Home screen.
2 Customise the following settings:
- Select Home: Select a Home screen mode.
- Wallpaper: Change the Home screen background wallpaper.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.
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Icon shape: Choose if you want icons to have square or rounded
corners.

Sort apps by: Set how apps are sorted on the Home screen.
Grid: Change the app arrangement mode for the Home screen.

Hide apps: Select which apps you want to hide from the Home
screen.

Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

Smart Bulletin: Use the Home screen to view information
customised to your needs.

Search: Search by swiping down on the Home screen.

Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.

Screen lock

5

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

+ Ascreen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.
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Setting a screen lock
There are several options available for configuring the screen lock settings.

T On the homescreen, tap Settings > Lock screen & security > Select
screen lock and then select the method you prefer.

2 Customise the following settings:

None: Deactivate the screen lock function.

Swipe: Swipe on the screen to unlock the screen.

Knock Code: Tap the screen in a pattern to unlock the screen.

Pattern: Draw a pattern to unlock the screen.

+ PIN: Enter a numeric password to unlock the screen.

- Password: Enter an alphanumeric password to unlock the screen.
« Fingerprints: Unlock the screen by using your fingerprint.

- Allow face recognition: Unlock the screen by allowing the device to
recognise your face.

+ Allow voice recognition: Unlock the screen by allowing the device
to recognise specific voice commands.

E « If you incorrectly attempt to unlock the device 5 times, the screen is
blocked for 30 seconds.

Secure start-up settings

When you select Pattern, PIN or Password as a screen lock method, you
can configure your device to be locked whenever turning on the device in
order to secure your data.
+ You cannot use all functions, except for emergency calls until you
unlock the device.

- If you forget your decryption password, you cannot restore encrypted
data and personal information.
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Precautions for the secure start-up feature

- If you forget your decryption password, you cannot restore encrypted
data and personal information.

- Be sure to keep your screen lock passwords separately.

- If you enter the screen lock passwords incorrectly more than the
specified times, the device automatically resets itself and the encrypted
data and your personal information are deleted automatically and they
cannot be restored.

- Be cautious not to enter incorrect screen lock passwords more than
the specified times.

+ When you turn on the device right after the device resets, encryption
also starts. If you stop the encryption arbitrarily, the data may be
damaged. Be sure to wait until the reset is completed.

Customise Lock screen

You can customise lock screen.

7 On the homescreen, tap Settings > Lock screen & security >
Customize Lock screen.

2 Select a function you want to set.
- Wallpaper: Allows you to set the background for your Lock screen.

+ Clock: Allows you to set where to position the clock on the Lock
screen.

+ Shortcuts: Allows you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.

- Screen swipe effect: Allows you to set the screen transition effect
to apply when the screen is unlocked.

- Weather animation: Enable this option to display weather
animations for the current location on the Lock screen.

- Contact info for lost phone: Allows you to set text to be displayed
on the Lock screen to identify the phone's owner.
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Secure lock settings
You can set secure lock settings.

1 On the home screen, tap Settings > Lock screen & security > Secure
lock settings.

2 Select a function you want to set.

- Make pattern visible (shown only when Pattern is set as a screen
lock): Turn on to make pattern visible.

+ Lock timer: Allow you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

- Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

- Show lockdown option (shown only when a screen lock is set):
Enable this option to display the Lockdown icon when you press
and hold the Power/Lock button. Tap the Lockdown icon to turn off
Smart Lock, biometric unlocking, and notifications on the lock screen.

+ Smart Lock: Allow you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

+ Available menu options may vary depending on the lock screen method
selected.
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KnockON

You can turn the screen on or off by double-tapping the screen.

I_;r] « This option is available only on the Home screen provided by LG. [t may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ \When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Knock Code

You can unlock the screen by creating your own Knock Code. When the
screen is locked, you can directly access the Home screen by tapping the
screen in a specified sequence.

+ You can use your Knock Code together with the KnockOn feature.
+ Make sure to use your fingertip when tapping the screen.
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Creating a Knock Code

1 On the homescreen, tap Settings > Lock screen & security > Select
screen lock > Knock Code.

2 Tap the squares in a pattern of your choice to create a Knock Code
and tap Next.

3 Input the created Knock Code again for verification, then tap Confirm.

Unlocking the screen with a Knock Code
Unlock the screen by inputting the Knock Code you have created.

You can also input your Knock Code on the touch screen when the screen
is turned off.

- Itis also possible to enter a Knock Code when the lock screen is turned
on.

Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

1 On the home screen, tap Settings > Lock screen & security >
Encryption & credentials > Encrypt SD card.

2 Read the on-screen overview of memory card encryption and then tap
Continue to continue.

3 Select an option and tap Encrypt now.

+ New data encryption: Encrypt only data that is saved on the
memory card after encryption.

+ Full encryption: Encrypt all the data currently saved on the memory
card.

+ Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.
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E + Once memory card encryption starts, some functions are not available.

« If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check if the battery level is sufficient before starting encryption.

+ Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

« You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.

Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down key at the
same time for at least two seconds.

- Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Capture+

On the screen where you want to take a screenshot, drag the status bar
downwards, then tap (7,

E + \When the screen is turned off or locked, you can access Capture+
by pressing the Volume Up key twice. To use this feature, On the
homescreen, tap Settings > Extensions > Shortcuts and turn on Open
Capture+.

« See Writing notes on a screenshot for details.
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Entering text

Using the Smart toolbar

You can use various keyboard input methods in one place. You can select

the desired input method from the top of the keyboard.
1 Select the desired keyboard input method from the Smart toolbar.

2 Tap v and select the input method you want to show on the Smart

toolbar, or reorganise them.

_
Smart—%2 @ # & & @ B8 -
toolbar

i - —

+ You can add up to 6 tools to Smart toolbar.

+ Some supporting input methods may differ depending on the device
you have.

+ You can turn on or off the Smart toolbar feature from the keyboard
settings.

- You can also use the keyboard input methods by tapping $63.

- ©:Add emajis.
+ 22 :Open Draw chat.
« §63 : Access keyboard settings.
+ ¢ :Tap & to enter text with your voice.
- To maximise the voice command recognition, speak clearly.

- To enter text with your voice, make sure that your device is
connected to a network.

- To select the language for voice recognition, tap £ > Languages

on the voice recognition screen.
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- This function may not be supported, or the supported languages
may differ depending on the service area.
- [&: Open the clip tray.
. : Activate floating keyboard when you use the Multi-window
feature. You can also move the keyboard to the desired location.

Using the Smart keyboard
You can use the Smart keyboard to enter and edit text.

With the Smart keyboard, you can view text as you type without
bothering to alternate between the screen and a conventional keyboard.
This allows you to easily find and correct errors when typing.

Moving the cursor

With the Smart keyboard, you can move the cursor to the exact position
you want. When typing text, touch and hold on the space bar and then
drag left or right.

Smal ri keyboard

E « This option is available only on the QWERTY keyboard.
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Suggesting words

Smart keyboard automatically analyses your usage patterns to suggest
frequently used words as you type. The longer you use your device, the
more precise the suggestions are.

Enter text, then tap a suggested word or gently drag the left or right side
of the keyboard upwards.

+ The selected word is automatically entered. You do not need to

manually type every letter of the word.

Smartphone Smartphones

Smart ‘Smartphones: Smartphone Smart|

ITIIIIIII -II-IIIVfI
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Copy and Paste

You can cut or copy text from an app, and then paste the text into the
same app. Or, you can run other apps and paste the text into them.

7 Touch and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.

3 Select either Cut or Copy.
+ Cut or copied text is automatically added to the clip tray.

4 Touch and hold the text input window, then select Paste.

« Ifthereis no item that has been copied or cut, the Paste option will not
appear.

Entering text by using voice
On the keyboard, select @.

« To maximise the voice command recognition, speak clearly.

« To enter text with your voice, make sure that your device is connected
to a network.

- To select the language for voice recognition, tap ¥ > Languages on the
voice recognition screen.

« This function may be not supported, or the supported languages may
differ depending on the service area.
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Clip Tray

If you copy or cut an image or text, it is automatically saved to the clip tray
and can be pasted to any space at any time.

1 On the keyboard, select [}
You can also touch and hold the text input window, then select Clip
Tray.

2 Select and paste an item from the clip tray.
+ Amaximum of 20 items can be saved to the clip tray.

« Tap £} to lock saved items in order not to delete them, even when
the maximum quantity is exceeded. A maximum of ten items can be
locked. To delete locked items, unlock them first.

- Tap 1] to delete the items saved to the clip tray.

5 + The clip tray may not be supported by some downloaded apps.

Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.
71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items from the Gallery or Music app, tap Cgor ¢ >
Play on other device.
Or on the home screen, tap Settings > Connected devices > Screen
sharing and then tap () ) to activate it.

3 Select the TV you want to connect to.

I_;'] « For use with Chromecast, Google Play services should be up to date.
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Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

5 « Make sure that File sharing (DLNA) is activated on both the device and
the connected device.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
¢ > Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.

Sending or receiving files
You can share files between your device and another LG device, or a tablet.

Sending files

From the Gallery or other apps, tap : > Share or «&, then select a device
on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, on the home
screen, tap Settings > Connected devices > File sharing > SmartShare

Beam ().

I_;'] + You can share files with certain devices that support DLNA.
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Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.
On the home screen, tap Settings > Sound > Do not disturb.
+ Mode and select the mode you want:
- Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.
- Total silence: Disable both the sound and vibration.
- Select priorities: Receive alarms and the notifications for the selected
apps.
- Calls from: Set up a range of notifications when receiving a call.

+ Repeated calls: Second call from the same caller within 15 min is not
silenced.

- Messages from: Set up a range of notifications when receiving a
message.

Use Do not disturb: Turn on the Do not disturb feature.

Sleeping: Set the schedule for which you want to turn on the Do not
disturb feature.

Help: View the help for Do not disturb.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

Press and hold any empty area on the screen, and then press € of the
app you want to delete.

Uninstalling by using the settings menu
On the home screen, tap Settings > Apps & notifications > App info,
select an app, then tap Uninstall.

I_;'] + Some apps cannot be uninstalled by users.
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Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.

Installing and uninstalling apps during the

setup

\When you turn on the device for the first time, you can download
recommended apps.

You can skip to the next step without installation.

App trash
You can view the uninstalled apps on the Home screen. You can also
reinstall apps which were uninstalled within 24 hours from now.
7 On the home screen, tap Management > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
7 Activate the desired function:
+ Restore: Reinstall the selected app.
« {ij : Remove the uninstalled apps permanently from the device.

E + Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

- This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.
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App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap g to configure the settings for the desired app’s widget.
« Tap @ to view the information for the desired app.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad
7 Onthe home screen, tap (@ > Dial.

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making Calls from Contacts
7 Onthe home screen, tap (8 > Contacts.

7 After selecting the number you want to call from the list of contacts,

tap &...
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Answering a call
To answer a call, drag @ on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.
+ To end a call without turning off the screen, on the home screen, tap
Settings > Network & internet > Call > Answer and end calls and
then activate End call with the Power key.

E + On the home screen, tap Settings > Network & internet > Call >
Answer and end calls > End call with the Power key, you can end a
call by pressing the Lock/Power key while the call-in-process screen is
turned on.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

+ To add or edit a rejection message, On the home screen, tap Settings >
Network & internet > Call > Call blocking & Decline with message.

+ When a call is coming in, press the Volume Up, Volume Down or Power/
Lock key to mute ringtone or vibration, or to hold the call

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.

5 + On the home screen, tap Settings > Network & internet > Call >
Additional settings > Show voice calls while in an app and then
select the desired way you would like to display the incoming call while
using an app.
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Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap (@ > Call logs on the home screen.

Functions accessible during a call
During a call, you can access a variety of functions by tapping the
on-screen buttons:
- Contacts: View the contact list during a call.
+ Hold: Place the current call on hold.
- Dialpad: Display or hide the dial pad.
- Speaker: Turn on the speakerphone function.
- Mute: Mute your voice so that your voice cannot be heard by the other
party.
+ Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.
- @ :Endacal
+ X You can switch to video call from a voice call.
+ + :Access additional call options.

+ Some functions are not available during a video call.

+ Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call.

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E + You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, on the home screen, tap (8> Call logs. Then,
you can use the following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap &...

- To delete call records, tap : > Delete.

E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.

+ The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.

T On the home screen, tap (8 > Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message
You can create and send messages to your contacts using the Messaging
app.

« Sending messages abroad may incur additional charges. Consult with

your service provider for more information.

T On the home screen, tap @.

2 Tap D

3 Specify a recipient and create a message.
+ To use multimedia options, tap (.
« To access optional menu items, tap .

4 Tap P> to send the message.

Reading a message

You can view exchanged messages organised by contact.
1 On the home screen, tap €.

2 Select a contact from the message list.

« While on the message list or chat window, you can adjust the font size
by placing two fingers on the screen and either widening or narrowing
the fingers.
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Configuring messaging settings

You can change messaging settings to suit your preferences.
1 On the home screen, tap €.

2 Tap : > Settings from the message list.

E « You can designate settings for the notice window, blocking calls, disaster
alert, multimedia messages, etc.

Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

On the home screen, tap (&).

5

Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

Be careful not to stain the camera lens with your fingers or other
foreign substance.

.

Images included in this user guide may be different from the actual
device.

.

Photos and videos can be viewed or edited from the Gallery. See Gallery
features for details.

Refrain from using the product for a purpose that may violate someone
else’s privacy or rights.
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Taking a photo
You can take photos with the camera in the product.
1 Tap () and focus on the subject.
+ You can touch the subject to focus on.
- You may spread or pinch two fingers to zoom in or out.
2 Tap(  totake aphoto.

You can also press the Volume Down or Volume Up key to take a
photo.

You can take a photo while recording a video by pressing @ on the
screen.

The options displayed on the shooting screen may differ depending
on the selected camera (front or rear) and camera mode.

+ The camera will turn off automatically if you do not use it for a while

after running the Camera app.
Start Google Lens
Current camera mode

Set/Cancel timer —3J

setting e — Switch to front-facing/
Set/Cancel flash — rear-facing camera
setting . & — Take photo
Apply filter effect —§ Select zoom

b — Preview
T -
Auto scene optimizer

Set camera —)

E + You can run the camera app by short-pressing the power key twice. On
the home screen, tap Settings > Extensions > Shortcuts and then tap
Open Camera to activate it.

\When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice.

+ On the home screen, tap Settings > Extensions > Shortcuts and then
tap Open Camera @ to activate it.
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Customising the camera options
You can customise a variety of camera options to suit your preferences.

Tap 63 on the screen.

5 - Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

- [F] : Take a photo in FullVision (18.9:9 aspect ratio).
- [0]: Select values for aspect ratio and size for taking photos.

+ [4:Select values for resolution and size for recording videos.

+ (O :Set the timer to automatically take photos or record videos after a
specified period of time.

Super Bright
Camera

Take brighter, sharper photos in low illuminance. (When

the Super Bright Camera is selected, it automatically
turns on or off depending on the surrounding light
conditions.)

HDR

Obtain photos in vivid colours and get compensated
effects even when they are taken against the light.

These functions are provided by the high dynamic range

(HDR) technology equipped in the camera.

Live photo

Record the action before and after you take a photo.

Cheese shutter

Take photos with voice commands.

Tag locations

Save the image with GPS location data.

Display guide grids so that you can take photos or

Grid record videos based on the horizontal and vertical
reference lines.

Add signature Display a personalised signature on the photos.
Select if you want to store the pictures and videos

Storage in the Internal storage or SD card. (Available when a
memory card is inserted.)

Help Provide Help for each camera menu.
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Additional options on the front camera

Selfie shot

Take a selfie by selecting its option between Gesture
shot and Auto shot.

Save as flipped

Save as flipped images after taking selfies.

E + When using the front camera, you can adjust the filter, lighting effect,

and skin tone.

Useful Apps

107



Mode Selection

You can conveniently select from the modes displayed on the screen
which are selected to suit the shooting environment.

Tap () and swipe the camera modes left or right, or swipe the screen left
or right to select a camera mode.

Camera modes
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Using camera modes

Recording a video
1 Tap (& and select Video by swiping camera modes.
2 Tap @ to record a video.

Set camera —=3& &—— Set timer setting

Apply filter effect Set/Cancel flash setting

Turn On/Off steady cam

1— Switch to front-facing/
rear-facing camera
l— Recording a video

- To take a photo while recording a video, tap ® .

Preview —=l

- To pause the video recording, tap (1. To resume the video recording,
tap(e.

+ While recording a video, you may spread or pinch two fingers to
zoom in or out.

While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap(= toend the video recording.
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Taking a photo
Tap (&) and select Photo by swiping camera modes.
See Taking a photo for more details.

Taking portraits

You can take photos or videos that make the subject more distinct and
stand out by blurring the background.

1 Tap () and select Portrait by swiping camera modes.
« Select a desired effect by swiping effect options for portrait.

2 Tap () to take a photo.

Set camera —pg o Set timer setting
Apply filter effect 'T T' Set/Cancel flash setting
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3 Tap = toend the video recording.

E « When you see the message “Portrait is available’, start taking a photo.

+ The Portrait feature may not work if the camera cannot recognise the
subject.

.

While taking a photo, keep the distance to your subject to 1.3 ~ 5 feet.
This feature is not available if the surroundings are too dark.

.

.

Recording a video is only possible with Blur effect. Tap and hold () to
active it.

Using additional camera modes
Tap (&) and select More by swiping camera modes.

Useful Apps 111



Panorama

You can create a panoramic photo by moving the camera in one direction
to photograph and stitch continuous shots of a wide view.

1 Tap (&) and select More by swiping camera modes.

2 Tap

3 Tap(  and then slowly move the camera in one direction.
4 Tap @ to stop capturing the panoramic.

Set camera IMR Set timer setting

Apply filter effect Set/Cancel flash setting

5 + \When moving the camera in one direction, make sure that the screen
you shoot is not out of the guide line.
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Manual Camera

You can create photos featuring professional touch by using a variety of
advanced features.

1 Tap () and select Manual Camera by swiping camera modes.

2 Customise the following camera settings.

+ If you set Auto for options, the options are automatically adjusted
according to the shooting target and environment.

- If the Focus peaking option is set, the focus area is highlighted in
color. This feature is available only in Manual Focus (MF) mode.

Set camera —¥& s— Set timer setting

Apply filter effect Set/Cancel flash setting

various Graphy
options

Adjust white
balance = Adjust shutter

speed
Adjust focus v
‘ Adjust ISO
Adjust speed

brightness

3 Tap( to take the photo.
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E - If you tap (&) and select a Graphy effect, a list of recommended photos
with various settings will appear.

+ Selecting the Graphy effects allows you to shoot using the white
balance, shutter speed, and ISO setting values applied to the
recommended photo.

« This feature is available only in Manual camera mode.

You can see a variety of recommended photos if you download the

Graphy app from the Google Play Store.

You may be charged for data usage, depending on your pricing plan.

- Tap 83, then tap ( () from the Graphy photos menu to deactivate this

feature.

Customising the camera options
You can customise a variety of camera options to suit your preferences.
Tap €3 in Manual Camera.

Adjust the white balance, ISO and shutter speed for the

Graphy photos | recommended photo.
See Manual Camera for detalils.
The image is stored as a RAW file format so that you can
dify it.
Save as RAW modiy!

The DNG and JPEG files are created while taking a photo,
then saved as a non compressed high resolution image.

Cheese shutter

Take photos with voice commands.

Tag locations

Save the image with GPS location data.

Guide

Display guide grids so that you can take photos based on
the horizontal and vertical reference lines.

Add signature

Display a personalised signature on the photos.
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Select if you want to store the pictures and videos in the
Storage Internal storage or SD card. (Available when a memory card
is inserted.)
Help Provide Help for each camera menu.
Slo-mo

Create a fun video by changing the speed of movement. This function is
useful when you want to playback a video at a slower speed compared to
the actual speed of the original clip.

1 Tap (&) and select More by swiping camera modes.
2 Tap @

3 SelectPart:  =)orAll. =) toapply the slow motion effect to
it
« Part: Allows you to apply a slow motion effect to a specific section
of the video.

- Press © at the moment where you want the slow motion effect
to be applied. With a short-press, slow motion effect will be
applied for 0.5 second. With a long-press, slow motion effect will
be applied until you release your finger.

« All: Allows you to apply a slow motion effect to the entire video.
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Set camera —¢ &— Set timer setting

Apply filter effect Set/Cancel flash setting

4 Tap (e toshoot video.

- To pause the video recording, tap (1. To resume the video recording,
tap(e.

5 If you want to finish shooting, press (= .

YouTube Live
You can record a video and directly upload to YouTube.

To use this feature, you must meet the eligibility requirements. Contact
YouTube for the requirements.

1 On the home screen, tap (&).
2 Select More by swiping camera modes, then tap ().
E + YouTube Live is available only when your device is connected to the

Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.
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Useful camera features

Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen in the Auto mode. To turn off the feature, tap a blank
area on the screen.

Set camera —& s Set timer setting

Apply filter effect Set/Cancel flash setting

Auto-Exposure/
Auto-Focus lock

E « This feature is available only in specific modes.
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Switching between cameras
You can switch between the front and rear cameras to suit your
environment.
- To switch between the front and rear cameras, swipe the screen up or
down on the shooting screen in the Camera app.

5 « Use the front camera to take selfies. See Selfie shot for details.

Zoom in or out

You may spread or pinch two fingers to zoom in or out when you take
photos or videos.

E - Zoom in/out function is not available in the selfie mode (front camera).
+ This function is not supported in a number of modes.
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Using the Burst Shot

You can take consecutive photos and view them as moving pictures in the
Gallery.

1 Tap (@ and select Photo.

2 Tapandhold
+ Multiple, consecutive photos are taken while you are holding down

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

E - To use this feature, switch to the front camera mode, then tap @ >
Selfie shot > Gesture shot.
+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.
- This feature may not be available while using some of the camera features.
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Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

- The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

E - Tap §63 > Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camer,
then clench your fist twice quickly.

+ Four photos are taken at reqular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap €63 > Save as flipped.
The image is flipped horizontally.

5 + When using the front camera, you can change how selfies are taken in
the camera options. See Customising the camera options for details.

Selfie shot

You can use the front camera to view your face on the screen and take selfies.
1 Tap (&) and select Photo by swiping camera modes.

2 Tap {0} to switch to the front camera.

3 Tap(  to take photos.
- Tap ) to apply various beauty effects.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.

Viewing photos
You can view the photos saved to the product.
1 Tap @M and select a desired folder:
7 Tap adesired photo.
+ The Gallery folder contains Albums, Photos, Memories, and Play.

Start Google Lens.

Back to the previous —& L — Access additional options.

screen.
Start the camera.
Add to or remove from
your favourites.
\Write a memo on a photo. — g e Delete images.
View related content 41 l— Share images.
Edit images.

+ Details menu appears when the screen is lightly touched. Touching the
screen once again makes the menu disappear.
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Playing a video
You can view the videos saved to the product.

Back to the —&
previous screen.

— Access additional
options.

Start the camera

Add to or remove from
your favourites

Pause or play the —gaaame
video.

View related content — manX iR — Delete images.
Edit images. j Share images.

E « To adjust the sound volume, drag the right side of the video screen up
or down.

+ To adjust the screen brightness, drag the left side of the screen up or
down.

+ Dragging the screen to the left on the video play screen allows you to
rewind (REW) and dragging to the right allows you to fast forward (FF).
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Deleting files
You can delete files by using one of the following options:
+ Touch and hold a file from the file list, then tap Delete.
- Deleted files are automatically moved to : > Trash and they can be
restored to the Gallery within 7 days.

- Tap [x] to completely delete the files. In this case, the files cannot be
restored.

Sharing files
You can share files by using one of the following options:

- While viewing photo or video, tap «& to share the file by using the
method you want.

E - If you take photos or videos after you tap (&) > £63 > Tag locations = @
, the location-specific memories album is automatically created after a
certain time under the Memories tab of Gallery.

« You can search the photos or videos by place, tag, camera mode, etc. by
tapping Q in the gallery.

- Some file formats may not be supported, depending on the installed
software.

+ Some files may not be opened due to encoding.
« Files that exceed the size limit may cause an error.
+ You need to activate the GPS feature to create Memory albums.

Making a collage

You can make a collage from the associated content.
1 Tap@¥and select : > Make collage.

2 Select the desired images to add to the collage and then tap Next.
+ Select the desired layout from the bottom of the screen.
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3 Tap Make.

E A maximum of 9 images can be used to create a collage.

Creating a movie
You can create a new movie by putting images and videos together.

1 Tap@and select : > Create movie.
2 Select images or videos for your movie and tap Next.

3 Edit the selected images and videos and then tap Save.

g —— Effecting files

Resetting files

e Previewing a file

Deleting files

f Adding files

E « A maximum of 50 videos can be used to create a movie.
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Making a GIF

You can easily make a GIF file using recorded video.
Tap @ and select : >Making a GIF.

Creating video
T At the desired starting point while watching a video, tap .

2 Select the length of the GIF you want to create.
+ GIF is generated for the time selected from the specified starting
point.
- For videos that are less than 5 seconds, GIF images are
automatically generated for the remaining time.

Creating GIF Photographs
1 Inthe photograph list in the Gallery, tap : > Create GIF.

2 Select a picture to turn into a GIF photograph, and then tap Next.

+ You can add/delete a photograph, adjust the speed or screen ratio,
and set the photograph order.

E - Creating GIF photographs is a function provided for the user to produce
creative images. Violating rights such as intellectual property right
or defaming the reputation of another person by using the creating
GIF photographs function may lead to a civil or criminal liability in
accordance with the related laws. Be cautious not to copy or transmit
another person's work without authorization. LG Electronics is not liable
in any way for such acts by users.

+ You can select up to 100 photographs to produce when you create a
GIF
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Contacts

Contacts overview
You can save and manage contacts.
On the home screen, tap Essentials > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -

- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : > Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap Confirm.

3 Select the contacts and tap Import.
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Adding contacts to the speed dial list
1 On the contact list screen, tap : > Speed dial.
2 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap (i) to add a speed dial number.

Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the bottom of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.

+ From the index of the contact list screen, tap the initial letter of a
contact.

L;'] + Pressing the search bar at the bottom of the Contacts screen and
entering a contact or phone number brings up the integrated search
results from the call history and contacts list saved onto the product.
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Contacts list

Editing contacts
1 On the contact list screen, select a contact.
2 On the contact detail screen, tap /2 and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:

+ On the contact list screen, touch and hold a contact you want to
delete, then tap {ij.

- Tap : > Delete on the contact list screen.

E + Deleted contacts may not be restored.

Adding favourites
You can register frequently used contacts as favourites.
T On the contact list screen, select a contact.

2 On the contact detail screen, tap ¥y.

Creating groups

1 On the contacts group list, tap -+

2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

4 Tap Save to save the new group.
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QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this
advanced notepad feature, such as image management and screenshots,
which are not supported by the conventional notepad.

Creating a note
7 On the homescreen, tap QuickMemo+.
2 Tap @ to create a note.
- @ :Saveanote.
+ <5 :Undo the previous edit.
+ > :Redo the recently deleted edits.
« (1):Enter a note by using the keypad.
« / :Write notes by hand.
+ & :Erase handwritten notes.
« {):Zoom in or out, rotate or erase the parts of a handwritten note.
+ < :Access additional options.

3 Tap @ to save the note.
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Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap (7.
« The screenshot appears as the notepad background theme. Memo
tools appear at the top of the screen.
2 Crop the image (if necessary) and take notes as desired.
- Write notes by hand on the photo.

3 Tap @ and save the notes to the location you want.
- Saved notes can be viewed in either QuickMemo+ or Gallery.

- To save notes in the same location all the time, select the Use as
default app checkbox and select an app.

E « You can capture the entire screen by using the scroll capture feature.

« While using an app such as Message and Chrome, drag the notifications
panel downwards and then tap Capture+ > Extended to capture the
entire screen you are currently viewing as a single file.

- This feature is available only on some apps that support the scroll
capture feature.

Pinch two fingers or spread your fingers apart to change the memo
layout.
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Clock

Alarm

You can set an alarm to trigger it at a specified time.
7 Onthe homescreen, tap Clock > Alarm.

2 Tap—}to add a new alarm.

3 Configure the alarm settings and tap Save.

E « If you select a previously set alarm, you can edit the alarm.

World clock

You can view the current time in cities around the world.
7 Onthe homescreen, tap Clock > World clock.
2 Tap-}+and add acity.

Timer
You can set the timer to trigger an alarm after a specified period of time.
7 Onthe homescreen, tap Clock > Timer.

72 Set the time and tap Start.
« To suspend the timer, tap Pause. To resume the timer, tap Resume.

3 Tap Stop to stop the timer alarm.
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Stopwatch

You can use the stopwatch to record a lap time.

T On the homescreen, tap Clock > Stopwatch.

2 Tap Start to initiate the stopwatch.
+ Torecord a lap time, tap Lap.

3 Tap Pause to suspend the stopwatch.
+ To resume the stopwatch, tap Resume.

+ To clear all the records and restart the stopwatch, tap Reset.

Calendar

Calendar overview
You can use the calendar to manage events and tasks.

Adding events
7 Onthe homescreen, tap Essentials > Calendar.
2 Select a date and then tap €.

3 Enter event details and tap Save.

Syncing events
Tap : > Calendars to sync, and select a calendar to sync.

5

+ When your events are saved from the device to your Google account,

they are automatically synced with the Google Calendar, too. Then, you
can sync other devices with the Google Calendar in order to make those
devices have the same events that your device has and to manage your
events on those devices.
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Tasks

You can register tasks to your device to easily manage schedules.
T On the homescreen, tap Essentials > Tasks.

2 Tap @ to add a task.

3 Enter task details and then tap Save.

Music

You can play and manage songs or music albums.
T On the homescreen, tap Essentials > Music.
2 Select a category.

3 Select a music file.

.

,— Set sound effects.

Back to the previous —s| _

: — Access additional options.
screen.

— Switch to the playlist.

Turn on/off Boombox —
show.

—— Pause or play.

— Turn on/off Flash Light.

Tap to play from the
beginning of the current

file / Double-tap to play l Tap to play the next file /
the previous file / Touch l ;FOUCh (ajnd hold to fast
and hold to rewind. x W Ppowom orward.
Play in random order. — L Selecta repeat mode.
Adjust the sound volume. ——3 & «—— Change pitch and speed.
—r
Add to or delete from your [

favourites.
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E - Some file formats may not be supported, depending on the installed
software.
« Files that exceed the size limit may cause an error.
+ Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying
a music file. To download or copy a music file, first check the copyright
law for the relevant country.

This model supports Hi-Fi audio playback. Hi-Fi audio files display the
Hi-Fi icon.

+ When the Boombox Show feature is activated, the screen shows visual
effect to the music.

Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.

1 On the home screen, tap Calculator.

2 Use the keypad to make a calculation.
- If you want to calculate from the beginning, tap and hold (]

Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

7 Onthe home screen, tap Essentials > Game Launcher.

2 Select the desired option.
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LG Health

LG Health overview

You can manage your health and maintain good exercise habits by
keeping track of the exercises you do.

Getting started with LG Health

You can configure LG Health when launching the app for the first time or
after resetting it.

T On the homescreen, tap Essentials > LG Health.

2 Follow the on-screen instructions to complete configuration.

Using LG Health

You can view main information on LG Health and manage the amount of
physical exercise and health information.

7 On the homescreen, tap Essentials > LG Health.
2 The following options are available.
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+ = :View your exercise log on the day you want to check.
-+ © :Begin tracking an exercise. The route and amount of your
physical exercise are recorded for each exercise type.

« + :Set your daily exercise goals including calories and steps, or set
various LG Health settings.

E + Health-related information provided by LG Health is designed for user
convenience and cannot be used for purposes of disease prevention,
treatment, diagnosis or other medical issues.

.

LG Health may vary or may not be available, depending on the country
and service provider. LG Health functions that are available and apps
that can be added to LG Health may vary, depending on the country. This
is due to differing laws and regulations.
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E-mail

E-mail overview

You can register an email account to your device and then you can check
and send emails from your device.

« If you use mobile data, you may be charged for data usage depending
on your pricing plan. Consult with your service provider for more
information.

Registering email accounts

\When you use the email app for the first time, register your email account.
7 On the homescreen, tap Essentials > E-mail.

2 Select an email service provider.

3 Enter your email address and password and then tap Next to register
your account.
+ To manually register an email account, tap Manual setup
(if necessary).

Managing email accounts

To view or edit your email account settings, tap + > Settings.
- To add an account, tap Add account.
« To delete an account, tap : > Remove account.

Opening another email account

If several email accounts are registered and you want to view another
account, tap = and select another one from the account list.
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Checking email
1 Tap=and select a mail box.

2 Select an email from the email list.
+ The email message appears.

Sending email
1 Tap ©.
2 Enter the recipient’'s email address.

3 Enter a subject and message.
- To attach files, tap .
+ To access optional menu items, tap .

4 TapB>to send the email.

E « Pinch two fingers or spread your fingers apart to adjust the font size of
your email list.

FM Radio

You can listen to FM radio.
On the homescreen, tap Essentials > FM Radio.

E « To use this app, first connect earphones to the device. The earphones
function as the radio antenna.

« This function may not be supported depending on the area.
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File Manager

You can view and manage files saved on your device or cloud.
T On the homescreen, tap Management > File Manager.

7 Tap==and select the desired storage location.

LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.
7 On the homescreen, tap Management > LG Mobile Switch.

You can also tap Settings > System > Backup > LG Mobile Switch.

7 Follow the on-screen instructions to select a desired method for
transfer.

- Data in a Google Account will not be backed up. \When you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

+ Fully charge the battery before transferring data to avoid unintentional
powering off during the process.

Downloads
You can view, delete or share files downloaded via the Internet or apps.
On the homescreen, tap Management > Downloads.
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SmartWorld

You can download a variety of games, audio content, apps and fonts
provided by LG Electronics. Customise your device to suit your preferences
by using Home themes and fonts.

E « If you use mobile data, you may be charged for data usage depending
on your pricing plan.

« This feature may not be supported depending on the area or service
provider.

71 On the homescreen, tap Services > SmartWorld.
2 Tap : >LG Account, then sign in.

3 Select and download the desired content items.

Downloading SmartWorld app

If the SmartWorld app is not installed, follow these steps to download it.

7 Onthe homescreen, tap Settings > System > Update centre > App
Updates.

2 From the list, select SmartWorld and tap Download.
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RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

« To use this function, first you must agree to usage of the function.

+ If you use mobile data, you may be charged for data usage depending
on your pricing plan.

1 On the homescreen, tap Services > RemoteCall Service.

2 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associate’s instructions to
enter a six-digit access number.

+ Your device is remotely connected and the remote support service
starts.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

On the homescreen, tap Services > Cell Broadcast.

Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.
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Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.

Duo

Make simple, high quality video calls to your friends and family on Android
phones and iPhones.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter, and helps you stay organized.

Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.

Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.
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Photos

Home for all your photos and videos, automatically organized so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

Play Music

Purchase music from the Play Store. Play music saved on your device.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organize and analyze information
together in real-time.

Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organize information, present results, and make
decisions together in real-time.

YouTube

Watch your favorite channels, listen to music you love, and upload videos
to share with people around the world.

Google Assistant

Your device has the Google Assistant built-in. Find answers and get things
done while on-the-go. To get started, just tap the Google Assistant key
on the side of the phone or touch and hold the home button of the phone.

E + The Google Assistant is not available in certain languages and countries.
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Settings
You can customise the device settings in accordance with your
preferences.

On the home screen, tap Settings.

E « If you enter a keyword on the search window at the top of the screen,
you can conveniently run the items that need to be set.

Network & internet
Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
7 On the settings screen, tap Network & internet > Wi-Fi.
2 Tap () toactivate it.
+ Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget.
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Wi-Fi network settings
On the settings screen, tap Network & internet > Wi-Fi.

- Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

E « This feature depends on the service provider.

-+ :Customise Wi-Fi network settings.

Wi-Fi Direct
You can connect your device to other devices that support Wi-Fi Direct to

share data directly with them. You do not need an access point. You can
connect with more than two devices by using \Wi-Fi Direct.

1 On the settings screen, tap Network & internet > Wi-Fi> ¢ >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
« Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using Wi-Fi Direct.
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Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
1 On the settings screen, tap Network & internet > Mobile data.
2 Tap to activate it.

Customising mobile data settings
71 Onthe settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

+ On:Set to use data connections on mobile networks.

+ Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« + :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.

Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

71 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.
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Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.
1 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap (1)) to activate it.

5 « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ \When connecting to a computer, download the USB driver from
www.lg.com and install it on the computer.

+ You cannot send or receive files between your device and a computer
while USB tethering is turned on. Turn off USB tethering to send or
receive files.

+ Operating systems that support tethering are Window XP or higher, or
Linux.

Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

T On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap () ) to activate it.

2 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.
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5 - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#wifi

Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your
device’s mobile data.

71 On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap () ) to activate it.

2 Turn on Bluetooth on both devices and pair them.

+ This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help
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Airplane mode

You can turn off the call and mobile data functions. \When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

7 Onthe settings screen, tap Network & internet > Airplane mode.

2 Tap Turn on in the confirmation screen.

Mobile networks
You can customise the mobile networks settings.

T On the settings screen, tap Network & internet > Mobile networks.

2 Customise the following settings:

- Data roaming: Browse the web, use emails, multimedia messages
and other data services overseas.

- Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

- Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN

1 On the settings screen, tap Network & internet > VPN.

2 Tap+

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPNS list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNS

You can configure the Private DNS (Domain Name System) options.
7 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

71 On the settings screen, tap Connected devices > Bluetooth.

2 Tap to activate it.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.
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Screen sharing

You can play the screen and sound of the device on a different device,
such as a TV, that supports the Miracast function.

7 On the settings screen, tap Connected devices > Screen sharing.
2 Tap () toactivate it.

3 Select a device from the list of nearby devices.
« If the desired device does not appear, tap Search to refresh the list.

+ After connecting to the device, the device displays the screen of
your device.

« Screen sharing turns off automatically if there is no sharing-compatible
device in the vicinity.

NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

7 On the settings screen, tap Connected devices > NFC.

2 Tap())toactivate it.

« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.
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Android Beam

You can share files by touching the back of the device to other device. You
can also share files including music, videos or contacts and open a web
page or launch an app from the other device.

T On the settings screen, tap Connected devices > Android Beam.

7 Touch the back of the device with another device.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.

Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

7 On the settings screen, tap Connected devices > Sharing panel.

2 Tap @  to deactivate each option.
+ Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery, Music, and File Manager apps.
« Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

Settings 154



File sharing
You can send and receive files between your device and other LG devices
or tablets.
7 On the settings screen, tap Connected devices > File sharing.
2 Customise the following settings:
+ G7 ThinQ: Change the device name.

- Save to: Set the destination folder to save files sent from other
devices in.

- File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.

Media server

You can share media content on your device with nearby devices that
support DLNA.

7 On the settings screen, tap Connected devices > Media server.

2 Customise the following settings:
- Content sharing: Share content on your device with nearby devices.
+ G7 ThinQ: Set your device'’s name.

E + Depending on the user’s product, the menu names may appear
differently.

- Content to share: Select the type of media content to share with
other devices.

- Allowed devices: View a list of devices permitted to access content
on your device.

Not-allowed devices: View a list of devices not permitted to access
content on your device.
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MirrorLink

You can connect the device to a car via USB to use the MirrorLink app
installed on the device from the infotainment system or the head unit of
the car

- This app is available only in cars that support MirrorLink.

+ Download the MirrorLink app from an app store or market. For more
information, visit https7//mirrorlink.com/apps.

- Some functions may be restricted for driver's safety while using the
MirrorLink feature.

1 On the settings screen, tap Connected devices > MirrorLink.

2 Connect the device to an automobile using the USB cable and turn on
Connect via USB cable.

E « If your device is connected to a vehicle that supports automatic
MirrorLink connection, connect via USB cable is automatically activated
on your device.

- Tap + to configure MirrorLink USB auto-connect.

Printing

You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.

On the settings screen, tap Connected devices > Printing.

- Tap Default Print Service to search for printers you can connect to. Or,
tap : > Add printer to manually add a printer.

+ Tap (+) Add service to download the printer app you want.

E + This is available only when the mobile network or the Bluetooth
function is turned on.

- To down the printer app in (+) Add service, first log on to your Google
account.
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Sound

You can customise sound, vibrate and notification settings.
On the settings screen, tap Sound and customise the following settings:

- Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

+ Volume: Adjust the sound volume for various items.

- Ringtone: Select a ringtone for incoming calls. Add or delete ringtones.

- Notification sound: Select a notification ringtone. Set music saved on
the device as a notification ringtone.

- Ring with vibration: Set the device to vibrate and play a ringtone
simultaneously.

- Ringtone ID: Create a ringtone for an incoming call from a particular
contact.

- Flash alert for incoming call: Set the flash to blink according to LG
ringtone.

- Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on particular
days of the week.

- Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

- Volume: Adjust the sound volume for various items.

Normalize Volume: Use the function to normalise the volumes of
different sound sources.

- Equalizer: Use the function to adjust the equalizer settings.

DTS:X 3D Surround: Use the function to play music or video in
three-dimensional, immersive and vivid sound when earphones,
speaker or other external audio devices are connected. See DTS:X 3D
Surround for details.

- Hi-Fi Quad DAC: Connect earphones, speaker or other external
audio devices to the stereo headset jack and use any of them as a
Hi-Fi Quad DAC.
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- Sound preset: Use the function to select sound preset.

- Digital filter: Use the function to adjust the back and forth echo to
play the music as desired.

- Balance: Use the function to adjust the left and right volume of the
earphone.

- Vibration strength: Adjust the vibration intensity.

- Vibration type: You can select the type of vibration when receiving
calls.

- Vibrate on tap: Set the device to vibrate when you tap certain items
on the screen.

- Dialing keypad sound: Select the keypad sound effect.
+ LG Keyboard sound: Select LG keyboard sound effect.
+ Touch sound: Select a sound effect for tapping an item.

+ Screen lock sound: Select a sound effect when the screen is locked or
unlocked.

Display
You can customise detailed settings for each screen type.
On the settings screen, tap Display and customise the following settings:

- Home screen: Customise settings for the Home screen. See Home
screen settings for details.

+ Wallpaper & theme: Select a screen wallpaper, theme, icon, and AOD
for your device.

+ Font: Change the font size, bold text or type.

+ New Second screen: Select how the status bar and app corners will
look.

- Navigation bar: Set the style of the navigation bar with Gestures
or Buttons only. you can also change the button combination when
you set Buttons only as a style of the navigation bar. For detalils, see
Navigation bar.
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AOD (always-on display): Always display information, such as the
date, time and notifications, even when the screen is turned off. For
details, see AOD (always-on display).

Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.

Screen colour: Adjust the colour, colour temperature for the desired
screen.

E - Tap) to reset the settings.

+ App scaling: Adjust the screen size of apps.

Aspect ratio
+ This device uses 19.5:9 aspect ratio.
- Some downloaded apps may not support 19.5:9 aspect ratio.

In this case, select the most optimal screen ratio for the app or
consult the app provider for more information.

- You can select the aspect ratio for individual apps by tapping O >
Settings > Display > App scaling. Select the desired aspect ratio
from Compatibility (16:9), Standard (16.7:9), and Full screen.

- Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

- Screen resolution: Adjust the screen resolution.

E + When you change the screen resolution, currently running apps are
closed.

+ Brightness: Use the slide bar to change the device's screen brightness.
To automatically adjust screen brightness according to ambient light
intensity, tap the Auto switch.

- Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.
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- Brightness boost timeout: Set the device to turn off Brightness boost
automatically after the time set.

- Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

- Auto-rotate screen: Automatically rotate the screen according to the
device's orientation.

- Screen saver: Display a screen saver when the device is connected to
the holder or charger: Select a screen saver type to display.

- One-handed screen: Make the screen size smaller to conveniently use
the device with one hand. Drag the left/right edge to the middle and
hold.

Lock screen & security

You can customise lock screen and security settings.
- Google Play Protect: Scans your device daily for potentially harmful
apps.
- Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure automatic
installation settings.

+ Select screen lock: Select the desired screen lock method. See Setting
a screen lock for details.

- Customize Lock screen: Change the information displayed on the
locked screen.

- Secure lock settings: Change the secure lock settings.

- Fingerprints: Use your fingerprint to unlock the screen or content. See
Fingerprint recognition overview for details.

- Face Recognition: Allows you to unlock the screen with your face. See
Face Recognition overview for details.

- Voice Recognition: Release the lock screen by recognising your voice
command.
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Content lock: Allows you to set a lock type (password or pattern) for
your QuickMemo-+ and Gallery files.

Encryption & credentials: Configure the settings for SD card

encryption and credentials.

- Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for details.

Secure start-up: Protect your device with a lock when it powers on.
See Secure start-up settings for details.

Credential protection: View the type of the storage where the
security certificate will be saved.

- Trusted credentials: View your system's root CA certificates and
user-installed CA certificates.

User credentials: View and change secure certificate information
stored on your device.

Install from storage:Install a secure certificate from a storage.

Clear credentials: Delete user-installed secure certificates and
related credentials.

Set up SIM card lock: Lock or unlock the USIM card, or change the
password (PIN).

Phone administrators: Allows privileges to restrict the control or use
of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app can
be used.

Usage access: View details on usage of apps on the device.
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Privacy

+ Permission manager: Allows you to check and change the permissions
granted to the apps.

+ Show passwords: Display characters briefly as you type.

+ Lock screen: Allows you to set notifications to show on the lock
screen.

+ Make passwords visible: Enable this option to briefly show each
character of the password as you type it S0 you can see what you've
entered.

+ Auto-fill service from Google: Enable this option to enter your
information saved in your account such as password, address, or credit
card number with a single tap. You can also disable this option, use the
Google Autocomplete feature, or add a new service account.

- Google Location History: Allows you to enable or disable Location
History. When enabled, Google periodically stores and uses your
phone’s most recent location data in connection vvith your Google
Account. From the Location History screen, tap  to view and/or
manage your location data.

- Activity controls: Select activities and information which you want
Google to save.

+ Ads: Allows you to check the advertising ID and set the personalised
ads.

- Usage and diagnostics: Enable this option to help improve the
Android experience by automatically sending diagnostic, device, and
app usage data to Google.

Location

You can check how your location information is shared and configure the
permission to access your location information. On the settings screen,
tap Location and set the desired function.
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Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it.

On the settings screen, tap Extensions > Smart Doctor.

Context Awareness

You can automatically change your device settings according to the usage
pattern and location.

7 Onthe settings screen, tap Extensions > Context Awareness.

7 Activate items you want to automatically change settings for.
+ AUTOMATED: You can set the device to change the sound
profile, Bluetooth and Wi-Fi options automatically in different
environments, such as At home, Away from home, At work, and Off
work. You can also set an app to open when earphones are plugged
in or a Bluetooth device is connected.

E + To use this feature, home or work location must be preset in My places.
On the settings screen, tap Location > My places to set the locations.
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Gaming
You can configure settings for game tools, graphics and battery saving
feature.
71 On the settings screen, tap Extensions > Gaming.
2 Customise the following settings:
- Game Launcher:Tap QD to use the game launcher.

- Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.

+ When you change the resolutions on some games, the screen display
feature may not work properly.

« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.

Screen recording
You can configure the settings for screen recording.

1 On the settings screen, tap Extensions > Screen recording.

2 Customise the following settings:
+ Include yourself in video by: Select one from the following options
and tap Save.
- Image:Includes your profile image in video when recording. After
selecting this, tap @ and select a profile image. Then, adjust the
size of the image using the slide bar.

- Front camera:Includes yourself recorded using the front camera
while recording the screen.

- Never: Nothing is included.
+ Audio source: Choose the audio source between Mic and
Contents.
- Video resolution: Select the resolution for screen recording.
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To record the screen

1 Drag the status bar downward to open the Quick access icons list.

2 (If necessary, swipe left over the Quick access icons area.) Tap Gl

3 Read the disclaimer and tap Start. It will start recording in 3 seconds.

4 To stop recording, tap () located at the bottom right of the screen.
The recorded video will be saved in Gallery.

E - If you violate another person's rights such as portrait right or intellectual
property right or defame another person’s reputation by using the
functions provided for the screen recording service, you may be held
liable to civil, criminal or administrative charges in accordance with the
relevant laws. LG Electronics is not legally responsible in any way for the
acts of users.

Dual App

You can install duplicate messenger apps on the product and use two
accounts at the same time.

1 On the settings screen, tap Extensions > Dual App.
2 After reading the disclaimer, tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.

App suggestion

You can quickly access apps that you may need at the moment on the
Overview screen.
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Floating Bar

You can activate frequently used features including shortcuts,
screenshots, Music, Contacts and more by touching and then swiping the
Floating Bar on the screen. See Floating Bar overview for details.

Shortcuts

You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.

71 Onthe settings screen, tap Extensions > Shortcuts.
2 Customise the following settings.
- Open Camera: Press Power key twice to open Camera.

- Open Capture+: Press Volume Up key twice to open Capture+
when the screen is locked or off.

- Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

- Open Google Assistant: Press the Google Assistant key on the
side of the phone.

- Talk to Google Assistant: Press and hold the Google Assistant key
to quickly talk to your Assistant.

E + Google Assistant does not support certain languages.

KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.
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Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app.

Also, you can manage the mobile phone use time by using the Bedtime
mode and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.

Apps & notifications

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

T On the settings screen, tap Apps & notifications.

2 Customise the settings.

Settings 167



Battery

You can view the current battery information or turn on power-saving
mode.

1 On the settings screen, tap Battery.

2 Customise the following settings:
- Battery usage: View the battery usage details. To view more details,
select a specific item.
- Battery percentage on status bar: Display the remaining battery
level as a percentage on the status bar.
- Adaptive battery: Limit battery for apps you don't use often by
limiting their activity in the background.

Background restrictions: Enable this option to restrict background

apps to save the battery while using the device. Restricted apps

for power saving may not work properly or may not send you

notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any

functional limitation while in power saving or battery optimisation

mode.
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Storage
You can view and manage internal storage on the device or storage space
of the memory card.
1 On the settings screen, tap Storage.
2 Customise the following settings:
- Internal storage: View the total storage space and free space in the
devices internal storage. View a list of apps in use and the storage
capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Users & accounts

You can add users to share your device and register a cloud account.
1 On the settings screen, tap Users & accounts.

2 Customise the settings.

Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.
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System

Update centre

You can check and install the latest version of the app or software
provided by LG.

71 On the settings screen, tap System > Update centre.

2 Customise the following settings:

- App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard
You can customise language and keyboard settings for your device.
7 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.
- Manage keyboards: You can change the product’s basic keyboard

setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice

input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.

- Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

- Autofill service: Enable this option to enter your information saved

in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

- Text-to-speech output: Configure the settings for text-to-speech
output.
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- Pointer speed: Adjust the pointer speed of a mouse or trackpad.

- Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time

You can customise date and time settings for your device.
71 Onthe settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

71 Onthe settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.

Backup

You can back up data saved on your device to another device or account.
7 Onthe settings screen, tap System > Backup.

2 Customise the following settings:
+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for details.
- Backup & restore: Back up your device data or restore data to your
device from a backup.

A + Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

- Google backup: Change Google drive backup settings. You can

also check the backup account currently used, or add a new backup
account.
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Restart & reset
You can reset the device including network and app settings.

T On the settings screen, tap System > Restart & reset.

2 Customise the following settings:

- Auto-restart: Automatically restart and optimise the phone at a
set time. Tap () ) to activate this feature. The device automatically
restarts at a set time and optimise itself. Select a date and time for
restart.

E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

+ Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

+ The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery levelis 30% or less, or when the USIM card is locked.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

Network settings reset: Reset Wi-Fi, Bluetooth and other network
settings.

Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.

Factory data reset: Reset all settings for the device and delete
data.

E + Restarting and resetting your device deletes all data on it. Enter your

device name, Google Account and other initial information again.
« After data initialization, the data cannot be restored.
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About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety
You can view regulatory marks and related information on your device.
On the settings screen, tap System > Regulatory & safety.

Accessibility
You can manage accessibility plug-ins installed on your device.
T On the settings screen, tap Accessibility.

2 Customise the following settings:

- Vision > TalkBack: Set the device to notify screen status or actions
via voice.

- Vision > Voice notifications: Set the device to read the caller
information via voice.

- Vision > Font: Change the font size, bold text or type.

- Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

« Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

- Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion:Increase the display colour
contrast for people with low vision.
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- Vision > Screen colour adjustment: Adjust the display colour.

- Vision > Monochrome: Switch the screen to grayscale mode.

« Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

+ Hearing > Captions: Turn on the subtitle service when playing
videos for the hearing impaired.

+ Hearing > Blink LED: Set to turn on LED light for incoming calls and
notifications.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.

- Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

+ Hearing > Audio channel: Select the audio type.

+ Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

- Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

- Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

- Motor & cognition > Physical keyboard: Customise the keyboard
settings.

- Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.

+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.
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+ Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Select to Speak: Allows you to tap items to hear spoken feedback.
+ Switch Access: Create key combinations to control your device.
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LG Language Settings

Select a language to use on your device.
+ On the home screen, tap Settings > System > Language & keyboard
> Language > Add language, and select a language.

- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview
You can back up contacts, photos and more to the computer or update
the device software.

E + See LG Bridge help for detalils.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
- Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

- Update the device software from a computer via USB cable connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.

Appendix 180



Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

« For DTS patents, see http//patents.dts.com. Manufactured under
license from DTS Licensing Limited. DTS, the Symbol, & DTS and the
Symbol together, DTS, and the DTSX logo are registered trademarks
or trademarks of DTS, Inc. in the United States and/or other countries.
© DTS, Inc. All Rights Reserved.

LG Boombox Edition

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

- G7ThinQ s a trademark of LG Electronics Inc.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

- Wi-Fi® and the Wi-Filogo are registered trademarks of the Wi-Fi
Alliance.

- All other trademarks and copyrights are the property of their
respective owners.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-G710EM product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration
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Contact office for compliance of

this product

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

The use of the 5150 - 5350 MHz band is restricted to indoor use only.
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More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Aspect ratio
This device uses 19.5:9 aspect ratio.
+ Some downloaded apps may not support 19.5:9 aspect ratio.

In this case, select the most optimal screen ratio for the app or consult
the app provider for more information.
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Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Bands Tx Output power

GSM 900 34.0dBm

GSM 1800 31.0dBm

WCDMA B1 23.5dBm

WCDMA B8 24.8dBm

LTEB1 23.5dBm

LTEB3 24.2 dBm

LTEB7 24.5dBm

LTEBS8 24.8dBm

LTEB20 24.8 dBm

LTEB28 24.8 dBm

LTEB38 24.5dBm

LTEB40 24.5dBm

BT 24GHz 11.0dBm

WLAN 2.4GHz 15.5dBm

WLAN 5.150~5.350GHz 150dBm

WLAN 5.470~5.725GHz 15.0dBm

WLAN 5.725~5.875GHz 10.5dBm
NFC -22 dBuA/m

Travel Adapter Information can be found at
http7//www.lg.com/global/support/cedoc/cedoc
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialing.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.

Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.
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Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Center.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.

The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Center.
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Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.

Reset the device
- If the methods above do not solve your problem, perform a factory
datareset.
- On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.
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Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Centre.

A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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